
SICAM
SICAM SCC
Human-Machine Interface
(HMI)

V9.06

Manual

E50417-H8976-C501-B5

Preface

Open Source Software

Table of Contents

Product Overview 1
Installation and Uninstallation 2
Working with SICAM SCC 3
Graphic Objects 4
Topological Coloring 5
SICAM Add-In 6
Components and Functions 7
Client-Server Systems 8
Redundancy 9
Different SICAM PAS Versions 10
WinCC Web Navigator 11
System Time 12
Converting Projects from Previous
Versions 13
Components and Functions of Earlier
SICAM PAS CC/SCC Versions 14
Appendix A
Literature

Index



ii NOTE
For your own safety, observe the warnings and safety instructions contained in this document, if available.

Disclaimer of Liability
Subject to changes and errors. The information given in
this document only contains general descriptions and/or
performance features which may not always specifically
reflect those described, or which may undergo modifica-
tion in the course of further development of the products.
The requested performance features are binding only when
they are expressly agreed upon in the concluded contract.
Document version: E50417-H8976-C501-B5.05
Edition: 05.2020
Version of the product described: V9.06

Copyright
Copyright © Siemens 2020. All rights reserved.
The disclosure, duplication, distribution and editing of this
document, or utilization and communication of the content
are not permitted, unless authorized in writing. All rights,
including rights created by patent grant or registration of a
utility model or a design, are reserved.

Trademarks
SIPROTEC, DIGSI, SIGRA, SIGUARD, SIMEAS SAFIR, SICAM,
and MindSphere are trademarks of Siemens. Any unauthor-
ized use is prohibited.



Preface

Purpose of the Manual

This document provides all necessary information for installation, for commissioning, as well as details
regarding the functionality of SICAM SCC.

Target Audience
This manual is mainly intended for commissioning engineers, programmers and users of SICAM SCC. Basic
knowledge of SIMATIC WinCC is required.

Scope
This manual is valid for SICAM SCC V9.06.

Standards
SICAM SCC has been developed in compliance with ISO 9001:2008 standard.

Additional Support
For questions about the system, contact your Siemens sales partner.

Customer Support Center
Our Customer Support Center provides a 24-hour service.
Siemens AG
Customer Support Center
Humboldtstrasse 59
90459 Nuremberg
Germany
E-mail: support.energy@siemens.com

Training Courses
Inquiries regarding individual training courses should be addressed to our Training Center:
Siemens AG Phone: +49 (911) 433-7415
Siemens Power Academy TD Fax: +49 (911) 433-7929
Humboldtstrasse 59 E-mail: poweracademy@siemens.com
90459 Nuremberg Internet: www.siemens.com/poweracademy
Germany

Notes on Safety
This document is not a complete index of all safety measures required for operation of the equipment (module
or device). However, it comprises important information that must be followed for personal safety, as well as
to avoid material damage. Information is highlighted and illustrated as follows according to the degree of
danger:
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! DANGER
DANGER means that death or severe injury will result if the measures specified are not taken.

² Comply with all instructions, in order to avoid death or severe injuries.

! WARNING
WARNING means that death or severe injury may result if the measures specified are not taken.

² Comply with all instructions, in order to avoid death or severe injuries.

! CAUTION
CAUTION means that medium-severe or slight injuries can occur if the specified measures are not taken.

² Comply with all instructions, in order to avoid moderate or minor injuries.

NOTICE
NOTICE means that property damage can result if the measures specified are not taken.

² Comply with all instructions, in order to avoid property damage.

ii NOTE
Important information about the product, product handling or a certain section of the documentation
which must be given attention.

Qualified Electrical Engineering Personnel
Only qualified electrical engineering personnel may commission and operate the equipment (module, device)
described in this document. Qualified electrical engineering personnel in the sense of this document are
people who can demonstrate technical qualifications as electrical technicians. These persons may commission,
isolate, ground and label devices, systems and circuits according to the standards of safety engineering.

Proper Use
The equipment (device, module) may be used only for such applications as set out in the catalogs and the
technical description, and only in combination with third-party equipment recommended and approved by
Siemens.
Problem-free and safe operation of the product depends on the following:

• Proper transport

• Proper storage, setup and installation

• Proper operation and maintenance
When electrical equipment is operated, hazardous voltages are inevitably present in certain parts. If proper
action is not taken, death, severe injury or property damage can result:

• The equipment must be grounded at the grounding terminal before any connections are made.

• All circuit components connected to the power supply may be subject to dangerous voltage.
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• Hazardous voltages may be present in equipment even after the supply voltage has been disconnected
(capacitors can still be charged).

• Operation of equipment with exposed current-transformer circuits is prohibited. Before disconnecting the
equipment, ensure that the current-transformer circuits are short-circuited.

• The limiting values stated in the document must not be exceeded. This must also be considered during
testing and commissioning.
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Open Source Software

The product contains, among other things, Open Source Software developed by third parties. The Open
Source Software used in the product and the license agreements concerning this software can be found in the
Readme_OSS. These Open Source Software files are protected by copyright. Your compliance with those
license conditions will entitle you to use the Open Source Software as foreseen in the relevant license. In the
event of conflicts between Siemens license conditions and the Open Source Software license conditions, the
Open Source Software conditions shall prevail with respect to the Open Source Software portions of the soft-
ware. The Open Source Software is licensed royalty-free. Insofar as the applicable Open Source Software
License Conditions provide for it you can order the source code of the Open Source Software from your
Siemens sales contact – against payment of the shipping and handling charges – for a period of at least 3
years after purchase of the product. We are liable for the product including the Open Source Software
contained in it pursuant to the license conditions applicable to the product. Any liability for the Open Source
Software beyond the program flow intended for the product is explicitly excluded. Furthermore any liability
for defects resulting from modifications to the Open Source Software by you or third parties is excluded. We
do not provide any technical support for the product if it has been modified.
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Product Overview

What is SICAM SCC?
SICAM SCC (SICAM Station Control Center) is the Human-Machine Interface (HMI) for the following power
automation systems:

• SICAM PAS/PQS

• SICAM RTUs

• IEC 61850 devices

• IEC 60870-5-104 devices
SICAM SAS comprises:

• SIMATIC WinCC process visualization system

• SICAM SCC components
SIMATIC WinCC provides standard function modules for the display of graphic diagrams and views for alarms,
archiving and logging. Based on its powerful process interface, fast display refresh rates and safe data
archiving functions, it provides for high availability.

SICAM SCC Components
SICAM SCC comprises the following components:

• SICAM graphic object library

• Alarm system extension

• SICAM Import/Export Wizard, SICAM PAS Wizard, and SICAM IEC Wizard

• SICAM Functions

• SICAM Normalization DLLs

• SICAM PAS PROTOCOL SUITE and SICAM IEC COMMUNICATION SUITE

• SICAM Valpro (evaluation of archives for measured and metered values)

SICAM graphic object library
The SICAM graphic object library includes objects for the representation of typical substation control and
protection equipment (e. g. switchgears). These graphic objects are used for the creation of station diagrams.
The SICAM graphic object library includes e.g. several typical graphic objects for switchgears.
Graphic objects can be dragged and dropped from the library to a station diagram.
They already include dynamic display properties. For example, a circuit breaker provides all dynamic features
required for the representation of the process states ON, OFF, Intermediate Position, Fault Position, Not
Topical, PAS not OK, Bay Blocking, Substituted and Telecontrol Blocking.
You can quickly and efficiently define the topology parameters of your system in the Graphics Designer.

Alarm system extension
The alarm system extension ensures that data is logged and archived in correct chronological order.
The SICAM PAS normalization DLL evaluates the data and assigns it related items of process information.

1
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In order to assign process information, the normalization DLL accesses the SIMATIC WinCC text library.
Texts can be customized in the text library to meet individual requirements.
The information in the event list is of great significance.

SICAM Wizard

ii NOTE
Use the SICAM Import/Export Wizard as the standard wizard (see 7.2.1 SICAM Import/Export Wizard). If
required, you can start the SICAM PAS Wizard or the SICAM IEC Wizard from the context menu of the
SICAM Import/Export Wizard.

The SICAM Wizard supports you in the creation of a new project or in updating an existing WinCC project. The
following wizards are available:

• SICAM PAS Wizard for the connection of SICAM PAS

• SICAM IEC Wizard for the connection of SICAM RTUs, IEC 61850 and IEC 61870-5-104 devices
You can perform the following tasks using the SICAM Wizard:

• Creating the SICAM-specific structure types
You can create the structure types required in a SICAM system for structured tags.
These structure types are required for data exchange with SICAM PAS, SICAM RTUs, IEC 61850 and IEC
60870-5-104 devices.

• Importing the tags from SICAM PAS, SICAM RTUs, IEC 61850 and IEC 60870-5-104 devices
You transfer the information to SICAM SCC.
This enables you to visualize items of information from these systems under SICAM SCC, i. e. for use in
process diagrams.

• Creating administrative tags for SICAM PAS
Creating the SICAM-specific Alarm Logging system
You create a SICAM-specific Alarm Logging system in SICAM SCC.
The SICAM graphic object library provides objects for the following lists:
– Event list
– Warning message list
– Protection message list
These SICAM-specific lists are stored in the SICAM graphic object library.
You can configure messages in this Alarm Logging system.

• Importing messages from the import files
This enables you to visualize messages in SICAM SCC in the Alarm Logging system.

• IImporting the SICAM graphic object library into the project
Load the SICAM graphic object library into your current project.
Use the SICAM graphic object library for visualizing station diagrams under SICAM SCC.

• Creating the measured-value and metered-value archives for process data
Create a Tag Logging system under SICAM SCC.
The SICAM SCC Tag Logging system comprises:
– a measured-value archive
– a metered-value archive
You can import metered and measured value tags into this Tag Logging system.

Product Overview
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• Adding a communication driver
You can add a communication driver and thus define the transmission path to SICAM PAS, SICAM RTUs,
IEC 61850 and IEC 60870-5-104 devices.

SICAM functions
The SICAM functions (VB or C scripts) complement the library of SIMATIC WinCC functions. They are available
as project-specific functions in the corresponding folders.
Use the SICAM functions in station diagrams. For example, you can execute commands via these actions.

SICAM Graphics Designer Extension
The Graphics Designer enables you to define several graphic objects simultaneously by means of defined
tasks. Predefined tasks are available.

SICAM Valpro
SICAM Valpro has been designed for the processing, display and printing of archived measured and metered
values.
SICAM Valpro interacts with the SICAM SCC Tag Logging system.
SICAM Valpro can be used independently of SICAM SCC.
For a more detailed description regarding SICAM Valpro, refer to /5/ SICAM Valpro, Measured/Metered Value
Processing Utility SICAM Valpro.

Redundant system
To provide fail safety, a SICAM SCC system can be implemented in redundant configuration.
If one of the two SICAM SCC servers fails, the client computers automatically switch over from the failed server
to the active SICAM SCC server. Based on this concept, proper process monitoring and operation is always
ensured.
A redundant SICAM PAS system or SICAM RTUs are supported.

Product Overview
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Installation Requirements
Operating System and SIMATIC WinCC

SICAM SCC V9.06 is a 32-bit-application. The table below indicates possible combinations of the operating
system and SIMATIC WinCC.
Windows SIMATIC WinCC

V7.3 V7.4 SP1 V7.5 SP1
7 Professional 32-bit SP11

7 Ultimate 32-bit SP11

7 Enterprise 32-bit SP11

x x

7 Professional 64-bit1

7 Ultimate 64-bit SP11

7 Enterprise 64-bit SP11

x x

8.1 Professional 32-bit1

8.1 Enterprise 32-bit
x x

8.1 Professional 64-bit1

8.1 Enterprise 64-bit1

x x

10 Professional 64-bit1

10 Enterprise 64-bit1

10 IoT Enterprise LTSB 64-bit1

x x

2008 Server SP2 32-bit1 x
2008 Server R2 SP1 64-bit1 x x
2012 Server R2 64-bit x x x
2016 Server 64-bit x x
2019 Server 64-Bit x x

SIMATIC WinCC must be licensed and the latest update for the installed WinCC version must be installed. You
can find a list of the necessary updates in the corresponding Readme file. You can download the update pack-
ages from the following website: SIEMENS Industry Online Support (SIOS).

Microsoft .NET Framework
Before installing WinCC, make sure that .NET Framework is installed in the correct version depending on the
operating system:

• Windows 10
Microsoft .NET Framework 3.5 is required in order to be able to install SQL Management Studio

• Windows Server 2012 R2
Microsoft .NET Framework 4.6.1 (install this version later, if required)

• Windows 10 / Windows Server 2016
Microsoft .NET Framework 4.7

Microsoft Visual C++ Redistributable Packet VCRedist 2008 SP1 (x86)
Microsoft has discontinued support for the 2008 version of Visual Studio. Therefore, this version of the Visual
C++ Redistributables can no longer be included on the SICAM SCC DVD.
In order to be able to use projects from older versions with SICAM SCC V9.06, components of these versions
are partially included on the SICAM SCC DVD, e.g. for the connection to SICAM PAS V5.11 and V6.0 extensions
for the alarm system and communication channels are included.

2.1

1 These operating systems can be installed as standard version or as MUI version.

Installation and Uninstallation
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These components are not further developed. The Visual C++ Redistributables of version 2008 SP1 are neces-
sary for operation. You can download this package from the Microsoft Internet pages:
https://www.microsoft.com/en-us/download/details.aspx?id=26368

• Install the version for x86 operating systems.
SICAM Valpro has not yet been upgraded to a newer version of Visual C++ and also requires these Microsoft
runtime components.

Ports Required for Operating SICAM SCC
Certain ports are required in order to be able to operate SICAM SCC with SICAM DISTO, IEC 60870-5-104
communication drivers, IEC 61850 communication drivers and SNMP.
For more detailed information, refer to SICAM / SIPROTEC, System Hardening for Substation Automation and
Protection.

Basic Hardware

CPU
Windows 7 Client

Single-user system:
3 GHz/Multi Core
3.5 GHz/Multi Core

Windows 8.1
Windows 10

Client
Single-user system:

3 GHz/Multi Core
3.5 GHz/Multi Core

Windows Server 2008 R2
Windows Server 2012 R2
Windows Server 2016

Single-user system:
Server:

3.5 GHz/Multi Core
3.5 GHz/Multi Core

Primary storage
Windows 7 Client

Single-user system:
32-bit: 2 GB, 64-bit: 4 GB
32-bit: 2 GB, 64-bit: 4 GB

Windows 8.1 Client
Single-user system:

32-bit: 2 GB, 64-bit: 4 GB
32-bit: 2 GB, 64-bit: 4 GB

Windows 10 (64-bit) Client
Single-user system:

4 GB
4 GB

Windows Server 2003 Single-user system:
Server:

32-bit: 2 GB, 64-bit: 4 GB
32-bit: 2 GB, 64-bit: 4 GB

Windows Server 2008 R2
Windows Server 2012 R2
Windows Server 2016

Single-user system:
Server:

8 GB
8 GB

Hard disk capacity
Client:
Server:

1.5 GB
10 GB

Virtual primary storage
1.5 times primary storage

Primary storage for Windows printer spooler
100 MB

Graphics card
32 MB, True Color (32 Bit), 1024 x 768 or 1366x768
recommended for FullHD (1980x1080) or later

Installation and Uninstallation
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Miscellaneous
Monitor suitable for graphics card
Dual-layer DVD drive
USB port for licensing
Keyboard
Mouse

Sequence of Installation
SICAM SCC consists of the following 2 software packages:

• SIMATIC WinCC

• SICAM SCC components
Install the 2 software packages one after the other. Hotfixes and Service Packs are available on the SIOS portal
from SIEMENS DI. Check if there is a newer Hotfix or an update available for one of your installed components.

The components must be installed in the following order:
² Install the SIMATIC WinCC process visualization system.

² License SIMATIC WinCC to make the program executable.

² Install the SICAM SCC components.

² License the SICAM SCC components to make them executable.

ii NOTE
To ensure that all the components function correctly, they must be installed in the following order:

• Install the program package using the setup routine. Exit it as soon as the package has been
completely installed.

• License the program components.

Installation and Uninstallation
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Installing SIMATIC WinCC
Install SIMATIC WinCC on your computer using a setup routine.
Local administrator rights are required to perform the installation.
Following installation, SIMATIC WinCC must be licensed in order to make the software executable.

ii NOTE
On a computer with installed licenses, do not run any routines which would modify the partitioning or the
structure of the hard disk(s).
Hard-disk maintenance routines, e. g. routines for the repair, defragmentation or partitioning of your hard
disk, must be avoided. If you use routines of this type, you run the risk of losing your license!
Make sure you temporarily transfer your license back to the license USB stick prior to running a hard disk
maintenance routine.

Installation

Before installing SIMATIC WinCC, you must install MS Message Queuing. To install this component, follow the
instructions on the SIMATIC WinCC installation DVD.
To install SIMATIC WinCC, proceed as follows:
² Insert the DVD with SIMATIC WinCC into your DVD drive.

² Select Start > Run.

² Enter X:\Start. In this input sequence, X is the letter of your DVD drive.

² Click OK.

² Select Install SIMATIC WinCC.

² Follow the installation instructions until the Installation type dialog opens. Select the Package installa-
tion and click Next >.

² In the Program packages dialog, select the WinCC Installation and click Next >.

² Continue to follow the instructions until the setup routine requests your license.

² Answer the question whether the license shall be installed during the installation procedure with No. The
setup routine skips the licensing.

² Restart the computer after the installation is completed.

Licensing

You license the product by transferring the license from the license USB stick to your computer.
To install your SIMATIC WinCC license, proceed as follows:
² Plug the license USB stick included in the scope of delivery into the USB interface.

² Start the Automation License Manager.

² Transfer the license from the license USB stick to your hard disk.

2.2

2.2.1

2.2.2
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Installing SICAM SCC Components
You can install SICAM SCC components on your computer by means of a setup routine.
During the installation procedure, the setup routine transfers all the necessary data to your computer.
Following installation, the SICAM SCC components must be licensed in order to make them executable.

ii NOTE
On a computer with installed licenses, do not run any routines which would modify the partitioning or the
structure of the hard disk(s).
Hard-disk maintenance routines, e. g. routines for the repair, defragmentation or partitioning of your hard
disk, must be avoided. If you use routines of this type, you run the risk of losing your license!
Make sure you temporarily transfer your license back to the license USB stick prior to running a hard disk
maintenance routine.

Design Variants

To execute the SICAM SCC components you can choose between the following options:

• Demo Mode

• Trial Mode

• Licensed Version
In order to be able to execute all these variants, both SIMATIC WinCC and the SICAM SCC components must be
installed. The decision as to which variant you want to use must be made upon the licensing of the SICAM SCC
components.

ii NOTE
If SIMATIC WinCC is not licensed, the restrictions for the non-licensed SIMATIC WinCC apply in addition to
the restrictions for non-licensed SICAM SCC components, see SIMATIC WinCC Information System.

Demo Mode
No license for the SICAM SCC components is required for using the Demo mode. The Demo mode is only avail-
able for SICAM SCC V8 components (or higher). Components of older SICAM SCC versions, which are still
included in the scope of delivery for compatibility reasons, do not support this mode.
The following restrictions apply in Demo mode:

• Configuration
– A note pops up in Demo mode 30 minutes after the start of configuration in the Graphics Designer.

You can save your picture or exit the Graphics Designer without saving. You must restart the
Graphics Designer in order to be able to carry out configuration steps during another 30 minutes.

– A note concerning the use of the Demo mode pops up in the Graphics Designer before saving
pictures. This note disappears after 30 seconds and the picture is saved.

– When calling up a wizard, a note informs you that the license is missing. You have the option to
activate the trial license. The Demo mode is activated if you click Skip to reject the license. The
wizards cannot be started in Demo mode.

– You can also operate the SNMP functions (SICAM Network Manager) using the Trial license or
operate them for 30 minutes in Demo mode.

2.3

2.3.1

Installation and Uninstallation
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• Runtime
– When starting the runtime, a note pops up to inform you that the license is missing. You have the

option to activate the Trial license. The Demo mode is activated if you click Skip to reject the
license. A note pops up to inform you that the software is running in Demo mode.

– In the Alarm Logging lists, all the logged alarms in the Status and Cause columns are additionally
marked with the Demo mode attribute.

– After using a switching device object, a note is shown every 5 minutes to inform you that you are
working in Demo mode. In order to be able to continue operation within the picture, you must click
OK to close this note.

Trial Mode
If no applicable license could be found on your computer when starting a SICAM SCC component such as the
SICAM PAS Wizard, SICAM SCC offers a trial mode license via the Automation License Manager. If you acti-
vate this trial mode license, you can use the SICAM SCC component for 14 days. The trial mode license expires
after this period. In order to continue to use the full scope of SICAM SCC, you must transfer a standard license
without a time limit for the SICAM SCC components, see 2.3.3 Licensing. The trial mode license can only be
activated once. The SICAM SCC components change over to Demo mode assoon as the Trial mode period has
expired. The SICAM Wizard cannot be started in Demo mode.

Licensed Version
In order to be able to use the licensed version, the licenses for the SICAM SCC components must be trans-
ferred to your computer, see 2.3.3 Licensing.

Installation

ii NOTE
Before installing the SICAM SCC components, you must install the SIMATIC WinCC updates. The SIMATIC
WinCC updates are available from the SIEMENS Industry Online Support (SIOS). A list of the updates
required is provided in the corresponding Readme file.

To install the SICAM SCC components:
² Insert the SICAM SCC DVD into your DVD drive.

² Click Start > Run.

² Enter X:\Setup. In this input sequence, X is the letter of your DVD drive.

² Click OK.
You can select the appropriate components during the custom setup procedure.

² Follow the installation instructions.

2.3.2

Installation and Uninstallation
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[Installation_Userdefined, 2, en_US]

Figure 2-1 Custom Setup

ii NOTE
To install only the SICAM Valpro SICAM SCC component on a computer, SIMATIC WinCC does not need to
be installed on this computer. During the installation, select only the Valpro component.

Licensing

To install the license for your SICAM SCC components:
² Plug the license USB stick included in the scope of delivery into the USB interface.

² Start the Automation License Manager.

² Transfer the license from the license USB stick to your hard disk.

Automated Installation

The SICAM SCC setup also provides (in addition to the standard installation) an automated installation via
installation scripts or batch files. The default installation is installed if you choose the automated installation
process.
To install SICAM SCC unattended and without user interaction, the following commands are supported:

• Installation:
<Installation medium>\Setup.exe /si
With changed installation path:
<Installation medium>\Setup.exe /si "INSTALLDIR=D:\Siemens\...\SCC”

• Uninstallation:
<Installation medium>\Setup.exe /sx
<SICAM installation directory>\SCC\Setup\Setup.exe /arp /sx

The default setting for the SICAM installation directory is:
%Program-Files(x86)%\Siemens Energy\SICAM

2.3.3

2.3.4

Installation and Uninstallation
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e.g. under Windows 7 (64-bit): C:\Program Files (x86)\Siemens Energy\SICAM
You can use the environment variable %ProgramFiles% or %ProgramFiles(x86)% instead of the textual path
and enter it e.g. directly in the address bar of the Windows Explorer or use it in the Windows command line.
The variable is automatically translated into the actual path by the system.
You can modify the SICAM SCC installation directory, if required.

ii NOTE
C:\Program Files (x86) or C:\Program Files must be used depending on the operating system (64-bit or
32-bit). The setup uses the registered directory name.

ii NOTE
Uninstallation via command line is only available if SICAM SCC has also been installed in this mode.
During automated installation, the setup does not check if SIMATIC WinCC is installed. Ensure that a
SIMATIC WinCC version is installed which is approved for SICAM SCC.

ii NOTE
Installation via command line installs the standard scope. Adding further components by changing the
installation is not possible. In this case, uninstall SICAM SCC and re-install it in normal mode.

Installation and Uninstallation
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Uninstalling SICAM SCC Components
You can remove the SICAM SCC components from your computer using the uninstall routine.
All data installed by the SICAM SCC setup routine will be deleted during uninstallation.
You can remove the license for SICAM SCC without using the uninstall routine.

Removing the license

Durch die Übertragung der Lizenz von Ihrem Rechner auf den Lizenz-USB-Stick entfernen Sie die Lizenzierung.

ii NOTE
The license can also be transferred to another removable medium, e. g. a memory stick.

To remove the license of your SICAM SCC components:
² Plug the license USB stick included in the scope of delivery into the USB interface.

² Start the Automation License Manager.

² Transfer the license from the hard disk to the license USB stick.

Uninstallation

To uninstall the SICAM SCC components:
² Click Start > Settings > Control Panels > Add/Remove Programs.

² Select SICAM SCC in the list of programs.

² Click Remove to start the uninstall routine.

² Follow the uninstallation instructions.

Protection against data loss

The uninstallation routine does not remove any files created by the user. Directories including such data are
therefore not removed.

2.4

2.4.1

2.4.2

2.4.3
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Uninstalling SIMATIC WinCC
SIMATIC WinCC can be removed from your computer using the uninstall routine.
During this procedure, all data installed by the setup routine of SIMATIC WinCC will be deleted.

Removing the License

You remove the licensing by transferring the license from your computer to the license USB stick.
To remove the license for SIMATIC WinCC, proceed as follows:
² Plug the license USB stick included in the scope of delivery into the USB interface.

² Start the Automation License Manager.

² Transfer the license from the hard disk to the license USB stick.

Uninstallation

There are 2 options to uninstall WinCC:
Via the WinCC product DVD or via the Windows Control Panel.

To uninstall WinCC via the product DVD, proceed as follows:

² Start the WinCC product DVD.

² If the autorun function of the operating system is enabled, the DVD is started automatically. If the
autorun function is not enabled, start the Setup.exe program on the DVD.

² Follow the on-screen instructions.

² Select the setup type Uninstall.
² Select the components to be uninstalled.

To uninstall WinCC via the Control Panel (alternative), proceed as follows:

² Open the Windows Control Panel via the Start menu.

² Double-click Add/Remove Programs.

² Click Modify or Remove Programs.

² Select the desired entry and click Remove or Modify.
The names of all the WinCC components installed start with "SIMATIC WinCC".

² If WinCC options are installed, uninstall these options first and then uninstall the WinCC version.

Uninstalling Microsoft SQL Server
After uninstalling WinCC you must uninstall the SQL Server instance "WinCC".
² Click Control Panel > Programs and Features and select Microsoft SQL Server xxxx for uninstallation.

Protection against data loss

The uninstallation routine does not remove any files created by the user. Directories including such data are
therefore not removed.

Virtualization

SICAM SCC supports virtualization with VMWare®.

2.5

2.5.1

2.5.2

2.5.3

2.5.4
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Demo Project
As soon as SICAM SCC has been installed, a WinCC demo project is available under ...\SICAM\SCC\Samples\. All
the major functions of SICAM SCC are implemented in this demo project.
In addition, the demo project includes sample configurations for the functionalities described in this manual.
You can simply transfer these sample configurations for use in your projects.
This paragraph provides an example for the implementation of certain functions from the demo project.
The demo project provides the following options:

• The demo project is fully dynamized.

• Tags can be modified using the SIMATIC WinCC tag simulation.

• Switch statuses can be simulated in a SICAM structure tag window.

• A field is executable together with the data of the SICAM PAS V8.0 demo project.

ii NOTE
The demo project is executable with SIMATIC WinCC V7.4 and must neither be edited nor started with an
older SIMATIC WinCC version. Read the notes in the file How to use the demo project.pdf (in the
DemoSCC folder).

3.1

Working with SICAM SCC
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Creating a New Project
For each new WinCC project, you must perform frequently repeated operator actions. These actions must be
performed in the correct order, because each step is based on the previous one.
If SICAM PAS is mentioned in this section, the same applies to SICAM RTUs and to IEC 61850 and IEC 60870-
5-104 devices. Differences will be pointed out.

How to proceed
To create a new WinCC project, you must execute the following steps one after the other:

• Creating a new WinCC project

• Defining computer properties
Select the WinCC components to be started during runtime. Select the desired runtime language. During
the import process, the data is imported in the runtime language defined.

• Starting the SICAM Wizard
(SICAM Import/Export Wizard, SICAM PAS Wizard, or SICAM IEC Wizard)
The SICAM Wizard supports you in creating a WinCC project by importing configuration data from the
target systems. You can visualize items of information from the target systems under SICAM SCC, i. e. for
use in process diagrams. In addition to this, it integrates the SICAM-specific extensions into the new
WinCC project.

ii NOTE
If you use the SICAM Import/Export Wizard, you must not use one of the other Wizards additionally - and
vice versa. Otherwise the project could be damaged.

ii NOTE
The SICAM Wizard supports you in creating a new WinCC project. This wizard is an autonomous application
started via the WinCC Explorer.
To start the SICAM Wizard:

• To open the WinCC Explorer, click Start > Siemens Energy > SICAM > SCC > SCC.

• In the WinCC Explorer, double-click the SICAM Wizard.

ii NOTE
The configuration of the SICAM TOOLBOX II and the SCD/ICD/CID files must not include special characters
such as ä, ö, ü or ß.
If special characters are included, you must modify the coding of the XML file.
Change the entry <?xml version="1.0" encoding="UTF-8"?> in the first line as follows:
<?xml version="1.0" encoding="iso8859-1"?>

Creating a New WinCC Project

How to proceed
To create a new WinCC project, click File > New in the WinCC Explorer.

Creating a new project
To create a new project, proceed as follows:
² Click File > New in the WinCC Explorer.

3.2

3.2.1
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² Select your project type from the WinCC Explorer dialog, e.g. single-user project, and then click OK to
confirm.

[pascc301, 1, en_US]

Figure 3-1 Selecting a single-user project

² The Create a new project dialog opens. Specify a project path and enter the project name.

[pascc302, 1, en_US]

Figure 3-2 Creating a new project

² Click Create to create the new project.

Defining Project Properties

In the project properties you define e.g. the operating mode, the design and the hotkeys. You can define
Logon and Logoff hotkeys for your project.

• Logon: Opens a window for logging on a user during Runtime

• Logoff: Opens a window for logging off a user during Runtime
To open the Project Properties dialog:

3.2.2

Working with SICAM SCC
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² Right-click the project in the WinCC Explorer.

² Select Properties in the context menu.

[pascc302a, 1, en_US]

Figure 3-3 Example, assigning hotkeys

² For example, you can assign hotkeys for the Logon and Logoff actions.

² Click OK to close the dialog.

Defining Computer Properties

How to proceed
To define the computer properties:
² Open the Computer properties dialog in the WinCC Explorer.

² Check the computer name in the General tab.

² Activate the required runtime components in the Startup tab.

² Select the language of the runtime system in the Parameters tab.

² Set the desired parameters in the Graphics Runtime tab.

3.2.3
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Opening the Computer properties Dialog
To open the Computer properties dialog:
² Select the Computer level in the WinCC Explorer.

² Right-click the name of the computer.

² Select Properties in the context menu.

[pascc303, 2, en_US]

Figure 3-4 Opening the Computer properties Dialog

Checking the Computer Name

² In the Computer properties dialog, click the General tab. Next, check whether the correct name of your
computer is indicated in the Computer name entry field.

The computer name is entered automatically when creating a new WinCC project.
² Enter the name of your computer unless the name has already been entered automatically.
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[pascc304, 1, en_US]

Figure 3-5 Checking the Computer Name

Activating Runtime Components
To activate the runtime components:
² In the Computer properties dialog, click the Startup tab.

² In the WinCC Runtime Start Up Order section, you can select each runtime component by clicking on
the corresponding checkbox. Select further components (if required).
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Figure 3-6 Activating All Runtime Components

Defining the Runtime Language
It is important to define the runtime language before starting the SICAM Wizard. You specify in which
language column of the text library the message texts will be arranged and in which language e.g. the
message classes will be created.
To define the runtime language:
² In the Computer properties dialog click the Parameters tab.

² Select the desired language from the Runtime Default Language drop-down list box.
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Figure 3-7 Defining the Runtime Language

Setting the Graphics Runtime Parameters
To set the parameters of the graphics runtime:
² In the Computer properties dialog, click the Graphics Runtime tab.
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Figure 3-8 Setting the Graphics Runtime Parameters

ii NOTE
After you have created a start screen in the Graphics Designer, enter its name (e.g. start.PDL) in the Start
screen entry field of the Graphics Runtime tab.

Setting Runtime Parameters
To set the parameters of the graphics runtime:
² In the Computer properties dialog, click the Runtime tab.
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Figure 3-9 Setting the Runtime Parameters

² Click OK to close the dialog.

Initializing a WinCC Project

Initialize the new WinCC project with the SICAM Import/Export Wizard, see 7.2.1 SICAM Import/Export Wizard.

ii NOTE
Use the SICAM Import/Export Wizard as the standard wizard (see 7.2.1 SICAM Import/Export Wizard). If
required, you can start the SICAM PAS Wizard or the SICAM IEC Wizard from the context menu of the
SICAM Import/Export Wizard.

3.2.4
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In case you use the old Wizards, be aware of the station type which you want to connect to SICAM SCC. The
procedures are almost identical and only differ with regard to certain points. The following station types are
possible:

• SICAM PAS station, initialization using the SICAM PAS Wizard, see 3.2.4.1 SICAM PAS Station

• SICAM PAS/PQS station or SITIPE, initialization using the SICAM Import/Export Wizard, see 7.2.1 SICAM
Import/Export Wizard

• SICAM RTUs, initialization using the SICAM IEC Wizard, see 3.2.4.2 SICAM RTUs

• IEC 60870-5-104 devices, initialization using the SICAM IEC Wizard, see3.2.4.3 IEC 60870-5-104 Devices

• IEC 61850 devices, initialization using the SICAM IEC Wizard,see3.2.4.4 IEC 61850 Devices

• SICAM SAS station, initialization using the SICAM Global Wizard, see /10/ SICAM SCC for SICAM SAS.
The following section describes details of and differences between the procedures to be applied for the indi-
vidual station types.
The wizards mustnot be started in the Runtime mode of SIMATIC WinCC. SIMATIC WinCC editors must neither
be started nor exited while a wizard is active. They interrupt the interfacing of the wizard, and changes cannot
be performed.
The task of the wizard is to import configuration data into a SIMATIC WinCC project and update this data. The
update function cannot be used in order to replace existing station data in a SIMATIC WinCC project by
completely different data. This also refers to deleted or newly created devices in SICAM PAS or TOOLBOX II
projects and SCD files. In these cases you must delete and re-import the imported data using the corre-
sponding wizard.
The Create SICAM Alarm Logging System option on pages 4/5 should only be selected to re-create the
SICAM Alarm Logging System. To do this, the Alarm Logging message blocks must be removed first. Other-
wise, the column headers in the alarm lists may disappear.

Volume Requirements
You can use 8 different IEC 61850 imports as well as 8 T104 imports.
You can execute

• 8 different IEC 61850 imports as well as

• 8 IEC 60870-5-104 imports.
1 Import corresponds to:

• 1 SXD file,

• 1 SCL-compliant file (SCD, ICD, CID, or IID) or

• 1 folder with XML files (max. 255)
ProjectIDs are assigned automatically during import, starting with 10.
For SICAM PAS the following applies: 1 import = 1 station. Thus, for mixed operation 9 PAS stations can be
imported (max. 25 with PXD import only). For PAS connections the ProjectID is assigned manually in PAS
Config.
Hence a maximum of 25 stations (import-data files) can be imported.
The ProjectIDs must be different (they are configured in SICAM PAS). For mixed import with IEC 61850/
IEC 60870-5-104 stations you have to ensure that the ProjectIDs are unique.

ii NOTE
For IEC 61850 and IEC 60870-5-104 there is a limit of 255 devices per import (station).
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SICAM PAS Station

Starting the SICAM PAS Wizard

ii NOTE
Use the SICAM Import/Export Wizard as the standard wizard (see 7.2.1 SICAM Import/Export Wizard). If
required, you can start the SICAM PAS Wizard or the SICAM IEC Wizard from the context menu of the
SICAM Import/Export Wizard.

² In the WinCC Explorer, double-click SICAM PAS Wizard.
The SICAM PAS Wizard starts.

² In the first dialog, click Next.

Entering Station Names and Selecting Parameters

² In the 1/5 dialog, enter a name for the new station and select the parameters.

² Click Next.

Importing Station Data and Selecting Functions
In the 2/5 dialog, enter the components to be imported into the SICAM SCC project using the SICAM PAS
Wizard.
² Select the Import/Update option.

² Select the path of the SICAM PAS data directory.

² From the selection list, select the file (e.g. station1.PXD) which includes the corresponding SICAM
process tags.

² Select the functions.

3.2.4.1
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Figure 3-10 Defining the Path and the Name of the Import Components

² Click Next.

Defining Station Parameters

² Define the station parameters in the 3/5 dialog.
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Figure 3-11 Defining Station Parameters for SICAM PAS

² Click Next.

[pascc320, 1, en_US]

Figure 3-12 Note Regarding Connection Parameters

Check the connection parameters after terminating the SICAM PAS Wizard – see 3.2.5 Connection Parameters.

Initializing the Project

² Define the project-specific settings in the 4/5 dialog.

² Click Next.
² In the 5/5 dialog, click Finish.
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² Continue as described in 3.2.5 Connection Parameters.

SICAM RTUs

Starting the SICAM IEC Wizard

ii NOTE
Use the SICAM Import/Export Wizard as the standard wizard (see 7.2.1 SICAM Import/Export Wizard). If
required, you can start the SICAM PAS Wizard or the SICAM IEC Wizard from the context menu of the
SICAM Import/Export Wizard.

² In the first dialog, click Next.

Selecting the Station and Parameters

[pascc311_1703, 1, en_US]

Figure 3-13 Selecting the Station and Parameters

² In the 1/5 dialog, select the Station type (type of the file to be imported).
∙ TOOLBOX II / IEC 61850
Import of an *.sxd file with IEC 61850 data from a SICAM TOOLBOX II.
∙ TOOLBOX II / IEC 60870-5-104
Import of an *.sxd file with IEC 60870-5-104 data from a SICAM TOOLBOX II.

² Enter a name for the new station.

² Select the Parameters.

² Click Next.

3.2.4.2
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Importing Station Data and Selecting Functions
In the 2/5 dialog, enter the components to be imported into the SICAM SCC project using the SICAM IEC
Wizard.
² Select the Import/Update option.

² Select the path of the data directory.

² From the selection list, select the file (e.g. station1.SXD) which includes the corresponding SICAM
process tags.

² Select the functions.

[pascc311_1703_2, 1, en_US]

Figure 3-14 Defining the Path and the Name of the Import Components

² Click Next.

Defining Station Parameters

² Define the station parameters in the 3/5 dialog.
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Figure 3-15 Defining Station Parameters for SICAM RTUs

The Channel Unit is pre-selected according to the selected Station type.
When importing TOOLBOX II data (*.sxd) only information for the selected protocol is imported.
² Click Next.
To connect SICAM RTUs, no connection parameters need to be configured. These parameters are included in
the SXD file and are stored in a configuration file for the channel.

Initializing the Project

² Define the project-specific settings in the 4/5 dialog.

² Click Next.
² In the 5/5 dialog, click Finish.

² Continue as described in 3.2.5 Connection Parameters.

IEC 60870-5-104 Devices

ii NOTE
For importing IEC 60870-5-104 data from a DIGSI/XML file, you require the separate SCC IEC 60870-5-104
data import license.

Starting the SICAM IEC Wizard
To start the SICAM IEC Wizard:

3.2.4.3
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² In the WinCC Explorer, double-click SICAM IEC Wizard.
The SICAM IEC Wizard starts.

[pascc310_1703, 1, en_US]

Figure 3-16 Calling up the SICAM IEC Wizard

² Click Next in the subsequent dialog.
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Selecting the Station and Parameters

[scc_104_02, 2, en_US]

Figure 3-17 Selecting the Station and Parameters

² In the 1/5 dialog, select the Station type (type of the file to be imported).
∙ XML / IEC 60870-5-104
Importing *.xml files from DIGSI

² Enter a name for the new station.

² Select the Parameters.

² Click Next.

Importing Station Data and Selecting Functions
In the 2/5 dialog, enter the components to be imported into the SICAM SCC project using the SICAM IEC
Wizard.
² Select the Import/Update option.

² Store the XML files for each IEC 60870-5-104 station in a separate subdirectory.
Select the path where the XML files of the station to be imported are stored.

ii NOTE
If more than 255 XML files are stored in the specified path, only the first 255 files are imported.

² Select the functions.
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Figure 3-18 Defining the Path of the Import File

² Click Next.

Defining Station Parameters

² Define the station parameters in the 3/5 dialog.
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Figure 3-19 Defining Station Parameters for IEC 60870-5-104 Devices

The Channel Unit is pre-selected according to the selected Station type.
The Logical Connection is derived from the station name when setting up a new station. It only may be
adjusted before the first import.
² Click Next.

Initializing the Project

² Define the project-specific settings in the 4/5 dialog.

² Click Next.
² In the 5/5 dialog, click Finish.

The SICAM IEC 60870-5-104 Wizard starts.

Editing Device Data
The SICAM IEC 60870-5-104 Wizard provides a mapping interface for the DIGSI/XML import where you can
select the information to be created in SICAM SCC. In addition, you can configure device and connection
parameters in the Expert view.
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Figure 3-20 SICAM IEC 60870-5-104 Wizard, Selecting Devices

ii NOTE
For the first import all devices from the import directory are displayed. You can only select devices with the
same station number. When updating the station, only devices with this station number are displayed.

If only 1 XML file is available in the directory, no device selection is displayed.
² Select the devices whose data you want to import with the SICAM IEC Wizard.

² Click Next.
The next dialog opens.

² Select the Mapping tab.
In the Mapping tab, all the tags from the imported XML files are displayed device-specifically.

ii NOTE

Updating a Device or the Station
To perform an update of already imported devices or of the complete station with changed device address
parameters (XML section [LANConnection]), you have to manually adjust the address parameters in the
Wizard UI; alternatively, you delete the corresponding devices or the complete station with the Wizard and
re-import them before the update.
Since the device address parameters can be adjusted in the Wizard UI, they are stored persistently after the
import and considered as reference. Thus, they are not overwritten when import files are changed.
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Figure 3-21 SICAM IEC 60870-5-104 Wizard, Selecting Tags

The device list on the left-hand side of the dialog shows all the devices which have been selected in the Use
column of the device selection.

ii NOTE
You can combine devices to groups in order to be able to select several devices at the same time, see
Figure 3-25.

² Select a device.
The tags of this device are shown in a list on the right-hand side of the window.

² In the Alarm logging, Tag Management, and Tag logging columns, select the WinCC components, or in
the Use column select the process tags that you want to import with the SICAM IEC Wizard.

Right-clicking the column heading of the Monitoring direction or Command direction lists opens a context
menu. This allows you to show additional columns in the lists in order to display the names modified for
SIMATIC WinCC.
By clicking Additional columns you can show or hide all columns at once.
The additional columns are:

• For Alarm Logging: the Message Group and Message Text columns.

• For Tag Management: the columns Variable group and Process information.

• For Tag Logging: the Tag logging hierarchy and Tag logging information columns.
The texts for these columns are created when selecting a process tag for the tags (components).
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Figure 3-22 SICAM IEC 60870-5-104 Wizard, Showing Additional Columns

² Activate the Expert view in order to select the Device Settings and Global settings tabs.

Device- and Driver-Specific Settings

² Select the Device settings tab.
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Figure 3-23 SICAM IEC 60870-5-104 Wizard, Showing Device Settings

The settings of the selected device are displayed. They correspond to the parameters in the XML file.
² Select the Global Settings tab.

[scc_104_11, 2, en_US]

Figure 3-24 SICAM IEC 60870-5-104 Wizard, Showing Global Settings
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The general, device-independent settings are displayed.
You can only define these parameters in the first station imported into your project. They are valid for all the
IEC 60870-5-104 stations of this project. Changes in other stations are ignored.

ii NOTE
The significance of these parameters corresponds to the significance of the parameters in the SICAM
TOOLBOX II. No settings are required.

² Click Finish to close the dialog.
This starts the device data import.

Combining Devices into Groups
After the first start of the SICAM IEC 60870-5-104 Wizard, all previously selected devices (Figure 3-21) are
listed in the device list under Single Devices. You can now combine devices into groups and then select tags
for several devices at the same time.
The settings of the first device of the group are transferred automatically to the devices which are subse-
quently added to the group.
To combine devices into groups, use the context menu, the Drag&Drop function or the toolbar. Make sure that
you only combine devices of the same type and with the same data points. Each device group must be
assigned a unique name.

[scc_104_12, 2, en_US]

Figure 3-25 SICAM IEC 60870-5-104 Wizard, Combining Devices into Groups

ii NOTE
The handling of the SICAM IEC 60870-5-104 Wizard is similar to the handling of the Windows Explorer

To edit a device group:
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² Select the device group.
The data points of the devices in the group are displayed.

² In the Alarm Logging, Tag Management, and Tag Logging columns, select the tags to be imported
using the SICAM IEC Wizard.
The selection applies to all the devices in the group.

The devices of a group cannot be edited individually. If you remove a device from the group, it is displayed
under Single Devices once again and can be edited separately. The device maintains the current parameter
settings.

IEC 61850 Devices

ii NOTE
For importing IEC 61850 data from an ICD/IID/CID/SCD file, you require the separate SCD import for IEC
61850 communication license.

ii NOTE
When importing an IEC 61850-SCL file, up to 50 reports per device can be included.

ii NOTE
A static dataset can contain at most 499 process data-points. If static data records are used in your protec-
tion device connected via IEC 61850, you must make sure that all the information defined in SICAM SCC is
also defined in the parameters of the static data record of your device. If information is missing, the driver
switches to cyclic polling. In this case, the correct logging of information in your message lists cannot be
ensured.

ii NOTE
For IEC 61850 tools such as the SysCon, Client ICD files for SICAM SCC are included on the DVD (directory:
ProductEnhancements\IEC61850).
These files can be imported into the SysCon. When assigning information to a SICAM SCC, you can select
SCC-relevant during the SCD import. This ensures that only the information assigned in SysCon is
imported.

Special Treatment for Enumerated CDC Types
When importing an ENUM tag, a special message is created in the AlarmLogging for each ENUM value. The
description of the ENUM value is integrated in the message text. One message of the current ENUM value
each is logged as raised, and the previous message is logged as cleared. Enumerated CDCs are e.g. the direc-
tion information of a general pickup.
If a general pickup is triggered during operation, all the messages are transmitted to SICAM SCC and are
entered in the message lists in case of status changes (e.g. interruption of connection).
Only one single tag is created in the Tag Management. Its runtime value corresponds to the ENUM value.
The significance is defined in the device configuration, e.g. in DIGSI, from where it can be transmitted. The
ENUMs are also described in the SCL import file.

Starting the SICAM IEC Wizard
To start the SICAM IEC Wizard:
² In the WinCC Explorer, double-click SICAM IEC Wizard. The SICAM IEC Wizard starts.

3.2.4.4
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Figure 3-26 Calling up the SICAM IEC Wizard

² Click Next.
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Selecting the Station and Parameters

[scc_61850_02, 2, en_US]

Figure 3-27 Selecting the Station and Parameters

² In the 1/5 dialog, select the Station type (type of the file to be imported).
∙ SCL / IEC 61850
Import of SCL-compliant files (*.scd,*.icd,*.cid,*.iid).

² Enter a name for the new station.

² Select the Parameters.

² Click Next.

Importing Station Data and Selecting Functions
In the 2/5 dialog, enter the components to be imported into the SICAM SCC project using the SICAM IEC
Wizard.
² Select the Import/Update option.

² Select the path under which the ICD/IID/CID/SCD file is stored.
An ICD/CID file includes the data of one IEC 61850 device; an SCD file includes the data of one or several IEC
61850 devices.
² Select the file to be imported.

² Select the functions.
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Figure 3-28 Defining the Path and the Name of the Import Components

² Click Next.

Defining Station Parameters

² Define the station parameters in the 3/5 dialog.
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Figure 3-29 Defining Parameters for IEC 61850 Devices

The Channel Unit is pre-selected according to the selected Station type.
The Logical Connection is derived from the station name when setting up a new station. It only may be
adjusted before the first import.
² Click Next.
To connect IEC 61850 devices, set the connection parameters (when importing an ICD file) in the SICAM
IEC61850 Wizard, if required. The connection parameters are included in the CID/SCD file and are applied by
the SICAM IEC61850 Wizard.

Initializing the Project

² Define the project-specific settings in the 4/5 dialog.

² Click Next.
² In the 5/5 dialog, click Finish.

The SICAM IEC61850 Wizard starts.

Editing Device Data
The SICAM IEC61850 Wizard provides an SCD import mapping interface where you can select the information
to be created in SICAM SCC. In addition, you can configure device and connection parameters in the Expert
view.
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Figure 3-30 SICAM IEC61850 Wizard, Selecting Devices

If the imported file only contains 1 device the device selection is not displayed.
² Click Next.

The next dialog opens.

² To view all information, activate the Expert view.

² Select the Mapping tab.
With the options Telegram addresses and Descriptions you can define the display of the second column. The
texts shown for the process tags are transferred from the ICD/SCD file.
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Figure 3-31 SICAM IEC61850 Wizard, Selecting Tags

A list of all the previously selected devices is shown on the left-hand side in the window.

ii NOTE
You can combine devices into groups in order to be able to select several devices at the same time, see
Figure 3-37.

Static Datasets
If you activate this option, only the information points are shown that are available via static datasets in the
SCD file.
If a device does not support dynamic datasets, you can only select the data for import which are defined in the
static datasets. In this case, you cannot deactivate this option.
A static dataset can contain at most 499 process data-points.

SCC relevant
If you activate this option, only the information points are shown that have been assigned to one or more
clients in SYSCON.
If this option is active, the Static Datasets option will not be considered.
² Select a device.

The tags of this device are shown in a list on the right-hand side in the window.

² In the Alarm logging, Tag Management and Tag logging columns, select the WinCC components, or in
the Use column, select the process tags which you want to import with the SICAM IEC Wizard.
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Figure 3-32 SICAM SCD Wizard, Showing Descriptions

Right-clicking the column heading of the Monitoring direction or Command direction lists opens a context
menu. This allows you to show additional columns in the lists in order to display the names modified for
SIMATIC WinCC.
By clicking Additional columns you can show or hide all the columns simultaneously.
The additional columns are:

• Clients: This column shows the name of the Client to which the corresponding information points are
assigned.

• Names of the dataset: This column shows the name of the data set to which the corresponding informa-
tion points are assigned.

• For Alarm logging: the Message Group and Message Text columns.

• For Tag management: the Variable group and Process information columns.

• For Tag logging: the Tag logging hierarchy and Tag logging information columns.
The texts for these columns are created when selecting a process tag for the tags (components).
² With Update SCC texts you re-transfer the currently displayed texts for the selected devices of column 2

to the additional text columns.
This overwrites previously edited texts.

ii NOTE
Dynamic display features in WinCC diagrams do not work anymore after changing a tag name.
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Figure 3-33 SICAM SCD Wizard, Showing Additional Columns

Texts can only be edited for selected tags.
² Double-click the desired cell to edit the text. The tag is displayed later with this text in SIMATIC WinCC,

e.g. in the Alarm Logging system.
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Figure 3-34 SICAM IEC61850 Wizard, Editing Texts

² Select the tags for the other devices.

² Activate the Expert view in order to select the Device Settings and Global settings tabs.

Device- and Driver-Specific Settings

² Select the Device settings tab.

Working with SICAM SCC
3.2 Creating a New Project

SICAM, SICAM SCC, Manual 69
E50417-H8976-C501-B5, Edition 05.2020



[scc_61850_10, 1, en_US]

Figure 3-35 SICAM IEC61850 Wizard, Showing Device Settings

The settings of the selected device are displayed. They correspond to the parameters in the SICAM TOOLBOX
II.
When importing from an ICD file, the IP address of the IEC 61850 device is not imported. You must enter it
under Remote IP address. No further settings are required.
² Select the Global Settings tab.
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Figure 3-36 SICAM IEC61850 Wizard, Showing Global Settings

The general, device-independent settings are displayed.
You can only define these parameters in the first station imported into your project. They are valid for all
stations of this project. Changes in other stations are ignored.
If your system contains several network cards it may be necessary to configure the server IP address. A value
of 0.0.0.0 switches the IEC 61850 driver to automatic mode. The routing is handled by Windows. This mode is
required if you want to connect several networks simultaneously.
In order to route all connections over 1 network, enter the IP address of the corresponding network connec-
tion.
If no IP address is configured, the entire traffic is routed over the first network in the system.

ii NOTE
The significance of these parameters corresponds to the significance of the parameters in the SICAM
TOOLBOX II. No settings are required.

² Click Finish to close the dialog.
This starts the device data import.

Combining Devices into Groups
After the first of the SICAM IEC61850 Wizard, all the previously selected devices (Figure 3-31) are listed in the
device list under Single Devices. You can now combine devices into groups and then select tags for several
devices at the same time.
To combine devices into groups, use the context menu, the Drag&Drop function or the toolbar. Make sure that
you only combine devices of the same type and with the same data points. Each device group must be
assigned a unique name.
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Figure 3-37 SICAM IEC61850 Wizard, Combining Devices into Groups

To edit a device group:
² Select the device group.

The data points of the devices in the group are displayed.

² In the Alarm Logging, Tag Management, and Tag Logging columns, select the tags to be imported
using the SICAM IEC Wizard.
The selection applies to all devices in the group.

The devices of a group cannot be edited individually. If you remove a device from the group, it is displayed
under Single Devices once again and can be edited separately. The device maintains the current parameter
settings.

ii NOTE
The table always displays the information of the first device of the group.
All the devices must be configured identically:

• Information that is not provided by all devices will not be displayed.

• You cannot filter for datasets that are not available in the first device.

Using the Originator Address for Checking the Switching Authority
For SIPROTEC 5 IEC 61850 devices you can use the originator address for a switching authority check. To do
this, change the value of the Originator addresses to 1 in the settings of the corresponding device using the
SICAM IEC 61850 Wizard.
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² Send Direction
Define your HMI’s own originator address in the Own originator address parameter in the Global
settings tab.

² Receive Direction
To show the originator address of a command in your message list, set the Show originator address
parameter to 1 in the Global settings tab.

The texts are assigned values in the PasNorm.ini file. A template for this INI file is available in the misc direc-
tory of the SICAM SCC installation. Copy this PasNorm.ini file into your project directory.
Before creating your project you can define up to 30 user-specific texts in the text library. Enter these texts in
the sicam_messagetext.txt file, from TextID 1770 onwards.
The defined texts are assigned to the corresponding originator address via the PasNorm.ini file. You can
assign several originator addresses the same TextID.
When receiving changed information with an originator address set, your defined text is shown in the Loca-
tion message list column instead of the standard texts NEAR, REMOTE and LOCAL.

Connection Parameters

The steps to be performed for the configuration of the connection parameters depend on the station or device
connected to SICAM SCC in the individual case.

• SICAM PAS
No connection parameters need to be defined when connecting a SICAM PAS station Version 8.00 or
later. The connection parameters are transferred from the SICAM PAS import file.
The connection parameters for older versions of SICAM PAS are pre-assigned with default values.
The connection parameters must correspond to the values defined in SICAM PAS. Check the connection
parameters as described below.

• SICAM RTUs
No connection parameters need to be configured for the connection of SICAM RTUs. The connection
parameters, and also the redundancy setting, are included in the SXD file. You can check the settings in
your SICAM TOOLBOX II project.

• SCD/CID Files
No connection parameters need to be configured for importing SCD and CID files. All relevant parameters
are included in these files.

• XML Files
To import XML files, the connection parameters must be defined, see 3.2.4.3 IEC 60870-5-104 Devices.

• ICD Files
To import ICD files, the connection parameters must be defined, see 3.2.4.4 IEC 61850 Devices.

ii NOTE
During a data import using the SICAM Wizard, the manually changed connection parameters are over-
written with the parameters from the import file. For this reason, the connection parameters must be
checked after the data import.

To check the parameters for the connection to the SICAM PAS station:
² Click the desired station in the Tag Management under PAS Data Server.

3.2.5
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Figure 3-38 Station, Properties – Connection

² Click  to define the IP address of the corresponding SICAM PAS system. The PAS Connection dialog
opens.

[pascc322, 1, en_US]

Figure 3-39 Entering the IP Address

² Enter the IP address of the SICAM PAS system.

² Click OK to confirm your settings.
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Creating a Control Diagram
Purpose

The control diagram serves for displaying detailed information concerning the individual station sections to be
controlled. For this purpose, you use the graphic objects from the graphic object library in order to represent
color changes, blinking, etc.
DThe configured switching operation must be performed as follows:

• Select a switch
Click the switch icon to open the dialog for selecting the switching direction.

• Select the switching direction
To select the switching direction, click the corresponding button in the dialog in order to create the
command and to display the buttons for issuing or canceling the command.

• Issue the command. Click the Acknowledge button in the dialog to issue the command.
The dialog closes if no additional operator action is performed within 30 seconds of clicking on a switch
object.
Besides the two-step switching operation described above, two-step and synchronized switching is also
possible (see 4.3 Using Graphic Objects).
The different states of a switch are indicated by small, colored rectangles. A specific color can be selected for
the following states:

• Not current

• PAS not OK

• Bay Blocking

• Substituted

• Telecontrol blocking
The switch object blinks spontaneously spontaneously if the value of the assigned tag changes and if spon-
taneous was entered as the cause.
When the command is issued, the switch object starts to blink in the set status as soon as the target switching
direction (ON or OFF) has been selected. It stops blinking when the command has been completely executed
or aborted.
In the target status, the blinking frequency is half the frequency for a spontaneous cause.

ii NOTE
For connections via IEC 60870-5-104 and IEC 61850, the blocking state is represented as Not topical..

Switching device objects
Use ActiveX Controls from the SICAM graphic object library as a circuit breaker or disconnector objects. Since
the above-mentioned functions are already integrated in these controls, you can create a fully functional user
interface within a short time.

Ground disconnectors and feeders
To perform the topological coloring, use ActiveX Controls from the SICAM graphic object library as ground
disconnectors/feeders.

Connector and Connection Point
To realize the topological coloring, use connectors and connection points from the SICAM graphic object
library.

3.3
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Figure 3-40 Control diagram with circuit breaker and indicator

How to proceed
To create the control diagram:

• Create a new diagram under the name Detail_E01.PDL.

• To do this, insert the objects from the SICAM graphic object library.
To control and show objects in the control diagram, the individual objects must be assigned tags.

Creating a New Diagram

To create a new control diagram:
² In the WinCC Explorer, double-click Graphics Designer.

Alternatively, you can open the Graphics Designer via the context menu.

3.3.1
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Figure 3-41 Graphics Designer context menu

² This opens the Graphics Designer with an empty workspace.

² To save the diagram, click File > Save as.... In the file selection dialog which opens, enter
Detail_E01.PDL as file name.

Defining diagram properties
Define the properties of Detail_E01.PDL.
² Right-click the workspace and select Properties from the context menu.

The Object properties dialog opens.

² In the Properties tab, select the Geometry object property.
To create a diagram with a size of 900 x 700 pixels:
² Double-click Picture width and enter 900 in the dialog. Click OK to confirm.

² Double-click Picture height and enter 700 in the dialog. Click OK to confirm.

² Close the Object properties dialog.

Working with SICAM SCC
3.3 Creating a Control Diagram

SICAM, SICAM SCC, Manual 77
E50417-H8976-C501-B5, Edition 05.2020



[pascc332, 1, en_US]

Figure 3-42 Defining the diagram size

Setting the grid
To facilitate your work, you should define the grid:
² To open the Settings dialog, click View > Grid....
² Apply all settings as shown in below.
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Figure 3-43 Settings of the workspace

Using SICAM Switch Controls

The Circuit breaker, Disconnector, Ground and Feeder control types are ActiveX Controls. When creating the
picture, insert these controls and link them using lines or connectors.
The Ground and Feeder types must be positioned analogous to the switch controls. For more detailed infor-
mation on how to define the necessary parameter settings, refer to 5.2.2 SICAM Electrical Device Control.

Positioning a Switch Control
To position a SICAM Switch Control from the SICAM graphic object library on the workspace, proceed as
follows:
² To open the Library, click View > Library.

² To show a preview of the graphic objects, click Preview in the toolbar of the Library.

² Select SICAM LS under Switching devices.

² Hold down the mouse button and move the cursor over the workspace until the graphic object has
reached the desired position.

3.3.2
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Figure 3-44 Positioning a graphic object

Setting the parameters of a switch control (switching device object)
To define the properties of your switch controls, open the SICAM Switch Control Properties dialog.
² To do this, double-click the graphic object.

The SICAM Switch Control Properties dialog opens.
The dialog consists of 6 tabs:

• In the Style tab you can define the representation style or orientation of the circuit breaker (see Graph-
ical representation, Page 108).

• In the Tag connection 1 and Tag connection 2 tabs you define the protocol type and the protocol,
assign tags to the circuit breaker and enter the tooltip text (see 4.4.2 Process Connection of SICAM Switch
Controls).

• In the Advanced tab you can assign further properties for the circuit breaker (see 4.4.3 Advanced Proper-
ties of SICAM Switch Controls).

• In the Color tab you can assign specific colors for the switch positions and circuit breaker states (see
4.4.4 Colors of SICAM Switch Controls).

• In the Picture tab you assign pictures for the circuit breaker values (see 4.4.5 Picture of SICAM Switch
Controls). You must only assign a picture to the switch control if you have selected the Picture option for
Norm in the Style tab.

² Define the parameters and click OK to apply the properties.

Specifying further properties
Specify further properties of the Circuit breaker and Disconnector objects in the context menu.
² Right-click the graphic object and select Properties from the context menu.

The Object properties dialog opens.
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² Select the desired object property (e. g. Geometry) in the Properties tab.

² Double-click the attribute in order to modify the corresponding parameter.

[pascc343, 1, en_US]

Figure 3-45 Specifying object properties

² Close the Object properties dialog.

Using Connectors and Connection Points

Positioning Connectors and Connection Points
After you have added and defined all ActiveX Controls, you can add the lines (connectors and connection
points).
Connectors and connection points which support topological coloring are available in the Topology folder of
the SICAM graphic object library. With these graphic objects, you can show the states of lines in different
colors during runtime.
For more detailed information concerning topological coloring, refer to 5 Topological Coloring.

ii NOTE
You can also use simple lines or rectangles to represent connectors and connection points, but these lines
and rectangles do not support topological coloring.

To position connectors and connection points from the SICAM graphic object library on the workspace,
proceed as follows:
² To open the Library, click View > Library.

² Select a Connector/Connection Point under Topology.

² Hold down the mouse button and move the cursor over the workspace until the graphic object has
reached the desired position.

After you have linked the graphic objects to the connectors, you must create the event functions and scripts.
² Click the Enable picture for topology calculation icon:

3.3.3

Working with SICAM SCC
3.3 Creating a Control Diagram

SICAM, SICAM SCC, Manual 81
E50417-H8976-C501-B5, Edition 05.2020



² Click the Create topological structure icon:

The entire project, including the connection scripts, is now created. All the pictures changed are opened
and generated during this process. If an error occurs when generating a picture (e.g. because a connector
has not been connected correctly), the generation process is aborted and the defective, open picture is
shown. You can correct the problem immediately.
Furthermore, you can view the progress of the picture generation process in the Report window. For
more detailed information concerning error messages, refer to 5.3.5 Notes on Configuration.

ii NOTE

The  Check current picture function only checks the picture. The existing topology does not change as
long as the picture has not yet been saved. Scripts are also not written.
As soon as you save the picture, it is highlighted as changed and the project must be created once again.

Displaying a Measured Value

For more detailed information on the measured value object refer to 4.8 Measured/Metered Value Display.

Purpose
The detailed control diagram serves for displaying a measured value of SICAM PAS.

Inserting a Measured-Value Object
Change to the Graphics Designer and insert a measured value object in your control diagram:
² To open the Library, click View > Library.

² To show a preview of the graphic objects, click Preview in the toolbar of the Library.

² Select SICAM Measured Value under Measured/Metered Value.

² Hold down the mouse button and move the cursor until the graphic object has reached the desired posi-
tion.

Connecting a Tag

² Double-click the measured value object inserted. The SICAM Numeric Control Properties dialog opens.

² Select the Tag connection tab.

² Click ... to the right of the Tag name information entry field.

² In the tag selection dialog which opens, select the desired tag and then click OK.

ii NOTE
Use the Filter field in the tag selection dialog in order to restrict the number of listed tags: Enter e.g.
*.RTInfo if you want to show structure elements of the RTInfo type only.

3.3.4
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Figure 3-46 Connecting a Tag

² Define further settings (e.g. Unit, Tooltip Text).

² Close the SICAM Numeric Control Properties dialog.

Inserting an Acknowledge button

Inserting an Acknowledge button
The circuit breaker blinks spontaneously when the state of the assigned tag changes in monitoring direction
with the cause Spontaneous. This spontaneous blinking must be acknowledged.
To acknowledge the blinking of one or several switches, insert a button from the SICAM graphic object library
into the diagram.
² To open the Library, click View > Library.

² To show a preview of the graphic objects, click Preview in the toolbar of the Library.

² Under Controls, select Button quit blinking.

² Hold down the mouse button and move the cursor until the graphic object has reached the desired posi-
tion.

3.3.5
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Figure 3-47 Inserting an Acknowledge button

Defining a Tooltip Text for a Button
To define a tooltip text for a button, proceed as follows:
² Right-click the button and select Properties from the context menu.

² Select Others in the Properties tab.

² Double-click the Tooltip text attribute. The Text input dialog opens.

² Enter the tooltip text into the Enter a value entry field and click OK to confirm.
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Figure 3-48 Defining a Tooltip Text for a Button

The setting of the button properties ensures that the button can be activated via mouse click or by pressing a
key on your keyboard.
Instead of an acknowledge button, you can also use the integrated dialogs of the switching device objects (see
4.4.6 Runtime Dialogs of SICAM Switch Controls).

Completing the Control Diagram

² Complete the control diagram. Add e.g. labels.

² Save the completed diagram.
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Figure 3-49 Control Diagram
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Creating an overview diagram
Overview diagram

The diagram hv_overview.pdl shows an overview of your system. Fields which include several circuit breakers
and disconnectors are shown with a graphic object.

[sc_overview, 1, en_US]

Figure 3-50 Overview diagram

To create the overview diagram, you must
² create a new diagram hv_overview.PDL (width 900 and height 700),

² draw the diagram and insert objects and icons, e. g. bay overview objects and labels.

Positioning a bay overview object
To position an SICAM Bay Overview Control from the SICAM graphic object library on the workspace, proceed
as follows:
² To open the Library, click View > Library.

² To show a preview of the icons, click Preview in the toolbar of the toolbar of the Library.

² Select the graphic object SICAM boxed under Overview objects in the project library.

² Hold down the mouse button and move the pointer over the workspace until the icon has reached the
desired position.

3.4
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Figure 3-51 Bay overview icons in the SICAM graphic object library

Defining a bay overview object
To define the properties of the bay overview, open the SICAM Bay Overview Control properties dialog.
² Double-click the bay overview icon. The SICAM Bay Overview Control Properties dialog opens.

² Define the tag connection (see 4.7.2 Tag Connection to Bay Overview).

² Important: Delete the default tag link for switchgears which do not actually exist in the bay.

² Click OK to close the dialog.
For more detailed information concerning the Bay overview graphic object, refer to 4.7 SICAM Bay Overview.

Inserting a button
Insert a Button object into the hv_overview.pdl diagram. Click this button to show the detail_E01.pdl control
diagram.
² Select the Button object in the object palette under Windows objects.

² Create the button at the desired position.
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Figure 3-52 Inserting a button

Configuring a button
The Button configuration dialog opens.

Working with SICAM SCC
3.4 Creating an overview diagram

SICAM, SICAM SCC, Manual 89
E50417-H8976-C501-B5, Edition 05.2020



[sc_button_config, 1, en_US]

Figure 3-53 Configuring a button

² Define the text, the font and the color.

² Under Change diagram on mouse click, select the detail_E01.PDL diagram.

² Click OK.

Defining a tooltip text for a button
To define a tooltip text for a button, proceed as follows:
² Right-click the button and select Properties from the context menu.

² Select Others in the Properties tab.

² Double-click the Tooltip text attribute.
The Text input dialog opens.

² Enter the tooltip text into the Enter a value entry field and click OK to confirm.
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Figure 3-54 Defining a tooltip text for a button

² Click OK. The settings are applied.
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Creating a List View
You want to define that the event list is displayed after clicking the Event list button. To do this, you must
create the eventlist.PDL diagram and insert the SICAM SCC event list object. Later, the buttonbar.PDL file must
be completed by the corresponding Button object.

Creating an event list
In the eventlist.pdl diagram, insert a SICAM SCC event list without DAF object (for further information
regarding DAF, see 7.5 Dynamic Alarm Filter (DAF)).

[pascc375, 2, en_US]

Figure 3-55 View Showing an SICAM SCC Event List without DAF

To create the event list view, proceed as follows:
² Create the eventlist.pdl view (width 900 and height 700)

² and insert the SICAM SCC event list object, see below.

Inserting an event list
To insert an event list, proceed as follows:
² To open the Library, click View > Library.

² To show a preview of the graphic objects, click Preview in the toolbar of the Library.

² Select the SICAM SCC event list object under Alarm Logging templates in the project library.

² Hold down the mouse button and move the cursor over the workspace until the graphic object has
reached the desired position.

² Save the view under eventlist.pdl.

3.5
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Creating a Button Bar
In the button bar, you can arrange all the buttons of the project. These buttons can be used to switch to a
different view (e. g. overview diagram, list view) or to quit the runtime system.

[pascc330, 1, en_US]

Figure 3-56 Button bar with various buttons

To create the button bar, proceed as follows:

• Create a new view buttonbar.PDL.

• Inserting the buttons with their different functions

Inserting an Event List Button

² Create a new view named buttonbar.PDL (width 900 and height 100).

² Select the Button object in the object palette under Windows objects.

² Create the button at the desired position.
The Button configuration dialog opens.

[pascc359, 1, en_US]

Figure 3-57 Configuring a button

² Define the object properties (e. g. text, color).

3.6

3.6.1
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² Leave the Display changeover on mouse click entry field empty. Afterwards, you must set the switching
between different views/diagrams as C action.

² Click OK to close the dialog.

Defining dynamic display properties
Via the dynamic properties of the button, specify the action for displaying the event list (eventlist.pdl).
² Double-click the new button. The Object properties dialog opens.

[pascc364, 1, en_US]

Figure 3-58 Defining the object properties

² Click the Events tab and then click Mouse.

² Right-click the flash icon next to Mouse action.

² Select C Action from the context menu.
The Edit action dialog opens.

[pascc384, 1, en_US]

Figure 3-59 Defining dynamic display properties

² In the Edit action dialog, enter the rows SetPropChar("start.pdl","Bildfenster2", "PictureName","event-
list.pdl"); between the curly brackets.

² Click OK. The settings are applied.

² If you are requested to recompile, confirm with Yes.

² To insert the HV Overview button, proceed in the same way as for the Event List button. This button can
be used later for showing the diagram hv_overview.PDL.
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Inserting a Quit Button

To add the Quit button to the button bar, click Project library > Control elements. This button serves to
deactivate the runtime.

3.6.2
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Creating a Start Screen
Start Screen

Divide the start screen into two window sections (designated "picture windows"). The upper section shows the
button bar (buttonbar.PDL). In the lower section, you can switch between the overview diagram (hv_over-
view.PDL), the control diagram (detail_E01.PDL) and the list view (eventlist.PDL) during runtime.
The start screen is shown during runtime. It is 900 x 800 pixels in size.

[pascc390, 1, en_US]

Figure 3-60 Example of a Start Screen

Overview
To create the start screen:
² Create a new display named start.PDL (width 900 and height 800).

² Create separate picture windows for buttonbar.PDL (900 x 100) and hv_overview.PDL (900 x 700).

Positioning Picture Windows
To position a picture window:
² Select Picture window under Smart objects in the Object palette.

As soon as you move your cursor over the workspace, it changes its shape to a cross-hair with an object
icon appended.

² At the desired position, drag the mouse cursor while holding down the mouse button until the Picture
window object has reached the desired size.

3.7
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Figure 3-61 Inserting a Picture Window

Setting the Parameters of a Picture Window
To set the parameters of a picture window:
² Right-click the picture window and select Properties from the context menu.

The Object properties dialog opens.

ii NOTE
In the text box, you can view the picture name (e.g. PictureWindow1 or PictureWindow2) which has been
automatically assigned by SIMATIC WinCC.

Specifying the Picture to be Displayed on Screen
To specify which picture is shown on screen:
² Right-click the picture window and select Properties from the context menu.

The Object properties dialog opens.

² Select Others in the Properties tab.

² Double-click the attribute to be changed, i.e. Picture name.
A file selection window opens and shows the names of all the pictures in the project.

² Select buttonbar.pdl and click OK to confirm.
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Figure 3-62 Defining the Picture to be Displayed on Screen

² In order to ensure that the picture window remains open, set the Display attribute to Yes.

² To apply all parameters, close the Object properties dialog.

Second Picture Window

² Create the second picture window.

² Assign hv_overview.pdl to PictureWindow2.

Defining WinCC Runtime Start Screen
To open the Computer properties dialog:
² Select the Graphics Designer level in the WinCC Explorer.

The screens are shown in a list.

² Right-click the start.pdl screen.

² Select Define screen as start screen from the context menu.

Activating the Project

² To activate the project you created, select File > Activate.
You can now check whether the configured user interface meets your requirements.
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Setting up User Authorizations
The User Administrator editor serves to specify user groups and users and to assign them user authorizations.
If a registered user calls up a function, the User Administrator checks whether the user has been assigned the
required user rights. If this is not the case, it prevents access to the function concerned. User authorization is a
feature of SIMATIC WinCC.

Calling up the user administrator
Open the User Administrator to set up a new user group or a new user.
² In the WinCC Explorer, double-click the User Administrator level.

Creating a user group
When creating a new project, the Administrator group is automatically created with the Administrator user.
Create a new user group and assign the required rights. The rights of the group apply for all users belonging to
the corresponding group.
² Select User > Add group.

² Enter the name of the new user group (e.g. Group 1).

² Assign the group rights by double-clicking on the desired row in the Authorization column.

[pascc380, 1, en_US]

Figure 3-63 Assigning group rights

Setting up a user
Set up a user in the new group and assign him specific rights.
² Select the new group.

² Select User > Add user. The Add a new user dialog opens.

² In the Login entry field, enter the user name (e. g. User 1).

² Enter a password and repeat it.

² Select Copy group settings also to assign the user all rights of the corresponding group.

3.8
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[pascc381, 1, en_US]

Figure 3-64 Setting up a user

² Assign the user additional, individual rights (e.g. Action Editing).

[pascc382, 1, en_US]

Figure 3-65 Assigning user rights

Assigning an authorization for a circuit breaker
You can assign authorizations for various different objects, such as circuit breakers and buttons, in the Object
Properties window.
Proceed as follows to assign an authorization for a circuit breaker:
² Double-click the circuit breaker in the Graphics Designer.

The SICAM Switch Control Properties dialog opens.

² Select the Advanced tab.
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² Click the ... Button to the right of the Operator authorization field and select the desired authorization.

Assigning an authorization for a button
Proceed as follows to assign an authorization for a Button:
² In the Graphics Designer, right-click the corresponding button.

² Select Properties in the context menu.

² Click the Others level in the Properties tab.

² Double-click Authorization and select an entry.

Working with SICAM SCC
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Overview
The SICAM graphic object library includes graphic objects for the representation of typical substation control
and protection equipment (e.g. switchgears, displays). Additionally, graphic objects are available for topo-
logical coloring. You can use these graphic objects to create station diagrams in the Graphics Designer.
This section describes objects and functions that can be used with the target systems SICAM PAS, SICAM
RTUs , and directly connected IEC 61850/IEC 60870-5-104 devices.
This chapter describes the SICAM graphic objects Circuit Breaker, Disconnector and Bay Overview SICAM
SCC V8.00 or later. Older SICAM graphic objects can still be used - for a description refer to 14 Components
and Functions of Earlier SICAM PAS CC/SCC Versions.

4.1
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Design of Graphic Objects
The SICAM graphic object library provides graphic objects for the representation of the components of a
power network. You require these graphic objects for creating station diagrams. The ActiveX Controls are a
special kind of graphic objects.

SICAM Graphic Objects

Structure
A SICAM graphic object serves for the graphical representation of electrical equipment using dynamic display
features.

Graphical representation
The graphical representation of the SICAM graphic objects (e. g. circuit breaker) is based on the ANSI/IEEE 315
1975 (R1995) and ANSI/IEEE 315A 1986 (R1995) standards.
The SICAM graphic object library provides several typical graphic objects for each element.

Dynamic display properties
Some graphic objects already include dynamic display properties.
With the dynamization you can visualize the station status in control and monitoring direction.
The typical dynamic display properties of a graphic object are defined by default. Finally, you only have to link
the dynamic properties to the process via tags.
There are 3 different ways to set the parameters for dynamic display properties:

• via the Dynamic dialog

• via a C action or

• via a VBS action (Visual Basic action)

Dynamic Dialog
In the Dynamic dialog, you can specify the dynamic display properties and thus the process interfacing
(referred to as "tag connection").
To do this, you insert the available dynamicdisplay properties into a predefined frame.

C Action
The C action offers you more flexibility in Dynamization than the Dynamic Dialog.
You can use all functions provided by SIMATIC WinCC, including SICAM PAS processing functions.

SICAM graphic object library
In the SICAM graphic object library, some dynamic display properties of graphic objects are defined via the
Dynamic dialog; others are defined via the C action. You can use the corresponding graphic objects alterna-
tively.

ActiveX Controls

The following graphic objects are implemented as ActiveX Controls:

• Circuit Breaker, Disconnector, Load Break Switch, and Earth Isolator as SICAM Switch Control

• Bay Overview as SICAM Bay Overview Control

• Measured value object as SICAM Numeric Control

• Feeder, Ground Disconnector, Transformer, and Termination as SICAM Electrical Device Control

4.2

4.2.1

4.2.2
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These ActiveX Controls in the Graphics Designer are available in the SICAM graphic object library.

Structure
An ActiveX Control is a Windows control element whose properties (e. g. graphical representation, tag connec-
tion) can be defined via a dialog.

Graphical representation
An ActiveX Control (e. g. a circuit breaker) can be graphically represented in various different manners. The
form, line width and orientation of the graphic object can be specified by the user. 3-D representation is
possible. Dialogs can be anchored at any position on the diagram.
The colors for the representation of the value and the status are selectable. Furthermore, the graphic object
can be individually designed.

Tag connection
The protocol type can be selected. Depending on the protocol type, the process interfacing of the ActiveX
Controls can be performed using tags.
A tooltip text can be entered.

Further setting options
The Synchronized/Not Synchronized Switching and Interlocked/Non-Interlocked Switching functions can be
parameterized. Spontaneous Blinking, Setpoint Blinking and SET = ACTUAL Switching can be admitted. A
twostep switching operation and Blinking with Negative Command Feedback can be parameterized. The
command execution timeout can be defined and the user authorization can be selected.

Graphic Objects
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Using Graphic Objects
To use graphic objects from the SICAM graphic object library in your project, you must link the SICAM graphic
object library to the project first.
Afterwards only, you can position graphic objects in station diagrams and set parameters for dynamic display
properties in order to visualize the different states of the station.

SICAM graphic object library
Use the SICAM Wizard to integrate the SICAM graphic object library into the current project.

Displaying the SICAM graphic object library
To display the SICAM graphic object library, select View>Library. The SICAM graphic objects are available
under Project Library.

Positioning graphic objects
Using the Graphics Designer of SIMATIC WinCC, you can copy graphic objects via Drag & Drop from the library
into a station diagram.

Defining graphic objects
Link graphic objects to the related process tags using the SIMATIC WinCC Graphics Designer.

4.3
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SICAM Switch Controls
The Circuit Breaker, the Disconnector, the Load Break Switch, and the Earth Isolator are available as switching
devices. They are stored in theSwitching devices folder as SICAM Switch Control in the SICAM graphic object
library. These ActiveX Controls already include typical functions.

Graphical representation
The SICAM graphic object library provides the SICAM Switch Controls in 5 different representation styles:

Table 4-1 Graphical representation of SICAM Switch Controls

View Circuit Breaker Disconnector Load Break Switch Earth Isolator
SICAM style

based on
DIN 42200

based on
IEC 445

based on
LSA

based on
LSA
(alternative; LSA-2)

ii NOTE
You can assign your own individual image files to the objects.

ii NOTE
The element Earth Isolator is firmly connected to earth potential on one side, thus representing a 1-pole
for topology calculation. The line must be connected to the left port (marked with a small square, see
chapter 4.4 SICAM Switch Controls) of the earth isolator, the earth symbol can be connected to the right.
To avoid errors in topology calculation, the earth isolator must be rotated via the SICAM Switch dialog with
the Orientation parameter, if required; not via the WinCC Object properties dialog.

Connecting points
The points highlighted with a square are the left-hand/top connecting points (below called left-hand connec-
tion points); the points (without a square) on the opposite side are the right-hand/bottom connecting points
(below called right-hand connection points). See also 1- and 2-pole elements , Page 183.

4.4
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ii NOTE
The squares always indicate the left-hand/top connecting points independently of the rotation of the
object.

Representation Style of SICAM Switch Controls

Each circuit breaker, each disconnector etc. must be assigned a certain number of properties.
✧ Double-click the graphic object.

The SICAM Switch Control Properties dialog opens.
✧ Select the Style tab.

[sc_style_switch_control, 1, en_US]

Figure 4-1 Defining the style

Type
The following graphic object types can be selected: Circuit Breaker, Disconnector, Load Break Switch, or
Earth Isolator.

Norm
The following 6 options are available for the graphical representation of the graphic object:

• SICAM

• DIN 42200

• IEC 445

• LSA

• LSA-2

• Picture
Depending on the switch position, individual pictures can be displayed for the Picture style. In the Picture tab,
the individual pictures must be assigned switch positions, see 4.4.5 Picture of SICAM Switch Controls.

4.4.1
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3-D style on click
If this checkbox is activated, circuit breakers and disconnectors are represented with a three-dimensional
effect when clicking with the mouse.

Line width
You can select a value to define the Line width of the graphic objects. Level 1 corresponds to the smallest line
width.
The line width can be entered in representation styles in accordance with DIN 42200, IEC 445 and LSA.

Direction
Orientation is possible in the 0°, 90°, 180° and 270° angles in all representation styles apart from Picture.

Fix dialog position
The Runtime dialogs can be anchored at a fixed position in the picture.

Process Connection of SICAM Switch Controls

Each circuit breaker, each disconnector etc. must be assigned tags. The assignment options depend on the
protocol type.
You can assign tags in the Tag connection 1 and Tag connection 2 tabs.
✧ Double-click the graphic object.

The SICAM Switch Control Properties dialog opens.
✧ Select the Tag connection 1 tab.

[sc_switch_process1, 1, en_US]

Figure 4-2 Tag connection, Part 1
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Protocol type
Select the desired protocol type from the drop-down list box. The following protocol types are available for
selection:

• SICAM PAS Protocol Suite
for connection to SICAM PAS-Stationen

• SICAM IEC Communication Suite
for connection to SICAM RTUs or IEC 61850/IEC 60870-5-104 devices

Information tag
Click the button to the right of the entry field. The Tags dialog opens. Select the corresponding tag from the
list and click OK to confirm.

Command tag
If a command tag for a related information tag is specified in the SICAM PAS import data record, the command
tag is determined automatically when selecting the information tag and entered in the Command tag entry
field.
To manually select a tag, proceed as described in the paragraph Information Tag.

ii NOTE
Delete the predefined scripts if you do not want to use the stored functionality in command direction.

Acknowledge flashing tag
You can assign a tag, e.g. the AckFlashing tag, for several switching device objects in order to form a group.
In this case, you can acknowledge spontaneous flashing for all switching device objects of the group at the
same time by clicking the All button.
To define acknowledgement groups, you can maintain the predefined AckFlashing tag or create a new tag.
To select another tag, click the button to the right of the entry field. The Tags dialog opens. Select the corre-
sponding tag from the list and click OK to confirm.

Tooltip text
Enter a text in the entry field. This text is displayed as Tooltip in the active project.
✧ Select the Tag connection 2 tab.

Graphic Objects
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[sc_switch_process2, 1, en_US]

Figure 4-3 Tag connection, Part 2

In the Tag connection 2 tab, you can configure tags for the advanced control of synchronization and inter-
locking functions during command output.
You can only assign tags in this tab if the SICAM PAS Protocol Suite protocol type has been selected in the
Tag connection 1 tab, i.e. if the devices are connected via SICAM PAS.

SICAM PAS IED protocol
Select the desired IED protocol from the list. The following setting options are available:

• Not specified
Select this setting if you do not require the switchover of the synchronization or interlocking function
during runtime.
With this setting you cannot assign tags.

• PAS - IEC 61850 devices
Select this setting if devices are connected to SICAM PAS via IEC 61850. With this setting you can assign
tags for controlling the Synchronized/Not Synchronized and Interlocked/ Non-Interlocked switching func-
tions.

• PAS - ILSA devices
Select this setting if devices are connected to SICAM PAS via ILSA. With this setting you can assign the
command tags for unsynchronized switching and for a measurement interrogation.

Table 4-2 Process tag connection depending on the target system and the device type

Protocol type IED protocol Attribute Meaning
SICAM IEC Communication Suite
or
SICAM PAS Protocol Suite

N/A
 
None

RTInfo <Information tag name>.RTInfo

RTCmd <Command tag name>.RTCmd

Graphic Objects
4.4 SICAM Switch Controls

112 SICAM, SICAM SCC, Manual
E50417-H8976-C501-B5, Edition 05.2020



Protocol type IED protocol Attribute Meaning
SICAM PAS Protocol Suite IEC 61850 devices RTInfo <Information tag name>.RTInfo

RTCmd <Command tag name>.RTCmd
AddRTInfo1 <Information tag name-

NotSynchronized>.RTInfo
AddRTCmd1 <Command tag name-

NotSynchronized>.RTCmd
AddRTInfo2 <Information tag name-NonIn-

terlocked>.RTInfo
AddRTCmd2 <Command tag name-NonIn-

terlocked>.RTCmd
ILSA devices RTInfo <Information tag name>.RTInfo

RTCmd <Command tag name>.RTCmd
AddRTCmd1 <Command tag name-

NotSynchronized>.RTInfo
AddRTCmd2 <Command tag name-Measur-

ementInterrogation>.RTCmd

Information tag
Click the button to the right of the entry field. The Tags dialog opens. Select the corresponding tag from the
list and click OK to confirm.

Command tag
If a command tag is specified for an information tag in the SICAM PAS import data record, the command tag is
determined automatically when selecting the information tag and entered in the Runtime command tag
editing field.
To manually select a tag, proceed as described in the paragraph Information Tag.

ii NOTE
The descriptions of SIMATIC WinCC apply to the use of tag and server prefixes and indirect addressing.
SICAM-specific processing is not necessary.
For more detailed information concerning the use of the acknowledgment tag without prefix, e.g. in
picture windows, refer to the configuration information in the SIMATIC WinCC Information System,
Using a Tag Prefix and a Server Prefix. A preceding @NOTP, for example, disables the use of the tag
prefix.

Advanced Properties of SICAM Switch Controls

In the Advanced tab, you can assign the SICAM Switch Controls additional properties.
✧ Double-click the graphic object.

The SICAM Switch Control Properties dialog opens.
✧ Select the Advanced tab.

4.4.3
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[sc_switch_advanced, 1, en_US]

Figure 4-4 Advanced properties

For the connection to SICAM RTUs or IEC 61850/IEC 60870-5-104 devices, the command mode (Qualifier of
Command, QoC) for command output must be transmitted with the command.

Visible in RT
Under Visible in RT, activate the checkboxes for the options you want to show additionally during runtime in
the switching dialog and which can be modified.

Preset
Under Preset, activate all values to be transmitted as qualifiers of command (QoC). If the Visible in RT option
is activated, you can define here the pre-assignment in the runtime dialogs. The checkboxes under Preset can
only be activated if the SICAM IEC Communication Suite protocol type has been selected in the Tag connec-
tion 1 tab.

Table 4-3 Configuration with different protocol types

Protocol type Activated fields Attribute Effect
SICAM PAS Protocol Suite Visible in RT Unsynchronized Shown in the switching

dialog during runtime.
Non-interlocked Shown in the switching

dialog during runtime.
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Protocol type Activated fields Attribute Effect
SICAM IEC Communication Suite Visible in RT Unsynchronized Shown in the switching

dialog during runtime.
Non-interlocked Shown in the switching

dialog during runtime.
Specification Unsynchronized Pre-assignment of the

value sent as QoC as part
of the command
(synchronized/
unsynchronized switching)

Non-interlocked Pre-assignment of the
value sent as QoC as part
of the command
(synchronized/
unsynchronized switching)

Enable spontaneous flashing
Spontaneous flashing can be enabled or disabled.
If the value of the assigned tag has changed and if spontaneous has been entered as cause, the Circuit
Breaker or the Disconnector flashes spontaneously.

Enable setpoint flashing
Setpoint flashing can be enabled or disabled.
During command output the graphic object starts flashing in its SET state when the SET switching direction
(ON or OFF) has been selected. It stops flashing as soon as the command has been terminated or aborted, i.e.
in the following cases:

• After a command output has been aborted

• On expiry of the command output monitoring time

• If Command Termination is entered as cause in the command confirmation

Enable SET = ACTUAL
Switching over to the represented actual state can be enabled or disabled. Activate this checkbox in order to
enable the switching direction independently of the switch position. This ensures e.g. that another switch-on
command can be issued for a switched-on switch.

Enable Select before operate
A Select command is issued before the actual switching command. The switching command can only be
issued after the Select command has been positively acknowledged.

Flashing on negative confirmation
If a switching command is not successful, i.e. if CO-, COE-, Select, Command Monitoring Time Expired is
returned, the switching device object changes from slow command blinking to fast blinking in order to indi-
cate that an abnormal event has occurred.
There is no fast blinking if this option has been deactivated. The switching device object changes to the actual
position after a negative acknowledgment; command blinking is terminated.

Command execution timeout
In the command execution timeout field, enter the maximum delay time in seconds until successful
command execution. As soon as this time has expired, the command process is terminated and a negative
command termination is entered in the log.
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ii NOTE
For IEC connections, the command execution timeout only affects the switching object. The command
itself only gets affected with SICAM PAS connections.

Operator authorization
Select the desired operator authorization. For more detailed information on the setting and assignment of
operator authorizations, refer to 3.8 Setting up User Authorizations.

Colors of SICAM Switch Controls

The color of the graphic object in normal state depends on its value. A specific color is set by default for each
individual value. However, the color can also be freely selected from a color palette.
In the Color tab, you can assign colors for the individual switch positions and states of the SICAM Switch
Control.
✧ Double-click the graphic object.

The SICAM Switch Control Properties dialog opens.
✧ Select the Color tab.

[sc_switch_color, 1, en_US]

Figure 4-5 Assigning colors

Value
The following colors are predefined for the graphic object:

Table 4-4 Switch position

Value Color
ON 10, value = 2 Red
OFF 01, value = 1 Green
Intermediate position 00, value = 0 Yellow
Disturbed 11, value = 3 Yellow

4.4.4
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The form of the graphic object in representation styles in accordance with DIN 42200, IEC 445, and LSA
depends on the value.

Table 4-5 Predefined forms according to DIN 42200 and IEC 445

Value Form
ON 10, Value = 2 Switch closed
OFF 01, Value = 1 Switch open
Intermediate position 00, Value = 0 Switch on/off dashed
Disturbed 11, Value = 3 Switch on/off dashed

Table 4-6 Predefined forms according to LSA

Value Form
ON 10, Value = 2 Filled
OFF 01, Value = 1 Not filled
Intermediate position 00, Value = 0 Half filled
Disturbed 11, Value = 3 Half filled

A red cross is indicated for values which are not indicated in the tables (e.g. Value=4).

Background
The background color of the graphic object can be individually defined. Gray is the default color.

State
The switch status is represented with small, colored rectangles next to the switch. A default color is predefined
for each status. The color can also be freely selected from a color palette.

[dw_cb_states, 1, en_US]

Figure 4-6 Switch with switch status

The predefined colors of the rectangles depend on the status:

Table 4-7 Switch status

Status Color Explanation
System not ok Dark cyan (teal) Connection between SICAM SCC and the automa-

tion system/ device.
Bay blocked Red Messages from this bay are no longer transmitted

to the automation system/device.
Not topical Cyan (turquoise) The device state is not topical.
Substituted Blue The switch position was set manually because there

is no connection to the primary system.
Telecontrol blocked Red Messages from this bay are no longer transmitted

to the telecontrol center.
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Picture of SICAM Switch Controls

The values of a SICAM Switch Control (switch positions) can be assigned to individual pictures. In order to
ensure that these pictures are displayed during runtime, the Picture option must be activated in the Style tab
under Norm, see 4.4.1 Representation Style of SICAM Switch Controls.
The following picture formats are possible:

• BMP

• EMF

• JPG

• GIF

ii NOTE
If, in the Style tab under Norm, the Picture option is active, you have to assign pictures to the values.
Otherwise no switching object will be displayed.

To apply values to the pictures follow these steps:
✧ Double-click the graphic object.

The SICAM Switch Control Properties dialog opens.
✧ Select the Picture tab.

[sc_switch_picture, 1, en_US]

Figure 4-7 Assigning pictures

Properties
The values of the Circuit Breaker/Disconnector are listed under Properties. You can assign a picture and a
blink picture to each value. During runtime, the following representations result for a switching object:

• No blink picture assigned
The display switches between picture and background color.

• Blink picture assigned
The display switches between picture and blink picture.

4.4.5
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Highlight a value and click Browse to assign the value a picture. Pictures are stored in the WinCC project in the
\GraCS\SicamIXPics directory. You can assign these pictures or individual pictures.

• DIST00Picture
Picture for the representation of Value 0 - Intermediate position

• DIST00PictureBlink
Blink picture for the representation of Value 0 - Intermediate position

• DIST11Picture
Picture for the representation of Value 3 - Disturbed

• DIST11PictureBlink
Blink picture for the representation of Value 3 - Disturbed

• OFFPicture
Picture for the representation of Value 1 - OFF

• OFFPictureBlink
Blink picture for the representation of Value 1 - OFF

• ONPicture
Picture for the representation of Value 2 - ON

• ONPictureBlink
Blink picture for the representation of Value 2 - ON

Preview
The assigned picture is shown in a preview.

Runtime Dialogs of SICAM Switch Controls

Dialogs are available for performing switching operations, for status display, to acknowledge blinking and for
synchronization.
To call up these dialogs during runtime, click the graphic object.

2-Step Switching Operation
Click the graphic object to open the dialog for a switching operation.

[SCC_RT_401, 1, en_US]

Figure 4-8 Switching Dialog without Command Mode

Use the following dialog for switching operations with SICAM RTUs and IEC 61850/IEC 60870-5-104 devices.
Controlling is performed via the SICAM IEC COMMUNICATION SUITE with the IEC 61850/IEC 60870-5-104
communication protocol.

4.4.6
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[SCC_RT_402, 1, en_US]

Figure 4-9 Switching Dialog with Command Mode

This dialog is extended by 2 setting options for the selection of the command mode (Qualifier of Command,
QoC).
The command mode can be defined with the following object properties in the object properties of the
switching devices:

• Visible in RT
Under Visible in RT, activate the checkboxes for the options you want to show additionally during
runtime in the switching dialog and which can be modified.

• Preset
Under Preset, activate the values to be transmitted.
If the Visible in RT option is activated, you can define the pre-assignment in the runtime dialogs. The
checkboxes under Preset can only be activated if the SICAM IEC Communication Suite protocol type has
been selected in the Tag connection 1 tab.

Table 4-8 Configuration with Different Protocol Types

Protocol type Attribute Effect if activated
SICAM PAS Protocol Suite Not synchronized Sends a marker command for unsynchronized

switching to SICAM PAS.
This is indicated in the check box with return of
this marker command.

Non-interlocked Sends a marker command for non-interlocked
switching to SICAM PAS.
This is indicated in the check box with return of
this marker command.

SICAM IEC Communication
Suite

Not synchronized Sends the Not synchronized Switching qualifier of
command with the switching command in the
command value.

Non-interlocked Sends the Non-Interlocked Switching qualifier of
command with the switching command in the
command value.

You can define the parameters of the Select before operate function via the properties of the control in the
Graphics Designer, see 4.4.3 Advanced Properties of SICAM Switch Controls.
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After clicking ON or OFF, the Select command is transmitted if the bay devices are connected via IEC 61850.
The ON and OFF buttons are disabled until a confirmation has been received. If the Select command has been
successful, the Confirm dialog (see Figure 4-11) opens directly.

[SCC_RT_403, 1, en_US]

Figure 4-10 Switching Dialog, Select Command Is Running

The select command can receive a positive or negative acknowledgment. Depending on the acknowledgment,
one of the following dialogs opens.

[SCC_RT_404, 1, en_US]

Figure 4-11 Switching Dialog, Selection Is Active

The check resulted in a positive acknowledgment. The actual switching command can be issued by clicking the
Confirm button.

[SCC_RT_405, 1, en_US]

Figure 4-12 Switching Dialog, Selection Rejected

The actual switching command cannot be issued. The switching operation must be aborted.
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Synchronized/Not Synchronized and Interlocked/Non-Interlocked Switching
For the connection of devices to SICAM PAS via the IEC 61850 and SINAUT LSA ILSA communication proto-
cols, switching is possible by means of dialog extensions, Command mode dialog field. The following options
can be selected by means of the dialog extensions:

• Synchronized or Not Synchronized switching

• Interlocked or Non-interlocked switching
The sequence of the advanced switching operation during runtime depends on the IEC 61850 or SINAUT LSA
ILSA communication protocol. For this reason, a distinction is made between the communication protocols in
the paragraphs below.
Synchronized/interlocked switching is supported by further communication protocols (e.g. IEC 60870-5-101-
Master). In this context, however, the dialog extensions are not used.
The dialog extensions for synchronization and interlocking are only displayed if you have activated the corre-
sponding option in the SICAM Switch Control Properties, Advanced tab under Visible in RT, see
4.4.3 Advanced Properties of SICAM Switch Controls.

IEC 61850 Communication Protocol
This section describes the sequence of an advanced switching operation for the connection of devices to
SICAM PAS via the IEC 61850 communication protocol.
Click the graphic object to open the dialog window for an advanced switching operation.

[SCC_RT_402, 1, en_US]

Figure 4-13 Switching Dialog with Dialog Extensions

A confirmation dialog opens if you activate the Not synchronized or Non-interlocked checkbox.
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[SCC_RT_406, 1, en_US]

Figure 4-14 Confirmation Dialog

Click Confirm to issue a single command with the value OFF to the Sync not effective or Non-interlocked
command tag.
At the same time, all the buttons are deactivated until a command feedback is received.

[SCC_RT_407, 1, en_US]

Figure 4-15 Advanced Switching Dialog for Synchronized Switching, Buttons Deactivated

As soon as a message has arrived via the Sync not effective information tag, the Sync ON button is activated
and can be clicked.
The same procedure applies to non-interlocked switching.
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[SCC_RT_408, 1, en_US]

Figure 4-16 Advanced Switching Dialog for Synchronized Switching, Sync ON Button Activated

The Sync ON button can only be used for synchronized switching. The switching command is issued as usual:
✧ Click Sync ON.

The control blinks in the setpoint status and the confirmation dialog opens.
✧ Click Confirm.

The command is issued.

As long as the synchronized switching command is running, you can still abort the synchronization.
✧ To abort the synchronization, click the graphic object.

The switching dialog with the Abort synchronization button opens.

[SCC_RT_413, 1, en_US]

Figure 4-17 Aborting the Switching Dialog for Synchronized Switching

✧ Click Abort synchronization.
Synchronized switching is aborted.
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SINAUT LSA ILSA Communication Protocol
This section describes the sequence of the advanced switching operation for the connection of devices to
SICAM PAS using the SINAUT LSA ILSA communication protocol.
Click the graphic object to open the dialog window for an advanced switching operation.

[SCC_RT_409, 1, en_US]

Figure 4-18 Switching Dialog for Synchronized/Not Synchronized Switching

If the Not synchronized checkbox has been activated, the command tag for Not synchronized switching is
used for the subsequent command output. The inscription on the button changes from Sync ON to Unsync
ON.
Click the Sync ON button to send a Synchronized Switching command with the normal command tag (Tag
connection 1). The switching command is issued as usual:
✧ Click Sync ON.

The control blinks in the setpoint status and the confirmation dialog opens.
✧ Click Confirm.

The command is issued.

Click Start Meas to issue a measurement trigger to the synchronization unit. The measured values are
updated without performing a switching operation.

Status
The status dialog can be opened by clicking with the right mouse button, provided that the status display has
been activated in the Properties dialog.
An information-specific block can be defined for the information of the SICAM PAS target system in combina-
tion with SICAM PAS/PQS V8.01 or later. This means that the process value update can be blocked for indi-
vidual information objects, here: Double-point indication. You can set/undo the bay blocking/telecontrol
blocking in the status dialog of the switching device objects. To do this, activate the corresponding function.
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[SCC_RT_410, 1, en_US]

Figure 4-19 Status Dialog

The current status is also indicated by a tick in the corresponding checkbox in the status dialog; the switch is
marked with a colored rectangle, see switching status in Figure 4-6.
If Bay blocked is activated, the switch position can be substituted by clicking Substitute. The dialog for substi-
tuting a switch position opens, see 4.4.7 Substituting the Switch Position.

Acknowledge Blinking
Click a blinking graphic object to open the Acknowledging blinking dialog.

[SCC_RT_411, 1, en_US]

Figure 4-20 Acknowledge Blinking

Click This to acknowledge a status change or a spontaneous alarm for this switch.
Click All to use the tag entered in the properties under
Tag name acknowledgement tag for spontaneous flashing for acknowledging. All ActiveX Controls
currently displayed in the diagram and connected to this tag are acknowledged at the same time.
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ii NOTE
To enter a new command, the flashing must be acknowledged first.

Substituting the Switch Position

[SCC_RT_412, 1, en_US]

Figure 4-21 Substituting the Switch Position

In this dialog, you specify how the switch position is to be substituted. Click Substitute in order to open the
Confirm dialog. Click the Confirm button to execute the substitution.

Substituting Switch Positions for IEC 61850 Devices
To substitute switch positions for IEC 61850 devices, the SICAM IED protocol SICAM PAS – IEC 61850 devices
must be selected in the SICAM Switch Control Properties, Tag connection 2 tab. Furthermore, the tag to be
substituted must be selected from the drop-down list below.

4.4.7
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[sc_prop_switch_control_2, 1, en_US]

Figure 4-22 Defining SICAM Switch Control Properties – Tag connection 1

[sc_prop_switch_control, 2, en_US]

Figure 4-23 Defining SICAM Switch Control Properties – Tag connection 2

ii NOTE
Substituting is only possible on IEC 61850 data points with Functional Constraint (FC) SV, e.g. SubVal. For
IEC 61850 devices, substitution is usually performed to the XCBR or XCSWI data point.
Alternatively, you can create a new SubVal2IED = 1 in the 61850.ini file under [GENERAL]; in this case,
the .stVal can be used directly for substitution.
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Defining Object Properties

The Object properties dialog consists of the Properties and Events tabs. The following section describes
certain parameters from these tabs.
Proceed as follows to open the Object properties dialog:
✧ Right-click the graphic object.
✧ Select Properties in the context menu.

The Object properties dialog opens.

Properties tab

[sc_switchcontrol_props, 1, en_US]

Figure 4-24 Object properties, Properties tab

The following table provides a list of certain important object properties of the circuit breakers/disconnectors.

Table 4-9 Object properties

Object properties Meaning
Operator control enable The user can define for the SICAM Switch Control whether or not the object can

be operated during runtime.
In order to be able to operate an object, the user must have the corresponding
authorization.

DrawWidth Drawing width in dots.
The drawing width of the graphic object can be defined. Step 1 represents the
smallest line width.
The adjustment of the line width is possible for all representation styles according
to DIN 42200, IEC 445 and LSA.

BackColor Background color of the control. This color is displayed when the control blinks.
SwitchType Type of control, circuit breaker or disconnector.
Norm Graphical representation style of the SICAM Switch Control.

For a list of possible styles, refer to Graphical representation, Page 108

4.4.8
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Object properties Meaning
Direction Picture rotation in degrees:

• 0
• 90
• 180
• 270

Style3D 3D representation:

• Yes
• No
The 3D style illustrates the view of the selected object.

DialogPosLeft This property defines the position of the left-hand edge of the Runtime dialog.
DialogPosTop This property defines the position of the upper edge of the Runtime dialog.
FixDialogPosition This property defines whether the dialog shall be opened next to the object or

next to the defined position.
ToolTipText This property defines a tooltip text in the picture.
ONPicture If the Picture setting is defined in the Properties dialog, Style > Norm tab, the

picture configured under ONPicture (Picture tab) is shown for the ON (2) status.
⇒ The ActiveX properties dialog opens.

OFFPicture If the Picture setting is defined in the Properties dialog, Style > Norm tab, the
picture configured under OFFPicture (Picture tab) is shown for the OFF (1)
status.
⇒ The ActiveX properties dialog opens.

DIST00Picture If the Picture setting is defined in the Properties dialog, Style > Norm tab, the
picture configured under DIST00Picture (Picture tab) is shown for the Inter-
mediate Position (0) state.
⇒ The ActiveX properties dialog opens.

DIST11Picture If the Picture setting is defined in the Properties dialog, Style > Norm tab, the
picture configured under DIST11Picture (Picture tab), is shown for the fault posi-
tion (3) state.
⇒ The ActiveX properties dialog opens.

ONColor With this property you define the color for the ON state.
OFFColor With this property you define the color for the OFF state.
DIST00Color With this property you define the color for the Intermediate Position with the

value 0.
DIST11Color With this property you define the color for the fault position with the value 3.
NotTopicalColor With this property you define the color for the Not topical status of the device

information. The device is switched off or cannot be contacted.
PASNotOKColor With this property you define the color for the PAS not OK status. There is no

connection to the target system.
BayBlockedColor With this property you define the color for the bay block defined.
SubstitutedColor With this property you define the color for substituted values.
TeleBlockedColor With this property you define the color for the telecontrol block defined.
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Object properties Meaning
StateColorVisibleFlag With this property you define the display of the following statuses:

• 0x0100: Bay blocking
• 0x0400: Not topical
• 0x0800: Substituted value
• 0x2000: Telecontrol blocking
• 0x0008: No connection to the target system
The default value is 0x0100 | 0x0400 | 0x0800 | 0x2000 | 0x0008 = 11528: All
statuses are shown.

CommandTimeout The command execution is canceled by SICAM PAS if there is no feedback from
the process. This value can also be modified in the Advanced tab.
The control switches to normal state or to Spontaneous flashing.

EnableSpontaneous-
Flashing

With this property you enable spontaneous flashing in case of spontaneous
messages.

EnableSetPointFlashing With this property you enable spontaneous flashing when selecting the switching
direction in the Command dialog.

EnableFlashingOn-
NegConfirm

With this property you enable spontaneous flashing in case of a negative
command acknowledgement.
Flashing is only enabled for the control which has been operated. Other controls
with the same tag connection or controls on a redundant system do not flash.

EnableSETIsACTUAL With this property you enable switching to the ACTUAL state of the switching
device, e.g. sending an ON command if the device is already in ON state.

Authorization With this property you assign authorizations.
0 = without authorization check
The authorizations of the User administrator settings are checked.

AckSpontanFlashing With this property you enable the simultaneous acknowledgement of several
controls in a group.

InputValue1
InputValue2

Input points for topological coloring.

TOPOColorINVALID This value defines the default color for lines in the INVALID state.
It is forwarded to the related connectors if the graphic object is in the INVALIFD
state.

TOPOColorOFF Default value for defining the color in case of topological coloring.
This value is transferred to the corresponding connectors if the graphic object is
in the OFF status.

ConnectorAttributes see Topological Settings for Selected Objects, Page 185
ColorUse see Topological Settings for Selected Objects, Page 185
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Events tab

[sc_switchcontrol_event, 1, en_US]

Figure 4-25 Object properties, Events tab

• OnLeftClick
The switching dialog is opened by default via the OnLeftClick event.

• OnRightClick
The status dialog is opened by default via the OnRightClick event.

• OnExecuteCmd
The command type (internal) and the command value are transferred to the OnExecuteCmd_V800(...) C
script via the OnExecuteCmd event.

The switching dialog and the status dialog are opened by default in the OnLeftClick and OnRightClick events.
You can adapt the scripts of these events to your specific requirements.
In the OnExecuteCmd event, the PAS_CommandExecute_V800 command output script is called up. The
command type and the command value are transferred to this script.
You can complement these events in order to adapt the integrated command output mechanism to your
specific requirements.
The C script of the OnExecuteCmd event is shown in the screenshot below. Insert your script lines before
calling up PAS_CommandExecute_V800.

[SICAMSwitch_Script, 1, --_--]

Figure 4-26 OnExecuteCmd C script, SICAM Switch Control graphic object
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The information required for command output using the SICAM Switch Control graphic object and the
processing of the SICAM SCC Runtime Data Server tags in C scripts is available in the SCC_Def.h file. Integrate
this header file into the C script.
The values and meanings of the cmdtype and cmdvalue tags are listed in the tables below.

Table 4-10 Command types and related values in the cmdtype tag

Command type Enum tag Value
Information-specific block Command_Set_Blockstate -3
Substitute Command_Substitute -2
Acknowledge flashing Command_Acknowledge -1
Switching Command_Switch 1
Set point Command_Setpoint 2
Select Command_Select 3
Abortion Command_Abort 4

The Switch command type is also used for the output of the Not synchronized and Non-interlocked options.

Table 4-11 Command values in the cmdvalue tag and their meaning

Valid for command
types

Meaning Constant Value

Substitute, Switch, Select
and
Not Synchronized, Non-
Interlocked changeover

Switch position Inter-
mediate position

VALUE_SWITCH_DIST00 0

Switch position OFF VALUE_SWITCH_OFF 1
Switch position ON VALUE_SWITCH_ON 2
Switch position disturbed VALUE_SWITCH_DIST11 3

Acknowledge flashing One object VALUE_ACKNOWLEDGE_THIS 1
All objects (depending on
the Acknowledge tag)

VALUE_ACKNOWLEDGE_ALL 2

Operation with Self-Created Dialogs

If it is not sufficient to adapt the event scripts to normal dialog control, you can replace the default dialogs by
customized dialogs. To do this, you must edit the scripts which open the switching dialog and save them
under a new name.
Example of a self-created switching dialog: When clicking on the switching device objects with the left mouse
button, the command tag name is written in a text tag, and the self-created switching dialog opens.
In your switching dialog you can use the ON or OFF button and the intermediately stored command tag name
to call up a command output script, e.g. SCC_Command. To implement a two-stage command output, you can
comment the increase of the counter tag in this script at the point described (// start: execute the command).
Rename the script, e.g. void SCC_Command_NoExecute(), and save it under this name. Use the SCC_Comman-
dExecute_V500 script to send the command.
This screenshot provides an example of self-created dialogs with large touch operation buttons:

4.4.9
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[scc439, 1, en_US]

Figure 4-27 Example, self-created dialogs
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Authorization Check
To also enable a check of the Authorization level with self-created dialogs, insert an authorization check in
the OnLeftClick/OnRightClick events that you use.

[sc_authorization_check, 1, --_--]

Operation via Keyboard

The SICAM Switch Controls graphic objects can be operated via the mouse or using the keyboard.
To initiate a switching operation using the keyboard, buttons must be inserted into the display, and a hotkey
must be configured for each button.
The switching operation is initiated by pressing the configured key or key combination during runtime. Addi-
tionally, a user right can be assigned for the operation of the button.
The runtime dialogs of switching device objects are not displayed for operation via keyboard/buttons.
An ordinary PC keyboard or a special function keyboard can be used. To use a function keyboard, the PC
keyboard must be removed from the computer and the function keyboard must be plugged in instead.

4.4.10
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Configuring a button
A specific button for each action must be inserted into the diagram (Object palette > Windows object). The
Button Configuration dialog opens as soon as the button has been inserted.

[pascc440, 1, en_US]

Figure 4-28 Configuring a button

✧ Enter the button text into the Text entry field.
✧ Next, click Hotkey... to define a hotkey for the button.
✧ Click OK to close the dialog.

For more detailed information regarding the configuration of a button, refer to the WinCC Information
System.

Defining a C script
In order to be able to initiate an action via a button for SICAM Switch Controls, a C script has to be defined for
the button. When clicking this button, the C script executes the SCC_Command function. This function trans-
fers the object name, the command type, and the command value.
In the following example an ON Select command shall be transmitted for a switching object.
✧ Open the Object properties of the button.
✧ Select the Miscellaneous entry in the Properties tab.
✧ For the Hotkey attribute, configure a function key to which the button shall respond.
✧ Select Mouse in the Event tab.
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[pascc441, 1, en_US]

Figure 4-29 Opening the editor

✧ Right-click Mouse Action in the Action column.
✧ Select C Action from the context menu.

The editor opens and the C script is displayed.

The name of the selected control can be dynamically determined in the C script using the Get_Focus function.
✧ Edit the C script.
✧ Compile the C script and click OK to close the editor.

You can now add further buttons for deactivating, confirming, and canceling the switching operation and
configure these buttons accordingly. In this case, the diagram looks as shown below.

[pascc443, 1, en_US]

Figure 4-30 Diagram with buttons for a switching operation

Define the TAB order in the Graphics Designer in order to be able to select the controls using the keyboard.
Afterwards, you can select the controls using the Tab key on the keyboard during runtime.
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Switching operation during runtime
During runtime, a switching operation (OFF > ON) would be executed as follows:

• The switch is in OFF state. You press the CB1 ON hotkey on the keyboard.

• The switching device object starts blinking in setpoint state.

• You press the CB1 Confirm hotkey on the keyboard. The switching command is executed.

• The switching device object switches to the ON state. The switching operation is completed.
Feedback messages regarding the switching operation are shown in the event list.
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Interfaces for Project-Specific Dialogs

The SICAMSwitch.dll has been extended by several interfaces which enable the communication of self-
created dialogs with the SICAM Switch Control in the same way as for the integrated dialogs.

SetControlCommand Function
This functions allows the user to transmit all operations of the intergrated dialog from the outside to the
SICAM Switch Control.

Command
SetControlCommand (LONG CmdType, LONG ButtonID, LONG ButtonStates)

Parameter
CmdType transfers the command type.
Information-specific block Command_Set_Blockstate -3
Substitute Command_Substitute -2
Acknowledge flashing Command_Acknowledge -1
Switching Command_Switch 1
Set point Command_Setpoint 2
Select Command_Select 3
Abortion Command_Abort 4

ButtonID transfers the ID of the actuated button.
ButtonStates defines the button mask, i.e. the IDs of the buttons actuated are linked via an OR operation and
transferred.

[sc_fct_1, 1, --_--]

 
 
 
 
 
 

4.4.11
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GetControlState Function
This function is used to read out the current status of the SICAM Switch Control. The enum value is transferred
upon the call; afterwards the return value is indicated here.t.

Command
GetControlState ( VARIANT* pVal)

[sc_fct_2, 2, --_--]

gcs_get_LimitStates return values:

• Bit 0: Command Timer Timeout

• Bit 1: Setpoint Flashing

• Bit 2: Spontaneous Flashing

4.4.11.2
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Event OnProcDataChange
The event is triggered by SICAMSwitch if the object status changes.

[sc_fct_3, 2, --_--]

The value parameter indicates the value, e.g. the switching direction in case of commands or the new status
in case of a process value change.

4.4.11.3
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Anwendungsbeispiele für die Funktionen

Script for Event OnProcDataChange

This script sets the QuitBlinking variable at event OnProcDataChange of the SICAM Switch Control in the
same way as the Switch Control object for SICAM SCC V7 or earlier versions:

• Checking the switch for spontaneous flashing

• Setting iSwitchState for the call to gcs_IsSpontaneousFlashing

• The return value in iSwitchState is a Boolean value (Yes/No)

• bReturn is only required for VBS, does not include information

[sc_func_ex_1p1, 1, --_--]

4.5
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[sc_func_ex_1p2, 1, --_--]
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SICAM Electrical Device Control
The following SICAM Electrical Device Control types are available: Feeder, Ground, Transformer (additionally:
Auto transformer 1-phase and Auto transformer 3-phase) and Termination. These control types are included in
the Topology folder of the SICAM graphic object library.
See 5.2 Topological Elements.

4.6
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SICAM Bay Overview
The Overview folder in the SICAM graphic object library includes the SICAM Bay Overview user object. It is
implemented as an ActiveX Control and already contains typical functions.
You can use a bay overview to show the status of an entire bay by means of a single graphic object.

Graphical representation
4 bay overview variants are available in the SICAM graphic object library:

Table 4-12 Graphical representation of the bay overview

Bay overview View Graphic
LSA rounded LSA representation with circular symbol

LSA boxed LSA representation with rectangular symbol

SICAM rounded SICAM representation with circular symbol

SICAM boxed SICAM representation with rectangular symbol

Maximum bay extension
A bay overview diagram can show one single bay with the following maximum extension:

4.7
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[sc_topo max bay overview, 1, en_US]

Figure 4-31 Maximum bay extension shown in a bay overview

The SICAM bay overview is processed with only 1 busbar by the topology component.

ii NOTE
If switches configured in the bay overview are configured as single switches in another picture, you have to
take care of the orientation of the connection points.
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If multiple busbars should be considered, there are 2 ways for the configuration:

• The busbar disconnectors are configured outside of the project: The bay overview then is electrically
connected between the busbar disconnectors and the circuit breakers.

[sc_topo busbar ext, 1, en_US]

Figure 4-32 Bay overview with busbar disconnector outside of object

• The busbar disconnectors are configured inside of the project: The connector to the busbar above is not
considered by the topological coloring. You can color this connector at will.

Graphic Objects
4.7 SICAM Bay Overview

SICAM, SICAM SCC, Manual 147
E50417-H8976-C501-B5, Edition 05.2020



[sc_topo busbar int, 1, en_US]

Figure 4-33 Bay overview with busbar disconnector within object
The picture displayed in the bay overview must be configured in another (detail) picture to ensure that a
consistent topological model can be generated.

Representation Style of Bay Overview

Each bay overview must be assigned several properties.
✧ Double-click the graphic object.

The SICAM Bay-Overview Control Properties dialog opens.

The properties are listed in the Style tab.

Type
The following 5 options are available for the representation of the graphic object:

• SICAM boxed

• SICAM rounded

• LSA boxed

• LSA rounded

• Picture

4.7.1
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With the Picture style, individual pictures can be displayed depending on the switch position. The individual
pictures must be assigned switch positions in the Picture tab, see 4.7.4 Picture of Bay Overview.

Grounded only with CB closed
With this option you define whether the grounding shall only be represented with the circuit breaker closed.

• The Grounded only with CB closed option is activated:
The bay overview is only shown as grounded if the grounding disconnector and the circuit breaker are
closed.

• The Grounded only with CB closed option is not activated:
The bay overview is shown as grounded if the grounding disconnector is closed.

[sc_grounding_without_cb, 1, --_--]

Figure 4-34 Grounding without circuit breaker

3-D style
If this checkbox is activated, the bay overview is represented with a three-dimensional effect as soon as the
user clicks with the mouse.

Line width
The line width of the graphic objects (LSA only) can be selected. Step 1 represents the smallest line width.

Tooltip text
Enter a text in the entry field. This text is displayed as a Tooltip in the active project.

Tag Connection to Bay Overview

The bay overview must be assigned tags.

4.7.2
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² Double-click the graphic object.
The SICAM Bay Overview Control Properties dialog opens.

² Open the Tag connection tab.

[scc324, 1, en_US]

Figure 4-35 Defining the bay overview

Tag assignment
Proceed as follows to assign the graphic object a tag:
² Click the ... button next to the entry field.

The Tags dialog opens.

² Select the corresponding tag from the list and click OK to confirm.

ii NOTE
Delete the default tag link for switching devices which do not exist in the bay.

• Double-click the tag to be deleted. The tag is selected.

• Delete the selected tag.
This ensures that the elements in question are no longer considered for the determination of the bay state,
i.e. the value and the status of the bay overview are independent of the deleted elements.
However, at least the circuit breaker must be configured for the bay overview.

Colors of Bay Overview

Value
In normal state, the color and the form of the graphic object depend on its value. A specific color is defined by
default for each individual state. It is also possible to select the color from a color palette.
In the SICAM representation style, only the color and not the form is changed depending on the corre-
sponding value.

4.7.3
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Table 4-13 Colors defined according to SICAM

Value Color Meaning
ON Red The circuit breaker, the line disconnector and at least one

busbar disconnector are switched on.
OFF Green The circuit breaker, the line disconnector or all busbar

disconnectors are switched off.
Disturbed Yellow At least one of the connected devices in the bay is faulted.
Grounded Pink The bay is grounded.

Table 4-14 Colors defined according to LSA

Value Form Meaning
ON Filled The circuit breaker, the line disconnector and at least one

busbar disconnector are switched on.
OFF Not filled The circuit breaker, the line disconnector or all busbar

disconnectors are switched off.
Disturbed Half filled At least one of the connected devices in the bay is faulted.
Grounded
Geerdet

Filled/ not filled The bay is grounded.

Background
The default background color is gray. It can also be freely selected.

Status
The switch state is indicated by small, colored rectangles next to the graphic object. A specific color is set by
default for each individual state. The color can also be freely selected from a color palette.
The following colors of the rectangles are set by default for the representation of the individual states:

Table 4-15 Switch status

Status Color Explanation
System not ok Dark cyan (teal) Connection between SICAM SCC and the automa-

tion system/ device.
Bay blocked Red Messages from this bay are no longer transmitted

to the automation system/device.
Not topical Cyan (turquoise) The device state is not topical.
Substituted Blue The switch position was set manually because there

is no connection to the primary system.
Telecontrol blocked Red Messages from this bay are no longer transmitted

to the telecontrol center.

Priority of the object colors
The bay overview states are represented as a sum of all the switching devices in the bay from high priority to
low priority:
Fault position - Grounded - On - Off
The representation of the bay overview states is implemented as the sum of all the switching devices in the
bay and shows the states of the individual switches according to their priority. If, for example, a switch is in
fault position, the bay overview object is shown in fault position. This means that other switch positions are no
longer relevant. If the grounding disconnectors and outgoing feeder disconnectors are switched on in such a
case, the bay overview object is represented as grounded.

Graphic Objects
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Picture of Bay Overview

You can assign the values of Bay Overview individual pictures. To ensure that these pictures are shown during
runtime, the Picture checkbox must be activated under Type in the Style tab, see 4.7.1 Representation Style
of Bay Overview.
The following picture formats are possible:

• BMP

• EMF

• JPG

• GIF

Properties
The values of Bay Overview are listed under Properties. Assign each value a picture.
Highlight a value and click the Browse button to assign the value a picture. Pictures are stored in the \GraCS
\SicamIXPics directory in the WinCC project. You can assign these pictures or individual pictures.

Preview
The assigned picture is shown in a preview.

4.7.4
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Measured/Metered Value Display
The Measured/Metered values folder in the SICAM graphic object library includes the Numeric display
object. Typical functions are already provided in this ActiveX Control.
With this graphic object you can:

• display measured and metered values

• substitute measured and metered values

• issue setpoint commands for measured and metered values

• define upper and lower limits
Figures consisting of up to 7 digits can be displayed with the measured value object. The WinCC data type
used does not allow any further digits.

Style of the Numeric Display

A SICAM Numeric Control consists of a value field and a unit field.

[sc_numeric_control_1, 1, --_--]

You can adjust its appearance as follows.
✧ Double-click the graphic object.

The SICAM Numeric Control Properties dialog opens.
✧ Select the Style tab.

[SICAM_Numeric_05, 2, en_US]

Figure 4-36 Specifying the style

4.8

4.8.1
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Digits behind comma
Enter the desired number of decimal places.

Divider
The value of the SICAM Numeric Control is divided by this number before being displayed.

Unit
Enter the text to be displayed in the unit field.
Additionally, you can determine the ratio of the size between the value field and the unit field – or if the unit
field is displayed at all.

• If you want to display a unit in default size, just enter it, for example "kWh".
Without further information, the default size (width) of the unit field represents 30 % of the width of the
complete control.

• If you want to change the size of the unit field, enter the corresponding percentage value, separated by
"#", next to the text of the unit.
In order to set the size to, for example, 20 % of the complete control, enter "kWh#20".

• If you want to display an empty unit filed with, for example, 15 % size, enter "#15".

• If you leave the text for the unit empty, the unit field is hidden.

ii NOTE
The unit field is limited to 10 characters.

Touch operation
If this option is activated, the runtime dialogs are displayed with optimized settings for touch operation (e.g.
bigger buttons, different style).

3-D style on click
If this option is activated, the value output triggered by a mouse click is represented with a three-dimensional
effect.

Graphic Objects
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Fix dialog position
You can place the dialogs in a fixed position on the screen.

Tag Connection of the Numeric Display

Each value output must be assigned to a tag.
✧ Double-click the graphic object.

The SICAM Numeric Control Properties dialog opens.
✧ Select the Tag connection tab.

[SICAM_Numeric_01, 2, en_US]

Figure 4-37 Tag connection

Protocol type
Select the desired protocol type from the drop-down list box. The following protocol types are available for
selection:

• SICAM PAS Protocol Suite
for connection to SICAM PAS-Stationen

• SICAM IEC Communication Suite
for connection to SICAM RTUs or IEC 61850/IEC 60870-5-104 devices

Information tag
Click the button to the right of the entry field. The Tags dialog opens. Select the corresponding tag from the
list and click OK to confirm.

Tag name command
If a related command tag is indicated for an information tag in the SICAM PAS import data record, the
command tag is determined automatically when selecting the information tag and entered in the Tag name
command entry field. In order to select a tag yourself, proceed as described under Tag name information.

4.8.2

Graphic Objects
4.8 Measured/Metered Value Display

SICAM, SICAM SCC, Manual 155
E50417-H8976-C501-B5, Edition 05.2020



Value type
This setpoint type is used for the command tag in order to describe the data type of the command.

Tooltip text
Enter a text in the entry field. This text is shown as a Tooltip in the active project.

Advanced Properties of the Numeric Display

In the Advanced tab you can assign further value output properties.
✧ Double-click the graphic object.

The SICAM Numeric Control Properties dialog opens.
✧ Select the Advanced tab.

[SICAM_Numeric_02, 2, en_US]

Figure 4-38 Advanced properties

Visible in RT
Under Visible in RT, activate the checkboxes for the options you want to show additionally during runtime in
the switching dialog and which can be modified.

Preset
Under Preset, activate all values to be transmitted as qualifiers of command (QoC). If the Visible in RT option
is activated, you can define here the pre-assignment in the runtime dialogs. The checkboxes under Visible in
RT and Preset can only be activated if the SICAM IEC Communication Suite protocol type has been selected.

4.8.3
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Table 4-16 Configuration with different attributes

Protocol type Activated fields Attribute Effect
SICAM IEC Communication Suite Visible in RT Unsynchronized Shown in the switching

dialog during runtime.
Non-interlocked Shown in the switching

dialog during runtime.
Preset Unsynchronized Pre-assignment of the

value sent as QoC as part
of the command
(synchronized/
unsynchronized switching)

Non-interlocked Pre-assignment of the
value sent as QoC as part
of the command
(synchronized/
unsynchronized switching)

Enable ’Select before operate’
A select command is issued before the actual command. The setpoint can only be issued after the select
command has been answered with a positive acknowledgment.

Command execution timeout in seconds
Enter the Command execution timeout in seconds. This corresponds to the maximum timeout until the
successful command execution. As soon as this timeout has elapsed, the command process is terminated and
a negative command termination is logged.

ii NOTE
For IEC connections, the command execution timeout only affects the switching object. The command
itself only gets affected with SICAM PAS connections.

Operator authorization
Select the desired Operator authorization. For more detailed information on the definition and granting of
operator authorizations refer to 3.8 Setting up User Authorizations.

Limit Values of the Numeric Display

Enter limit values for the information and the setpoint in the Limits tab.
✧ Double-click the graphic object.

The SICAM Numeric Control Properties dialog opens.
✧ Select the Limits tab.

4.8.4
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[SICAM_Numeric_03, 2, en_US]

Figure 4-39 Defining limit values

Information
You can define 2 upper and lower limits for the value. The font color changes if the value is above or below
the 1st upper/lower limit. The display starts flashing if the value is above or below the 2nd upper/lower limit.

Set point
You can define a setpoint with upper and lower limits for the value. The display starts flashing if the value is
above/below the upper/lower limit of the setpoint.

Color of the Numeric Display

Value
In the Color tab you can assign further colors for the value ranges and states.
✧ Double-click the graphic object.

The SICAM Numeric Control Properties dialog opens.
✧ Select the Color tab.

4.8.5
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[SICAM_Numeric_04, 2, en_US]

Figure 4-40 Assigning colors

The following colors are predefined for the graphic object:

Table 4-17 Value

Value Color Meaning
Normal state Black The value is in the normal range.
Overflow Magenta The value is above/below the setpoint range.
Upper limit Black The value has exceeded the upper limit defined.
Lower limit Black The value is below the lower limit defined.

Background
You can individually define the background color of the graphic object. White is the default color.

State of the value
The state of the measured value object is represented with small, colored rectangle icons on the measured
value object. A color is defined by default for each state, but the color can also be freely defined from a color
palette. The size of the colored rectangles is automatically adapted to the measured value object.

[le_status, 1, --_--]

Figure 4-41 Measured value object with state

The default colors of the rectangles depend on the individual state:
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Table 4-18 Value state

State Color Meaning
1 No connection Dark cyan (teal) No connection between SICAM SCC and the auto-

mation system/device.
2 Bay blocked Red Messages in this field are no longer transmitted to

the automation system/device.
3 Not topical Cyan (turquoise) The device state is not topical.
4 Substituted Blue The value was set manually because no connection

was available, e.g. to a protection device.
5 Telecontrol blocked Red Messages in this field are no longer transmitted to

the telecontrol center.

Unit
The unit color can be defined individually. Black is the default font color, and white is the default background
color.

Font of the Numeric Display

Define the font in the Font tab.
✧ Double-click the graphic object.

The SICAM Numeric Control Properties dialog opens.
✧ Select the Font tab.

[SICAM_Numeric_06, 2, en_US]

Figure 4-42 Defining the font

Font
Select the desired font from the drop-down list box.

4.8.6

Graphic Objects
4.8 Measured/Metered Value Display

160 SICAM, SICAM SCC, Manual
E50417-H8976-C501-B5, Edition 05.2020



Size
Select the desired font size from the drop-down list box.

Effects
You can select the Bold, Italic, Underline and Strikeout boxes.

Runtime Dialogs of the Numeric Display

Issuing the setpoint
Dialogs are available in order to transmit the setpoint to the process. To call up these dialogs during runtime,
click the related graphic object.

[SCC_RT_420, 1, en_US]

Figure 4-43 Applying the setpoint value

✧ Enter the setpoint value in the entry field.
You can enter a dot or a comma as a decimal separator.

✧ Click Apply.
The Apply dialog opens.

4.8.7

Graphic Objects
4.8 Measured/Metered Value Display

SICAM, SICAM SCC, Manual 161
E50417-H8976-C501-B5, Edition 05.2020



[SCC_RT_421, 1, en_US]

Figure 4-44 Issuing the setpoint

✧ Click Confirm in order to send the setpoint command to the destination system.

Status
The status dialog can be opened by clicking with the right mouse button, provided that the status display has
been activated in the Properties dialog.
An information-specific block can be defined for the information of the SICAM PAS target system in combina-
tion with SICAM PAS/PQS V8.01 or later. This means that the process value update can be blocked for indi-
vidual information objects.
You can set/undo the bay blocking/telecontrol blocking in the status dialog of the Numeric Display. To do this,
activate the corresponding function.

[SCC_RT_422, 1, en_US]

Figure 4-45 Status dialog

The current status is also indicated by a tick in the corresponding checkbox in the status dialog; the Numeric
Display is marked with a colored rectangle, see status information in Figure 4-41.
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If Bay blocked is activated, the value of the Numeric Display can be substituted by clicking the Substitute
button.

Substituting the value

ii NOTE
This function is only available with connection to SICAM PAS.

In this dialog you can define the desired substitute value (setpoint) for the corresponding value. Click Substi-
tute in order to open the Apply dialog. The substitution is carried out after clicking Confirm.

Representing Measured Values for the Invalid State

For the SICAM Measured value display object you can define the information to be displayed for the Invalid
state. Depending on the individual configuration the last valid value or a question mark is displayed.
Perform the configuration via the StateColorVisibleFlag attribute in the Object properties dialog.
To configure the display for the Invalid state:
✧ Right-click SICAM Measured value display and select Properties from the context menu.
✧ Select SICAMNumericCtrl > Control properties in the Properties tab.

[state_unvalid, 1, en_US]

Figure 4-46 Defining the StateColorVisibleFlag attribute

ii NOTE
The information shown for an invalid value is defined via Bit 0x10000 in the StateColorVisibleFlag
attribute.

✧ Enter the desired value for the StateColorVisibleFlag attribute:

• To show the last valid value, enter 11528.
• To show a question mark, enter 77064 (11528 + 0x10000).

4.8.8
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Support of Controllable Analogue Process Value (CDC = APC)

The SICAM SCC IEC channel supports the IEC 61850 Common Data Class (IEC) APC (Controllable Analogue
Process Value) in receive direction and command direction. The currently set analog set point (attribute name
mxVal.f) of an APC data object is received via reporting and displayed in Tag Management and Alarm Logging.
The analog set point (attribute name ctlVal.f) can be sent to the remote location via SICAM Numeric Control
in the following types of sequence of commands:

• ctlModel=1 (direct control with normal security)

• ctlModel=3 (direct control with enhanced security)

• ctlModel=4 (sbo control with enhanced security)
The locking conditions (synchocheck/interlocking) specified via the SICAM Numeric Control are encoded and
transmitted accordingly in the sequence-of-commands telegram. For SBO (select before operate), the
command can be canceled after Select with Cancel. The transmission causes Activation (COT=6), Confirma-
tion (COT=7), and Termination (COT=10) are set on the command tag depending on the state of the
command flow.

4.8.9
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Introduction
The term topology describes the structure of a network, which results from the switching and operating states
of the equipment (switchgear, transformers, etc.). A network has a limited, but very large number of possible
connections, i.e. a so-called potential topology. However, the major part consists of switchable connections in
the bays of the switchgear. The connections switched on at a certain time determine the current topology of
the network.
The operational network conditions are represented in network diagrams.
Based on the object parameterization, the compiler creates the topology model using the SICAM add-in Create
Topological Structure.

ii NOTE
The new topological coloring (SICAM SCC V9.0 or later) is not supported for SICAM SAS components.

ii NOTE
You require a separate license for topological coloring.

ii NOTE
The configuration of the topological coloring only works for pictures in the root directory of the Graphics
Designer: <project directory>\GraCS.
Images from subdirectories are excluded.

Overview
Using topological coloring, the states of a power network can be represented by means of different colors in
SICAM SCC. All adjacent graphic objects of a feeder are assigned the same color. The uniform color assignment
is interrupted if a control element is open.
In terms of topological coloring, a power system consists of lines (connectors), transformers, switches and
further objects. To be able to forward information, the graphic objects must be interconnected via their
connecting points. Each connecting point consists of 1 input and 1 output.

[dw_topo col network, 2, en_US]

Figure 5-1 Network Consisting of 3 Connectors, 1 Connection Point, and 1 Disconnector

5.1
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Incoming information is forwarded through the entire network and issued on the connecting points
connected. This mechanism works in any direction.
The following graphic objects support topological coloring:

• Circuit breaker, disconnector, load break switch, earth isolator

• Bay overview

• Feeder, ground, transformers, termination

• Connectors and connection point
Connectors in the SICAM graphic object library support the same functions as connectors in the SIMATIC
WinCC object palette.

The graphic objects Feeder, Ground Disconnector, Connector and Node are available in the Topology folder of
the SICAM graphic object library.

Dynamic Network Coloring
The Dynamic network coloring function enable you to represent the electrical connection between various
network sections using specific colors. On the SICAM SCC operator console, you can thus obtain a quick over-
view of the switching status of the station.
The Dynamic network coloring function detects the Secure supply status as well as the Connection of
several feeders. These operating states can be highlighted specifically via the line width used to represent the
tie lines, or also via dashed lines.
The switching status can be represented by means of specific colors in all graphical network diagrams,
including substation diagrams and the worldmap. The interlinkage with the dynamic network coloring algo-
rithms is performed via the process references (variables) of the equipment represented in the pictures, such
as disconnectors, circuit breakers, transformers.

Restrictions
The restrictions concerning topological coloring specified in SICAM SCC V9.06 must be observed:

• The topological coloring does not support umlauts for tag names.

• Multi-clients with pictures including active objects from several servers are not supported.

• Mixed configurations of pictures are not possible.

• Topological coloring across several WinCC servers is not possible.

• Indirect addressing for active objects cannot be used.

• If you deactivate a picture and a different option was selected for Coloring of switch controls, you have
to select the option Use topological color in the Topological settings for selected objects under
Coloring of switch controls; thus, all elements are displayed with default color again. See also
5.3.3 Settings.

Topological Coloring
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Topological Elements

General

The following objects are available in SICAM SCC:

• SICAM Topology (SICAM Electrical Device Control)
– Feeder
– Ground
– Transformer
– Auto transformer 1-phase and 3-phase
– Termination

• SICAM Switch Control
– Circuit breaker
– Disconnector
– Load breaking switch
– Earth isolator

• SICAM Bay Overview

• Connector

• Connection point
The following paragraphs describe the individual types with their specific parameterization options.

5.2

5.2.1
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[sc_library_topology, 1, en_US]

Figure 5-2 SICAM SCC Library

SICAM Electrical Device Control

Description of Functions
The following SICAM Electrical Device Control types are available: Feeder, Ground, Transformer (addition-
ally: Auto transformer 1-phase and Auto transformer 3-phase) and Termination. These are described below.

Feeder
The Feeder object represents the start of a topological network.
The feeder is an active component which initiates the coloring in the WinCC picture. It transfers its value to the
graphic objects connected to it.
Each power network in which topological coloring is to be realized must have a feeder. Preferably use just 1
feeder, e.g. for a busbar. If several feeders are available on a busbar, you must define the preferred feeder.
A topological status (i.e. supply type with color) must be defined for each feeder (see 5.3.3 Settings).
A feeder has different statuses. The representation style is determined by the switching status of the process
tag linked, as well as by its status:

• Feeder switched on
Color defined on the feeder as the Supply type color for the Topological color (see Color, Page 173)

• Feeder switched off
Color for de-energized. This color is defined for the entire project (see Topological Project Settings,
Page 186).

5.2.2

5.2.2.1
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• Status of the DIST feeder
Color for Undefined. This color is defined for the entire project (see Topological Project Settings,
Page 186).

• Status of the DIFF feeder
Color for Undefined

• Disturbed status
Color for Undefined

• Initial status
Color for Initial. This color is defined for the entire project (see Topological Project Settings, Page 186).

Ground
Ground is a special type of feeder. It always transfers the color for grounding to the graphic objects connected
to it.
Ground elements serve for the grounding of station sections which have been switched off. Since the element
is fixedly connected to ground potential on one side, it is considered as a 1-pole within the scope of topology
calculation.
If the element is in the ON status, i.e. the breaker is closed, the connected network section is represented in
the color defined for grounded.

Transformer
The transformer performs an electrical isolation.
A transformer can operate in the same way as the Feeder element.
If the transformer is supplied from one side, the other side becomes a feeder, provided that a topological
status has been assigned from the project settings.
If reverse energization is possible, an individual supply type must be defined for each side (usually a non-
secure supply type is used). If reverse energization is not possible, do not assign a color to the corresponding
side.

ii NOTE
A structure tag must be created and assigned for the transformer (5.2.2.5 Creating Structure Tags).

In addition to the ordinary transformer, the Auto transformer 1-phase and Auto transformer 3-phase types
are available.
The Grounded status cannot be spread beyond a transformer.

Termination
This element is only used if a single feeder must be logically connected, e.g. if a branch to a consumer has to
be represented. This is e.g. not the case for sections from an overview picture.

Graphical representation
The following SICAM Electrical Device Controls are available in the Topology folder in the SICAM graphic
object library:

Table 5-1 Graphical representation style of the SICAM Electrical Device Controls

Graphic object Type Graphic
Feeder 1-pole

Ground 1-pole

5.2.2.2
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Graphic object Type Graphic
Transformer 2-pole

Auto transformer 1-phase 2-pole

Auto transformer 3-phase 2-pole

Termination 1-pole

Properties of SICAM Electrical Device Controls
Each SICAM Electrical Device Control must be assigned a certain number of properties.
✧ Double-click the graphic object.

The SICAM Electrical Device Control Properties dialog opens.

Style

[sc_edc_style, 1, en_US]

Figure 5-3 Properties of SICAM Electrical Device Controls, Style

Type
The following types are available:

• Feeder

• Ground

• Transformer

• Auto transformer, 1-phase

• Auto transformer, 3-phase

• Termination

5.2.2.3
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Each type has a pre-defined style (5.2.2.2 Graphical representation). You can adapt the style to your needs
and requirements.

Orientation
For all representation styles apart from pictures, the orientation angles 0°, 90°, 180°, and 270° can be defined.

Line width
You can define a line width for graphic objects; line width 1 is the smallest line width.

Measured value
In these input boxes you can define values for Level ON/OFF and Hysteresis.
To do this, the Measurement tag type must have been selected in the Tag connection tab (see Tag Connec-
tion, Page 172).

Pictures
If you activate the Pictures checkbox, the image files selected in the Picture tab are used for displaying the
status of the object.

Tag Connection

[sc_edc_process, 1, en_US]

Figure 5-4 Properties of SICAM Electrical Device Controls, Tag connection tab

Tag Type
The following types are available:

• Internal information
Used, for example, in order to integrate statuses determined from a script (on the Tag name topological
information output). See also 5.2.2.5 Creating Structure Tags.

• Process information
A single- or double-point indication is connected here which directly includes the ON, OFF, and
Disturbed states and forwards these states.

Topological Coloring
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• Measured value
Used for connecting a measured value as an input value which controls the output via the configuration
of the ON/OFF level and the hysteresis (connection: Tag name topological information).

The tag type is not available for Ground and Termination.
See also 5.2.2.4 Tag Connection of the Feeder.

Tag name information (*.RTInfo)
Here you can assign the tag types Process information and Measured value a process tag with the file exten-
sion RTInfo.

Tag name topological information (*.RTInfo)
Here you assign the tag types Internal information and Measured value an internal tag with the file exten-
sion RTInfo.

Tooltip text
Enter a text in this entry field. This text is displayed as a Tooltip for the object in the active project.

Color

[sc_edc_color, 1, en_US]

Figure 5-5 Properties of SICAM Electrical Device Controls, Color

Foreground
The foreground color of the graphic object can be individually set. Red is the default setting.

Background
The background color of the graphic object can be individually defined. Gray is the default setting.

Topological Coloring
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Topological style
Here you select the colors for the topological representation style of the object.

• For the Feeder you define the Supply type color.

• For the Transformers you define the colors for the Primary side (reverse energization) and the Secon-
dary/output side.

Define the colors and their priority via the Settings for the project dialog (see Topological Project Settings,
Page 186)

Picture

[sc_edc_picture, 1, en_US]

Figure 5-6 Properties of SICAM Electrical Device Controls, Picture

Assigning Pictures
Select a value under Properties and click Browse to assign an image file.

• INVALIDPicture
Picture for representing the INVALID status.

• OFFPicture
Picture for representing the OFF status.

• ONPicture
Picture for representing the ON status.

Preview
The assigned picture is shown in a preview.

Topological Coloring
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ii NOTE
For the changes made to the SICAM Electrical Device Control properties to take effect (e.g. change of the
supply type color), proceed as follows:

• Save the changed picture in the Graphics Designer,

• re-generate the entire topological structure for the project,

• start – or stop and re-start – the runtime.
This has to be done using the WinCC Explorer. Activating the picture via the Graphics Designer only is
not sufficient.

 
 

Tag Connection of the Feeder
The tag connection of the feeder must be defined depending on the supply type.

Supply of Internal Information
If the feeder is supplied by an item of internal information, the internal tag must be created with the
PAS_InformationInternal structure type (see 5.2.2.5 Creating Structure Tags) and is directly defined as topo-
logical information.
For controlling the topological coloring, the tag has the values OFF = 1 or ON = 2.

[sc_edc_process, 1, en_US]

Figure 5-7 Supply of Internal Information

Supply of a (Process) Measurement
If the feeder is supplied by a (process) measurement, an internal tag must be additionally created as a
PAS_InformationInternal structure type (see 5.2.2.5 Creating Structure Tags) and assigned.
For controlling the topological coloring, the tag has the values OFF = 1 or ON = 2.

5.2.2.4
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[sc_topo_feeder_measured_value, 1, en_US]

Figure 5-8 Supply of a (Process) Measurement

The switching point when the feeder switches from OFF to ON is defined in the Style tab.

[sc_topo_feeder_measured_value_level, 1, en_US]

Figure 5-9 Defining the Switching Point

In order to prevent continuous switching the color ON and OFF in the case of slightly fluctuations around the
switching point, a hysteresis can be defined.
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[dw_topo value hysteresis, 1, en_US]

Figure 5-10 Hysteresis around the Switching Point

ii NOTE
When controlling the feeder with a measured value, the feeding object must be active in the picture
displayed at runtime in order to ensure that the changes are applied in the Runtime. The measured value is
the input value which controls the topological tag with ON/OFF within the scope of configuration on the
object (switching threshold and hysteresis).
The topological tag is not used if the object is not active.
Alternatively,

• you can evaluate the measured value via a global script and define the tag.

• you can place the feeding object invisibly at any position in other pictures (no connection required).

Supply of Process Information
If the feeder is supplied by an item of process information, the value of the information is directly used as an
input for controlling the topological coloring with the value OFF = 1 or ON = 2.
An additional topological control tag is not required for this configuration.
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[sc_topo_feeder_processinfo, 1, en_US]

Figure 5-11 Supply of Process Information

Creating Structure Tags
To be able to use Internal Information as Tag type for the Tag connection, you first have to create structure
tags.

ii NOTE
Do not use special characters and umlauts in tag names.

Changes in Tag Management

✧ Create new tags in Structure tags > PAS_InformationInternal, e.g. TopoTestLoad and TopoTest-
Feeder.

[sc_tagmanagement, 1, en_US]

Figure 5-12 Tag management

Defining SICAM Electrical Device Controls

✧ Insert a SICAM Electrical Device Control.
✧ In the Style tab, select Feeder as Type.

5.2.2.5
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✧ In the Tag connection tab, select Internal information as Tag type.
✧ Enter the name of the desired internal tag in the Tag name topological information column, here e.g.

TopoTestFeeder.RTInfo.

[sc_edc_topo, 1, en_US]

Figure 5-13 Defining SICAM Electrical Device Controls

SICAM Switch Controls

A closed control (switching device object) functions like a connector. An incoming value is transferred to the
output of the other connecting point. An open control does not transfer the value.
If the switching object is in the OFF state, the color value defined for de-energized is issued.
The ON and Grounded colors are not prioritized by the controls, but processed with the same priority.
If a control is in the Intermediate position/Fault position, the line color is transferred depending on the
priority of the line color on one of the inputs: Only if the line color unequal OFF is pending on one of the
inputs will the line color Undefined be transferred.

ii NOTE
The element Earth Isolator is firmly connected to earth potential on one side, thus representing a 1-pole
for topology calculation. The line must be connected to the left port (marked with a small square, see
chapter 4.4 SICAM Switch Controls) of the earth isolator, the earth symbol can be connected to the right.
To avoid errors in topology calculation, the earth isolator must be rotated via the SICAM Switch dialog with
the Orientation parameter, if required; not via the WinCC Object properties dialog.

SICAM Bay Overview

You can use a bay overview to show the status of an entire bay by means of a single graphic object.

5.2.3

5.2.4
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ii NOTE
If the breakers configured in the bay overview are configured as individual breakers in another picture,
make sure that the connecting points are correctly oriented.
In the topological model of the bay overview, the earth isolator is connected to the circuit breaker
connector pointing away from the busbar, if the corresponding tags have been programmed (see
Figure 4-34).

Connector

Connectors are used to link graphic objects. Usually it is used to represent, e.g., cable trains and bsubars.
Lines must not be used for this purpose.
A connector can be linked to a graphic object on both ends. A connection is performed automatically if one
end of a connector is positioned next to a graphic object. As soon as the connection has been successfully
defined, the color changes from green to red.
For more detailed information regarding connectors, refer to the online help of the Graphics Designer.

Connecting points
If a graphic object is moved, the linked end of the connector moves as well. The connector itself cannot be
moved when linked to a graphic object. A connector must always be linked to a graphic object on both ends.

Node

With the Connection point graphic object, 2 connectors are linked or a feeder is created. A node can be repre-
sented as a circle or as a rectangle.
Up to 4 connectors can be linked to the same connection point.

[dw_topo col node, 1, en_US]

Figure 5-14 Connection Point

ii NOTE
Do not draw the connection point too small in order to ensure that the link to the connector can be
conveniently defined.

5.2.5

5.2.6
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Parameterization

Data Analysis

Various definitions for the representation of the network equipment and for the evaluation of the network
status must be performed in order to be able to use the Dynamic network coloring function.

• In which pictures do you want to represent the current network status?
– Substation diagrams
– Worldmap with definition of the zoom levels (visibility)

• Which colors and symbols are used in order to represent the various equipment items?
– Color of the voltage levels and feeders
– Symbols used in the network diagrams
– Coloring of the switch symbols from the topology

• What colors are used in order to represent the individual network statuses?
– De-energized, grounded, undefined
– Priorities of the topological status values

• Which of the following functions do you want to use additionally?
– Consistent coloring across multiple pictures
– Coupled and secure operating mode

The connectors are represented in the color defined for the individual network status. This line color can also
be applied to the switching objects.

Data Model

Topological Elements
All the objects whose indications are used to determine the current switching status of the network are
referred to as "topological elements".
These include:

• Switching elements, e.g. disconnectors and circuit breakers

• Feeders

• Transformers

• Termination
In order to design networks which enable dynamic network coloring, all equipment items must be available as
dynamic SICAM structure tags (RTInfo).
When designing pictures, it must be ensured that the lines end in the objects. This is a major prerequisite in
order to be able to create an electrically connected network in which the topology can be calculated.

Coloring – Basic Principles
For dynamic network coloring the topological view of the network is represented via connectors and other
topological elements. This function requires at least the following topological elements connected to each
other via connectors:

• Source (Feeder)

• Termination

5.3

5.3.1

5.3.2
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[le_basic_structure, 1, --_--]

Figure 5-15 Basic structure

(1) Feeder
(2) Connector
(3) Termination

In addition, the switching elements are inserted in this basic model, e.g. a circuit breaker.

[le_basic_structure_w_breaker, 1, --_--]

Figure 5-16 Basic structure with circuit breaker

(1) Feeder
(2) Connector
(3) Termination
(4) Circuit breaker

Via the supply type assigned, the topological element Feeder determines the color used for representing the
lines. All other elements, e.g. the circuit breaker, transfer the color to other elements or restrict the coloring.

Topological Coloring
5.3 Parameterization

182 SICAM, SICAM SCC, Manual
E50417-H8976-C501-B5, Edition 05.2020



1- and 2-pole elements 

ii NOTE
The left-hand connection point of the 1- and 2-pole-elements is highlighted with a small square in the
Graphic Editor.
For more information regarding the connectors see Connecting points, Page 108

The topological graphic objects are subdivided into 1-pole elements, 1-pole elements with special function
and 2-pole elements:

• 1-pole: Feeder, ground, terminator
A 1-pole element only has a connection on the left-hand side. Since all the objects have 4 connecting
points, only 1 side may be used in any case.

• 1-pole with special function: Grounding disconnector (Earth isolator)
This 1-pole element must always be connected to the topology via its left-hand connection. The right-
hand side can be used additionally for a connection to a ground symbol graphic object.

• 2-pole: Circuit breaker, disconnector, load break switch, transformer, bay overview
To ensure unambiguous identification, the 2 connections of these 2-pole elements are referred to as the
"left-hand connection" and "right-hand connection". 2-pole elements must always be connected to 2
connectors. The left-hand connection is marked with a small square in the Graphic Editor. See also
Connecting points, Page 108.
Bay overview objects are not marked with a square; the left-hand connection is 'Always at the top' or on
the 'Left'.

ii NOTE
The left-hand connection of the 1- and 2-pole elements is marked with a small square in the Graphic Editor.

Line Node
Connections connected by means of connectors (lines) form a line node.
An element with 2 connections is connected to 2 line nodes, e.g. a circuit breaker (2-pole element). An
element with 1 connection is connected to 1 line node, e.g. a grounding switch (1-pole element).
Each line node must be represented completely with all its elements in at least 1 picture. For more detailed
information, refer to 5.4 Cross-Picture References
All other functions, such as coloring or , are derived from the topological calculations performed for this line
node. For this reason, the topological parameters of the node elements must be identical in all pictures.
This means that a switch represented in various pictures must always have the same neighbor (breaker).
However, these do not necessarily need to be drawn, e.g. for bay representations as a section from an over-
view picture.
As soon as the parameterization and project generation have been completed, the node structure of your
network as well as any errors are shown in the tree view of the topology.
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[sc_treeview, 1, en_US]

Figure 5-17 Representation of the topological node structure in the editor, example

When selecting a topological element, the corresponding picture is shown. The selected element is high-
lighted.

[sc_node_and_graphic, 1, en_US]

Figure 5-18 Representation of the Topological Node Structure in the Editor with Picture Section, Example

Settings

You can access the two setting dialogs described below from the Topological coloring submenu of the
SICAM menu (see 6.2 SICAM Menu).

5.3.3
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Topological Settings for Selected Objects
In the Topological Settings for Selected Objects dialog you can set the parameters of the Topological
coloring function of the selected line and switching objects.
First, select the objects to edit. When the dialog is opened, their parameters are read in. If the selected objects
are parameterized differently, the relevant parameter fields are displayed empty, check boxes are marked in
the mixed state. If you do not edit these parameters, they will not be changed when you save them.
The following applies to Line mode:
With Use topological project settings you apply to the selected objects the properties which have been
defined as default in the Topological Project Settings, Page 186 dialog.
To make different settings for the selected objects, remove the check mark next to Use topological project
settings and set the line mode, the line thickness, and, if necessary, a different color for de-energized lines.
The following applies to the Line mode:

• With Single-colored the color of the supplying source is displayed with highest priority.

• With Two-colored the 2 source colors with highest priority are displayed with dashed lines when
supplied by different sources, otherwise they are displayed with single color.

• With Fail-safe, i.e. if the network section is supplied on both sides, the color of the source with highest
priority is displayed. If the section is not fail-safe, i.e. if it is supplied only on 1 side, dashed lines are
displayed with the colors of the source with highest priority and Not energized.

Set the Line weight independent from each other For insecured supply and For secured supply.
For de-energized lines you can use a color different from supply type Not energized.
The following applies to the coloring of switch controls:

• Choose whether you want to use the topological color for the selected switch controls.

• Since 2 different line colors can meet for switching state OFF, you still need to specify how the switching
object should be colored:
– Do not use topological color
– Use color of top left connector
– Use color of bottom right connector

ii NOTE
Use deviating color for de-energized lines is ignored in this case – the setting in Topological project
settings will be used.
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[sc_settings_for_selected_objects, 2, en_US]

Figure 5-19 Dialog Topological Settings for Selected Objects

Topological Project Settings
In theTopological Project Settings dialog you define the project-wide default settings. In the Topological
Settings for Selected Objects, Page 185 dialog you can define differing values for single objects.
Use the Supply type tab to define Line color and Secured state as project default value for each available
Topological state.
In addition, you can use Add topological state in order to define further topological states.
The states highlighted in gray are predefined. In contrast to self-defined states (highlighted in white), only the
line color can be changed for these states; however, they cannot be renamed.
For the SICAM Topology objects (SICAM Electrical Device Controls), the color settings for the topological states
are available as a selection list for the Supply type (see Color, Page 173).
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[sc_settings_for_project, 2, en_US]

Figure 5-20 Dialog Topological Project Settings – Supply Type

Use the Line representation tab to define the project-wide default values for Line mode and Line weight.
For further information regarding possible settings for Line mode and Line weight, see Topological Settings
for Selected Objects, Page 185.

[sc_line_representation, 1, en_US]

Figure 5-21 Dialog Topological Project Settings – Line Representation
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ii NOTE
For changes to take effect, the runtime has to be restarted

ii NOTE
Do not use the WinCC Classic design with large line widths because 2-color connections cannot be
displayed correctly in this case.
Use WinCC Classic with Line weight 1 only.

Priority of the Topological Status Values (Colors)
The priorities of the topological status values are as follows:
Grounded > Energized > Undefined > Initial state > Not energized

[sc_settings_for_project_priority, 1, en_US]

Figure 5-22 Priority in the Topological Project Settings

Parameterizing Elements and Symbols

For more detailed information on how to set the parameters of the elements, refer to 4 Graphic Objects.

Notes on Configuration

Before you create the topological structure, the connections are first checked. The Report window shows the
result of this check, warnings or error messages.

5.3.4

5.3.5
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An error message is displayed if the topological coloring could not be performed correctly during runtime. A
warning is shown if the topological coloring could be performed although a discrepancy exists. A new topo-
logical calculation is performed if a warning is issued, but not in the case of an error.
The following table provides a list of faulty connections.

Table 5-2 List of Faulty Connections

Faulty connections Result of the check Correct connections Remark
Error
The connector has not
been completely linked.

Open connections can delay the
build-up of a diagram.
The open side of a connection tends
to automatically link to another
object.

Error
2 connectors are linked
without a connection
point.

An additional connector or an addi-
tional connection point must be
inserted.

Error
Circular connection

Disconnect the
circular connection.
Avoid a loop in a
network.

The term ‘circular connection’ desig-
nates that an active object (switch,
bay overview, feeder and ground
disconnector) is connected to itself.
A loop consisting e.g. of 2 switches is
not considered as a circular connec-
tion.

Warning
Connection to a graphic
object which does not
support topological
coloring.

No topological coloring of this
graphic object takes place during
runtime.

Warning
The graphic object has
more than 1 connection
on one of its inputs/
outputs.

For graphic objects, only 1 single
connection can be defined per input/
output.

Topological Coloring
5.3 Parameterization

SICAM, SICAM SCC, Manual 189
E50417-H8976-C501-B5, Edition 05.2020



Cross-Picture References
If network sections are represented in different pictures, e.g. in the overview picture and in the branch picture,
cross-picture node references must be created. This ensures that dynamic network coloring is possible across
the limits of the individual picture.

Reference via Double Representation of Topological Elements
If the topological elements of a node are represented in various pictures, the topology algorithm detects that
the same elements have been created in the node copy.
As a prerequisite, the node must be completely described with all its elements in one of the pictures. In this
case, fewer elements can be created on the node in the other pictures. Regarding the topology, the same
parameter values must have been set as for the original node. However, no additional elements may be
connected to the node copy.
In the example illustrated below, the Original of branch HV Bay 1 is located in the overview picture and the
Copy is located in the branch picture.

[sc_node_original, 2, en_US]

Figure 5-23 Original Node Definition (Overview Picture)

5.4
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[sc_node_copy, 2, en_US]

Figure 5-24 Reference Node Definition, Copy (Branch Picture)
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Using Topological Coloring
The following requirements must be fulfilled in order to use the topological coloring function:

• The graphic objects Feeder and Ground must be used in your station diagrams.

• Connectors and connection points must be added instead of simple lines and circles.

• Feeders must be configured.

• Topological structure has to be created.
This subchapter provides an example for the creation of a picture using topological coloring. A measured value
is used as source for the topological coloring.
The following section describes how to draw and configure a branch. Alternatively, you can use default
branches from the library.

Positioning Graphic Objects
Proceed as follows to position graphic objects on your workspace:
² To open the Library window, click View > Library.

² Select a feeder under Topology.

[sc_topo_insert_object, 1, en_US]

Figure 5-25 Inserting graphic objects

² Hold down the mouse button and move the cursor over the workspace until the graphic object has
reached the desired position.

² Insert the controls (switching device objects) from the library.

² Insert a grounding (consisting of earth isolator and ground disconnector).
The grounding is available in the library under Topology.

5.5
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[sc_topo_swob1, 2, --_--]

Figure 5-26 Picture with a feeder, controls (switching device objects) and a grounding.

Inserting Connection Points and Connectors

² Insert the connection point into the picture.
The connection points and connectors are available in the library under Topology.

² Insert the connectors.
When inserting the connectors, make sure that the connection to the graphic object is properly defined. A
successful connection is represented by a red dot.
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[sc_topo_swob2, 2, --_--]

Figure 5-27 Picture with connection point and connectors

ii NOTE
After renaming an active graphic object (e.g. a feeder, switch, or connection point), all connections to this
graphic object must be redefined. To do this, separate the connection in the picture and redefine it after-
wards. This ensures that the new name is entered in the properties of the connector.

Configuring a Feeder
Proceed as follows to configure a feeder:
² Double-click the feeder.

The SICAM Electrical Device Control Properties dialog opens.
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[sc_edc_style, 1, en_US]

Figure 5-28 Configuring a feeder

² In order to use a measured value as source for topological coloring, on the Tag connection tab, select
Measurement as Tag type.

² In the Style tab under Measurement, you can now define the values for Level ON/OFF and Hysteresis.

Linking feeders to tags
Each feeder must be linked to a tag.
To link the feeder to a tag, proceed as follows:
² In the SICAM Electrical Device Control Properties dialog, select the Tag connection tab.

² Select a Tag type:
Process information: The value of the information includes ON/OFF/DISTURBED or RAISED/CLEARED and
is directly transferred to the topology calculation
Internal information: internal data structure, e.g. filled by a script; ON/OFF/DISTURBED values are trans-
ferred to the topology calculation
Measured value: Input data originate from a measured value; the switching point and the hysteresis
determine ON/OFF and set the additionally linked internal message to this value which is then transferred
for topology calculation. For further information see hint after Figure 5-10.
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[sc_topo_tagconnection, 1, en_US]

Figure 5-29 Feeders, connecting tags

² Select the corresponding Tag names (*.RTInfo).

² Click OK to close the dialog.

Creating the Topological Structure
After inserting all graphic objects required and linking them to the appropriate connectors, the topological
structure must be created.
² Activate the picture (e.g. by clicking the corresponding icon in the SICAM toolbar):

² Check the picture:

² Click the Create Topological Structure icon:

After checking the topology, the model and the event scripts on the objects are generated. You can view the
progress in the Report window. Also errors are displayed here, see 5.7.1 General Information.
For more detailed information concerning error messages, refer to 5.3.5 Notes on Configuration.
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Using Picture Windows
You can use pictures as picture windows in superordinate pictures. If the picture window in the superordinate
picture uses variable prefixes, you have to apply them for the picture which you want to display in the picture
window. Therefore, during configuration you define a list with prefixes. These are taken to generate all
possible combinations to be used for the topological coloring.
If you click a picture window in the superordinate picture during runtime, the corresponding values are
displayed.
How to use the prefix list:
² Drag and drop the List tag prefixes element from the Topology section of the Library into your picture.

[sc_bildfenster_prefix de, 2, en_US]

The element is inserted.

[sc_bildfenster_prefix_obj, 1, --_--]

² Right-click the List tag prefixes object and open its Properties.
Under Geometry you can set the Number of Rows as desired.

5.6
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[sc_bildfenster_rows de, 1, en_US]

² Under Miscellaneous you can change the texts.
Therefore, use Selected box to select the entry and change it in Selected text.

[sc_bildfenster_text de, 1, en_US]

² To hide the List tag prefixes object during runtime, set the Display attribute to No.

[sc_bildfenster_unsichtbar de, 1, en_US]
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Debugging

General Information

Any warnings or error messages which may pop up from the pictures during creation of the topological struc-
ture are displayed in the Report window.

[sc_error_generation, 1, en_US]

Figure 5-30 Error during generation, example

In addition, the error messages are also displayed in the tree view, see Figure 5-17.

ii NOTE
Click the link indicated in the error message in order to jump directly to the element concerned.

Error Messages

• An element occurs several times on the same node
An element must not occur several times on the same node. Otherwise, the representation can become
inconsistent.

• Element short circuited
The left- and right-hand connection of an element are connected. The subsequent error Not connected
can also occur.

• Connected too often
A 1-pole element has more than 1 connection, but may only occur in an original node.
A 2-pole element has more than 2 connections, but may only occur in 2 original nodes.

• Line without connection
Check the line connection.

• Node without connection
Check the configuration of the topological segment.

5.7

5.7.1

5.7.2
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• Not connected
At least 1 feeder or transformer and at least 1 terminator must exist and be connected in the topology
description. All other elements must be connected to a line and a neighboring element. Connectors
without connection cause an error message.

• Inconsistent representation
The most common cause is an erroneous double use of a process tag on a switching device objects.
Elements can be duplicated for cross-picture representations. In this case a node copy is created, e.g. in a
detailed picture. This node copy may include fewer elements than the original node, but no additional
elements. No valid original node can be determined in such cases.
Complete the original node by the missing elements.
Connect the correct neighboring elements.

• Incorrect transformer side
The transformer with its tag allocation has been used several times and has been installed at least once in
the opposite direction, i.e. the Side 1 and Side 2 connections have been confused.

• Type mismatch
Switching device or bay overview objects with the same tag assignment were defined with different
topological types.

• Supply type not clear
A different supply type was used for a SICAM Electrical Device Object in the original node and in the node
copy.

• Mounting direction (left/right reference) not consistent
The mounting direction of an element in the original node is opposite to the mounting direction in the
node copy.
Rotate the element using the Orientation parameter in the Properties dialog.
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Application Examples

Switchgear trucks

If switchgear trucks are shown in pictures, disconnectors supplied by the same process tag are represented on
both sides of the circuit breaker. Since this scenario cannot be represented in the topology, only one of the
disconnectors may be configured with the process tag.
The second disconnector must be connected to a newly created internal structure tag (type: PAS_Informatio-
nInternal). The names can be freely selected or adapted to the name of the external process tag.
The disconnector with the internal tag connection cannot be controlled. For this reason, you can remove the
OnLeftClick and OnRightClick scripts in the Event tab.

[sc_appex_carriage_event, 1, en_US]

Figure 5-31 Scripts

If the process values of the disconnector with the process tag change, the data of the process tag is trans-
ferred to the internal tag via copying. The C script
SCC_CopyTagValueRT(char* p_cSourceTagName, char* p_cDestinationIntTagName,
BOOL p_bDigitalValue) can be used for this purpose. You can configure the function to the OnProcData-
Change event of the disconnector with tag connection.

5.8

5.8.1
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[sc_appex_carriage_script, 1, --_--]

Figure 5-32 Example of the script

A .var file is required in order to ensure that the tag can be processed by the SICAMRTDataServer. The files
for the SICAMRTDataServer are stored in the GWData subfolder of the WinCC project.
The name must end with .var e.g. SICAMRTDS_TopoINT.var.
The file structure is as follows (identical with SICAMRTDS_TopoPlugIn.var):
# 2017-01-01 01:01:01.010101; SICAM_Pas803_T103M_T103IF_7SJ63_q1_einaus_INT.RTInfo;
<Generic type>;
Each tag created manually for a (truck) disconnector must be entered here.
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Overview
The SICAM add-in is an extension to the Graphics Designer.
It enables the parameterization of any graphic object in a diagram (picture) based on defined tasks. To do this,
you use predefined tasks, but you can also create user-defined tasks.
The tasks allow the simultaneous parameterization of several graphic objects. You can define parameters for
static values, tag dynamizations and also events.
Based on a specific task, you can e.g. assign a bay's switching device objects and measured-value objects tags
from a different tag group.
As a rule, the SICAM add-in is enabled. To disable/enable it, click Tools > Addin Manager in the Graphics
Designer.
The Graphic Library Explorer allows you to edit graphic objects in the SICAM graphic object library.

ii NOTE
The SICAM add-in for the logged on Windows user is registered during installation. If another user works
with SIMATIC WinCC, the SICAM add-in is not displayed in the SIMATIC WinCC Graphics Designer.
To activate the SICAM add-in for a newly logged on Windows user, the SICAM add-in must be registered
while the new user is logged on. A SICAMAddIn.reg registration file which includes this registration is
available in the <InstallationDirectory>\bin.

6.1

SICAM Add-In
6.1 Overview

204 SICAM, SICAM SCC, Manual
E50417-H8976-C501-B5, Edition 05.2020



SICAM Menu
The SICAM menu provides the following functions:

• Topological Coloring
– Topological settings for selected objects

Opens the Topological settings for selected objects dialog.
– Topological project settings

Opens the Topological project settings dialog, which allows you to define topology states and
assign the project-wide default settings to lines and active objects.

– Verify current picture
Verifies the object parameterization of the current picture and shows the result as well as any errors
in the Report window.
This function enables the user to verify the picture without the need to change the existing project.
The topological structure only must be generated once again after the picture has been saved.

– Enable/disable picture for topological coloring
Enables/disables the current picture and indicates the status with a checkmark.

– Create topological structure
Starts the project generation for the topology and shows the result and any errors in the Report
window.

– Tree view
Represents the topological node structure.

• Tasks
Shows the dialog for executing predefined or user-defined tasks.

• Define working area
Defines the working area in the picture by dragging a rectangle with the mouse. This working area
applies to subsequent functions.

• Select identical objects
Selects all graphic objects in the working area which correspond to the type of the selected graphic
object. It is also possible to select several object types simultaneously.
This function allows you to simultaneously change e.g. the color settings for all selected graphic objects
in the WinCC Properties dialog.

• Invert selection
Inverts the current selection. Selected graphic objects are deselected; deselected graphic objects are
selected.
This function applies to the graphic objects in the whole picture.

• Show Graphic Library Explorer
Opens the Graphic Library Explorer.

• Settings...
This submenu items allows you to perform general settings and create user-defined tasks, see
6.4 Performing Settings.

6.2
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[sc_sicam_menu, 2, en_US]

Figure 6-1 Graphics Designer, SICAM menu

Based on these tasks, you can edit:

• Controls (switching device objects) – circuit breakers and disconnectors

• Feeders, Ground

• Measured-value objects

• All other graphic objects, e.g. standard objects

Define working area
The Define working area function influences the next two functions in the list. You can use it in order to
define to which picture section the selection functions shall apply. If no working area or an empty working
area has been defined, the selection functions apply to the entire picture.
To simultaneously modify the object properties of several identical graphic objects (e.g. breakers), you can use
the selection function.
Proceed as follows to execute a selection function:
² Click to select the working area in your picture.

² Click the Define working area function.
The graphic objects in the working area are recorded internally.

² Click on a free space on the picture.
All visible markers are removed.

² Select the reference object.

² Next, click Select identical objects.
All identical graphic objects are selected in the working area.

The working area remains active until a new area is defined.
² Right-click one of the selected graphic objects.

² Open the Object properties dialog.
You can now e.g. modify the ColorON attribute simultaneously for all selected graphic objects.

SICAM Add-In
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SICAM Toolbar

Die SICAM Toolbar wird angezeigt, wenn das SICAM Add-In über das Menü Extras > Addin Manager akti-
viert wurde.

Functions

Table 6-1 Functions of the SICAM Toolbar

Icon Meaning
Define working area

Select identical objects

Invert selection

Show task dialog

 / Activate/deactivate current picture for Topological Coloring

 / Check current picture; if an error occurs, the red symbol is displayed

 / Create topological structure; if an error occurs, the red symbol is displayed

Show tree view

You can also call up the functions of the SICAM Toolbar via the SICAM menu, see 6.2 SICAM Menu.

6.3
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Performing Settings
To open the Settings dialog, click SICAM > Settings.... This dialog allows you to perform general settings and
create user-defined tasks.
The following entries are displayed on the uppermost level of the tree structure in the left-hand pane of the
dialog.

• General
This entry is required for working with the Graphic Library Explorer.

• Tasks
All user-defined tasks are arranged under this entry. User-defined tasks can only be displayed after they
have been created by the user.

The settings are displayed and can be edited in the right-hand pane of the display. The display always shows
the settings which belong to the entry selected in the tree structure. The settings are described in the
following paragraphs.

General Information

[sc_sicam_settings, 1, en_US]

Figure 6-2 Settings dialog, General

6.4

6.4.1

SICAM Add-In
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The following setting is possible under General:

• ShowLibObjList
This setting defines how a modified graphic object is inserted in the Graphic Library Explorer.
False adds the modified graphic object under a new name.
True opens the Select graphic object dialog. In this dialog, you can modify the name of the graphic
object and define whether it is replaced.
To replace the existing graphic object, right-click the graphic object and click OK. The existing graphic
object is replaced by the modified graphic object; the name is retained.
The name of the replaced graphic object remains unchanged in each available language.

Tasks

[sc_sicam_tasks, 1, en_US]

Figure 6-3 Settings dialog, Tasks

User-defined tasks can be created and defined below the User-defined tasks entry, see 6.6 Creating User-
Defined Tasks.
You can call up these user-defined tasks in the Graphics Designer (SICAM > Show or hide task dialog) or via
the SICAM Toolbar. They influence the graphic objects of a diagram.

Deleting a user-defined task
To delete a user-defined task:
² In the tree structure in the Settings dialog, select the task to be deleted.

² Click Delete.

6.4.2
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Exporting a user-defined task
You can export the current task configuration into a *.satsk file. Afterwards, the task can be imported into
another project.
To export a user-defined task:
² In the tree structure in the Settings dialog, select the task to be exported. In the tree structure, select the

tasks in order to simultaneously export all user-defined tasks.

² Click Export.

Importing a user-defined task
You can import a task from a *.satsk file into the Settings dialog. The imported task is displayed in the tree
structure in the left-hand pane of the display.
To import a user-defined task:
² In the Settings in the tree structure, select the Tasks entry.

² Click Import.

SICAM Add-In
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Predefined Tasks
The SICAM Add-In provides several predefined tasks. You can select a predefined task in the Execute task
dialog.

To open this dialog, select SICAM > Show task dialog from the menu or click the icon in the toolbar.

[sc_tasks_given, 1, en_US]

Figure 6-4 Execute task dialog, Predefined tasks tab

ii NOTE
If objects were replaced by a task: Check after the replacement whether configured scripts which have
been applied must be adapted or removed.

Predefined Tasks
The following predefined tasks are available:

• Switches, bay overview: Change of tag connection (SCC V8, V9)
With this task you can change the tag connection of switch, bay overview, feeder, and ground objects in
a switch bay.

• Ground: Upgrade objects from SCC V7 to V9
With this task you can replace ground objects of SICAM SCC V7 with the ones of V9.

6.5
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• Feeder: Upgrade objects from SCC V7 to V9
With this task you can replace feeder objects of SICAM SCC V7 with the ones of V9.

• Switches: Upgrade objects from SCC V7 to V8, V9
With this task you can replace switch objects of SICAM SCC V7 with the ones of V8 and accordingly V9.

• Bay overview: Upgrade objects from SCC V7 to V8, V9
With this task you can replace bay overview objects of SICAM SCC V7 with the ones of V8 and accordingly
V9.

• Measured value up to V8.01: Upgrade to SICAM Numeric Control (V8.02) (step 1)
With this task you can replace measured value objects of former SICAM SCC versions with numeric
objects of V9. For a successful upgrade you have to execute step1 and then step 2.

• Measured value up to V8.01: Upgrade to SICAM Numeric Control (V8.02) (step 2)
With this task you execute the second step to upgrade measured value objects. The configured process
tags *.Counter are replaced by *.RTInfo.

• Switches, bay overview: Change of tag connection (SCC V7)
With this task you can change the tag connection of switch, bay overview, feeder, and ground objects in
a switch bay.

• Switches: Update PAS CC V5.10 objects with "Activate" tag
With this task you can update the switching device objects of PAS CC V5.10; the ActivateControls tag gets
connected. The ActivateControls tag is connected.

• Measured value: Upgrade PAS CC V5.10 objects to V6 (up to V8.01)
With this task you can replace measured value objects of SICAM SCC V5.1 with newer measured value
objects (V6 to V8.01).

• Measured value: Upgrade PAS CC V5.0x objects to V6 (up to V8.01) (step 1)
With this task you can replace measured value objects of PAS CC V5.0 with newer measured value objects
(V6 to V8.01). For a successful upgrade you have to execute step1 and then step 2.

• Measured value: Upgrade PAS CC V5.0x objects to V6 (up to V8.01) (step 2)
With this task you execute the second step to upgrade PAS CC V5.0 measured value objects. The config-
ured process tags *.Counter are replaced by *.RTInfo.

• Show dynamics
This task shows all the 'Dynamic' parameterization of the selected objects.

• Edit items of a Check Box or Option Group object
The task adds, removes, or modifies the items of the selected Check Box or Option Group.

• Edit Items of a Listbox or Combobox
The task adds, removes, or modifies the items of the selected Listbox or Combobox.

ii NOTE
You can continue to operate existing SICAM SCC projects of version 7.xx with the current IndustrialX
Controls without using the SICAM SCC Runtime Data Server.
In order to continue to use current IndustrialX Controls (switching device objects) the IX State Sync can also
be continue to be used.
The optionally installable IX State Sync redundancy component is entirely replaced by the SICAM SCC
Runtime Data Server and no longer is required when using the ActiveX Controls of V8.0 or higher.

SICAM Add-In
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ii NOTE
Be aware that pictures and settings configured under the Bitmap option are not applied for Send QoC in
command value.
Scripts or actions configured for properties or events of the switching device objects are not applied during
conversion. They cannot be applied because the property types and events are not fully compatible. The
scripts and actions must be created again after the conversion.
The new object which is used for replacement can be updated in advance with the corresponding pictures.
All further object settings are applied during conversion.

Executing a task
Due to the large number of different application options, the execution of the various tasks cannot be
described in detail. However, a brief description of each predefined task is provided in the Execute task
dialog.
Three different types of tasks are possible, see 6.6 Creating User-Defined Tasks.
Proceed as follows to execute the Switches: Update PAS CC V5.10 objects with "Activate" variable pre-
defined task:
² In the Graphics Designer, open the diagram (picture) to be edited.

² In the Graphics Designer, click SICAM > Show task dialog to open the Execute task dialog.

² Select the Predefined tasks tab.

² Select Switches: Update PAS CC V5.10 objects with "Activate" tag.

² In the display, select the V5.10 controls for which you want to perform an upgrade.

² Click Execute.
The Switches: Update PAS CC V5.10 objects with Activate variable dialog opens. The ActivateCon-
trols value is entered in the New value column.

² To confirm, click OK in the dialog which opens.
The switching device objects are upgraded and the new value is applied.
The result is output as a report.

SICAM Add-In
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Creating User-Defined Tasks
You can create your own, user-defined tasks in addition to the predefined tasks.
The following 3 types of tasks are possible:

• Parameterizing graphic objects
This task defines the properties and events of a group of graphic objects.

• Replacing graphic objects
This task replaces the graphic objects in a diagram (picture) with new graphic objects. The values of the
properties and events are copied in accordance with the definition.

• Editing elements of a graphic object
In your diagram, you can edit the elements of a check box, radio box, list box or combo box in order to
customize them according to your requirements. In the past, this task was performed in the Object Prop-
erties, attribute Index dialog. In the meantime, it could be further simplified with the new function.

The following paragraphs describe how to create user-defined tasks. A specific task is created for each
possible task type.
The examples illustrate the creation of predefined tasks. To create customized tasks, proceed as illustrated
below.

Upgrade V5.1 Measured Value Objects

This paragraph describes the creation and subsequent execution of the Upgrade V5.1 measured value
objects task.
The following steps must be performed:

• Creating a task

• Configuring a task

• Executing a task

Creating a task
To create a task:
² In the Graphics Designer, select SICAM > Settings.

The Settings dialog opens.

6.6

6.6.1
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[add-in501, 1, en_US]

Figure 6-5 Settings dialog, creating a task

² Select Tasks in the tree structure.

² Click New and then select the Replacement of graphic objects task type.
The task is created and displayed in the tree structure.

Configuring a task
You can now configure the task, i.e. define the actions performed by the task.
² Under StaticProperties and DynamicProperties, keep the (all) entry.

All values of the static and dynamic properties with the same property name are transferred during the
upgrade of the V5.1 graphic objects to the new graphic objects and will be retained.

² In the Events row, click (all) and then click the button with the dots.
The Events dialog opens.

SICAM Add-In
6.6 Creating User-Defined Tasks

SICAM, SICAM SCC, Manual 215
E50417-H8976-C501-B5, Edition 05.2020



[add-in502, 1, en_US]

Figure 6-6 Events dialog

² Under Action event, right-click (all) and select Delete.
This removes the (all) entry. During the upgrade, the scripts of the V5.1 graphic objects will be replaced
by new scripts.

² Right-click the empty field under Action event and select Apply.
The delete process is executed.

² Click OK to close the dialog.

² Under Name, enter Upgrade V5.1 measured value objects for the task.

² Under Description, enter a brief explanation of the task with notes on the workflow.

SICAM Add-In
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[add-in503, 1, en_US]

Figure 6-7 Settings dialog, newly created task

² Click OK to close the dialog.
The task has been created and is displayed in Graphics Designer, Execute task dialog, User-defined
tasks tab.

Executing a task
Proceed as follows to execute a task:
² In the Graphics Designer, open the diagram (picture) to be edited.

² Insert a measured value object of the new version into the diagram.

² In the Graphics Designer, click SICAM > Show task dialog to open the Execute task dialog.

² Select the User-defined tasks tab.

² Select the Upgrade V5.1 measured value objects task.

SICAM Add-In
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[add-in504, 1, en_US]

Figure 6-8 Graphics Designer, executing the task

² In the display, select the measured value objects for which you want to perform an upgrade.

² Click Collect.
The highlighted measured value objects are now available for selection.

² Select the measured value object of the new version.

² Click Execute.
The measured value objects are upgraded. The result is output as a report.

Upgrade of V5.10 Controls

This paragraph describes the creation and subsequent execution of the Upgrade V5.10 Controls task.
The following steps must be performed:

• Creating a task

• Configuring a task

• Executing a task

Creating a task
To create a task:

6.6.2
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² In the Graphics Designer, select SICAM Settings.
The Settings dialog opens.

[add-in505, 1, en_US]

Figure 6-9 Settings dialog, creating a task

² Select Tasks in the tree structure.

² Click New and then select the Parameterization of graphic objects task type.
The task is created and displayed in the tree structure.

Configuring a task
You can now configure the task. i.e. define the actions performed by the task.
² Click DynamicProperties and then click the button with the dots.

The DynamicProperties dialog opens.
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[add-in506, 1, en_US]

Figure 6-10 DynamicProperties dialog

² Right-click the empty field under Dynamic property and select Add.
The Add dialog opens.

² From the list in this dialog, select the name of the property you want to edit (here: Activate) and then
click OK to close the dialog.
If the desired property is not included in the list, you can enter the name.

² Under Initial value, select the Tag entry.

² Enter the ActivateControls initial value.
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[add-in507, 1, en_US]

Figure 6-11 DynamicProperties dialog

² Right-click the field under Dynamic property and select Apply.
The initial value is applied.

² Click OK to close the dialog.

² Under Name, enter Upgrade V5.10 controls for the task.

² Under Description, enter a meaningful text.
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[add-in508, 1, en_US]

Figure 6-12 Settings dialog, newly created task

² Click OK to close the dialog.
The task has been created and is displayed in Graphics Designer, Execute task dialog, User-defined
tasks tab.

Executing a task
Proceed as follows to execute a task:
² In the Graphics Designer, open the diagram (picture) to be edited.

² In the Graphics Designer, click SICAM > Show task dialog to open the Execute task dialog.

² Select the User-defined tasks tab.

² Select the Upgrade V5.1 controls task.

² In the display, select the switching device objects for which you want to perform an upgrade.
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[add-in509, 1, en_US]

Figure 6-13 Graphics Designer, executing the task

² Click Execute.
The Upgrade V5.10 controls dialog opens. The ActivateControls value is entered in the New value
column.
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[add-in510, 1, en_US]

Figure 6-14 Upgrade V5.10 switching device objects (controls)

² Click OK to close the dialog.
The upgrade of the switching device objects (controls) is performed. The result is output as a report.

Edit Items of a Listbox or Combobox

This paragraph describes the creation and subsequent execution of the Edit items of a Listbox or Combobox
task.
The following steps must be performed:

• Creating a task

• Configuring a task

• Executing a task

Creating a task
To create a task:
² In the Graphics Designer, select SICAM Settings.

The Settings dialog opens.

6.6.3
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[add-in511, 1, en_US]

Figure 6-15 Settings dialog, creating a task

² Select Tasks in the tree structure.

² Click New and then select the Edit items of a Listbox or Combobox task type.
The task is created and displayed in the tree structure.

Configuring a task
You can now configure the task. i.e. define the actions performed by the task.
² Click PropertynameCount and then on the button with the dots.

The PropertynameCount dialog opens.
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[add-in512, 1, en_US]

Figure 6-16 PropertynameCount dialog

² Select CheckBox1.
The attributes of a check box are listed in the window in the center.

² Select the name of the property (e.g. Number of boxes) in order to assign the property (e.g. BoxCount).
² Click OK to close the dialog.

² Leave the entries under PropertynameIndex and PropertynameText unchanged.

² Under Name, enter Edit items of check box for the task.

² Under Description, enter a meaningful text.
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[add-in513, 1, en_US]

Figure 6-17 Settings dialog, newly created task

² Click OK to close the dialog.
The task has been created and is displayed in Graphics Designer, Execute task dialog, User-defined
tasks tab.

Executing a task
Proceed as follows to execute a task:
² In the Graphics Designer, open the diagram (picture) to be edited.

² In the Graphics Designer, click SICAM > Show task dialog to open the Execute task dialog.

² Select the User-defined tasks tab.

² Select the Edit items of a Listbox or Combobox task.

² In the display, select the check box which you want to edit.
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[add-in514, 1, en_US]

Figure 6-18 Graphics Designer, executing the task

² Click Execute.
The CheckBox1 dialog opens.

[add-in515, 1, en_US]

Figure 6-19 CheckBox1 dialog

SICAM Add-In
6.6 Creating User-Defined Tasks

228 SICAM, SICAM SCC, Manual
E50417-H8976-C501-B5, Edition 05.2020



² Modify the texts of the existing options.

² To add an option, right-click the box and click Add.

² Click OK to close the dialog.
The check box with the new texts and the additional option is displayed.
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Replacing a Graphic Object in the Library
The replacement of existing objects by objects of a new version or by corrected objects can be performed
automatically. When replacing the objects, the existing tag connection will be applied, which significantly
reduces the configuration and testing expenditure.
To replace a graphic object:
² In the Graphics Designer, select SICAM > Settings.

The Settings dialog opens.

² Select General in the tree structure.

² Set ShowLibObList to True.
The ShowLibObjList setting enables you to define how a modified graphic object is inserted in the
Graphic Library Explorer, see chapter 6.4.1 General Information.

² Click OK to close the dialog.

² Insert the graphic object to be modified, e.g. a feeder, into a diagram.

² Modify the object properties, e.g. the feeder width.

² Drag the modified graphic object from the diagram into the graphic object library.
The graphic object is inserted temporarily, e.g. as Object2, and the Graphic Library Explorer opens.

[sc_lib_replace1, 1, en_US]

Figure 6-20 Modified graphic object, temporarily inserted

6.7
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[sc_lib_replace2, 1, en_US]

Figure 6-21 Graphic Library Explorer with the list of graphic objects

The Graphic Library Explorer displays a list of all graphic objects which are stored in the current directory and
can be replaced.
² Select the graphic object which you want to replace.

² Click OK to confirm.

² In the dialog which opens, click Yes.
The existing graphic object is replaced by the modified graphic object in the SICAM graphic object
library.
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[sc_lib_replace3, 1, en_US]

Figure 6-22 Graphic object replaced

ii NOTE
This procedure does not change graphic objects in existing diagrams. Newly inserted graphic objects have
the new properties.
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System Overview
This section provides you with detailed information on the connections to the supported target systems:

• SICAM PAS/PQS, see chapter 7.1.1 Connection to SICAM PAS/PQS

• SICAM RTUs, IEC 61850 and IEC 60870-5-104 devices, see chapter 7.1.2 Connection to SICAM RTUs or IEC
61850/IEC 60870-5-104

Connection to SICAM PAS/PQS

[System_SCC_1, 1, en_US]

Figure 7-1 SICAM SCC with SICAM PAS/PQS server and bay devices

SICAM SCC is connected to SICAM PAS/PQS using a SICAM SCC Proxy driver integrated in SICAM PAS/PQS. This
driver communicates with the SICAM PAS/PQS channel and enables the setup and connection of redundant
SICAM PAS/PQS or SICAM SCC systems.
The internal control is performed via administrative tags created in the corresponding channel connection in
a SICAM_Admin tag group in the WinCC Tag Management.
The process tags are created in the Tag Management according to their names in SICAM PAS/PQS. These tags
are created as data structures (structured tags) in order to enable the transmission of the value together with
additional information such as the status or cause.
The process data can be mapped into both the Tag Management and the Alarm Logging systems. When using
the Tag Management, the maximum number of licensed tags for SIMATIC WinCC must be taken into account.
For SICAM SCC, one item of SICAM information, i.e. one structured tag, is counted as a WinCC tag. This restric-
tion does notapply to the information for the Alarm Logging system.

7.1

7.1.1
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If several stations are imported into a SIMATIC WinCC project, the project ID of the imported stations must be
unique because this ID becomes part of the message numbers and enables the distinction of the individual
stations, see the note in chapter Table 7-15 following table 6-7.
Process data can also be mapped into the Tag Logging system. The maximum number of licensed data points
must also be observed for the Tag Logging system.A special license is available for this.

Message buffer
The SICAM SCC Proxy driver integrated in SICAM PAS/PQS includes a message buffer for the storage of
messages which occur in case of a communication fault ora short-time shutdown of SICAM SCC. As soon as
the communication between SICAM SCC and SICAM PAS/PQS has been restored, these buffered messages are
forwarded to the WinCC Alarm Logging system in order to prevent gaps in the message archives.
The messages are buffered from the start of the SICAM SCC driver in the SICAM PAS/PQS system. All status
changes which occur after the start of the SICAM PAS/PQS system and which are mapped to SICAM SCC are
logged in the SICAM SCC message list.
The message buffer size can be defined in SICAM PAS/PQS UI - Configuration. If the message buffer is set to
0, it is deactivated. A message buffer overflow is indicated by means of a system message in SICAM PAS/PQS.
This system message can also be mapped to SICAM SCC and logged in the message lists.

ii NOTE
If a redundant SICAM PAS/PQS system is connected to SICAM SCC and a SICAM PAS/PQS system cannot be
contacted, the entry of messages in the message lists can be delayed after an interruption of the connec-
tion or after the start of the SICAM SCC system.

Resetting the message archive
To reset the message archive:

• In the Alarm Logging window, right-click Messages and select Archive Configuration > Reset from the
context menu.
The message archive and the message lists are emptied.

[sc_archiv-reset, 1, en_US]

Figure 7-2 Resetting the message archive
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Saving the current status
To ensure the consistency of the message lists - thus to prevent missing messages or double entries even after
a restart of SICAM SCC - the last messages are saved persistently in a file. In order to enable a comparison of
the messages arriving from the message buffer with the current status of SICAM SCC, this data is read in upon
a restart of SICAM SCC. The PersistantStorage.psf file is stored in the corresponding station directory
(...\Project directory\GWData\<Station name>).
Delete message lists: To ensure that all messages are displayed as usual in the message list upon the restart of
SICAM SCC Runtime even after a reset of the message archive, the corresponding files of the stations included
in the project must be deleted as well.

Adaptation of the configuration required
To prevent double entries in the message list, the message lists in the diagrams of existing projects (up to
version 7.01) must be replaced by new ones from the SICAM graphic object library because the filter settings
have been adapted to the message buffer.

Connection to SICAM RTUs or IEC 61850/IEC 60870-5-104

[System_SCC_2, 1, en_US]

Figure 7-3 SICAM SCC with SICAM RTUs and bay devices

SICAM SCC is connected to SICAM RTUs or bay devices via IEC 61850/IEC 60870-5-104 using the SICAM IEC
COMMUNICATION SUITE. This also enables the setup and connection of redundant systems.
The internal control is performed via administrative tags created in the corresponding channel connection in
a SICAM_Admin tag group in the WinCC Tag Management.

7.1.2

Components and Functions
7.1 System Overview

236 SICAM, SICAM SCC, Manual
E50417-H8976-C501-B5, Edition 05.2020



The process tags are created in the Tag Management with their names from the SICAM TOOLBOX II configura-
tion or a SCD/CID/XML file. These tags are created as data structures (structured tags) in order to enable the
transmission of the value together with additional information such as the status or cause.
The process data can be mapped into both the Tag Management and the Alarm Logging system. When using
the tags in the Tag Management system, the maximum licensed number of tags for SIMATIC WinCC must be
taken into account. For SICAM SCC, one item of SICAM information, i.e. one structured tag, is counted as a
WinCC variable. This restriction does not apply to the information for the Alarm Logging system.
A project ID is assigned when creating a station with the SICAM IEC Wizard (import in the Wizard). The
numbering of the different stations starts with 10. It remains unchanged in case of a further import using the
Wizard.
Make sure that you use unique project IDs in the case of mixed projects with SICAM PAS connections.

Resetting the message archive
To reset the message archive:

• In the Alarm Logging window, right-click Messages and select Archive Configuration > Reset from the
context menu.
The message archive and the message lists are emptied.

[sc_archiv-reset, 1, en_US]

Figure 7-4 Resetting the message archive

Saving the current state for IEC 61850 devices
In order to also ensure consistency of the message lists without missing messages or double entries after a
restart of SICAM SCC, the last messages are persistently saved in a file.
This data is read in upon a restart of SICAM SCC in order to ensure that the messages arriving from the
message buffer can be compared to the current status of SICAM SCC.
The BufReportData.bin file is stored in the corresponding station directory (...\Project directory\GWData
\<Station name>\ComConfig61850).

Adaptation of the configuration required
In order to prevent double entries in the message list, the message lists in the diagrams of existing projects
(Version 7.01 or earlier) must be replaced by new ones from the SICAM graphic object library because the
filter settings were adapted to the message buffer.
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Initialization of the IEC Tags upon the Start of the Runtime
For IEC 61850 and IEC 60870-5-104 drivers, any changed values and any changed status information of the
tags during the runtime are stored in a status file (IEC 61850: DATA61850.BIN, IEC 60870-5-104: STATUS.BIN),
provided that this has been defined for the corresponding tag ("Save value”, "Save status").
When starting the Runtime, the values and status information are read out of these files and used to initialize
the tags as specified in the Status mask parameter. Afterwards, these tags are transmitted to the SCC. This
ensures that the process image in the Tag Management corresponds to the process image in the driver and
the GI is initiated with the correct data.
Via the IniTimeout parameter, the Invalid identifier of the receive data points can be retained from the time of
starting the Runtime until the connection has been set up successfully. Alarm and event list entries can thus
be avoided. Once this timer has expired, the non-received data points are transmitted to the SCC via an Invalid
replica.

Configuration for Improved Message Display in the Case of Redundancy

On redundant SICAM SCC systems, IEC 61850, IEC 104 and SNMP communication channels can result in dupli-
cate entries in the message lists. This behavior occurs especially after disconnections or restarts of the WinCC
runtime on one of the 2 redundant systems.
In order to identify and assign reporting instances to each other, SICAM SCC projects with IEC or SNMP chan-
nels use the timestamps provided by the transmitter. For identical timestamps, 1 instance can then be
discarded. This does not work with the SNMP port, because the messages are sent without a timestamp and
are only time-stamped in the SNMP channel of SICAM SCC itself. For all 3 ports, system messages are also sent
without a timestamp and must then be time-stamped by the channel driver, and in IEC 104 even General
Interrogation messages.
In order to avoid duplicate messages in these cases, you can link a DAF_Marker tag to the messages in the
Dynamic Alarm Filter (DAF), which then logs only the messages of the leading system. The DAF_Marker tag is
controlled by a global action. This requires an OPC connection between the 2 redundant WinCC computers,
which transmits the tag @RedundantServerState of both systems to the other side.

Setting Up OPC Connection on Both Machines

² To set up an OPC connection, start the Runtime on both WinCC servers.

² Open the Tag Management and select Add new driver > OPC from the context menu.

7.1.3
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[sc_opc_neuer_treiber, 1, en_US]

² In the Tag Management,right-click OPC Groups and select System parameters from the context menu.
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[sc_opc_systemparameter, 1, en_US]

² Click Computer... and enter the Computer Name of the redundant server.

[sc_opc_rechnername, 1, en_US]

² Click OK.

² Click the plus sign in front of the displayed computer name. If the OPC pairing is configured correctly and
all access rights are available (same user on both machines), the question mark disappears from the
computer icon.
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[sc_opc_expand, 1, en_US]

² Select OPCServer.WinCC.1 and click Browse Server (Runtime must be running).

² In the following Filter Criteria dialog, do not enter anything and click Next ->.
The OPCServer.WinCC.1 dialog opens.
² Under @LOCALMACHINE:: > Internal Tags select the @RedundantServerState tag. This tag contains

the redundancy status of the "other" WinCC machine at the runtime.

[sc_opc_internal_var, 1, en_US]

² Click Add Items.
To create a new logical connection, answer the following dialog with Yes.
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² In the New Connection dialog, the proposed name of the connection is displayed automatically. Change
the name if desired.

[sc_opc_new-conn, 1, en_US]

² Click OK.

² To use the tag in the global action, in the Add Tags dialog, enter "RedunPartner" as the tag's Prefix.

[sc_opc_add_var, 1, en_US]

² Click Finish.

² Go back to the Tag Management. Right-click OPCServer_WinCC_1 and select Connection Parameters
from the context menu.
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[sc_opc_conn-para, 1, en_US]

² Check the parameters for the OPC connection.
Under Run the server on another computer the name of the redundant server must be entered.
Via Test Server you can check if the OPC connection to the other WinCC computer is currently available.
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[sc_opc_connection, 1, en_US]

² ClickOK to close the dialog.

Providing Global Actions

² Copy the global action SicamSCC_DAF_RedunCheck.pas.
You can find it in the SCC installation path: C:\Program files (x86)\Siemens Energy\SICAM\SCC\pas

² Paste the copied file into the PAS subfolder of your project folder.
Example:
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[sc_global_paste, 1, en_US]

² You can find your copied action in the WinCC Explorer under Actions > Global Actions.

[sc_glocal_explorer, 1, en_US]

² Generate and save the action:
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[sc_global_generate, 1, en_US]

To prevent the channel from transmitting messages at the start of the runtime before this action can control
the DAF_Marker, the tag group SICAM_Admin_xxxx contains a StartupDelayTime_xxxx tag in the IEC and
SNMP channels that allows you to set a delay time (start value in milliseconds) before starting data transfer
after connecting to the remote sites. This delay time depends on the communication protocol, the number of
devices connected, and the number of information points. Therefore, this variable must be set to a project-
specific basis. By default, you can assume a value of 10 seconds (value of the variable: 10,000). In order to
avoid delays for stand-alone systems without redundancy, the value is not pre-set.

[sc_startup_delay, 1, en_US]

Configuring the DAF
The DAF (Dynamic Alarm Filter) must do the filtering of the remaining duplicate messages (i.e. those that
were not detected and removed due to the double timestamp). An internal DAF_Marker_1 tag is used for this
purpose.
For the DAF to prevent duplicate entries, filters must be created for all list entries, both binary and numeric.
The following is an example of duplicate messages.

ii NOTE
For each of the 4 states of a double message, the DAF_Marker_1 must be queried to the value 1. This vari-
able is set to 1 by the aforementioned global action if this computer is the redundancy leader. This means
that on the leading computer it is 1, on the standby computer it is 0. This only logs the messages of the
leading computer.
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[sc_daf_config, 1, en_US]

² In the mapping, assign all duplicate messages to this filter.
Similarly, all other messages in the DAF must be handled.

Control files in IEC 104 and IEC 61850
For a trouble-free transmission, the following parameter settings are necessary in the control files AKServ.ini
or IEC61850.ini which can be set via the corresponding Wizard using Expert View.
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• IEC 60870-5-104 Communication Connection
– AKServ.ini
– [DEFAULT]
– Ini-Timeout=60

[sc_SICAM_IEC_60870-5-104_Wizard_device_list, 1, en_US]
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• IEC 61850 Communication Connection
– IEC61850.ini
– [GENERAL], Ini-Timeout=60, NoReStamping=1
– Ini-Timeout=60
– NoReStamping=1

[sc_SICAM_IEC_61850_Wizard_device_list_2, 1, en_US]

ii NOTE
The newly added event list entries are not shown automatically after the start of the Runtime on the redun-
dant SCC server. These entries are only added after the archive adjustment (system message number
1012209, REDRT:<ComputerName>: Synchronization finished) has been completed and the event-list
picture is displayed once again.
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Data Import

SICAM Import/Export Wizard

Overview
Use the SICAM Import/Export Wizard to import TEA-X export files from SICAM PAS/PQS or SITIPE.
The functions of the SICAM Import/Export Wizard are to a large extent identical with those of other wizards.
You can import several TEA-X files from different SICAM PAS/PQS projects. During the import process, the
system automatically detects whether the data is an update for an existing project or whether it is an import
of an additional station.
You can import the following formats:

• TEAX

• SXD

• SCD

• CID

• ICD

• IID

• XML
Only TEA-X files are exported.
The SICAM Import/Export Wizard can export individual stations from SICAM SCC and import them into a TEA-X
file. This file can be edited with SITIPE and then also be imported into a new project.

ii NOTE
Use the SICAM Import/Export Wizard as the standard wizard. If required, you can start the SICAM PAS
Wizard or the SICAM IEC Wizard from the context menu of the SICAM Import/Export Wizard.

7.2

7.2.1
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[sc_SICAM_Import-Export_Import, 2, en_US]

Import – Step 1 of 4

² Click Next >.

² From the Select the import file selection box, select the file to be imported.
- or -

² Click ... to navigate to the file to be imported.
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[sc_SICAM_Import-Export_Import_1, 2, en_US]

Depending on the import format selected, you can assign the station name yourself; otherwise, the name is
predefined by the import file, see Table 7-1.
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[sc_SICAM_Import-Export_Import_1_update_station, 2, en_US]

[sc_SICAM_Import-Export_Import_1_update_station_teax, 1, en_US]
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Table 7-1 File Formats and Station Names

Case File format Station name
To be created newly *.teax Always predefined
Update *.teax Always predefined
To be created newly *.sxd Name to be entered by the user
Update *.sxd Always predefined
To be created newly *.scd, *.xml, *.ied, *.icd, *.iid Name to be entered by the user
Update *.scd, *.xml, *.ied, *.icd, *.iid The user must enter a name or

select a name from a drop-down
list box

ii NOTE
When configuring the SICAM SCC link in TOOLBOX II, keep the following in mind:
In principle, the "path" is stored in the hierarchy/group fields up to the device, in the "..." text and process-
information fields the process data-point itself is stored.
The IEC Wizard has adopted the Variable name, if any, as a complete WinCC variable name, using the
group name only as a "subfolder". If the Variable name is empty, the IEC Wizard assembles the WinCC vari-
able name from Variable group and Process information (variable group + "_" + process information).
The Import/Export Wizard creates the WinCC variable name from Variable group and Process information.
This does not use the Variable name property in the TOOLBOX II SCC link.
If the SICAM SCC link from the TOOLBOX II library is used, the fields are pre-populated with appropriate
formulas.
The archive (TagLogging) has the same rules for the hierarchy and info names, but the maximum string
length is shorter.
For the Alarm Logging system, the message group and the message text can be freely assigned and serve
the user in operation only to identify the information.

Import – Step 2 of 4

² Click Next >.

² Select the connection to be imported and then click Next >.
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[sc_SICAM_Import-Export_Import_2, 1, en_US]

Import – Step 3 of 4
The data is analyzed and the import progress is shown.
² Click Next >.
The import starts.
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[sc_SICAM_Import-Export_Import_3, 1, en_US]

The import is initiated. The import process can take some time depending on the size of the data to be
imported.

Import – Step 4 of 4
A summary is shown at the end of the import process.
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[sc_SICAM_Import-Export_Import_4, 1, en_US]

² Click Finish.

Initializing an Empty Project
You can create a simple, empty SICAM project.
² Click Next >.
In contract to the import process, you cannot select a file here and the station name is also not available.
² Click Next >.
A SICAM project including all text blocks and settings is available in WinCC. You can further configure this
project.
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[sc_Initialize_project, 2, en_US]

Station Conversion to the TEA-X Format
A project created with an IEC Wizard must be converted into a valid TEA-X project.
This step must only be carried out once for a project created with an IEC Wizard or a PAS Wizard.
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[sc_station_conversion, 2, en_US]

Convert station to TEA-X is only available if there is at least 1 station that can be converted. Such are stations
that have been imported via PAS Wizard or IEC Wizard.
² Click Next >.
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[sc_station_conversion_1, 1, en_US]

² Select the station to be converted.
For a PAS station, you must first create a TEA-X export file equivalent to PXD on this station. During
conversion, specify this new TEA-X file as the import file.
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[sc_station_conversion_1_teax, 1, en_US]

² Afterwards, proceed in the same way as for a standard import process.

[sc_station_conversion_2, 1, en_US]
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Export
The SICAM Import/Export Wizard can export individual stations from SICAM SCC to a TEA-X file. This file can be
edited with SITIPE and then imported into a new project.
² Select Export and click Next >.

[sc_SICAM_Import-Export_station_1, 2, en_US]

Export is only available if there is at least 1 station that can be exported. This is valid for stations that had
been imported directly or indirectly via TEA-X Wizard (now "Import/Export Wizard"). Such are stations that have
not been imported via PAS Wizard or IEC Wizard.
Converted stations (siehe Station Conversion to the TEA-X Format, Page 258) can also be exported.

Deleting a Station

² Select Delete station.
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[sc_SICAM_Import-Export_select_Delete, 1, en_US]

Delete Station is only available if there is at least 1 station that can be deleted. This is valid for stations that
had been imported directly or indirectly via TEA-X Wizard (now "Import/Export Wizard"). Such are stations that
have not been imported via PAS Wizard or IEC Wizard.
Converted stations (siehe Station Conversion to the TEA-X Format, Page 258) can also be deleted.
² Click Next >.

² Select the station to be deleted and click Next >.
The station is deleted.
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[sc_SICAM_Import-Export_delete_station, 1, en_US]

SICAM Wizard

Use the SICAM PAS Wizard for the connection of SICAM PAS/PQS stations. To connect SICAM RTUs, IEC 61850
and IEC 60870-5-104 devices, you use the SICAM IEC Wizard.
This section describes the proceeding with the SICAM PAS Wizard as an example.

ii NOTE
Differences between the use of the two SICAM Wizards are described in chapter 3.2.4 Initializing a WinCC
Project.

Initializing the project
The SICAM PAS Wizard supports you in initializing your WinCC project. It creates a new station in the project or
updates an existing station. To do this, it performs the following tasks:

• Creating SICAM PAS/PQS-specific structure tags

• Importing tags from SICAM PAS/PQS

• Creating administrative tags for the SICAM PAS/PQS system

• Creating the SICAM PAS/PQS-specific alarm system

• Importing alarms/messages from SICAM PAS/PQS

• Importing the SICAM PAS/PQS graphic object library into the project

• Creating measured-value and metered-value archives for SICAM PAS/PQS process data

• Creating the SICAM PAS/PQS-specific text library

• Adding the communication driver

7.2.2
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Creating structure tags
The structure tags are required for the data exchange with automation systems or devices. They include the
complete structure of a structured tag in SICAM SCC.
The different tags are assigned individual structure tags (see A.1 Structures).

ii NOTE
Be aware of the following when upgrading the version of WinCC projects created with a predecessor
version:
The structure types of existing projects are automatically changed to Version 9.00. Existing process tags are
not changed.
To convert existing tags to the new structure types:

• Delete the process tags using the SICAM PAS Wizard.

• Import the process tags using the SICAM PAS Wizard.
Alternatively, you can adapt existing process tags before the first import using the SICAM SCC 9.00 Wizard
as described in chapter 14.8.2 Editing Structure Types.

Importing tags
The SICAM PAS Wizard imports the tags from a file provided by SICAM PAS/PQS. This file has the extension
PXD (e. g. Station1.PXD).
The tags are automatically assigned to the corresponding structure type. Each tag includes several elements.
Examples of elements for the monitoring direction:

• the current process value

• the status (e. g. not updated, invalid, overflow, etc.)

• the tag type

• the cause (e. g. spontaneous, periodic, polled, ...)

• the additional cause

• the counters which are counted upon a tag change
The name of the tag imported into SIMATIC WinCC corresponds to the name specified in SICAM PAS/PQS for
the tag management of SICAM SCC. Special characters are already replaced by SICAM PAS/PQS UI – Configura-
tion. Any remaining tags will be replaced by the SICAM PAS Wizard during the import process (see appendix
A.3 Character Conversion).
Additionally, tags are structured in groups. The name of a group corresponds to the hierarchical name without
considering the last hierarchical level.

Creating administrative tags
The SICAM PAS Wizard creates internal and external SICAM SCC tags. Internal tags are stored in a SICA-
MAdmin group. External tags are stored in a channel-specific SICAMAdmin_xxx group.

Creating an Alarm Logging system
The SICAM PAS Wizard allows you to create an alarm system under SICAM SCC that meets the requirements of
a SICAM PAS/PQS system.
The alarm system consists of alarm message blocks, message classes, templates for alarm lists (Alarm Logging
templates) and texts. The related SICAM-specific objects for

• the event list

• the alarm list

• the protection message list

Components and Functions
7.2 Data Import

SICAM, SICAM SCC, Manual 265
E50417-H8976-C501-B5, Edition 05.2020



can be viewed in the Graphics Designer under View > Library > Project Library > Alarm Logging Templates
> WinCC V7.x.
Specific list templates are available for the connection to SICAM PAS/PQS and SICAM RTUs/IEC 61850/ IEC
60870-5-104.

Importing messages
The SICAM PAS Wizard imports messages from the PXD file.
The name of the message imported into SICAM SCC corresponds to the name configured in SICAM PAS/PQS UI
– Configuration.
Additionally, each imported message has a unique number. The SICAM PAS normalization DLL is assigned, the
value text group 0 is assigned, the specific properties are defined, and the message class SICAM Message EM
or SICAM Message DM/WM/RM is assigned.
The message number is composed of the project ID * 10,000,000 and the value ID.

ii NOTE
Make sure that you use unique project IDs when importing several stations. You can configure the project
ID in the SICAM PAS/PQS or SICAM TOOLBOX II project. Project IDs starting with 10 are assigned automati-
cally during the SCD import, see note in chapter Table 7-15.

Importing the SICAM graphic object library
The SICAM PAS Wizard loads the SICAM graphic object library into the current project. When importing the
SICAM graphic object library, administrative tags are created, and the SICAM functions (C scripts) are copied
into the project.

Creating an archiving system
Process data from SICAM PAS/PQS can be archived in the archiving system.
The SICAM PAS/PQS archiving system comprises:

• a process value archive for measured values

• a process value archive for metered values
The archives are created as sequence archives on the hard disk of the PC on which SICAM SCC is installed.
Their size is only limited by the capacity of the hard disk.

Starting the Wizard
Start the SICAM PAS Wizard in the WinCC Explorer.
To start the SICAM PAS Wizard:
² In the WinCC Explorer, double-click SICAM PAS Wizard.
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[pascc310, 1, en_US]

Figure 7-5 Calling up the

SICAM PAS Wizard

ii NOTE
While the SICAM PAS Wizard is active, do not start any editors in SIMATIC WinCC. Otherwise, the connection
of the wizard to a component will be aborted, and errors can occur during the import/update process.

The SICAM PAS Wizard starts.
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[pascc311, 1, en_US]

Figure 7-6 Calling up the

SICAM PAS Wizard
² Click Next to continue.

Entering the station name

² To add a new station to the project, select Create new station in project under Select station.

² Enter a unique station name into the entry field (e. g. Station1). The station name is suggested as the
name for the logic link in the SICAM PAS PROTOCOL SUITE.

ii NOTE
If you do not want to create a new station, but update an existing station, proceed as follows:

• Click Select existing station.

• Select a station from the list.
To perform an update, the import file must originate from the same SICAM PAS/PQS project.

Selecting parameters

² Select the desired special-character replacement from the drop-down list box. This selection ensures that
the SICAM PAS Wizard replaces those special characters in tag names which cannot be used by SICAM
SCC by SICAM SCC-conforming characters.
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ii NOTE
When editing old projects, you must select an option for the replacement of special characters which
complies with the origin of the diagrams used in the project.
If special characters are replaced incorrectly, different tag names can be created, which could possibly
cause problems concerning interconnections in these diagrams.

² Select SICAM trace window output in order to ensure that the SICAM PAS Wizard starts the SICAM PAS
trace window. To provide a concise overview, you can specify that only warnings/errors are shown in the
list.

[pascc312, 1, en_US]

Figure 7-7 Entering the station name and selecting parameters

² Click Next to continue.

Importing station data and selecting functions
In the following dialog, you can specify which components the SICAM PAS Wizard is to import from SICAM
PAS/PQS to SICAM SCC.
² Select Create SICAM components in project to provide the prerequisites for the use of SICAM SCC

components in multi-client projects on the client PC or to create SICAM PAS/PQS extensions in the WinCC
project without import data from SICAM PAS/PQS.

² ✧ Select the Import/Update item. The components are now imported into the new station.

² Enter the complete path in the SICAM PAS/PQS data directory (e. g. ...\station1). To do this, click the ...
button to open the path selection window.

² Select the file (e. g. station1.PXD) holding the corresponding SICAM process tags from the drop-down
list box.
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² Select SICAM process tags.

² Select SICAM archives to create the archives in your WinCC project.

² Select SICAM PAS messages.

ii NOTE
When updating an existing station, all entry fields are set to default values.
To perform an update, the import file must originate from the same SICAM PAS/PQS project.

[pascc313, 2, en_US]

Figure 7-8 Defining the path and the name of the import components

² Click Next.

ii NOTE
If Delete is selected in dialog 2/5 of the SICAM PAS Wizard, the dialogs 3/5 and 4/5 will be skipped.

Setting station parameters
The station parameters can be set in the dialog shown below.
The entries for Channel unit and Logical connection are set by default at SICAM PAS/PQS and can be applied
for the first station without changes.
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[pascc314, 2, en_US]

Figure 7-9 Setting Station Parameters for SICAM PAS/PQS

ii NOTE
When connecting SICAM PAS/PQS systems with different versions, select the corresponding Channel unit
in this dialog.

² Click Next.

[pascc320, 1, en_US]

Figure 7-10 Note regarding connection parameters

No connection parameters need to be defined when connecting a SICAM PAS/PQS station Version 8.00 or
later. The connection parameters from the SICAM PAS/PQS import file are applied. For older SICAM PAS/PQS
versions, the connection parameters are pre-assigned with default values.
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The connection parameters must correspond to the values defined in SICAM PAS/PQS. Check the connection
parameters, see 3.2.5 Connection Parameters.

ii NOTE
During a data import using the SICAM Wizard, the manually changed connection parameters are over-
written with the parameters from the import file. For this reason, the connection parameters must be
checked after the data import.

Initializing the project
In the following dialog, you can specify the initialization of the WinCC project.
² Select the Import SICAM graphic object library option in order to import the SICAM PAS/PQS graphic

object library (including ActiveX Controls) and the SICAM PAS/PQS administrative tags into the WinCC
project.

² Select the Create SICAM text library option to create the text library in the WinCC project.

ii NOTE
If the Create SICAM alarm system option is selected, the Create SICAM text library option must also be
selected during the first run.

² Activate Create SICAM alarm system to create the alarm system in the WinCC project.

[pascc315, 1, en_US]

Figure 7-11 Defining the project initialization

² Click Next.
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Summary
The following dialog shows a summary of the previously defined settings. Check them for correctness.

ii NOTE
If one of your settings proves to be incorrect, click Back to return to the previous dialog and correct it. The
previous dialog opens and you can correct your settings.

[pascc316, 1, en_US]

Figure 7-12 Checking the settings

² Click Finish.
The SICAM PAS Wizard now executes the selected steps.

In the Report window, you can observe the processing and see potential error and warnings.

Viewing the report
As soon as all steps have been completed, you can view the report.
² To do this, select the Overview tab in the Report window. The number of errors and warnings is indi-

cated in the Quit: row under Messages.

² Click Close to close the report.
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[pascc317, 1, en_US]

Figure 7-13 Viewing the report

ii NOTE
If the Report indicated error or warnings, you should save these messages for viewing and editing them
later.
If errors have occurred, the SICAM PAS Wizard requests you to delete the components effected during the
next run.

ii NOTE
The SICAM PAS Wizard saves its messages in the GWLog.txt file under the path of the project
(e.g. ...\project1).
The SICAM PAS Wizard overwrites this file upon each run. Save this file if required.

Configuring an IEC 60870-5-104 Connection During Runtime

Online configuration for the IEC60870-5-104 connection is only supported by SICAM IEC Wizard.
To avoid a shutdown of the SICAM SCC Runtime in the case of minor configuration changes, an IEC
60870-5-104 station can be extended in SICAM SCC in online mode. Devices and individual items of informa-
tion can be added and certain parameters can be modified.

Prerequisites/preparatory steps
In order to be able to extend an IEC 60870-5-104 station in online mode, at least 1 device with at least 1 item
of information must be configured.
Please note that only existing IEC 60870-5-104 stations can be extended during runtime. In order to be able to
add an IEC 60870-5-104 station in online mode, an empty dummy station including at least the administrative
SICAM SCC tags must first be created in offline mode.

Restrictions
Please note the following restrictions as compared to configuration in offline mode:

• It is not possible to add new WinCC IEC 60870-5-104 stations.

• Configured devices cannot be deleted.

7.2.3
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• Configured information cannot be deleted.

• For tags which have already been mapped in the Tag Management the following properties cannot be
modified in online mode:
– Tag name
– Tag group
– Tag type
– Mapping in TagLogging or AlarmLogging
– Linking indication and command tags

• To configure PAS and IEC 61850 stations the runtime must still be stopped first.

• Redundant systems cannot be configured during runtime.

Creating a dummy station for future extensions
To create a dummy station:
✧ Start the SICAM IEC Wizard.

The name cannot be changed later.
✧ Create an XML import file with 1 device without data points and the ASDU matching the station.
✧ Import this file and configure the ComFault or OprReady information in the Tag Management.

You can now extend your dummy station during runtime.
This imported dummy device must not be deleted when the station is extended later on.

Converting legacy projects created with earlier SICAM SCC versions
As a preparatory step you must convert existing projects created with a SICAM SCC version earlier than V8.03
HF1.
Make sure you call up the SICAM IEC Wizard for every IEC 60870-5-104 station with the same import data used
during the last import and re-import the graphic object library.
Note that the re-import of the SICAM graphic object library must first be activated in the project-specific
settings of the SICAM IEC Wizard.

SICAM IEC 104 XML Creator

Use the SICAM IEC104 XML Creators to create a parameter file (e.g. Rtu1.xml) for a SICAM RTU or another
device with an IEC 60870-5-104 communication connection. This XML file can be imported into your project
using the SICAM IEC Wizard. All the parameters required for import are included in the parameter file. A sepa-
rate parameter file must be created for every RTU and every device. Please note that Microsoft Office is
required to create and edit the parameter file.

General Procedure

Installation
To use the SICAM IEC104 XML Creator, the SICAMIEC104XMLCreator.dll must exist and be registered on
the computer.

• Computer with SICAM SCC
The SICAMIEC104XMLCreator.dll is registered automatically upon the installation of SICAM SCC.

7.2.4

7.2.4.1
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• Computer without SICAM SCC
On a computer with no SICAM SCC installed the SICAMIEC104XMLCreator.dll must be registered sepa-
rately.
As a prerequisite for registration .NET Framework ab V2.0 must have been installed. Please note that
administrator rights are required to perform the registration.

To register the SICAMIEC104XMLCreator.dll:
✧ To register the SICAMIEC104XMLCreator.dll, execute the SICAMIEC104XMLCreator_reg.bat file with

administrator rights. To do this, right-click the SICAMIEC104XMLCreator.dll and select Execute as
administrator from the context menu.
The batch file must not be located on a network drive or a substituted drive.

How to proceed
To create the parameter file (XML file) perform the following 3 steps:

• Save the Excel template file SICAM_IEC104_XMLCreator.xltm included in the scope of delivery as an
XLSM file.

• Enter the parameters of your device in the XLSM file, e.g. Rtu1.xlsm.

• Create the parameter file (XML file) from the XLSM file.
For a detailed description of the procedure refer to 7.2.4.3 Creating a Parameter File.

ii NOTE
You can edit Excel files using Excel versions 2007, 2010, or 2013. Furthermore, the 32-bit version of Micro-
soft Excel must be installed.

XLSM file
The entries in the XLSM file are divided as follows:

• Communication parameters, lines 4 to 7

• Data points and their parameters, from line 11
The XLSM file consists of 3 sheets:

• CreateIEC104Variables
This sheet includes the actual parameters.

• Help
This sheet includes help texts.

• Example
This sheet provides an example of a SICAM RTU with 2 LRUs and their data points.

Parameters and Data Types

Table 7-2 Communication parameters

Parameter Description Default value /
Value range

Recom-
mended
value

RTU Name Name of the SICAM RTU
Timeout response t1 Monitoring time for transmitting or testing the

APDU
15
1 to 255 s

Timeout transmit
acknowledge t2

Monitoring time for acknowledgment in case of a
missing data message

10
1 to 255 s

t2 < t1

7.2.4.2
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Parameter Description Default value /
Value range

Recom-
mended
value

Test frame period t3 Monitoring time for the transmission of S frames
in case of an extended idle time

20
1 to 255 s

t3 > t1

Transmit window Maximum difference between the sequence
number received and the transmission of the
status tags

12
1 to 32767
APDU

Receive window (w) Acknowledgment takes place after the receipt of
w frames in I format at the latest.

8
1 to 32767
APDU

w < 2/3 k

TCP/IP address TCP/IP address

The values indicated in bold are default values in accordance with the EN 60870-5-104 standard.

Data Point Parameters

Table 7-3 Data Point Parameters

Parameter Description Value range
LRU name Name of the LRU
ASDU Service data unit of the application layer 1 to 2047
Information name Name of the item of information
Data type IEC 104 data type
IOA Information address 1 to 16777214
Feedback link Only for commands: Information name of the

corresponding message
SCC Tag name Name of the SICAM SCC tag

ii NOTE
The information address is not checked.
Please note that you are responsible for the correctness of all parameters.

IEC 104 Data Types

SP (TI 30) Single-point indication with time stamp CP56Time2a
DP (TI 31) Double-point indication with time stamp CP56Time2a
ST (TI 32) Tap position indication with time stamp CP56Time2a
BO (TI 33) Bit pattern indication, 32 bits, with time stamp CP56Time2a
ME_TD (TI 34) Measured value, normalized value with time stamp CP56Time2a
ME_TE (TI 35) Measured value, scaled value with time stamp CP56Time2a
ME_TF (TI 36) Measured value, shortened floating point number with time stamp CP56Time2a
IT (TI 37) Metered value with time stamp CP56Time2a
SC (TI 45) Single command
DC (TI 46) Double command
RC (TI 47) Regulating step command
BO (TI 51) Bit pattern, 32 bits
SE_NA (TI 48) Set-point control command, normalized value
SE_NB (TI 49) Set-point control command, scaled value
SE_NC (TI 50) Set-point control command, short floating point number
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ii NOTE
The corresponding type identifier with time (TI > 30) must also be configured for data types without time
(TI < 30).

Creating a Parameter File
After the installation of SICAM SCC the template file is available in the following directory: ..\Programme
\Siemens Energy\SICAM\SCC\misc\IEC104Configuration.
To create a parameter file:
² Open the SICAM_IEC104_XMLCreator.xltm template file in Microsoft Excel.

[excel-datei, 1, en_US]

Figure 7-14 VSICAM_IEC104_XMLCreator.xltm template file

² Save this file e.g. as Rtu1.xlsm (Excel file with macros). You can use this file to define the parameters of
your SICAM RTU.

² Enter the parameters for your SICAM RTU.
Enter at least the following parameters:

• Name of the SICAM RTU

• TCP/IP address

• 1 data point with its parameters

• 1 LRU
The example in the screenshot above shows the parameters defined for 1 SICAM RTU with 2 LRUs (East,
West).

Note the entries in the SCC Tag name column: This column shows the tag names indicated later in SICAM SCC.
The following characters must not be used for parameters consisting of texts:

• Blank " $ % ' * : ? @ \

• Make sure you also check which characters are permitted in your destination system.

² Click Create XML file to create the parameter file, e.g. Rtu1.xml. It may be necessary to activate macros
before clicking this button.

7.2.4.3
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The XML file always has the same name as the Excel file and is saved in the directory in which the Excel file
has been opened. All incorrect data points which were not exported to the Rtu1.xml file are listed in an addi-
tional Rtu1.log file.
² Create a separate parameter file for each SICAM RTU.

² Import the parameter file into your project via the WinCCExplorer using the SICAM IEC Wizard.

Components and Functions
7.2 Data Import

SICAM, SICAM SCC, Manual 279
E50417-H8976-C501-B5, Edition 05.2020



SICAM Communication Connection - Tag Management
SICAM SCC makes available the following SICAM communication connections:

• SICAM PAS PROTOCOL SUITE (SICAM PAS channel DLL)
for the connection of SICAM PAS stations
For the connection of older SICAM PAS systems see 10 Different SICAM PAS Versions.

• SICAM IEC COMMUNICATION SUITE (SICAM IEC channel DLL)
for the connection of SICAM RTUs, IEC 61850 and IEC 60870-5-104 devices

SICAM PAS PROTOCOL SUITE

Overview
The SICAM PAS PROTOCOL SUITE provides for the connection of SICAM SCC to the SICAM PAS Full Server.
Besides this, it controls this process data connection.
The (process) connection between SICAM PAS and SICAM SCC or SIMATIC WinCC is ensured by the SICAM PAS
PROTOCOL SUITE. The SICAM PAS channel DLL logs on to the SICAM SCC proxy driver during runtime in order
to exchange process information.

[pascc403, 1, en_US]

Figure 7-15 SICAM PAS PROTOCOL SUITE in the WinCC Explorer

Performance characteristics
The SICAM PAS PROTOCOL SUITE has the following performance characteristics:

• Event-controlled update of the process image

• Time stamps from the process via raw data tags and the SICAM PAS normalization DLL

• Automatic start and stop via SIMATIC WinCC and SICAM PAS UI - Operation

• Connection of different or redundant SICAM PAS projects parallel to SIMATIC WinCC with automatic
switchover in case of faults

7.3

7.3.1
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Tasks
The SICAM PAS PROTOCOL SUITE performs the following tasks:

• Checking the consistency of the parameter settings

• Connect to the SICAM SCC proxy driver

• Forwarding of display and indication tags to SIMATIC WinCC

• Forwarding of commands to SICAM PAS

• Monitoring of the connection to the SICAM PAS system

• Control of SICAM PAS communication components

• Substitution of values

• Control of switching authorities

Compatibility key
A compatibility key is used in order to ensure that the project version of SICAM PAS is compatible with the
project version of SICAM SCC. This key is checked by a script upon the activation of the runtime operation. If
an error is detected during this check, the WinCC Runtime is stopped and an error message is displayed.
The compatibility key is irrelevant for SICAM RTUs.
For projects with an extremely large number of process tags the compatibility key upon the start-up of WinCC
Runtime can only be checked after several seconds. To prevent the operation of the project until the compati-
bility key has been checked, a picture must be configured which is positioned on top of the process images.
This picture is switched off depending on the result of the compatibility key check. To do this, compare the
external and internal CompKey… tags of the corresponding SICAM PAS connection. Place a picture window on
top of the start picture which you hide if the process values of the CompyKey… tags are identical.

Tags
The SICAM PAS PROTOCOL SUITE logs on to the SICAM SCC proxy driver in order to poll the required tags. Indi-
cation tags and display tags for the representation of process diagrams are polled during this process.
Additionally, system-internal tags (e. g. the project ID, compatibility key) are required from the SICAM PAS Full
system.
The distinction between a display tag and/or an indication tag is based on the specific tag information
created by the SICAM PAS Wizard during the creation of the tags. Furthermore, the ValueID of the corre-
sponding tags is included in this specific tag information. Via the ValueID, the SICAM PAS PROTOCOL SUITE can
perform an assignment between SICAM PAS tags and WinCC tags.

• SIMATIC WinCC uses display tags for process visualization.

• Unlike the display tags, the indication tags are not determined by the process diagram.

Licensing
With regard to the SICAM PAS PROTOCOL SUITE a distinction is made between 2 licenses, i.e. the license for
SICAM SCC - Configuration and the license for SICAM SCC - Runtime.

• If the license for SICAM SCC - Configuration is missing, the access to properties of connections and tags is
locked and the import of process tags with the Wizard is not possible.

• If the license for SICAM SCC - Runtime is missing, you can start the Runtime in Demo mode, see
2.3.1 Design Variants.

SICAM IEC COMMUNICATION SUITE

Overview
The SICAM IEC COMMUNICATION SUITE is required for the process data interfacing of SICAM SCC to SICAM
RTUs and IEC 61850/IEC 60870-5-104 devices, as well as for controlling the connection.

7.3.2
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SICAM RTUs/IEC 61850/IEC 60870-5-104 devices are connected to SICAM SCC or SIMATIC WinCC via the SICAM
IEC COMMUNICATION SUITE. The SICAM IEC COMMUNICATION SUITE logs on to the devices during runtime in
order to exchange process information.

[pascc403_1703, 1, en_US]

Figure 7-16 SICAM IEC COMMUNICATION SUITE in the WinCC Explorer

Performance characteristics
The SICAM IEC COMMUNICATION SUITE has the following performance characteristics:

• Event-controlled update of the process image

• Time stamps from the process via raw data tags and the SICAM PAS normalization DLL

• Automatic start and stop via SIMATIC WinCC

• Parallel connection of different or redundant SICAM RTUs to SIMATIC WinCC with automatic switchover in
case of faults

• Connection of different IEC 61850/IEC 60870-5-104 devices

Tasks
The SICAM IEC COMMUNICATION SUITE performs the following tasks:

• Connection to the SICAM RTUs/IEC 61850/IEC 60870-5-104 devices

• Forwarding of display and indication tags to SIMATIC WinCC

• Forwarding of commands to the SICAM RTUs substation controller/IEC 61850/IEC 60870-5-104 devices

• Monitoring of the connection to the SICAM RTUs substation controller/IEC 61850/IEC 60870-5-104
devices

Tags
To retrieve the process data required, the SICAM IEC COMMUNICATION SUITE logs on to the SICAM RTUs/IEC
61850/IEC 60870-5-104 devices. This data includes the process information for messages in WinCC Alarm
Logging and the tags required for the display of process diagrams in the Tag Management.
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During the import process, the wizard creates a ValueID for addressing each item of information in WinCC. To
show the assignment of the ValueID to the external telegram address, open the properties of a tags address
and view the specific tag information (address parameters).

Licensing
With regard to the SICAM IEC COMMUNICATION SUITE a distinction is made between 2 licenses, i.e. the license
for SICAM SCC - Configuration and the license for SICAM SCC - Runtime.

• If the license for SICAM SCC - Configuration is missing, access to the properties of connections and tags is
denied and no process tags can be imported with the Wizard.

• If the license for SICAM SCC - Runtime is missing, you can start the Runtime in Demo mode, see chapter
2.3.1 Design Variants.

System messages
The Communication fault (ComFault) and Operational readiness (OprReady) tag types can be configured
as status messages in the SICAM TOOLBOX II for the IEC 60870-5-104 and IEC 61850 connections. For an IEC
61850 connection the general interrogation can be also configured as status message.
During the import process for directly connected IEC 61850 devices the ComFault, OprReady and GIStatus
tags are provided as status messages of the corresponding device for mapping. They can be mapped like
normal process tags.
The GIStatus tag can have the following 4 status values:

• 0 = General interrogation never run

• 1 = General interrogation completed successfully

• 2 = General interrogation running

• 3 = General interrogation failed
In redundant systems the system messages from both SIMATIC WinCC servers are entered in message lists.
The name of the causing system is entered in the message lists in the Supplementary information column.

Command logging
The following is logged in the Additional cause column in the message lists:

• The qualifiers of command transmitted when issuing the command

• The causes indicated by the device in case of an unsuccessful command output

Showing the Originator Address in Message Lists
To show the originator address in the Location column, origin_userstate=1 must be set for IEC 61850 in the
IEC61850.INI file of the [GENERAL] driver. The device-specific parameter [IEDxxx] orIdent_mode must be
defined according to the device specification (0 to SAT200: <IP address> Origin:<OriginatorAddress> / 1 to
<OriginatorAddress> (numeric, 1Byte)). For IEC60870-5-104, the [DEFAULT] HerkAdrStati=1 parameter must
be set in the AKServ.INI file.

Qualifier of Command (QoC) for IEC 60870-5-104
In order to be able to use Qualifier of Command (QoC: sync / no sync, interlocked / not interlocked) during
switching, you must activate the QoC functionality. To do this, set the SendQOC attribute to 1 in the [Default]
section of the AKServ.ini file (SendQOC=0 deactivates the QoC function).
The file is available in the project directory under GWData > StationName > ComConfig104 > str.

1-of-N Command Interlocking
With the parameter COMMAND_GRP all commands of a command group (i.e. all with the same command
group number) are interlocked against each other, so only 1 command can be executed at the same time.
Commands triggered during command interlocking are refused and acknowledged to SICAM SCC with COT=7
(Confimation) PN-.
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The configuration is done via Toolbox, the Import Wizard writes the following lines in the AKServ.ini file:
[Default]
CommandDelay=5 ; delaytime for locking of command groups [sec], default=0
CommandTimeout=200 ; timeout for unlocking of command groups [sec], default=300

New Variable Parameter
In XML import file (Toolbox):
Parameter name: COMMAND_GRP (Command group number)
Data type: unsigned integer
Range of values: 0 to 65535
Default value: 0

Description
The following is logged in the IECChannel_IEC104Driver.log trace file:
"Command '<xxx>' rejected, because command '<yyy>' in same group is running"
Only after sending commands has been terminated (Termination, Cancel, or Confirmation PN-) and the time
delay for the command (CommandDelay) has been expired, a new command can be sent.
An incomplete sequence of commands (e.g. Termination has not been received) would cause an infinite
interlock of the command group. The parameter CommandTimeout is used to avoid this. When this timer has
expired (after sending commands has started) the command group is unlocked. CommandTimeout=0 disables
the safety mechanism.
The following is logged in the IECChannel_IEC104Driver.log trace file:
"Unlocking of commandgroup <nn> which contains control: '<yyy>'"

Substitute

ii NOTE
Substituting is only possible on IEC 61850 data points with Functional Constraint (FC) SV, e.g. SubVal. For
IEC 61850 devices, substitution is usually performed to the XCBR or XCSWI data point.
Alternatively, you can create a new SubVal2IED = 1 entry in the 61850.ini file under [GENERAL]; in this
case, the .stVal tag can be used directly for substitution.

SICAM DISTO
For more detailed information on the communication between SICAM DISTO and the IEC 61850-Client, refer
to chapter 7.10 Communication with SICAM DISTO.

Time Correction for DST
For SCC computers with Windows Time Zones DST option located on the southern hemisphere, use a work-
around for time correction for IEC104 Communication Suite process signals.
Disable the DST settings in the TMGF.str project configuration file (in folder <project>\GWData\<station>
\ComConfig104 \str\). Use the following settings:
/* 2. Bestimmung der Sommerzeitbeginn- u. Endezeitpunkte ****************** */
    SomZt / Beginn;
    /*    ab Jahr  Datum u. Zeit Beginn    / Datum u. Zeit Ende      / Offs */
    SomZt / Ende;

IEC 61850 Connection

The IEC 61850 driver supports Buffered Reporting using dynamic datasets. The driver successfully estab-
lishes the communication, uses the persistently saved assignment Datatset/Buffered Control Block (BRCB), and
queries the buffer values in the server which have been changed since the last clearing of the connection.
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Under the following scenarios, it is not possible to query buffered values from the server upon the first estab-
lishment of a connection:

• Using the IEC Import Wizard to change the data model or the communication parameters of an IEC 61850
connection

• Restart of the IEC 61850 device (the dynamic datasets are deleted in the process)

• Another IEC 61850 Client uses a BRCB reserved by the IEC 61850 driver.

• When copying the SCC project, the persistent Dataset/BRCB assignment is copied together with the SCC
project. The IEC 61850 driver of the 2nd SCC Runtime cannot use these BRCBs and activates its self-
created dynamic datasets using free BRCBs.

ii NOTE
During the direct connection of IEC 61850 devices you can define in the device-specific parameters which
of the following communication drivers shall be used:

• Static or Dynamic Dataset

• Unbuffered or Buffered Report
.
When selecting Buffered Report, you can additionally define whether or not you want buffered messages to
be logged in the Alarm Logging (a) or (b).
If SICAM SCC is used redundantly, (b) must be selected.

ii NOTE
Substituting is only possible on IEC 61850 data points with Functional Constraint (FC) SV, e.g. SubVal. For
IEC 61850 devices, substitution is usually performed to the XCBR or XCSWI data point.
Alternatively, you can create a new SubVal2IED = 1 entry in the 61850.ini file under [GENERAL]; in this
case, the .stVal tag can be used directly for substitution.

For more information, see 4.8.9 Support of Controllable Analogue Process Value (CDC = APC).

IEC 61850: Treatment of data with set Test Bit

Standardmäßig werden empfangene Daten unabhängig vom Zustand des Test-Bits (Quality.test) im SICAM
SCC verarbeitet, d.h. in den Bildern und Listen angezeigt.
By default, in SICAM SCC received data is processed regardless of the state of the test bit (Quality.test), i.e. it
is displayed in the pictures and lists.
To discard the data with set test bit (Quality.test = true) in the IEC 61850 driver and not process it in SICAM
SCC, configure the following in the configuration file IEC61850.INI:
[GENERAL]
DiscardTestBit=1

7.3.4
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Alarm Logging

The Alarm Logging component of SIMATIC WinCC serves as a basis for the Alarm Logging system. It ensures
that data is logged in the correct chronological order.

Alarm Logging System

The SICAM PAS Alarm Logging system differs from standard logging systems with regard to the information
transmitted with an alarm message.
By default, SIMATIC WinCC cyclically updates all information regarding the process state.
This mechanism is sufficient for visualization in diagrams.
Alarms, however, must not be lost and must be processed in the correct chronological order.

Raw data tag
SICAM PAS alarms are transmitted to SIMATIC WinCC as raw data tags with a time stamp and additional values.

Normalization DLL
For SIMATIC WinCC Alarm Logging, a SICAM PAS normalization DLL decodes the contents of the raw data tag.
It creates an alarm with a resolution of 1 ms in the Alarm Logging system.

Correct chronological order
Based on the time stamp of the raw data tag, alarms can be sorted chronologically in the alarm lists in order to
ensure that they are shown in the correct order of their appearance.

Alarm lists
You can set any filters also to textual process value columns in the alarm lists (SIMATIC WinCC V7.0 SP1 or
later).

SICAM Normalization DLL

Combined with the SICAM communication connection, the SICAM normalization DLL provides the basis for the
alarming and logging of data in correct chronological order.
The SICAM normalization DLL prepares the data of the source system (SICAM PAS, SICAM RTUs or IEC
61850/IEC 60870-5-104 devices) in a SICAM-specific manner for SIMATIC WinCC Alarm Logging.

SICAM normalization DLL
The SICAM normalization DLL evaluates the additional information transmitted in the process values and
generates an alarm with the corresponding alarm texts in the Alarm Logging system.
The file name is PASNORM.NLL.
The SICAM normalization DLL supports the hiding and blocking of messages for a SIMATIC WinCC server. The
message block is not set in SICAM PAS/SICAM RTUs. It must therefore be set separately on each individual
SIMATIC WinCC computer with a process connection.

Additional information
The following additional information is available:

• Value

• Location

• Cause

7.4
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• Status

• Additional cause

• ID number2

• Additional information

• Time status

• Flag (SICAM PAS flag used by the Alarm Logging system to suppress internal messages which are irrele-
vant for typical applications. This suppression corresponds to the default setting.)

For more detailed information, refer to Structure Elements, Page 524.

Text library
The normalization DLL retrieves the alarm texts from the text library. The texts are stored in the text library in
the language used.
To view the texts, click Text Library > Open in the WinCC Explorer. Texts with the text IDs 599 to 2216 are
available for new projects. These texts can be customized to meet the requirements of specific projects.
Furthermore, the user can add additional language columns for translated texts.

[pascc401, 1, en_US]

Figure 7-17 Text Library

The texts for the value of a process tag (e. g. ON/OFF) in the text library are subdivided into the value text
groups 0 to 16. Value text group 0 is the default group, and its texts should not be modified. The texts in
groups 1 to 16 can be customized to meet specific requirements.

2 If the devices are connected via SICAM RTUs and directly via IEC 61850/IEC 60870-5-104, this additional information is not available.
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The value text group whose texts are to be displayed in the alarm lists can be defined in the Value Text
column for each alarm in the Alarm Logging system.
For SICAM PAS V8.02 or later you can configure the value text group assignment in SICAM PAS – Configura-
tion. For older SICAM PAS versions or if no configuration has been performed, the value text group 0 is pre-
defined as standard.

ii NOTE
For accelerated searching of certain value text groups (e.g. value text group 5), click Edit > Find > Value
text group 5.

To show the value of an alarm instead of the alarm text, value text group 255 can be entered for this value.

Alarm Logging
To open the Alarm Logging editor in the WinCC Explorer, click Alarm Logging > Open. Enter the number of
the value text group in the Value Text column. 0 is the default group.

[pascc402, 1, en_US]

Figure 7-18 Alarm Logging

ii NOTE
The value text group is only predefined for process values for which a text can be shown. Measured/
metered values are always shown as numerical values.

Using the Alarm Logging Extension

In order to be able to use the alarm logging extension in a project, the Alarm Logging system must be gener-
ated in the project.
Afterwards, SICAM PAS alarm messages can be imported into this Alarm Logging system.

7.4.3
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Creating an Alarm Logging system
Use the SICAM PAS Wizard to generate an Alarm Logging system in your new WinCC project which meets the
requirements of SICAM PAS.
The Alarm Logging system consists of:

• Alarm message blocks

• Message classes

• Print layouts

• Texts
The corresponding graphic objects for the connection to SICAM PAS, SICAM RTUs or IEC 61850/IEC 60870-
5-104 devices are:

• Event list

• Warning message list

• Protection message list
These graphic objects are available in the Graphics Designer under View > Library > Project Library > Alarm
Logging Templates.

Moving Messages
If you move messages with the SICAM SCC AlarmLogging Editor to other reporting classes, make sure that
messages from a message class with

• a name containing EM can only be moved to other message classes with names containing EM;

• a name containing DM/WM/RM can only be moved to other message classes with names containing
DM/WM/RM.

This is because the configuration of these message classes, the data types of the process values and the
processing in the communication channel as well as the standardization DLL are coordinated.
In the message types of a message class, the Without status "went out" parameter must not be changed and
has to be equal for all message types of this message class.
To not display instances of messages with specific states in the lists, use the Dynamic Alarm Filter (see
7.5 Dynamic Alarm Filter (DAF))

Value Texts

By default, for the texts of the Value process-value row the texts of the configured value text group (default =
0) are used depending on the data type of the message. The WinCC text library contains 16 further value text
groups which you can use and change freely (groups 1 to 16).
To assign texts to dedicated integer values of a process information that are not covered by the value text
groups, proceed as follows:

² Enter your text in the Text Library.
Only the next free text can be used. This first text ID is used for the value 0. The subsequent text IDs are
used for further values. Enter all required texts at the same time.

7.4.4
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[sc_value_text_txtlib, 1, en_US]

² If you only need high values (e.g. 128 to 135), you can define an offset for the calculation of the value
text group entry in the Alarm Logging. Thus, you do not have to enter 127 empty texts (in this example)
in the text library.

² In the Alarm Logging Editor in the Value text group column of the message, enter the start ID from the
text library; the start value must be at least 256.

[sc_value_text_alarm, 1, en_US]

Message Coloring

In SIMATIC WinCC, messages are represented in different colors depending on the message state. The
message states are:

• Came in

• Went out

• Acknowledged
With SICAM SCC V8.04, the Message completed message state can be indicated with an additional color, e.g.
as soon as the processing of a fault has been completed.
The advantage of the additional color is that completed messages are no longer just displayed as Acknowl-
edged or Went out, but a defined representation for completed processes is now possible.
This function is available if the Alarm Logging Color Extension option has been selected during the custom-
ized installation of SICAM SCC. If this is the case, the CCAlarmColorProcessExtension.ini file is stored in the
MELD project directory when creating a SIMATIC WinCC project. You can edit this file - see the paragraphs
below.

7.4.5
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ii NOTE
You can subsequently activate the Alarm Logging Color Extension option via a customized installation of
SICAM SCC.

As an example, the paragraphs below describe the configuration and representation in SIMATIC WinCC for
various message settings and sequences in the message lists. The Message completed message state is
represented using a black font on a gray background.

Configuring message coloring
To configure the coloring of messages:
✧ Open the Properties dialog of the message type for which you want to configure message coloring.

[prop_colors, 1, en_US]

Figure 7-19 Configuring message coloring

✧ Configure the text and background colors for the Came in, Went out, and Acknowledged message
states.

To activate and configure the coloring of the Message completed message state:
✧ Open the CCAlarmColorProcessExtension.ini file in the MELD project directory using a text editor.

The file includes the following entries:
[Settings]
Enabled=1
[GlobalColors]
CompletedBack=c0c0c0
CompletedFore=000000
#[GlobalStateTexts]
#Come=2
#ComeAcked=5
#Go=3
#GoAcked=5
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✧ Under [Settings] set the Enabled entry to 1 in order to activate the function (0 =OFF, 1=ON). This
ensures that the last message of a message cycle is displayed in accordance with the settings performed
under [GlobalColors].

✧ Via CompletedBack and CompletedFore define the background and font colors of the message.

In the example, the background is gray and the font is represented in black. The entries correspond to the RGB
values of a color. These RGB color values are available in the SIMATIC WinCC Graphics Designer under the color
settings for any object (Color selection - HTML code).
✧ To enable the display of user-defined texts in the Status system message block of the Alarm logging,

remove the character # at the start of the line.

Texts that are stored under the corresponding ID in the text library in the current runtime language are
displayed. You can configure both the ID in the INI file and the text in the text library.
All messages are processed according to the selected type.

Example 1
The following settings are defined in the Configure message classes dialog, Acknowledgment tab:

• The messages have the states Came in and Went out.

• The Came in and Went out messages must be acknowledged.

[prop_example_1, 1, en_US]

Figure 7-20 Example 1, configuring message classes

The RAISED - Ack - CLEARED - Ack message sequence is shown as follows in the event list:

[list_example_11, 1, --_--]

The RAISED - CLEARED - Ack message sequence is shown as follows in the event list:
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[list_example_12, 1, --_--]

Example 2
The following settings are defined in the Configure message classes dialog, Acknowledgment tab:

• The messages have the states Came in and Went out.

• The Came in message must be acknowledged.

[prop_example_2, 1, en_US]

Figure 7-21 Example 2, configuring message classes

The RAISED - Ack - CLEARED message sequence is shown as follows in the event list:

[list_example_21, 1, --_--]

The RAISED - CLEARED - Ack message sequence is shown as follows in the event list:

[list_example_22, 1, --_--]

Example 3
The following settings are defined in the Configure message classes dialog, Acknowledgment tab:

• The messages only have the state Came in.

• The Came in message must be acknowledged.
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[prop_example_3, 1, en_US]

Figure 7-22 Example 3, configuring message classes

The RAISED - Ack message sequence is shown as follows in the event list:

[list_example_31, 1, en_US]

Flexible Configuration of the Alarm Logging System

To facilitate the interaction of SICAM SCC with other products such as SIMATIC STEP7 projects (WinCC OS
Project Editor) or PCS 7, the SICAM SCC Alarm Logging System can be adapted to the Alarm Logging System in
an existing SIMATIC WinCC project.

How to proceed
In SICAM SCC the Alarm Logging System can be flexibly configured in order to write texts or process values
into the same columns created for SIMATIC STEP7 or PCS 7 projects.
The IDs of message blocks and message classes can be configured in the PASNorm.ini file. The configuration
influences both the generation of the SICAM SCC Alarm Logging System during the import of the configura-
tion data and also the Normalization DLL which writes the current process data into the desired data blocks
during runtime. The default entries can be transferred to other message block IDs or deactivated.

Configuration of the PASNorm.ini file
A template for the configuration of the Alarm Logging System (_PASNorm_.ini) is available in the misc
subfolder of the SICAM SCC installation directory. This template can be adapted before the start of a SICAM
Wizard and saved as PASNorm.ini in the same directory. The PASNorm.ini is copied into the WinCC project
directory when running a SICAM Wizard for the first time in a newly created WinCC project. For this reason
any subsequent changes must be performed in the file stored in the project directory.
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ii NOTE
The message lists (WinCC Alarm Control) included in the scope of delivery of the SICAM graphic object
library are pre-configured for the SICAM SCC standard. In order to be able to use them, they must be
adapted to the modified Alarm Logging System structure (column display and arrangement, SICAM filter
settings in the Properties under Message Lists > Fixed selection > Edit).

ii NOTE
The modified PASNorm.ini file in the SICAM SCC installation directory is reused when creating a new
WinCC project. To configure new projects based on the SICAM SCC standard once again or to use a different
configuration, the PASNorm.ini file must be deleted or adapted before creating a new WinCC project using
a SICAM Wizard.

Settings for the runtime (behavior of the Normalization DLL)
In the ## RUNTIME Behavior ## section you configure the data for the processing of process values via the
Normalization DLL during the SIMATIC WinCC runtime.
Process value blocks
You can adapt the use of process value blocks via the Normalization DLL in the PASNorm.ini. The process
value blocks for the configuration mode must be modified analogously.
The use of the process value blocks can be adapted via the PASNorm DLL in the PASNorm.ini. The process
value blocks for the configuration mode must be modified analogously.

• Runtime mode column
The RB identifier is used to identify the process value blocks.

• Default ID column
Corresponds to the process value block number which has been fixedly defined so far.

• Process data block name column
Description of the text block.

• New block ID column
Newly defined block number. In the default setting this block number is identical to the default ID.

• Used Yes/No column
Defines whether the process value block is to be filled with process data during the SIMATIC WinCC
runtime.
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Dynamic Alarm Filter (DAF)

Overview

The Dynamic Alarm Filter (DAF) allows you to decide which – and how – status changes of a message or an
analog value are entered into the SICAM SCC message lists or written into a trigger variable.

• You can create several DAFs. There are binary DAFs (with a value of up to 32 bits) and numerical (analog
values) DAFs.

• Each DAF is written into a table line by line and you define a corresponding state/criterion and a reaction
in each line.

• You can integrate additional, user-defined criteria into the decision matrix which you can control via
WinCC (DAF_Marker1 ... 8).

• This means that you can, for example, process a spontaneous message in a different manner than the
command acknowledgment from a switch.

• You can define that no entries are created in the message lists for certain status changes.

• Furthermore, you can define value ranges for analog values. A message is shown if an analog value
exceeds this range. This ensures that a message is not entered for each value change.

• You can read out the user name from a WinCC variable and transfer it to the message lists (user name
DAF, process value block 10).

• In addition, you can describe a trigger variable for each state and, e.g., trigger an action.
The DAFs configured can be assigned to one or several messages.

ii NOTE
In order to use the DAF functionality, SIMATIC WinCC V7.4 SP1 Upd5 or later is required.

ii NOTE
To work with DAF, the entire project must be adapted accordingly.
Legacy projects continue to run without DAF by default.
Since message lists with DAF do not work completely in the same way as message lists without DAF,
different templates are available in the library.

Advantages
DAFs provide the following advantages:

• DAFs can be used multiple times. A DAF can be linked to several messages based on different data types.

• Value ranges are defined and a message is shown if a range is exceeded, whereas process value changes
within the defined range do not trigger a message (threshold function).

• DAFs enable status requests.

User Interface
The Dynamic alarm filter function is operated via the SICAM Dynamic Alarm Filter Configurator window
subdivided into the following 2 dialogs:

• In the SICAM SCC – Dynamic Alarm Filter Configuration dialog, you define states (filter criteria) to be
checked for the tags. See 7.5.3 Configuration.

• In the SICAM SCC – Dynamic Alarm Filter Mapping dialog, the messages must be assigned the corre-
sponding DAFs. See 7.5.4 Mapping.

7.5
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User name in message lists
To write the user name into the message lists, the DAF_UserName text tag is created in the SICAMDAF tag
group when creating the SICAM project.
The text must not exceed 30 characters. The contents of the tag are written into Process value block 10 (user
name) of the AlarmLogging when creating a message. This process value block can be shown in the message
lists. You can freely define the contents of the tags during the runtime. Example: The name of the current user
can be written into the tag when triggering a command.
The @CurrentUserName tag was not used because it is computer-specific and because the user who is logged
on to the process control client does not need to be identical with, e.g., the user logged on to the WinCC
server creating the message.

ii NOTE
This function is only available if the Dynamic Alarm Filter (DAF) is used.

Starting the Dynamic Alarm Filter Function

² In the WinCC Explorer, double-click SICAM Dynamic Alarm Filter.

The SICAM SCC – Dynamic Alarm Filter Configurator opens.
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Configuration

[le_daf_ui_config, 3, en_US]

(1) Dynamic alarm filter list, Page 298
(2) Configured filter criteria, Page 299
(3) Filter criterion settings, Page 300
(4) Filter criterion actions, Page 302
(5) Information bar

The information bar provides useful information, such as the number of binary and numerical
filters or the number of filter criteria.

(6) Buttons
Click Apply to save all the settings performed so far. Click Next > to open the 7.5.4 Mapping. Click
OK to apply all settings and close the window.

Dynamic alarm filter list
This list shows all existing DAFs. It is sub-divided according to the following 2 alarm filter types:

• Binary alarm filters
A binary DAF enables the bit-oriented evaluation of any state and status bits of messages. In addition,
you can evaluate digital values (e.g. bit patterns and metered values).

7.5.3
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• Numerical alarm filters
A numerical DAF enables the evaluation of any value ranges and status bits of digital and analog values
mapped to the message lists. In contrast to the binary DAF, the evaluation is based on numerical values.
This means that not the raw value, but the value converted to the measuring range is evaluated
(following a linear or non-linear value adaptation).

• Filter for Single-Point Indication with Alarm when ON
A filter type for single-point indications only which sets the alarm for a pending indication (10) and resets
it for a non-pending indication (01).

• Filter for Single-Point Indication with Alarm when OFF
A filter type for single-point indications only which sets the alarm for a non-pending indication (01) and
resets it for a pending indication (10).

All types are configured and mapped in the same dialog. The display of the value in the filter criteria is the only
difference.

Table 7-4 Controls

Icon Keyboard Function
<Ctrl> + <N> Add new filter

A new filter always has the default name ALARMFILTER and should be
renamed.

<Ctrl> + <C> Add filter copy
A copied filter always has the default name ALARMFILTER and should be
renamed.

<Del> Remove filter

<F2> Rename filter

only via context menu Move filter
Moves the filter to an other alarm filter type

You can also call up the functions via a context menu (by right-clicking the menu item).

Configured filter criteria
A DAF can include any number of filter criteria shown in this list together with the states to be checked.
The priority of the filter criteria – and of the states to be checked – decreases from top to bottom. This means
that the check starts at the top of the list and runs until a filter criterion is true. In this case, all following filter
criteria are not checked.
If one or several sub-criteria exist for the matching filter criteria, these sub-criteria are also checked in the
order described above. If a sub-criterion is true, only the actions for this sub-criterion are executed; the actions
defined for the corresponding main filter criterion are not executed. If no sub-criterion matches, the actions
defined for the main filter criterion are executed.
If no filter criterion matches the variable status or the latest known filter criterion applies again, no list entry
occurs. When stopping the runtime, the currently queued filter criteria of all variables are stored and will be
imported again during re-start of the runtime.

Table 7-5 Controls

Icon Keyboard Function
<Ctrl> + <N> Ad new filter criterion

<Ctrl> + <C> Add filter-criterion copy

<Del> Remove filter criterion
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Icon Keyboard Function
<Ctrl> + ← Use as main filter criterion

<Ctrl> + ↑ Move up – increase priority

<Ctrl> + ↓ Move down – lower priority

<Ctrl> + → Use as sub-filter criterion
A sub-criterion is shown with the following  icon.
Each main filter criterion can include any number of sub-criteria. Sub-criteria
cannot include any subordinate sub-criteria.

You can also call up the functions via a context menu (by right-clicking the menu item).
By default, Value, Status, Time status, Event list, Alarm list and Notes are shown in the header. Right-click
the header to open a context menu. Via the items of this context menu, you can show or hide further columns
of the Filter criterion settings and the Filter criterion actions.

Filter criterion settings
Via the Filter criterion settings you can define conditions to be fulfilled in order to execute the actions
defined under Filter criterion actions.

Table 7-6 Parameters of the Filter Criteria

Parameters Description
Value
Binary alarm filters Shows the individual bits (0 to 31) of the tag value from the Alarm

Logging.
These can be evaluated individually:

• 0 (OFF)
The bit is checked for the logical value 0

• 1 (ON)
The bit is checked for the logical value 1

•  (none = default)
The bit is masked out and is not considered

•  (rising edge)
The bit changes from 0 to 1

•  (falling edge)
The bit changes from 1 to 0

•  (alternating)
The bit changes from 0 to 1 or from 1 to 0

Numeric alarm filters The value or value range and the hysteresis can be indicated.

•  (none = default)
• <
• >=
• >
• >=
• =
• [x,y] (range; from x to y)
•  (Value change)
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Parameters Description
Single-point indication with alarm
for ON /
Single-point indication with alarm
for OFF

Shows the least significant bits (0 and 1) of the tag value from the
Alarm Logging.
These can be evaluated individually as for binary alarm filters (see
above).

Remark
Comment Enter a comment, e.g. in order to explain how the filter criterion is

applied.
You can also enter the comment directly in the list of Configured filter
criteria by double-clicking the corresponding entry in the Notes
column.

Status
• Invalid
• Bay blocking
• Telecontrol blocking
• Substituted
• Overflow

The following settings are possible for each status:

• 0 (OFF)
• 1 (ON)
•  (rising; from 0 to 1)
•  (falling; from 1 to 0)
•  (alternating; from 0 to 1 or from 1 to 0)

Time status
• Invalid
• Daylight saving time
• Time stamp replaced

The following settings can be defined for each status:

• 0 (OFF)
• 1 (ON)
•  (rising; from 0 to 1)
•  (falling; from 1 to 0)
•  (alternating; from 0 to 1 or from 1 to 0)

Origin
Initiator category The following settings can be defined for the initiator category:

• (none)
• Irrelevant
• Local
• Near
• Remote
• Automatic
• Automatic bay
• Process
• DIGSI local
• DIGSI remote
• Device invalid
• Device locked

For IEC connections only:
Originator address

If the originator address is used, origin_userstate=1 must be set for
IEC 61850 in the IEC61850.INI file of the [GENERAL] driver. The device-
specific parameter [IEDxxx] orIdent_mode must be defined according
to the device specification (0 to SAT200: <IP address> Origin:<Origina-
torAddress> / 1 to<OriginatorAddress> (numeric, 1Byte)).
For IEC60870-5-104, the [DEFAULT] HerkAdrStati=1 parameter must be
set in the AKServ.INI file.
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Parameters Description
Initiator category The following settings can be defined for the initiator category:

• (none)
• Direct (from source)
• Undefined origin
• From int. process image
• From buffer
1 initiator category per filter criterion can be selected.

For PAS connections only:
Change ID

The following settings are possible for the change ID:

• (none)
• Initial

(First change of this value after restarting SICAM PAS [SessionID
new, 1st change of the SICAM PAS-COVCounter3])

• No change of COVCounter
(Message already received, no process value change [SessionID and
COVCounter unchanged])

• Normal
(The value or status of the process value has changed [SessionID
unchanged, COVCounter increased])

Cause of transmission
Cause of transmission Here you can select from the list of all PAS causes of transmission,

Page 306.
1 PAS transmission cause per filter criterion can be selected.

Additional cause Here you can select from the list of all PAS additional causes, Page 306.
1 PAS additional cause per filter criterion can be selected.

User-defined tags
DAF_Marker_1 ... 8 These are bit tags created automatically after the Wizard run.

You can freely control the tag values during the runtime and use them
e.g. in order to activate/deactivate individual filter criteria or activate/
deactivate messages for certain operating states.

Filter criterion actions

Table 7-7 Parameter for filter criterion actions

Parameters Description
System behavior
No old/new comparison If this option is not activated (default setting), messages are rejected if

their filtered state is similar to the filtered state of the previous message.
If this option is activated, the comparison between the current and the
previous filter result is neglected. This allows you, for example, to inte-
grate cyclically transmitted metered values into the message lists even if
these values have not changed.

Show in event list If this checkbox is activated, the status is shown in the event list.
You can also activate this option directly in the Configured filter
criteria list in the Event list column.

3 COV: Change of value
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Parameters Description
Show in alarm list If this checkbox is activated, the status is shown in the alarm list.

You can also activate this option directly in the Configured filter
criteria list in the Alarm list column.

Acknowledgement for “Came in”
and “Went out”

If Show in alarm list is activated, you can define whether or not Came
in or Came in/Went out is acknowledged.

Automatic acknowledgement of
old entries

If Show in alarm list is activated, you can also define whether previous
instances of this message must be acknowledged automatically.

Blinking If Show in alarm list is activated, you can also define whether the status
is shown as blinking in the alarm list.
In this case, Blinking must be activated in the AlarmLogging for the
message type and in the corresponding message blocks. In the Alarm-
Control, Blinking must also be activated in the diagrams (pictures) for
the corresponding message blocks.
With these settings you can define different representation variants.

Re-enter upon system start If Show in alarm list is activated, you can additionally define here
whether the first message after the start of the SICAM SCC Runtime shall
be entered in the alarm list even if it has not changed compared to the
previous message.

Message text
Value text group Select whether you want to display the message from a value text group

(SCC default setting or Groups 1 to 16) or show the process value
directly.

Text Id (> 255) Alternatively, you can enter a text ID for a text to be displayed. This text
is used instead of the text from the value text groups.

Originator address text Id You can define a text ID for the originator address which is additionally
shown in the ID number column.

Add user name If you select this option, the value of the internal DAF_UserName tag
for this message is added to the XXX process value column.
Alarm list The current DAF_UserName is entered upon every message
change.

Trigger variable
Trigger tag It is also possible to trigger a tag as an action.

Select the corresponding trigger variable from the tag selection dialog.
Be aware that it must be binary. It is always set to 1 and can be reset by
the user. You can use it e.g. as a trigger for scripts or in order to control
a collective display of various messages which is reset by an acknowl-
edgment.

Colors Select the background and font color in which you want the message to
be displayed in this specific message state. If this option is not selected,
the colors of the message type configured in the Alarm Logging are
applied.

Acknowledgement colors Select the background and font colors in which you want the Acknowl-
edged messages to be displayed in this specific message state. If this
option is not selected, the colors of the message type configured in the
Alarm Logging are applied.
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Mapping

[le_daf_ui_mapping, 1, en_US]

(1) Messages, Page 304
(2) Selection filter for messages, Page 304
(3) Dynamic alarm filter, Page 305
(4) Selection filters for DAFs, Page 305
(5) Information bar

The information bar provides useful information, such as the number of binary and numerical
filters or the total number of messages.

(6) Buttons
Click Apply to save all the settings performed; click < Back to return to the 7.5.3 Configuration of
the filter criteria. Click OK to apply all settings and close the window.

Messages
This list shows all the messages imported into your SICAM SCC project.

Selection filter for messages
You can filter the list in order to reduce its size and browse for specific messages. All columns are available as
filter criteria.

• Message Group (free text)

• Message (free text)

• Message Number (free text)

7.5.4
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• Data Type (list box which automatically shows all available data types)

• Assigned DAF (list box which automatically shows all configured DAFs)
You can, for example, only show double-point indications with "einaus" in the Message Name:

[sc_daf map filter, 1, en_US]

ii NOTE
For the free texts for Message Group and Message you can use ".", "?" and "*" as wildcards.

Dynamic alarm filter
This list shows all configured DAFs.
In order to assign a DAF to a message, drag and drop the DAF from the list to the message selected. To
perform multiple assignments (i.e. assign a DAF to several messages), press the Shift or Alt key in order to
select several messages and then drag the corresponding DAF to these messages.
In just one step, you can e.g. assign the DAF myBinDAF_01 to the messages q1_einaus, q2_einaus and
q8_einaus from the example above (see Selection filter for messages, Page 304):

[sc_daf map dnd, 1, en_US]

To assign a DAF to several messages, you can double-click the messages in the Dynamic alarm filter column
and then select the corresponding DAF from the selection list:

[sc_daf map listbox, 1, en_US]

To delete DAF assignments, either select them individually (from the (none) list or press <Del> in the selected
line) or perform a multiple selection (select several lines and then press <Del>).
To undo a multiple selection, press <Esc>.

Selection filters for DAFs
You can filter the list in order to reduce its size and browse for specific DAFs. All columns are available as filter
criteria.

• Name (free text)

• Type (list box: none, binary, numerical, SI with alarm when ON, SI with alarm when OFF)
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• SI with alarm when ON

• SI with alarm when OFF

Assignment Tables

PAS causes of transmission
The following table serves for the assignment of IEC values to SICAM PAS values.
SICAM PAS also uses additional values.

Table 7-8 IEC-COT ⇔ PAS-COT Assignment Table

IEC-COT PN Bit4 SE Bit5 PAS-COT InitiatorCategory
empty=eIrrelevant (0)

COT_GA (2) - - eGeneralInterrogation (8)
COT_SPONTAN (3) - - eSpontaneous (1)
COT_ACTIVATION (6) - 1 eSelect (16)

- 0 eCommand (19)
COT_CONFIRMATION (7) 0 1 eSelectConfPos (17)

1 1 eSelectConfNeg (18)
0 0 eCommandConfPos (20)
1 0 eCommandConfNeg (21)

COT_DEACTIVATE (8) - - eAbort (25)
COT_CONFDEACTIVATE (9) 0 - eAbortConfPos (26)

1 - eAbortConfNeg (27)
COT_TERMINATION (10) 0 1 eSelectTermPos (39)

1 1 eSelectTermNeg (40)
0 0 eCommandTermPos (35)
1 0 eCommandTermNeg (36)

COT_RUECKMFERNBEF (11) - - eReturnInformation (34) eNearControl (2)
COT_RUECKMNAHBEF (12) - - eReturnInformation (34) eLocalControl (1)
COT_BACKGROUNDSCAN (20) - - eGeneralInterrogation (8)

PAS additional causes
The following table serves for the assignment of IEC values to SICAM PAS values.
SICAM PAS also uses additional values.

Table 7-9 IEC-AddCause ⇔ PAS-AddCause Assignment Table

IEC-AddCause PAS-AddCause
unknown (0) eAddCPositive (0)
not_supported (1) eAddCCommandNotAccepted (41)
Blocked_by_switching_hierachy (2) eAddCAuthorityViolation (99)
Select_failed (3) eAddCCommandNotAccepted (41)
Invalid_position (4) eAddCPlausibilityError (114)
Position_reached (5) eAddCStateAlreadyReached (117)
Parameter_change_in_execution (6) eAddCParameterError (98)

7.5.5

4 PN Bit: 1 = negative confirmation, 0 = positive confirmation
5 SE Bit: 1 = select, 0 = execute
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IEC-AddCause PAS-AddCause
Step_limit (7) CDC=BSC:

Value=2 (closed)
eAddCUpperBoundReached (112)
Otherwise: eAddCLowerBoundReached (113)
Otherwise: eAddCPositive (0)

Blocked_by_mode (8) eAddCOutputBlockageSet (102)
Blocked_by_process (9) eAddCOutputBlockageSet (102)
Blocked_by_interlocking (10) eAddCSwitchingErrorProtectionInterlock (97)
Blocked_by_synchrocheck (11) eAddCSychronizationPreconditionFailure (115)
Command_already_in_execution (12) eAddCTooManyActiveCommands 38()
Blocked_by_health (13) eAddCDeviceStatus (116)
One_of_n_control (14) eAddCOneOutOfNErrorSoftware (121)
Abortion_by_cancel (15) eAddCCommandNotAccepted (41)
Time_limit_over (16) eAddCMonitoringTimeExpired (118)
Abortion_by_trip (17) eAddCCommandNotAccepted (41)
Object_not_selected (18) eAddCCommandNotAccepted (41)
Object_already_selected (19) eAddCCommandNotAccepted (41)
No_access_authority (20) eAddCAuthorityViolation (99)
Ended_with_overshoot (21 eAddCOverload (105)
Abortion_due_to_deviation (22) eAddCCommandNotAccepted (41)
Abortion_by_communication_loss (23) eAddCCommandNotAccepted (41)
Blocked_by_command (24) eAddCOutputBlockageSet (102)
None (25) eAddCCommandNotAccepted (41)
Inconsistent_parameters (26) eAddCParameterError (98)
Locked_by_other_client (27) eAddCOneOutOfNErrorSoftware (121)
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SICAM Functions
Overview

The SICAM functions complement the default functions of SIMATIC WinCC. The SICAM functions are C scripts.
When a project is created, they are copied as project functions and made available by a SICAM Wizard.
SICAM functions can be used for the processing of commands, alarms and measured values.
C scripts can be opened and edited using the C Editor. For more detailed information, refer to the documenta-
tion of SIMATIC WinCC.

Commands

Use the SICAM functions described in this paragraph for issuing commands.
The following functions are available:

Table 7-10 SICAM functions for command execution

Name Meaning
SCC_Command_Analog Issuing of commands for analog values
SCC_Command Issuing of commands for digital values
SCC_CommandExecute Command execution, for two-step command output

The SICAM command output functions are available in the WinCC Explorer under Global Script/C Editor/
Project Functions/SICAMSCC/Command.
The SICAM command output functions can be used depending on the individual tag type.
By default, the SCC_Command_Analog and SCC_Command functions perform the complete command
output. In order to transmit the command in 2 steps, customize the scripts and additionally call up the
SCC_CommandExecute function. The related description is available in the corresponding scripts.

[pascc701, 1, en_US]

Figure 7-23 SICAM command output functions

Command for Floating Point Values

Format
The SICAM command output function in Float number format has the following structure:
void SCC_CommandAnalog ( char* p_cTagName, float p_fValue, DWORD p_dwValueType,
DWORD p_dwDuration, DWORD p_dwCOT )

7.6

7.6.1

7.6.1.1
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Description
Use this function to issue a command in Float format. The name of the command tag is used as transfer
parameter (e.g. Bay01_device02 or Bay01_device02.value).
The tag can be any structure element (Value, Cause, Valuetype, CmdCounter).
Additionally, you transfer a value of the Float type (e.g. in order to output an analog setpoint), the number
format (e. g. 22 for an analog setpoint), the command duration in milliseconds (ms), and the cause identifier.
For more detailed information on number formats, refer to appendix A.1.3.

Suggested trigger
Suggested trigger for the PAS_Command_Float function:
As trigger for this function, you can use any action of an object, e. g. a click a button.

ii NOTE
Use a Windows object of the Slider Object type (in the Graphics Designer of SIMATIC WinCC) in order to
create a variable definition of an analog setpoint in floating point format via the value structure element.

Command for Digital Values

Format
The SICAM command output function based on the Signed integer number format has the following struc-
ture:
void SCC_Command ( char* p_cTagName, int p_iValue, DWORD p_dwValueType,
DWORD p_dwDuration, DWORD p_dwCOT, BOOL p_bNoSynch, BOOL p_bNoLock )

Description
Use this function to issue a command in PAS_Command_Integer format. The name of the command tag is
used as transfer parameter (e. g. Bay01_device03 or Bay01_device03.value).
The tag can be any structure element (Value, Cause, Valuetype, CmdCounter).
Additionally, you transfer the switching direction (1=OFF, 2=ON for a pulse command), the number format (e.
g. 14 for a pulse command), the command duration in milliseconds (ms), the cause identifier, and the bits for
the Qualifier of Command (QoC, for the IEC Communication Suite). For more detailed information on number
formats, refer to appendix A.1.3.

Suggested trigger
Suggested trigger for the Command output with the Integer number format function:
As trigger for this function, you can use any action of an object, e.g. a click a button.

Command Execute

Format
The Command Execute function has the following format:
void SCC_CommandExecute(char* p_cTagName)

Description
This function executes a command. To do this, the value of the CmdCounter structure element of the
command tag is increased. The name of the command tag is used as transfer parameter.
The tag can be any structure element (Value, Cause, Valuetype, CmdCounter).
The Command Execute function is used as second step of a command execution.
As the first step, you can e. g. use the SICAM command output function. In this case, however, the rows for
the command execution must be commented in the C script! (See comments in the SCC_Command and
SCC_Command_analog script)

7.6.1.2

7.6.1.3
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To comment the script lines:
✧ Open the C script using the C editor.

[pascc702, 1, en_US]

Figure 7-24 Commenting command lines

✧ To comment the command execution lines (selected lines), add two slashes at the beginning of each
line.

✧ Save the modified script.

Suggested trigger
Suggested trigger for the Command Execute function:
As trigger for this function, you can use any action of an object, e.g. a click a button.

Substituting Values

Overview
Via SICAM SCC, values in SICAM PAS/PQS and in IEC 61850 devices that support substitution (z.B. SIPROTEC 5),
can be manually updated/substituted. For example, a substitution is required if there is no connection to the
device/primary technology level although values are required in SICAM PAS/PQS or SICAM SCC.
SICAM functions are available for the substitution of values.
The following values can be substituted:

• Bit pattern values

• Measured values (floating point values), metered values (integer values)

• Switch positions (signed integer values)
For more detailed information, refer to chapter 4.4.6 Runtime Dialogs of SICAM Switch Controls.

 

7.6.2
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Values are substituted by means of the following 2 subfunctions:

• Setting the value of the message to the substituted value and setting the status (validity) of the message
to substituted.

• Incrementing the value of the WBCounter (Write-Back-Counter) structure element in order to ensure that
the value is substituted in SICAM PAS/PQS.

For more detailed information on the structure of the indication tags, refer to appendix A.
 
A substitution can be performed if the message fulfils one or two of the following status criteria:

• Invalid

• Not topical

• Bay blocking set

• Substituted
The following functions are available:

Table 7-11 SICAM value substitution functions

Name Meaning
SCC_PAS_SubstituteAnalog Substitution of values in Float format
SCC_PAS_Substitute Substitution of values in Integer format

Table 7-12 Additional functions for IEC Communication Suite (at present only for IEC 61850)

Name Bedeutung
SCC_IEC_SubstituteAnalog Nachführen mit dem Zahlenformat Float
SCC_IEC_Substitute Nachführen mit dem Zahlenformat Integer
SCC_IEC_SubstituteReset Rücksetzen des nachgeführten Wertes

The SICAM substitution functions are available in the WinCC Explorer under Global Script/C Editor/Project
Functions/SICAMSCC/misc.
Various SICAM substitution functions can be used depending on the individual number format.

Substituting Floating Point Values

Format
The SICAM substitution function for values in Float number format has the following structure:
void SCC_PAS_SubstituteAnalog(char* p_cTagName, float p_fValue)

Description
Use this function to substitute a value in Float format. Therfor the tag name and the substitute value must be
transferred to the function.
The tag can be any structure element of a SICAM structure tag (Value, Cause, Valuetype, CmdCounter).
For more detailed information on number formats, refer to appendix A.1.3.

Suggested trigger
Suggested trigger for the PAS_Substitute_Float function:
As trigger for this function you can use any action of an object, e.g. a click on a button.

7.6.2.2
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Substituting Digital Values

Format
The SICAM substitution function for values in the Signed Integer number format has the following structure:
void SCC_PAS_Substitute(char* p_cTagName, int p_iValue)

Description
Use this function to substitute a value in the Signed Integer format. Therefor the tag name and the substitute
value must be transferred to the function.
The tag can be any structure element (Value, Cause, Valuetype, CmdCounter).
For more detailed information on number formats, refer to appendix A.1.3.

Suggested trigger
Suggested trigger for the Substitution with Integer number format function:
As trigger for this function, you can use any action of an object, e. g. a click a button.
For more detailed information on the substitution of switch positions, refer to chapter 4.4.6 Runtime Dialogs
of SICAM Switch Controls.
The Switch position substitution function is also integrated in the ActiveX Controls.

Object-Specific Blocking

When using SICAM PAS/PQS, V8.01 or later, an information-specific blocking can be defined for information
from the SICAM PAS target system. A C script is available for this function.

Format
The object-specific blocking has the following format:
void SCC_PAS_SetBlockState(char* p_cTagName, int p_iBayBlocked,
int p_iTelecontrolBlocked)

Description
You can use this function in order to set or undo blocking for an individual item of process information. When
using SICAM SCC switching device objects this function is integrated in the status dialog, see chapter
4.4.6 Runtime Dialogs of SICAM Switch Controls.
The parameters for the function are as follows:

• Tag name (p_cTagName)

• Bay blocking value (p_iBayBlock)

• Telecontrol blocking value (p_iTelecontrolBlock).
The following values are possible:

0 No change
1 Undo blocking
2 Set blocking

After activating bay blocking the value of the object can be substituted using the functions described in
chapter 7.6.2 Substituting Values.

7.6.2.3

7.6.3
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Functions for Processing of Messages

Overview
Use the SICAM functions described in this paragraph for the processing of alarm messages.
The following functions are available:

Table 7-13 General SICAM functions

Name Meaning
PAS_CreateMessage_V500 Create a message with text from the text library
PAS_CreateMessageStr_V500 Create a message with text transfer
PAS_CreateMessageStr2_V500 Create a message with transfer to 2 texts
SCC_AcknowledgeAlarm Acknowledge message in warning message list

The SICAM functions for the processing of messages and measured values are available in the WinCC Explorer
under Global Script/C Editor/Project Functions/SICAMSCC/misc.

Creating a Message - Text from the Text Library

Format
The Create message function has the following structure:
void PAS_CreateMessage_V500(DWORD dwMsgNr, DWORD dwState, DWORD dwTextID)

Description
This function creates a message in the SIMATIC WinCC Alarm Logging system.
It requires the message number, the SIMATIC WinCC message status (1 = Raised, 2 = Cleared) and the ID of the
text to be shown in the Value column.

ii NOTE
The new message must be created with this ID in the Alarm Logging system first.

Creating a Message - with Text Transfer

Format
The Create message function has the following structure:
void PAS_CreateMessageStr_V500(DWORD dwMsgNr, DWORD dwState, char* lpszMsgText)

Description
This function creates a message in the SIMATIC WinCC Alarm Logging system.
It requires the message number, the SIMATIC WinCC message status (1 = Raised, 2 = Cleared) and the text to
be shown in the Value column.

ii NOTE
The new message must be created in the Alarm Logging system first.

Acknowledging A Message in the Warning Message List

Format
The Acknowledge message in warning message list function has the following format:

7.6.4
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void SCC_AcknowledgeAlarm(char* p_cMsgAckTagName, DWORD MsgNumber)

Description
This function creates Acknowledged messages in the warning message list via the message number.
For this function you transfer the name of the raw data tag (MSG_Ack_... for acknowledgment) of the commu-
nication channel via which the message is received, as well as the message number.

Function for Copying Tag Values

Format
The Copy tag values function has the following format:
SCC_CopyTagValueRT(char* p_cSourceTagName, char* p_cDestinationIntTagName,
BOOL p_bDigitalValue)

Description
This function copies the current runtime data of a tag of the PAS Information type into an internal tag struc-
ture of the same type. This is mainly required in order to use a switch several times for topological coloring,
which the topological coloring plausibility check would not allow (e.g. use of switchgear trucks: the discon-
nector is drawn twice).
The transfer parameters are the structure tags of the source and target tags as well as the information
whether it is a digital or analog value.
The names can be transferred with an extension (e.g. .RTInfo) or without an extension.
p_bDigitalValue is transferred with 0 for analog and 1 for digital values.

Using SICAM Functions

The SICAM functions can be used to assign dynamic display properties to graphic objects in SIMATIC WinCC
station diagrams.

Dynamic display properties
With the dynamic display properties, you can visualize a station's status in the control and monitoring direc-
tion.

C action
Via the C action, you can use all functions provided by SIMATIC WinCC. These also include the SICAM func-
tions.

Commands
Use the Commands SICAM functions for the assignment of dynamic display properties in the command direc-
tion.

General SICAM functions
The general SICAM functions allow you to visualize the different states of a station in the monitoring direction.

Global Actions

The currently necessary global actions are copied into the project when importing the SICAM graphic object
library.
They are available in the WinCC Explorer under Global Script/C Editor/Actions/Global Actions.

7.6.5
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For optional global actions and global actions originating from previous versions refer to the installation direc-
tory in the PAS subfolder. You can copy them into your project if required.

SicamPAS_Compkey
This global action is created dynamically during the import process. During runtime, it checks whether the
compatibility keys of the SICAM SCC project and the SICAM PAS project are identical. If this is not the case, a
message is shown when the runtime is terminated.
No compatibility check is performed for SICAM RTUs, IEC 61850 and IEC 60870-5-104 devices.

Sicam_AsyncTicks
The Sicam_AsyncTicks global action writes into the @AsyncTick internal administrative tags (see
7.7.1 Administrative Tags). These tags are used to initiate topological coloring or a change in colors.

SicamPas_AlarmListFilter
The SicamPas_AlarmListFilter.pas C script distributes the settings performed via the Message List Filter
checkbox to the external administrative tags of the connected communication channels.
When the runtime is terminated, the filter setting can be saved for the next start:

• From SIMATIC WinCC V7.0 SP1, the Runtime Persistence option of the internal @AlarmList-
Filter_ValueInt tag can be set.

• With older versions of SIMATIC WinCC (earlier than V7.0 SP1), the AlarmListFilter_WriteExt tag must be
set to 1. This functionality is integrated in the Button End graphic object.

ii NOTE
The AlarmListFilter_WriteExt tag can only be used when terminating the runtime (consistency of the tag
management).

SICAM_FlashSyn
The SICAM_FlashSyn global action writes into the @Flashxxx internal administrative tags (see chapter
7.7.1 Administrative Tags).
This synchronizes the blinking of the IndustrialX Controls (SICAM PAS CC Version 5.10 or earlier).

Sicam1703_RedundancyMaster
The Sicam1703_RedundancyMaster.pas C script is created dynamically during the import process. It mirrors
the @RM_Master administrative tag to the RedundancyMaster_xx external tag.

Testing SICAM Functions

The progress of the SICAM functions can be viewed during the runtime. To do this, add an application window
and a checkbox from the project library to your diagram.

Inserting an application window

² Select the Application window object under Smart Objects in the Graphics Designer.

² Arrange the object in your diagram. The Window Contents dialog opens.

7.6.8
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[pascc704, 1, en_US]

Figure 7-25 Inserting an Application Window

² Select Global Script and click OK to confirm. The Template window opens.
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[pascc705, 1, en_US]

Figure 7-26 Selecting a Template

² Select GSC Diagnostics and click OK to confirm.

Inserting a checkbox
Insert the graphic object to be used for enabling/disabling the output of debug information.
² Insert the

CheckBox enable script output graphic object from the library into your diagram.

[pascc706, 1, en_US]

Figure 7-27 Inserting the CheckBox enable script output graphic object
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[pascc707, 1, en_US]

This checkbox allows you to enable/disable the output of debug information during runtime.

Calling the SICAM PQ Analyzer

Overview
You can call up the SICAM PQ Analyzer (Incident Explorer) from within SICAM SCC. This is possible from:

• A diagram

• The event list
In SICAM SCC you create a parameter file for the SICAM PQ Analyzer. In the opened Incident Explorer, the fault
records are displayed according to the parameters for topology and time period, as defined in SICAM SCC.

7.6.9
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Prerequisites
To be able to call up the SICAM PQ Analyzer from within SICAM SCC, the following prerequisites have to be
fulfilled:

• The SICAM PQ Analyzer V3.03 or higher is installed on the SICAM SCC computer with the required
licenses.

• A SICAM PQ Analyzer archive is configured according to the specifications, see Manual /11/ SICAM PQ
Analyzer, Incident Explorer.

• Fault records are available in the SICAM PQ Analyzer archive.

Call from a Diagram

Configuration in SICAM SCC
To configure the call in SICAM SCC:
² Create a new diagram in the Graphics Designer.

² To open the Library, click View > Library.

² Under Controls, select the Button PQA current time object.

² Draw the graphics object to the desired position within the diagram.

² Right-click the button and select Properties from the context menu.
The Object properties dialog opens.

² Open the Event tab.

² Under Button > Mouse, double-click Mouse Action.
The Action Editor opens and the C script is displayed.

[c-skript_editieren, 1, en_US]

Figure 7-28 Editing the C Script

² Adjust the following parameters for the display of your SICAM PQ Analyzer archive:

• char *cIPAddress
The IP address of the computer where the archive is located.
The IP address of the local computer is the default address.

7.6.9.1
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• char *cTopology
The topology to be displayed in the SICAM PQ Analyzer.
Be aware of the double notation of the backslash.

ii NOTE
Consider the correct upper and lower case. Otherwise the SICAM PQ Analyzer cannot display the topology
properly.

• DWORD dwMinutes, DWORD dwHours, DWORD dwDays
The period when the fault records are to be displayed in the SICAM PQ Analyzer. You can set the period in
minutes, hours, and/or days, see example below.

In the following example the Incident Explorer of the SICAM PQ Analyzer shows all fault records of the past
30 minutes up to now.
Example:
DWORD dwMinutes = 30;
DWORD dwHours = 0;
DWORD dwDays = 0;

² Compile the adjusted script.

ii NOTE
To get hints on configuration you can insert a GSC Diagnostics window. Therefor proceed as described in
chapter 7.6.8 Testing SICAM Functions.

² Save the diagram and start SIMATIC WinCC Runtime.

[pq_analyzer_aufrufen_01, 1, en_US]

Figure 7-29 WinCC Runtime with Button for Calling the SICAM PQ Analyzer

² To generate the parameter file for the SICAM PQ Analyzer, click PQA call current time. In the GSC Diag-
nostics window, the storage location of the generated parameter file is displayed.
The Incident Explorer opens. The fault records are displayed within the configured time period and with
the correct topology.
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[pq_analyzer_aufrufen_02, 1, en_US]

Figure 7-30 Incident Explorer with Displayed Fault Records

² Click PQA call current time to open the Incident Explorer in the foreground. The display of the Incident
Explorer is updated with the content of the SICAM PQ Analyzer fault record archive.

You can place and configure several buttons with different time parameters in the same diagram.

ii NOTE
An incorrect configuration results in a corresponding message within SICAM PQ Analyzer or in the SICAM
SCC GSC Diagnostics window.
If the Incident Explorer cannot be opened:

• Check the installation path of your SICAM PQ Analyzer as well as the path name in the C script
SCC_PQA_CreateParFile.fct.
You can open, change, re-compile, and save the C script in the WinCC Explorer under Global Script >
C-Editor > Project functions > SicamPAS > misc.

The following figure shows the meaning of the parameters of the C script for the PQA call current time
button in conjunction with the display in the Incident Explorer.
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[pq_analyzer_aufrufen_03, 1, en_US]

Figure 7-31 Incident Explorer and Parameters in the C Script

Call from the Event List

Configuration in SICAM SCC
To configure the call in SICAM SCC:
² Create a new diagram in the Graphics Designer.

² To open the Library, click View > Library.

² Under Alarm Logging templates > WinCC V7.x, select the SICAM SCC Event list for PQ Analyzer
object.

² Draw the graphics object to the desired position within the diagram.

² Under Control elements, select the Button PQA message time object.

² Draw the graphics object to the desired position within the diagram.

ii NOTE
To get hints on configuration you can insert a GSC Diagnostics window. Therefor proceed as described in
chapter 7.6.8 Testing SICAM Functions.

² Save the diagram and start SIMATIC WinCC Runtime.

7.6.9.2
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[pq_analyzer_aufrufen_04, 1, en_US]

Figure 7-32 WinCC Runtime with Button for Calling the SICAM PQ Analyzer

² Select the AutoScroll icon in the event list for the SICAM PQ Analyzer.

² Select the message from the event list for which you want to display fault records in your SICAM PQ
Analyzer archive.

² To generate the parameter file for the SICAM PQ Analyzer, click Call PQA message time.
As an alternative, you can generate the parameter file for the SICAM PQ Analyzer by clicking the icon for
the SICAM PQ Analyzer (magnifier) in the toolbar of the event list.
 
The Incident Explorer opens and the fault records of the SICAM PQ Analyzer archive are displayed for the
time of the message +/- 2 hours.

In the GSC Diagnostics window, the storage location of the new generated parameter file for the SICAM PQ
Analyzer is displayed.
Clicking Call PQA message time again updates the display of the SICAM PQ Analyzer.
The SICAM PQ Analyzer gets opened in the foreground.
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ii NOTE
If the Incident Explorer cannot be opened or the fault records are not displayed:

• Check the installation path of your SICAM PQ Analyzer and change it in the SCC_PQA_CreateParFile C
script, if required.
You can find the C scripts in the WinCC Explorer under Global Script > C-Editor > Project functions >
SicamPAS > misc.
In the C script, search for cPQ_DEFAULT_PATH1 and change the path there. Then compile and save
the changed C script.

• If the SICAM PQ Analyzer archive is not located on the SICAM SCC computer, you have to adjust the
global C script SicamSCC_PQA_SetTimeRange_MsgList.pas.
You can find the C script in the WinCC Explorer under Global Script > C-Editor > Actions > Global
actions.
In the C script, search for cIPAddress and replace the local IP address 127.0.0.1 with the IP address of
your computer where the SICAM PQ Analyzer archive is located.
Then compile and save the changed C script.
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System Control
Overview

When importing the SICAM graphic object library, internal and external administrative tags and several
global actions are additionally created in the project. They serve for system control only.

ii NOTE
Additional templates for global actions which you can use in your project are available in the installation
directory of SICAM SCC, PAS subdirectory. Be aware of the configuration notes within the corresponding
function.

 
 

ii NOTE
The functionality described in this section (e.g. bay/telecontrol blocking) depends on the support of the
destination system - refer to the documentation of the destination system.

Administrative Tags

Internal administrative tags
Internal administrative tags are available in the WinCC Explorer under Internal Tags in the SICAMAdmin
group. Tags starting with an @ character are required for the internal management of SICAM SCC and are not
intended for the user.

Table 7-14 Required internal administrative tags

Name Type
TextIDOffset Unsigned 32-bit value
AckFlashing/QuitBlinking Binary tag
@FlashFast Signed 32-bit value
@FlashMedium Signed 32-bit value
@FlashSlow Signed 32-bit value
@Language Unsigned 32-bit value
@AsyncTickx Binary tag
@AlarmListFilter_WriteExt Binary tag
@AlarmListFilter_ValueInt Unsigned 32-bit value
ActivateControls Binary tag
SubstVal_Float Floating-point value
SICAMPASCCSynchState 8-bit character set text variable

External administrative tags
External administrative tags are available in the WinCC Explorer under SICAM PAS PROTOCOL SUITE/ PAS
Data Server/Project Name in the SicamAdmin_xxx group. They must be assigned as described below.
The following applies to SICAM PAS:
The tag name of all external administrative tags is composed of 2 sections, i.e. a designation such as Alarm-
ListFilter and a string of digits such as 107. The string of digits is determined by the individual station and is
generated by the SICAM PAS Wizard. The string of digits consists of 2 sections and a 0 as separator. The first
section (e.g. 1) indicates the PAS project ID, and the second section (e.g. 7) indicates the HMI interface ID.
The following applies to SICAM RTUs, IEC 61850 and IEC 60870-5-104 devices:

7.7

7.7.1
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The tag name of all external administrative tags is composed of 2 sections, i.e. a designation such as Alarm-
ListFilter and a string of digits such as 1002. The string of digits is station-specific and is generated by the
SICAM IEC Wizard. The first digit (e.g. 10) represents the SICAM RTU project ID. A zero (0) serves as delimiter.
The second digit (e.g. 2) identifies the communication protocol:
 
    1 = IEC 60870-5-104
    2 = IEC 61850
 

Table 7-15 Required external administrative tags

Name Type Meaning
AlarmListFilter Unsigned 32-bit

value
for the definition of the filter function for the message/alarm
list (see chapter 7.7.3 Message List Filter)

InitiatorCategory Unsigned 32-bit
value

for the cause ID

ConnectionState6 Unsigned 32-bit
value

status of the connection to the SICAM PAS system

ForceConnectionState6 Unsigned 32-bit
value

for controlling the connection to the SICAM PAS system

RedundancyMaster
(SICAM RTUs only)

Unsigned 32-bit
value

for distinguishing the servers in case of a redundant SICAM
SCC system
1 = Master server
0 = Redundant partner server

Additional tags are available for system-internal use.

ii NOTE
After any change of the SICAM PAS project ID or the HMI interface ID, check the assignment of the
external administrative tags to the objects in the diagrams.
The project ID can be modified e.g. in SICAM PAS UI - Configuration.
The HMI interface ID can change after the deletion or re-creation of the SICAM SCC interface in SICAM PAS
UI - Configuration and also after the creation of redundant WinCC connections in a SICAM PAS project.
The project ID is assigned after the initial creation of a SICAM TOOLBOX II/SCDSCD/IEC 60870-5-104
project (import in the wizard). The project ID begins with the value 10. It remains unchanged during an
additional import using the wizard.
For the combined connection of SICAM PAS, SICAM RTUs, IEC 61850 and IEC 60870-5-104 devices in a
SICAM SCC project, be aware to use unique project IDs for each station.

Initiator Category

The initiator category is defined in the InitiatorCategory_xxx external administrative tag. The tag is included
in the command output to the automation system7. The content of the tag has the following significance:
 
    2 = NEAR (default value)
    3 = REMOTE
 
The contents of the tag must be changed to the value 3 if SICAM SCC is to act as the control center.
To modify the value of the InitiatorCategory_xxx tag:

7.7.2

6 If connected to SICAM PAS V5 or V6
7 Connection to SICAM PAS/PQS
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The tag is available in the WinCC Explorer under Tag Management/SICAM PAS PROTOCOL SUITE/ PAS Data
Server/Project Name/SICAMAdmin_xxx.
² Right-click the tag.

² Select Properties from the context menu.
The Tag properties dialog opens.

[pascc610, 1, en_US]

Figure 7-33 Tag properties

² Click to open the Limits/Reporting tab and define 3 as start value.

² Click OK to confirm your setting.

Message List Filter

Via the Checkbox message list filter graphic object, you can control for which changes of process data
alarms must be entered in the alarm/event list. In the SicamPas_AlarmListFilter.pas C script, assign the
AlarmListFilter_xxx external administrative tag.

ii NOTE
If you do not use the Checkbox message list filter graphic object, the default settings (all options
selected, time status deselected) are used.

To add the Checkbox message list filter graphic object to your diagram and to assign a tag:
✧ In the Graphics Designer, add the Checkbox message list filter object from the Project Library

\Controls library directory to your diagram.

7.7.3
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[pascc604, 1, en_US]

Figure 7-34 Checkbox message list filter object

ii NOTE
The message list filter is neither effective for SICAM RTUs nor for the direct connection of IEC 61850-/IEC
60870-5-104 devices.

Messages referring to a value change cannot be deselected. They are always entered in the list. Apart from the
Time status, all options are set by default.
✧ Under Global Actions, open the SicamPas_AlarmListFilter.pas C script.

[pascc605, 1, en_US]

Figure 7-35 C Script SicamPAS_AlarmListFilter.pas

The AlarmListFilter_xxx entry must be replaced by the corresponding alarm list filter tag.

Components and Functions
7.7 System Control

328 SICAM, SICAM SCC, Manual
E50417-H8976-C501-B5, Edition 05.2020



✧ Select AlarmListFilter_xxx.
✧ Select Edit > Tag selection.

The tag selection dialog opens.

[pascc615, 1, en_US]

Figure 7-36 Tag Selection dialog

✧ Select the tag (e. g. AlarmListFilter_1011) and click OK to confirm.
The tag is inserted into the C script.

The AlarmListFilter_1011 tag must now be entered as trigger.
✧ In the C script, right-click the AlarmListFilter_1011 tag and select Info/Trigger from the context menu.

The Properties dialog opens.
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[pascc616, 1, en_US]

Figure 7-37 Inserting a Trigger

✧ Select the Trigger tab.
✧ Delete the AlarmListFilter_xxx tag and add the AlarmListFilter_1011 tag.
✧ Click OK to close the dialog.
✧ Compile and save the C script.

Structure of the AlarmListFilter tag

ii NOTE
In order to define a specific filter, you do not need to use the Message list filter checkbox and the global
action. You can set the start value of the AlarmListFilter_xxx tag directly to the desired value.

The value is a bit combination as illustrated in figure 6-36. If the bits have been set, a new message is entered
in the message lists when the corresponding property of an item of information changes.

Table 7-16 Value of the AlarmListFilter tag

Value (decimal) Value (hex) Meaning Selected by default
0 0x00000000 Value (cannot be discon-

nected)
x

1 0x00000001 Status x
2 0x00000002 Location x
4 0x00000004 Cause x
8 0x00000008 ID number x
16 0x00000010 Additional information x
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Value (decimal) Value (hex) Meaning Selected by default
32 0x00000020 Time status
64 0x00000040 Additional cause x

The options marked with an x are predefined by default.

Switching Authority

For the control of switching authorities, use the switching authority tags mapped in SICAM PAS UI – Configu-
ration. These tags are stored among the status tags of the SICAM SCC interface.
The control of the switching authority is only supported for the SICAM PAS target system, but neither for
SICAM RTUs nor for directly connected IEC 61850/IEC 60870-5-104 devices.
Only map the switching authority tags in the monitoring direction.

ii NOTE
In order to be able to control the switching authority, switching authority groups for the SICAM SCC inter-
face must have been assigned in SICAM PAS.

The following 2 graphic objects are available for implementing the switching authority:

• PAS switching authority (Authority checkbox)
All states can be controlled via this checkbox.

• PAS switching authority (Switching authority button)
This button only controls the Near 1/Remote 1 switching.

Switching authority checkbox
This dialog provides the Read and Write buttons.
During runtime,

• the contents of the corresponding switching authority tag can be read in and shown by clicking Read.

• the contents of the checkbox can be written into the corresponding switching authority tag by clicking
Write.

[pascc601, 1, en_US]

Figure 7-38 Switching Authority Checkbox

Switching authority button
This dialog provides a button for switching between Near and Remote during runtime. The button text
changes depending on the current switching authority.

7.7.4
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Near and Remote in this dialog correspond to Near 1 and Remote 1 in the Switching Authority checkbox.

[pascc607, 1, en_US]

Figure 7-39 Switching Authority Button

To add the PAS Switching authority graphic object to your diagram and assign a tag:
² In the Graphics Designer, add the PAS switching authority object from the library to your diagram.

² Assign the PAS switching authority object the corresponding switching authority tag. To do this, right-
click the object.

² Select Properties in the context menu.
The Object properties dialog opens.

[pascc602, 1, en_US]

Figure 7-40 Properties of the PAS Switching Authority Object

² Select Tags from the Properties tab.

² Right-click the Dynamic column in the OutputValue row.

² Select Tag from the context menu.
The tag selection dialog opens.
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[pascc603, 1, en_US]

Figure 7-41 Tag Selection

² Select the desired switching authority tag and click OK.
While the WinCC project is active, the current setting of the switching authority is shown via the PAS
switching authority (PAS switching authority (complete)) object.
 
You can now request a change of the switching authority from SICAM PAS.
² Change the settings in the PAS switching authority object and then click Write to transmit them to

SICAM PAS.
The settings are transmitted to SICAM PAS and checked for reliability. If the requested switching authority is
not permissible, it is reset to the previous value.

ii NOTE
To log the current switching authority setting in the message lists, the switching authority tag in SICAM PAS
UI – Configuration must be mapped to the SICAM SCC Alarm Logging system within the SICAM SCC status
messages.

Bay/Telecontrol Blocking

ii NOTE
The functions described in this section cannot be used for connections via IEC 60870-5-104 and IEC 61850.

Device-Specific Blocking
The functions described in this section are used to block all the information of a device, an interface or an
application in case of a connection to SICAM PAS/PQS.

7.7.5

7.7.5.1
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The following graphic objects are available for controlling the bay/telecontrol blocking:

• Set bay blocking: Click this button to set/reset the bay blocking.

• Set telecontrol blocking: Click this button to set/reset the telecontrol blocking.

• Ignore telecontrol blocking: Click this button to ignore/obey the telecontrol blocking for a control
center.

[pascc611, 1, en_US]

Figure 7-42 Bay/Telecontrol Blocking Graphic Object, Buttons

Depending on the status of the bay/telecontrol blocking, the texts shown on the buttons change during
runtime.
 
The buttons (graphic objects) must be assigned the corresponding device tags.
 
To add the Set bay blocking to your diagram and assign the tags:
² In the Graphics Designer, add the Insert bay blocking button object from the library to your display.

² Right-click the object.

² Select Properties in the context menu.
The Object properties dialog opens.

[pascc612, 1, en_US]

Figure 7-43 Properties of the BayBlockingButton Object

² Select SICAM from the Properties tab.

² Right-click the Dynamic column in the Master BlockOper (*.Value) row.

² Select Tag from the context menu.
The tag selection dialog opens.
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[pascc613, 1, en_US]

Figure 7-44 Tag Selection

² Select the desired BlkOpr.Value tag and click OK.

² Link the BlockAdminXXX attribute to the BlkAdm tag.
Provided that a WinCC project is active, you can now set or reset the bay blocking by means of the Bay
blocking button.
You can insert the Telecontrol blocking button and Ignore telecontrol blocking button graphic objects in
the same way and assign them the same tags. The BlkOpr.Value and BlkAdm tags include information for all
3 graphic objects.
As an alternative to the buttons, you can use the CheckboxBay/Telecontrol Blocking graphic object.

[pascc614, 1, en_US]

Figure 7-45 Bay/Telecontrol Blocking Checkbox Graphic Object

Object-Specific Blocking
To block individual items of process information, you can set/undo a bay blocking/telecontrol blocking on a
switching device object via a status dialog. After setting a bay block this information can also be substituted,
see chapter 4.4.6 Runtime Dialogs of SICAM Switch Controls.
The PAS_SetBlockState_V801 function is available as a C script for the object-specific blocking of other
objects, see chapter 7.6.3 Object-Specific Blocking.

Ignoring Bay Blocking
You can use the Button Ignore Telecontrol Blocking graphic object in order to inform a control center
connection on the interface level that this connection may ignore the telecontrol block.

Triggering a General Interrogation in Case of IEC 61850 Connection

A template for the global action Sicam_IEC61850_DeviceGI.pas for triggering a general interrogation to
directly connected IEC 61850 devices is available in the installation directory of SICAM SCC, PAS subdirectory.
This template is used per device and enables a general interrogation for selected devices.

7.7.5.2

7.7.5.3

7.7.6
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Use this script if a message/measured value blocking, e.g. on a SIPROTEC device, is undone. In this case the
device does not transmit an up to date image, which means that SICAM SCC must perform a general interroga-
tion.
Be aware of the configuration notes within the function.

Changing Device Parameters via IEC 61850

Switching the Parameter Groups

Prerequisites
In DIGSI 5 the Via controller setting must be selected as Active parameter group in the corresponding device
settings.

SICAM SCC functionality
Tags are available for switching the parameter groups. These tags must be imported via the SICAM IEC 61850
Wizard and the SICAM SCC - IEC61850 data mapping Editor and used accordingly.

Table 7-17 Tags for switching the parameter groups

Tags Meaning
Tag extension:

• *.SettingGroup.NumberOfSG
Or as IEC61850 address:

• *.SGCB.NumOfSG

This information tag indicates the number of existing/
possible parameter groups in the device.

Tag extension:

• *.SettingGroup.ActiveSG
Or as IEC61850 address:

• *.SGCB.ActiveSG

This tag exists in:

• Information direction (indicates which param-
eter group is currently active)

• Command direction (activates one/this specific
parameter group)

Switching the parameter group
To switch the active parameter group, you must set the *.ActiveSG command tag to the value of the desired
parameter group:
² To modify the value of the *.ActiveSG command tag, use a SICAM function, see chapter

7.6.1 Commands, or the SICAM measured value with operating script object.

Modifying Individual Device Parameters/Settings Online

Prerequisites
The Block IEC61850 parameter changes option must not be activated in the corresponding device settings in
DIGSI 5.

SICAM SCC functionality
The tags available for online configuration must be imported using the SICAM IEC 61850 Wizard and the
SICAM SCC - IEC61850 data mapping Editor and used accordingly.

7.7.7

7.7.7.1
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Table 7-18 Tags for online configuration

Tags Meaning
Tag extension:

• *.SettingGroup.EditSG
Or as IEC61850 address:

• *.SGCB.EditSG

This command tag is used to select/set the parameter
group to be edited.
If the value 0 is set, all changes are undone or
rejected.

Tag extension:

• *.SettingGroup.ConfirmEdit
Or as IEC61850 address:

• *.SGCB.ConfirmEdit

With this command tag and the value 1 all the
changes performed in the selected parameter group
to be edited are confirmed.

Every parameter has an information tag and a command tag assigned.

Modifying device parameters/settings online
To modify device parameters/settings online:
² To activate the change process, set the *.EditSG command tag to the value of the desired parameter

group.

² To modify one or several parameters, set the corresponding command tag to the desired value.

² To confirm the change, set the *.ConfirmEdit command tag to the value 1.
- or -

² To reject the change, set the *.EditSG command tag to the value 0.
Use a SICAM function to set the *.EditSG and *.ConfirmEdit command tags, see chapter 7.6.1 Commands.
You cannot use the SICAM measured value with operating script object for setting the *.EditSG and
*.ConfirmEdit command tags.
You can use a SICAM function to define individual parameters, see chapter 7.6.1 Commands, or the SICAM
measured value with operating script object.
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SICAM SCC Runtime Data Server
To increase the quantity scopes supported by SICAM SCC, the SICAM SCC Runtime Data Server component
was introduced with Version 8.00. With SICAM SCC V8.00 or higher, up to 20,000 switching device objects per
WinCC project and up to 2,000 controls per picture can be managed with the aid of this component.
The SICAM SCC Runtime Data Server component processes all process data of the SICAM SCC project inde-
pendently of whether they are being shown in the picture or not.
SIMATIC WinCC, Version 7.0 SP3 or higher, is a prerequisite for the SICAM SCC Runtime Data Server compo-
nent.

[Runtime_Data_Server, 1, en_US]

Figure 7-46 SICAM SCC Runtime Data Server

The SICAM SCC Runtime Data Server supplies the controls with the relevant, calculated process data required
for display. The SICAM SCC Runtime Data Server is automatically started and stopped with the WinCC Runtime.
The blinking states between the redundant WinCC servers are compared in redundant SICAM SCC systems.

ii NOTE
You can continue to operate existing SICAM SCC projects of version 7.xx with the current IndustrialX
Controls without using the SICAM SCC Runtime Data Server. In order to continue to use current IndustrialX
Controls (switching device objects) the IX State Sync must also be continue to be used.
The optionally installable IX State Sync redundancy component is entirely replaced by the SICAM SCC
Runtime Data Server and no longer is required when using the ActiveX Controls of V8.0 or higher.

In order to be able to use the SICAM SCC Runtime Data Server for existing SICAM SCC projects, the IndustrialX
Controls (Switch and Bay Overview) must be replaced with the SICAM Switch Controls and SICAM Bay Over-
view Controls.
Using a task available in the SICAM Toolbar you can replace all IndustrialX Controls of a picture at the same
time, see chapter 6.5 Predefined Tasks.

ii NOTE
Be aware that pictures and settings configured under the Bitmap option are not applied for Send QoC in
command value.
Scripts or actions configured for properties or events of the switching device objects are not applied during
conversion. They cannot be applied because the property types and events are not fully compatible. The
scripts and actions must be created again after the conversion.
All further object settings are applied during conversion.

7.8
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Language Settings
Overview

When defining the language for SIMATIC WinCC/SICAM SCC, several system levels are distinguished. The
language must be switched at different locations.

• Language of the WinCC user interface
The language of the WinCC user interface is set in the WinCC Explorer. Any language enabled during the
installation of WinCC can be set for the WinCC user interface.

• Configuration language
The configuration language is set directly in the editor which you are using for configuration, e. g. the
Graphics Designer. You can select further languages as configuration languages in addition to the
languages installed with WinCC.

• Runtime language
The runtime language and the runtime default language are defined via the start configuration of the
runtime computer. You can select further languages as runtime language in addition to the languages
installed with WinCC.

More detailed information on the language setting is available in the WinCC Information System under Start >
SIMATIC > WinCC > WinCC Information System.
Specific graphic objects of SIMATIC WinCC are added to SICAM SCC. The distinction with regard to the
language setting also refers to these additional graphic objects.

ii NOTE
Before the first data import, define the runtime language required for the runtime texts. The configuration
data must be updated with the same language setting in order to ensure that the texts are stored in the
correct language in the SIMATIC WinCC text library.
To use additional runtime languages, the texts in the SIMATIC WinCC text library can be translated into the
corresponding language.
If you switch the runtime language in SIMATIC WinCC, you have to close and re-open the WinCC project
before import/update, in order to get the texts of the import data for the Alarm Logging System to be
written into the text library in the correct language.

Language Setting for SICAM Graphic Objects

Several languages (e. g. English, German) are available by default for the SICAM graphic objects. You can
switch between these languages without any preliminary steps.
It is also possible to use additional languages. To do this, some preliminary steps have to be performed (as
described below).

• SICAM Switch Controls
The texts for the Runtime dialogs of switching device objects, SICAM SCC V8.00 or later (SICAM Switch
Controls), are stored in the SICAMSwitch.xml file. This file includes a block for each language.

• Other SICAM graphic objects
The dialog/menu texts are stored in several text files for the individual languages. For the SICAM add-in
within the Graphics Designer, the SICAMToolbar_xxx.txt file is used. The xxx wildcard is used for the
language code, e. g. 409 for English. During the start-up, SICAM SCC loads these text files and shows the
included texts on the user interface.
The text files consist of individual rows. Each row includes the text ID, one or several space characters
and the text string. The text string is placed between quotation marks; this text is displayed.

The following table indicates for which program interfaces the described language settings are valid and
which text files are available.

7.9
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Table 7-19 Language setting - SICAM graphic objects

Program's User Interface Text File
Runtime dialogs of circuit breakers and disconnectors, SICAM SCC V8.00
or later

SICAMSwitch.xml

Properties dialog for circuit breakers and disconnectors PCCIX_xxx.txt
Runtime dialogs for circuit breakers and disconnectors
Error messages/information regarding circuit breakers and disconnectors
Dialog for defining the properties of the bay overview PASCC_BO_xxx.txt
Error messages/information regarding the bay overview
Toolbar for topological coloring
(in the Graphics Designer)

SICAMToolbar1_xxx.txt

Upgrade Controls dialog
to be opened via SICAM > Upgrade Controls in the Graphics Designer

All languages which can be set as runtime language can be used for texts shown during runtime (e. g. texts in
the runtime dialogs).
All other texts (e. g. texts of the properties dialogs for circuit breakers and disconnectors) can only be shown
in the languages defined for the WinCC user interface.
The texts of the properties dialogs for SICAM graphic objects, SICAM SCC V8.00 or later (SICAM Switch
Controls and SICAM Bay Overview Controls), are not included in the SICAMSwitch.xml file. They are stored in
the SICAMSwitchxxx.lng and SICAMBOxxx.lng language DLLs.

Preparing the language setting
To prepare the language setting:
First, determine the code of the desired language. All available languages are listed in the information system
of SIMATIC WinCC.
✧ To open the information system, click Start > SIMATIC > WinCC > WinCC Information System.
✧ Browse for the term Language code and open the Language code window.

The list shows all available languages with their code (e. g. 0x040A/1034 for Spanish).

Adding the language for Runtime dialogs of switching device objects, SICAM SCC V8.00 or later
The SICAMSwitch.xml file is stored in the following directory: ...\Siemens Energy\SICAM\SCC\bin.
✧ Open the SICAMSwitch.xml file using an XML Editor.
✧ Copy an existing language block.
✧ Enter the language ID of the new language, e.g. 1034 for Spanish.
✧ Enter the texts for the new language.
✧ Save and close the XML file.

Creating language-dependent text files for other SICAM graphic objects
The text files are located in the following directory: ...\Siemens Energy\SICAM\SCC\bin or ..\Siemens\WinCC
\bin.
✧ Copy the SICAMToolbar_409.txt file. 409 is the language code for English.
✧ Rename the file (e. g. to SICAMToolbar_40A.txt for Spanish).
✧ Open the SICAMToolbar_40A.txt file using a text editor.
✧ All texts placed between quotation marks can now be adjusted to the desired language.
✧ Save and close the text file.
✧ Create all other text files, too.
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Language of the WinCC user interface
To define the language of the WinCC user interface, click Tools > Language in the WinCC Explorer. You can
select any language which has been enabled during the installation of WinCC. As soon as you have defined the
desired language, all SICAM graphic objects can be configured in this language.

Switching the runtime language
The runtime language can be selected in the Computer Properties dialog, Parameters tab (see chapter
3.2.3 Defining Computer Properties). The language you select in this tab is used during the start of the
runtime. Alternatively, you can switch the runtime language during runtime (see chapter 7.9.2 Switching the
Language During Runtime).

Switching the Language During Runtime

If you have defined several languages during the configuration of a project, you need to configure a control
element via which the operator can set the desired language during runtime. SICAM SCC includes a pre-config-
ured control element which you can use in your project.
This paragraph explains how to define the switchover to the Spanish language.
For the language switching to function properly, the text files must be available in the ...\Siemens Energy
\SICAM\SCC\bin Spanish directory with the 40A language ID.
 
Proceed as follows to configure the switching of the runtime language:

Adding a control element to a display

² In the Graphics Designer, open the display to which you want to add the control element required for
switching the language.

² Insert the Button select language object from the SICAM graphic object library into your display.

[pascc423, 1, en_US]

Figure 7-47 Language Selection Button

Using the default control element, you can switch between the German and the English language. In order to
be able to define e. g. the Spanish language during runtime, this language must be configured accordingly.

Configuring language switchover
To define an additional option for switching to the Spanish language:
² Copy a button.

² Open the Object properties of the new button.

² Enter the new language for the attribute Text in the Properties tab.

7.9.2
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² Modify the Tooltip Text attribute.

² Customize the Text and Tooltip Text attributes also for the other configuration languages used.

² In the Events tab, double-click Mouse Action.
The Action Editor opens.

[pascc424, 1, en_US]

Figure 7-48 Editing the Action for Switching the Language

² Change the language code to 0x040A for Spanish at two different locations.

² Compile the action and close the editor.

² Save your display.
The configuration of the language switchover is now completed, and you can switch between 3 different
languages during runtime.

[pascc425, 1, en_US]

Figure 7-49 Switching the Language During Runtime
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Communication with SICAM DISTO
TCP/IP Connection

The TCP/IP connection is always set up by SICAM DISTO, i.e. the IEC 61850-Client waits until the connection
has been set up. The Port 5335 used is determined via the service name DISTO61850. This service name must
be entered in the Services file located in the following directory: <WINDIR>\system32\drivers\etc\services.
✧ Insert the following line into the Services file:

DISTO61850 5335/tcp #Disto

ii NOTE
If SICAM DISTO is used on a separate computer, open the DISTO port via firewall rules.

IEC 61850 file transfer mode
The file transfer services are used in order to transmit the fault records from IEC 61850 servers. The protec-
tion line of devices from which fault records are to be requested must be defined as IEC=61850-FT. The
StatNo parameter corresponds to the subsequent calculation of the LAN station number.

Calculation of the LAN station number
The LAN station number to be entered in SICAM DISTO is calculated via the number of the IEC 61850 Data
Server Station and the LAN number of the device to be connected.
StatNo = StatIndex * 512 + LANNo
Significance of the individual elements of the formula:

• StatNo = LAN station number to be entered

• StatIndex = Number of the station in the station list in the IEC 61850 Data Server (SIMATIC WinCC),
starting with 0

• LANNo = LAN number defined for the device, e.g. in the SICAM Toolbox II or in the SICAM IEC 61850
Wizard with direct connection to a IEC 61850 device.

You can view the LAN station number in the parameters of a tag of the corresponding device.

7.10
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[disto_01, 1, en_US]

Figure 7-50 Viewing the LAN station number
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SNMP – SICAM Network Manager (NWM)

Introduction

SNMP objects are managed in a kind of database in each device (agent) to be managed. The database contains
a number of objects which can be read and/or written via the network.

ii NOTE
The SICAM Network Manager requires a separate license.

Management Information Base (MIB)
The Management Information Base (MIB) is most important because it contains all the objects to be
managed for an agent. In order to be able to define SNMP objects, the MIB must be available in both the agent
and the network management system.
The MIB tags are implemented in the agent software and uniquely addressable. All the objects in an agent are
addressed based on a globally unique identification scheme designed as a number string. This number string is
transmitted to the agent when querying an object. As a result of the query, the agent returns the object
contents to the management station.
SICAM SCC also provides a collection of MIB files as a basis for defining the NWM parameters. You can extend
this collection yourself.
The Default_MIB folder is located on the SICAM SCC DVD in the ProductEnhancements folder. Copy this
folder to any drive.

Basic Procedure
The SNMP is configured with the following basic steps:

• Starting the SICAM Network Manager

• Finding and defining agents

• Loading the MIB container file MibSicamSCC.mcf

• Selecting and configuring MIB objects

• The report starts once the configuration has been completed; the parameters are processed and the Tag
Management is updated in the background

• Defining the SNMP IP address in the Tag Management

• Starting the Runtime

ii NOTE
Consider the information in 7.1.3 Configuration for Improved Message Display in the Case of Redundancy.

ii NOTE
To define that the SICAM SCC computer is monitored by a higher-level SICAM SCC using SNMP, open the
SNMP ports via firewall rules.

7.11
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SICAM Network Manager – Dialog

SNMP Agents
In this view you can find and define agents and specify the lined variables (identical with the MIB objects
view).
To specify these linked variables, at least 1 MIB object must have been defined (in the MIB objects view).

[sc_snmp_network_manager, 1, en_US]

Figure 7-51 SICAM Network Manager Dialog, SNMP Agents View

Element Explanation
New... Opens the Edit agent dialog for creating a new agent.
Edit... Opens the Edit agent dialog for editing the agent selected in the list.
De/Activate Activates or deactivates the agent selected in the list. The entry in the Active column

changes to Yes or No.
Delete Deletes the agent selected in the list.

The agent can only be deleted if no variable is linked any more.
Clone... Opens a dialog for cloning the variables of the agents selected in the list to the target

agent.
Import... Opens the file manager for importing from the exported agent.
Export... Opens a dialog for exporting (and thus backing up) agents with variables and objects.
Ping Sends a ping to the agent selected in the list and shows the result (status, response

time).
“Timeout” is shown if the agent cannot be contacted.

Find... Opens the Find agent dialog.

7.11.2
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MIB objects
In this view you can define and edit MIB objects.

[sc_snmp_network_manager_mib, 1, en_US]

Figure 7-52 SICAM Network Manager Dialog, MIB Objects View

Element Explanation
New... Opens the Create new MIB object dialog.
Edit... Opens the Edit MIB Object dialog for editing the MIB object selected in the list.
Delete Deletes the MIB object selected in the list.

The agent can only be deleted if no tag is linked any more.
Import... Opens the file manager for importing the exported objects.
Export... Opens a dialog where you can export objects.

Linked variables
In this window section you can link variables. This is possible in both the SNMP agents and the MIB objects
view.
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[sc_snmp_mib_linked_vars, 1, en_US]

Figure 7-53 Linked variables

Element Explanation
New... Opens the Create new variable dialog.

If you open this dialog from the SNMP agents view, you can only select objects from
the agent selected.
If you open this dialog from the MIB objects view, you can define from which agent
the selected object is to be linked (the same object can exist in several agents).

Edit... Opens a dialog for editing the variable selected from the list. The dialog which opens
depends on the variable type.

Delete Deletes the variable selected from the list.
Delete all Deletes all variables.

Create New Variable – Dialog
With this dialog you create new variables and select the variable type.
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[sc_example_var_new_type, 1, en_US]

Figure 7-54 Create New Variable Dialog

Variable Type Explanation
Binary Value range: 0 or 1

Supports MIB object types Integer, Timeticks, Gauge, and Counter
32 bit, signed Value range: -2 147 483 .48 to 2 147 483 647

Supports MIB object types Integer, Timeticks, Gauge, and Counter
32 bit, unsigned Value range: 0 to 4 294 967 295

Supports MIB object types Integer, Timeticks, Gauge, and Counter
Text tag 8-bit char-
acter set

Supports MIB object types OctetString, Integer, Timeticks, Gauge, and Counter

SNMP Counter Value range: 0 to 4 294 967 295
Provides the change of a MIB variable of MIB object type Integer, Timeticks, or Gauge.
The counter computes the average deviation of 2 values at intervals of its cycle time
and sends it to the runtime.

SNMP Table Not supported in SICAM V9.06
SNMP Trap Supports MIB object type Trap, provides 0->1->0 edges when the Trap arises.

Traps are spontaneous events which only contain information when they arise. Thus,
an incoming variable of type Trap provides 2 signal transitions that are treated like 1
binary variable: 0 -> 1, then immediately 1 -> 0, i.e. a "fleeting indication". To extract
the actually essential information from the Trap (what status really occurred?), the vari-
ables coming along with the Trap should be created. For these variables to be decoded,
the Trap variable has to be defined as described above, even if it is not displayed.
Not supported in SICAM V9.06

ICMP Echo Via the ICMP Echo components can be monitored that do not have an SNMP agent. In
this case, the monitoring is realized via a cyclic ping. The cycle time is derived from the
agent cycle. This variable type provides a result of 0 (echo/ping successful) or 1 (ping
not successful = error).

ii NOTE
When a variable is created, only those variable types are provided which are supported by the MIB objects
(e.g., for the MIB object "OctetString" only the variable type "Text tag 8-bit character set" can be selected).
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Find Agents Dialog
Open this dialog to find an agent.

[sc_snmp_find_agents, 1, en_US]

Figure 7-55 Find Agents Dialog

Element Explanation
Find Starts the search for available agents.

The query can take some time depending on the number of agents. Whether agents
can be contacted via routers depends on the multicast configuration of the routers.
The bar under the button indicates the progress of the search.

Host name If this checkbox is activated, the host name of the IP address found is also searched via
the inverse Domain Name Service. If this checkbox is deactivated or no name server
entry exists, the agent is automatically assigned a name in the following format:
“AGTnnn”.
NOTE: Finding the host name can take several minutes depending on the system
configuration.

as list If this checkbox is activated, the agents found are shown as a list; otherwise, they are
shown as icons.

Edit Agent Dialog
Open this dialog to edit an agent.

Components and Functions
7.11 SNMP – SICAM Network Manager (NWM)

350 SICAM, SICAM SCC, Manual
E50417-H8976-C501-B5, Edition 05.2020



[sc_snmp_edit_agent, 1, en_US]

Figure 7-56 Edit Agent Dialog

ii NOTE
Communication with an IP address ending with .255 is not possible because it is a broadcast address. In
this case, the Runtime uses the previously configured IP address of the agent.
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ii NOTE
For displaying the current status of a device with ComFault and OprReady, you have to configure at least 1
SNMP variable of this device.

Element Explanation
Agent Enter the name of the agent.
IP address Enter the IP address of the agent.
Read community Read access password, default: "public"
Write community Write access password, default: "public"
Sampling cycle You can either apply the default value (0s) or enter a different cycle value (comple-

mented by s, m, h for seconds, minutes, hours) for querying the agent (e.g. 10s =
10 seconds or 1m = 1 minute). The recommended minimum time is 10s. Use the
default value if possible.

Time-out Time during which the system tries to contact the agent. If the connection could not be
set up within this period, the attempt is aborted.

Retries Number of retries to set up a connection with the agent.
Agent active Activates or deactivates the agent.
Agent description
(optional)

Enter a meaningful description of the agent if required.

ComFault, OprReady Select here where you want the ComFault and OprReady information to be issued.
SNMP version Select the encryption: SNMPv1, SNMPv2 or SNMPv3
SNMPv3 parameter If you select the most secure SNMP version (v3), you can define the corresponding

parameters here, such as User name and Context name for accessing the agent as
well as Security Level, Authentication and Privacy (Encryption).

Ping Sends a ping to the agent and shows the result (status, response time).
“Timeout” is shown if the agent cannot be contacted.

SNMPv3

Security
Since the SNMP versions 1 and 2 only provide reduced security mechanisms, the SICAM Network Manager
also supports SNMPv3. This version provides significantly improved security. For this reason, Siemens always
recommends that you use SNMPv3.
Set all the relevant parameters directly in the Edit agent dialog.

7.11.3
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SNMPv3 parameter

[sc_snmp_edit_agent, 1, en_US]

Figure 7-57 Edit agent dialog
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Element Explanation
SNMP Engine ID (as
Octet string)

The SNMP Engine ID serves for the unique identification of the entity. Under SNMPv3,
an entity is an SNMP instance which can serve as a manager, an agent, or as a combi-
nation of both. Click Readout in order to query this ID directly from the agent.

Readout Queries the engine ID directly from the agent and enters it automatically in the SNMP
Engine ID (as Octet string) field.

User name The User name replaces the community strings of the versions v1 and v2c and is an
integral part of the User-based Security Model (USM).

Context name A context can be used in order to combine the management objects of an entity into
logical groups. Several contexts per SNMP entity are possible and these contexts can
also contain identical objects. The Context name serves for unique identification.

Security level Shows the security level used:

• NoAuthNoPriv
No authentication and no privacy (encryption). Corresponds to SNMPv1/ SNMPv2c
security; the user name is used as a community string.

• AuthNoPriv
Authentication is used

• AuthPriv
Both authentication and privacy are used

Authentication
Algorithm Authentication method (MD5, SH1)

Used in the AuthNoPriv and AuthPriv security levels.
Password Authentication password
Visibility... Provides the Show password and Hide password options
Privacy (Encryption)
Algorithm Encryption type

Used with the AuthPriv security level.
Password Encryption password
Visibility... Provides the Show password and Hide password options

Extending the MIB Container

You can complement the MIB file collection by additional MIB files.
² Copy the folder with your new MIBs into the Default_MIB folder (available under any path on your drive,

see Management Information Base (MIB), Page 345).
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[sc_snmp_add_mib1, 1, en_US]

The folder includes an .index file and at least one MIB file.

[sc_snmp_add_mib1b, 1, en_US]

² Click New... in the MIB objects view of the SICAM Network Manager.
The Create new MIB object dialog opens.
² Click Edit.
The MibSicamSCC.mcf container file is opened in the MIB File List Editor.
² Under [Directories] of the file, enter the name of the folder you have added previously and then click OK

to confirm.
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[sc_snmp_add_mib2, 1, en_US]

² In the Loaded column, double-click no in order to load the MIB file.

[sc_snmp_add_mib3, 1, en_US]
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The entry now reads yes and the MIB file is available in the MIB collection.

[sc_snmp_add_mib4, 1, en_US]

Separate Network Card for SNMP

If your computer is equipped with several network cards, you can define a specific IP address for SNMP.
² In the WinCC Explorer, open the Tag Management.

² Right-click SNMP and select Connection parameters from the context menu.

7.11.5
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[sc_snmp_add_ip1, 1, en_US]

The Select IP addresses dialog opens.
² Click New.
The default IP address (<auto>) of your computer is displayed. Via Selected entry you can select another IP
address, if existing.

[sc_snmp_add_ip2, 1, en_US]
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Configuring SNMP (Example)

Defining Agents

² In the WinCC Explorer, open the SICAM Network Manager.

[sc_example_open_nwm, 1, en_US]

² Click Find... in the SNMP agents view in order to open the Find agents dialog.
Click Find in the dialog.

All available agents are displayed.

7.11.6
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[sc_example_find_agent, 1, en_US]

² Double-click the desired agent (here: AGT004).
The Edit agent dialog opens (see Edit Agent Dialog, Page 350).
² If desired, enter a different name in the Agent field.

² For Read community and Write community, enter the "public" default entry.

² Select where you want the ComFault and OprReady information to be issued, e.g. in the Tag Manage-
ment.

² Change further parameter settings if required.
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[sc_example_edit_agent, 1, en_US]

² Click OK to close the Edit agent dialog.

² Click Close to close the Find agents dialog.
The agent is now shown in the SICAM Network Manager, SNMP agents view.

Components and Functions
7.11 SNMP – SICAM Network Manager (NWM)

SICAM, SICAM SCC, Manual 361
E50417-H8976-C501-B5, Edition 05.2020



[sc_example_nwm_with_agent, 1, en_US]

Configuring MIB Objects

² In the WinCC Explorer, open the SICAM Network Manager.

² Open the MIB objects view and click New....
The Create new MIB object dialog opens.

7.11.6.2
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[sc_example_mib_objects, 1, en_US]

² Click File, navigate to the MIB file folder and select the MIB container file MibSicamSCC.mcf.
This file contains a collection of all the MIB files included.

² Click Open.
All available MIB files are read in and all MIB objects are shown in the Create new MIB object dialog.

ii NOTE
If you have several MIB files with different versions, activate only 1 of these MIB files.
Select the desired objects from this file. Afterwards, you can open the dialog once again and load the other
MIB file.

² Click Read agents....
The Read all MIB variables dialog opens.
² Select your desired agent from the drop-down list box and then click Read agents.
Under Objects you can observe how the objects are read in.
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[sc_example_mib_read_agent, 1, en_US]

² Select the desired object and click Add....
The Edit MIB Object dialog opens.

[sc_example_mib_edit_object, 1, en_US]

² You can change the Object name here, if required. Assign name automatically is activated by default.

² Click Add and then click OK to confirm that you really want to add the object.
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² Click Close to close the Edit MIB Object dialog.

² Repeat these steps to add additional MIB objects, if required.

² Click Close to close the Read all MIB variables dialog.

² Click Close to close the Create new MIB Object dialog.
The MIB object is now shown in the SICAM Network Manager, MIB objects view.

[sc_example_nwm_with_mib_object, 1, en_US]

Creating Linked Variables

² In the WinCC Explorer, open the SICAM Network Manager.

² In the MIB objects view under Linked variables, click New....
The Create new variable dialog opens.

7.11.6.3

Components and Functions
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[sc_example_var_new_type, 1, en_US]

² For this example, select Text 8-bit character set and click OK.
The dialog for configuring the variable (here: Text variable 8-bit character set) opens.

[sc_example_var_config, 1, en_US]

² Select the desired Agent from the drop-down list box.

² Click Add and then click OK to confirm that you really want to add the variable.

Components and Functions
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² Click Close.
The variable is now shown under Linked variables.

[sc_example_var_linked, 1, en_US]

² Click Apply to apply the parameters for the linked variable.

² Repeat these steps to add additional linked variables, if required.

² Click OK to close the SICAM Network Manager.
The parameters are processed in the background and the Tag Management is updated. The "NWCCM shutting
down” message in the Report in the SNMP-Config view informs you that the update has been completed.

Components and Functions
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[sc_example_var_report, 1, en_US]

Starting the Runtime and Opening the Tag Management

² Start the Runtime in the WinCC Explorer.

² In the WinCC Explorer, open the Tag Management.

² Select your agent under SICAM SNMP Suite > SNMP Data Server > SNMP.
The linked objects are displayed.

[sc_example_var_managment, 1, en_US]

7.11.6.4

Components and Functions
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Configuration of the Graphic Objects

[client_serv01, 1, en_US]

Figure 8-1 Showing a server diagram on the client computer

Diagrams from various different servers can be viewed in individual screen sections. These so-called "picture
windows" are displayed in the basic frame configured on the client computer. The diagrams configured on the
servers are displayed in diagram windows. Each diagram is based on the data of an individual server. In order
to be able to integrate a server diagram as a picture window in a basic frame on the client computer, the file
name of the diagram must be preceded by the prefix of the server name. All server prefixes must be unique
within the distributed system.
The packages of the corresponding servers must be imported into the client.
² Open the basic frame on the client into which you want to insert the server diagram as picture window.

² In the Graphics Designer, select the Picture window from the group of smart objects. Insert it into the
basic frame.

² Double-click the picture window to open the Properties dialog.

² In the Miscellaneous group of the Properties tab, click the Picture name attribute in order to browse for
the diagram.

² Double-click the Server prefix attribute to browse for the server.

² Close the Properties dialog.
On the client, you can also create and show diagrams based on data from several different servers.

ii NOTE
On the server computer, you create the server packages in the WinCC Explorer under the Server level. On
the client computer, you import the server package in the WinCC Explorer under the Server level (see
chapter 8.3 Configuration of the SIMATIC WinCC Components and WinCC Information System).

8.1

Client-Server Systems
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Configuration of the Functions
When importing data, the compatibility key script (SICAMPAS_CompKey.pas), the alarm list filter script and
several other scripts are created in the PAS directory of the WinCC project directory. Scripts in this directory are
executed by all computers of the project.
For efficient system operation, move the scripts SICAMPAS_CompKey.pas and SicamPAS_AlarmList-
Filter.pas into the corresponding PAS directories of those computers in the project which are interfaced to the
process.

ii NOTE
During each import, the SICAMPAS_CompKey.pas script is created again by the SICAM PAS Wizard.

The WinCC project directory holds a subdirectory (<Computer Name>) for each computer in the project. This
subdirectory comprises the same subdirectories as the project directory. Data located in these subdirectories is
only assigned to the individual computer.

8.2
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Configuration of the SIMATIC WinCC Components
Picture Cache

The diagrams from a connected server can be shown in a picture window on a client computer. For a speedy
build-up of the diagram on the client computer, the corresponding diagrams should be copied into a Picture
Cache on the client. When using a Picture Cache, the WinCC client does not need to reload all individual
diagrams from the server.
Proceed as follows to set up a picture cache on the client computer:
The necessary pictures must be stored on the Client computer which shall use the picture cache.
² To do this, create the PDLCache directory within the <InstallationDirectory\bin> directory on this

computer and copy the pictures into this folder.
This folder is stored as the standard directory in the WinCC project. If you select a different directory, you
enter this directory in the Path input field. Enter the path to the directory in which the PDLCache directory
is stored.

² Copy the diagrams into this folder in order to show them on the client computer.

² Open the Computer Properties dialog on the client.

² Select the Runtime tab.

8.3
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[client_serv02, 1, en_US]

Figure 8-2 Defining a picture cache

² Enter the path of the picture cache under Path.

² Select Preferred from the Use cache list box.
Modified diagrams are read from the server; unmodified diagrams are read from the picture cache.

If a diagram is modified in the project on the server, it has to be manually copied into the picture cache of the
client.

Update: example of SICAM PAS data
Changes performed in SICAM PAS must be forwarded to SICAM SCC. For a client-server system, changes must
be forwarded as described below.

Client-Server Systems
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ii NOTE
The export of the first package from the server and the import into a client have to be performed manually.
All further updates of the packages on the server and the client can be performed automatically. You can
define when the package is to be updated and specify a trigger event.
For more detailed information, refer to the WinCC Information System.

² Import the new PXD file created with SICAM PAS into the WinCC server.

² Create a package on the server.
To manually load a package onto the client:
² Open the client project on the client computer.

² In the WinCC Explorer, select Server data and then select Load from the context menu. The Open File
dialog displays.

² Select the package to be loaded and click OK.
By default, the server packages are saved in the directory ...\\<Server Project Name>\<Computer Name>
\Packages\ under the name <Project Name_Computer Name>*.pck. You can also load packages saved
on any other data carrier.

² Click Open. The data is loaded.
To manually update a package on the client:
² Open the client project on the client computer.

² In the WinCC Explorer, select Server data and then select Update from the context menu.
The data is updated.

Client-Server Systems
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Overview
For safety reasons, a SICAM PAS system and SICAM RTUs can be implemented in redundant configuration. If
required, certain components can be implemented redundantly depending on the specific requirements of the
individual system. This section describes how to define the configurations illustrated below.

• Redundant SICAM PAS systems and SICAM RTUs are connected to 1 SICAM SCC Human-Machine Interface
(HMI).

• 1 SICAM PAS system/SICAM RTUs are connected to 2 redundant SICAM SCC HMIs.
Further redundant configurations are possible. For example, redundant SICAM PAS systems/SICAM RTUs can
also be combined with a redundant SICAM SCC system.
For more detailed information on redundancy, refer to the SIMATIC WinCC documentation.

ii NOTE
Make sure you also read 7.1.3 Configuration for Improved Message Display in the Case of Redundancy.

9.1

Redundancy
9.1 Overview
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Settings recommended for SICAM SCC in the WinCC Redundancy

[SCC_Redundancy_settings, 1, en_US]

Figure 9-1 WinCC Redundancy Settings Recommended for SICAM SCC
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Redundancy with a SICAM PAS System

Connection to 2 SICAM PAS Systems

A SICAM PAS system can consist of 2 redundant SICAM PAS systems running in parallel. Bay devices and
substations are connected to both SICAM PAS systems, and SICAM SCC is connected to both SICAM PAS
systems via the SICAM PAS PROTOCOL SUITE (SICAM PAS channel DLL). For a redundant SICAM PAS system,
the connection of SICAM SCC is active parallel to both SICAM PAS systems.

[Kanal_dll_a, 1, en_US]

Figure 9-2 System with redundant SICAM PAS Full Servers

Activating redundancy

ii NOTE
With SICAM PAS V8.00 or higher, the redundancy parameters are entered automatically.

Proceed as follows to activate the redundant configuration:
² In the WinCC Explorer, right-click PAS Data Server and select Properties from the context menu.

The Channel Unit Properties dialog opens.

² Click Properties.
The Connection properties dialog opens.

² Click Properties.
The PAS Connection dialog opens.

9.2

9.2.1

Redundancy
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[pascc404, 1, en_US]

Figure 9-3 Activating redundancy

² Select the Connection type.

² Enter the IP address of the second SICAM PAS system.
The IP addresses must correspond to the IP addresses configured for the SICAM SCC interfaces in SICAM PAS.
The ports must match the ports parameterized in SICAM PAS.
The Test frame period must correspond to the Test frame period parameterized in SICAM PAS for SICAM SCC.
² Click OK to confirm your settings.

Redundant SICAM SCC System

A redundant system consists of SICAM SCC Servers which run in parallel. Each SICAM SCC provides a SICAM
PAS PROTOCOL SUITE connection to the SICAM PAS system.
The first SICAM SCC (e.g. WinCC1) is the Master Server, and the second one is the redundant Partner Server.
Both connections are active in case of fault-free operation.
The SIMATIC WinCC redundancy package for data synchronization and for the control of the server redun-
dancy must be installed on both SICAM SCC servers.

9.2.2

Redundancy
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[Kanal_dll_1, 1, en_US]

Figure 9-4 System with redundant SICAM SCC

Configuring SICAM PAS
In SICAM PAS, you must enter the IP addresses of the two SICAM SCC computers.
Proceed as follows:
² To open SICAM PAS UI – Configuration, click

Start > Siemens Energy > SICAM > PAS > UI – Configuration.

² Insert an SCC application, an interface and a control center.

² Under Interface, enter the IP address of the Full Server via which you want to communicate with SICAM
SCC.
This is particularly important for Full Servers with several network cards.

² Under Control center, enter the IP addresses of the two SICAM SCC computers.

Redundancy
9.2 Redundancy with a SICAM PAS System
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[sc_first_dip, 1, en_US]

Figure 9-5 Control center, entering IP addresses

² The items of information to be used in SICAM SCC must be activated in the information mapping.

Exporting data
To import the configured items of information into SICAM SCC, they must be exported from SICAM PAS UI –
Configuration.
² Right-click Control Center and select Export from the context menu.
The export function creates a PXD file in the selected directory. Afterwards, you can import this file into SICAM
SCC using the SICAM PAS Wizard.
² Export the configuration data.

Creating WinCC projects

² Create a new WinCC project (e.g. SCC 1) on the first computer.

² Import the PXD file of the first DIP using the SICAM Import/Export Wizard.

² Close your WinCC project.
Create the redundant WinCC project via the Project Duplicator. It must be saved on a second computer.
² To start the Project Duplicator, click Start > SIMATIC > WinCC > Tools > Project Duplicator.

² Enter SCC 1 as source project.

² Enter a name for the redundant WinCC project (e. g. SCC 2).

² Click the Duplicate button. The redundant WinCC project is created now.

ii NOTE
To start the SIMATIC WinCC Runtime, the 2 WinCC servers must be started one after the other. Start the first
server and then start the second. For more detailed information, refer to the SIMATIC WinCC Information
System.

Redundancy
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Redundancy with SICAM RTUs
The connections between SICAM SCC and the devices of SICAM RTUs can be established on the basis of the IEC
61850 or IEC 60870-5-104 protocols. This section describes the procedure to be applied if the IEC 61850
protocol is used. The same procedure is applied to the IEC 60870-5-104 protocol.

Connection to Redundant SICAM RTU Substation Controllers

SICAM RTUs can be operated redundantly in order to ensure fail safety. Via the SICAM IEC COMMUNICATION
SUITE (SICAM IEC channel DLL), SICAM SCC is connected to both SICAM RTUs.
In case of redundant SICAM RTUs, the SICAM SCC connection to the two SICAM RTUs is active at the same
time.
For SICAM RTUs, redundant and non-redundant devices can be operated in parallel.

[Kanal_1703_dll_a, 1, en_US]

Figure 9-6 System with redundant SICAM RTUs and redundant bay devices

Redundancy and connection parameters
The redundancy and connection parameters (e.g. IP addresses) are defined using the SICAM TOOLBOX II
and integrated into the SICAM SCC project by importing the SXD file.

Redundant SICAM SCC System

A redundant system can consist of 2 SICAM SCC servers running in parallel. Each SICAM SCC provides a SICAM
IEC COMMUNICATION SUITE (SICAM IEC channel DLL) connection to the devices.
One SICAM SCC (e.g. WinCC1) is the Master serverand the other SICAM SCC (e.g. WinCC2) is the redundant
partner server. Both connections are active in case of fault-free operation. Commands are only issued by the
Master server
The SIMATIC WinCC redundancy package for data synchronization and for the control of server redundancy
must be installed on both SICAM SCC servers.

9.3

9.3.1

9.3.2

Redundancy
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[Kanal_1703_dll_1, 1, en_US]

Figure 9-7 System with redundant SICAM SCC

Creating WinCC projects

✧ Create a new WinCC project (e.g. SCC 1) on the first computer.
✧ Import the SXD file using the SICAM IEC Wizard.

The SXD file was exported from SICAM TOOLBOX II.
✧ Close the WinCC project.

Create the redundant WinCC project using the Project Duplicator. It must be saved on a second computer.
✧ To start the Project Duplicator, click Start > SIMATIC > WinCC > Tools > Project Duplicator.
✧ Enter SCC 1 as the source project.
✧ Enter a name for the redundant WinCC project (e.g. SCC 2).
✧ Click Duplicate. The redundant WinCC project is created now.

Synchronization of SICAM acknowledgment data
SIMATIC WinCC supports the synchronization of data between redundant servers. In order to ensure that the
data of the SICAM SCC components can be synchronized between the redundant servers, be aware of the
following:

• For the IX State Sync application, the same rules apply for SICAM RTUs and SICAM PAS/PQS systems, see
14.5 IX State Sync Application.

Redundancy
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Overview
Several SICAM PAS systems in different versions can be connected to a SICAM SCC. Special SICAM PAS chan-
nels are available for this purpose.

10.1

Different SICAM PAS Versions
10.1 Overview

386 SICAM, SICAM SCC, Manual
E50417-H8976-C501-B5, Edition 05.2020



Introduction
The SICAM PAS and SICAM SCC substation automation system communicate with each other via a channel in
SIMATIC WinCC. The SICAM PAS Protocol Suite uses components of the SICAM PAS system for communication.
The versions of all components involved must be identical. A SICAM PAS Protocol Suite can only establish a
connection to a specific SICAM PAS version.
For SICAM PAS CC/SICAM SCC V7.0 and higher the SICAM PAS channel supports the connection to SICAM PAS
V7.0 and higher. Starting from these versions, a mixed-versions operation is possible with the SICAM PAS
Protocol Suite standard channel.
For the extension of existing systems or upgrades of the SICAM SCC computer, such as a new SIMATIC WinCC
version, it might be necessary to connect the SICAM PAS system of an older version or several SICAM PAS
systems of different versions to a SICAM SCC.
In these cases, special SICAM PAS channels are available for the connection to SICAM PAS V5.11 and SICAM
PAS V6.00. In the SIMATIC WinCC Tag Management, you can load the SICAM PAS Protocol Suite V5 or the
SICAM PAS Protocol Suite V6. Afterwards, during the data import using the SICAM PAS Wizard, select the
desired Channel PAS Data Server V5 or Channel PAS Data Server V6.
The SICAM PAS Protocol Suite included in the scope of delivery is intended for applications from V7 or appli-
cations with consistently identical software versions. In the SICAM PAS Wizard, you use the Channel PAS Data
Server. For this channel, in case of an upgrade of SICAM PAS or SICAM SCC, the integrated components of the
basic software are automatically exchanged in order to ensure that the project can be further edited immedi-
ately after the upgrade and without any further configuration efforts.
If data was imported into a version-specific channel or if data has to be moved to such a channel, the configu-
ration must be modified accordingly. Data which you have imported into a channel is saved in the SIMATIC
WinCC database with its ID.
For WinCC V7.3 and higher, this exchange can be done in the Configuration Studio. To do so, select the
communication connection and change the communication driver in the properties.
During the upgrade from SICAM PAS V5.11 to V6.00/V7.00/V8.00, not all the conversion which would be
necessary to support new functions can be performed automatically.

10.2

Different SICAM PAS Versions
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Use Cases from Daily Practice
This paragraph provides a list of different examples from daily practice. Depending on the change (extension/
upgrade) to be performed on the system, a channel may or may not be exchanged.
You can exchange the channel using the Configuration Tool, see 14.8 Working with the SIMATIC WinCC
Configuration Tool.

• Upgrade of an existing SICAM PAS/SICAM PAS CC project
– Upgrade of SICAM PAS and SICAM PAS CC

Initial configuration: SICAM PAS V5.11/V6.xx with SICAM PAS CC V5.11/V6.xx
Target configuration: SICAM PAS V7.00 with SICAM SCC V8.04
With this upgrade scenario, a channel exchange is not necessary.

– Upgrade of SICAM PAS CC
Initial configuration: SICAM PAS V5.11/V6.xx with SICAM PAS CC V5.11/V6.xx
Target configuration: SICAM PAS V5.11/V6.xx with SICAM SCC V8.04
With this upgrade scenario, the default channel must be replaced with the version-specific V5/V6
channel.

• Connection of an additional SICAM PAS station with a different version
– Integrating a SICAM PAS V7.00/V8.00 station into an existing SICAM PAS/PAS CC V5.11 system.

Initial configuration: SICAM PAS V5.11 with SICAM PAS CC V5.11 and a new SICAM PAS V7.00/ V8.00
station
Target configuration: SICAM PAS V5.11 and SICAM PAS V7.00/V8.00 with SICAM SCC V8.04
For SICAM PAS CC, an upgrade from V5.11 to SICAM SCC V8.04 must be performed. With SICAM PAS
V7.00/V8.00, the default channel is used.
With SICAM PAS V5.11, the default channel must be replaced with the version-specific V5 channel.

– Integrating a SICAM PAS V7.00/V8.00 station into an existing SICAM PAS/PAS CC V6.xx system
Initial configuration: SICAM PAS V6.xx with SICAM PAS CC V6.xx and a new SICAM PAS V7.00/ V8.00
station
Target configuration: SICAM PAS V6.xx and SICAM PAS V7.00/V8.00 with SICAM SCC V8.04
For SICAM PAS CC, an upgrade from V6.xx to SICAM SCC V8.04 must be performed. With SICAM PAS
V7.00/V8.00, the default channel is used.
With SICAM PAS V6.xx, the default channel must be replaced with the version-specific V6 channel.

– Re-integrating an existing SICAM PAS V5.11/V6.xx station into a SICAM SCC V8.04 project
Initial configuration: SICAM PAS V7.00/V8.00 with SICAM SCC V8.04 and a separate SICAM PAS
V5.11/V6.xx station
Target configuration: SICAM PAS V5.11/V6.xx and SICAM PAS V7.00/V8.00 with SICAM SCC V8.04
With SICAM PAS V7.00/V8.00, the default channel is used. With SICAM PAS V5.11/V6.xx, the version-
specific V5/V6 channel is used instead of the default channel.

10.3
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• Integrating different SICAM PAS stations
– Initial configuration:

The original project was based on SICAM PAS V5.11 and SICAM PAS CC V5.11. In the first expansion
stage, it was complemented by a SICAM PAS V6.xx station. In the second expansion stage, the
project must be complemented by another station based on SICAM PAS V7.00/V8.00.

– First expansion stage:
SICAM PAS V5.11, SICAM PAS V6.xx with SICAM PAS CC V6.xx For communication with SICAM PAS
V5.11and SICAM PAS V6.xx, the version-specific V5 and V6 channels are used.

– Second expansion stage, target configuration:
The existing project is complemented by a SICAM PAS V7.00/V8.00 station. For SICAM PAS CC, an
upgrade from V6.xx to SICAM SCC V8.04 must be performed. The communication for the first two
SICAM PAS stations remains on the version-specific V5 and V6 channels. The default channel is used
for communication with the new SICAM PAS V7.00/V8.00 station.

Different SICAM PAS Versions
10.3 Use Cases from Daily Practice
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Overview
Using the WinCC Web Navigator, you can operate and monitor a WinCC project from anywhere in the world
via the Internet.
The WinCC Web Navigator includes special Web Navigator Server components installed on the server
computer, as well as Web Navigator Client components running on the Internet computer.

ii NOTE
SIMATIC WinCC Web UX cannot be used with SICAM SCC with SICAM Switch, Bay Overview or Numeric
Controls. Web UX does not support the ActiveX technology.

11.1

WinCC Web Navigator
11.1 Overview

392 SICAM, SICAM SCC, Manual
E50417-H8976-C501-B5, Edition 05.2020



Prerequisites
A Web Navigator Server and a Web Navigator Client are required in order to implement the WinCC Web Navi-
gator function. To use the WinCC Web Navigator for SICAM SCC, certain prerequisites must be met.

Web Navigator Server
The following requirements must be met by the computer used as a Web Navigator Server:

• SICAM SCC installed

• Web Navigator Server installed

• a user with Web Navigator rights installed

• a WinCC project installed and enabled for the WinCC Web Navigator

Web Navigator Client
The following requirement must be met by the computer used as a Web Navigator Client:

• Microsoft Internet Explorer installed
For more detailed information on the requirements with regard to the WinCC Web Navigator, refer to the
documentation and the online help of the Web Navigator. The section below describes the actions to be taken
especially for SICAM SCC.

ii NOTE
The display on the Web Navigator Client can be hidden or restricted by your browser's security settings.

Special characters
If you use scripts in your pictures, the names of the objects addressed by this script must not include blanks or
special characters. The special character "_" is supported. This means that you may use the special character in
the object name, e.g. StartPicture_1.

11.2

WinCC Web Navigator
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WinCC Web Navigator with SICAM SCC
To use the WinCC Web Navigator for SICAM SCC, certain prerequisites must be met. These prerequisites are
illustrated in the present section and must be executed in the order described.

Making SICAM SCC Plug-Ins Available

WinCC Web Navigator Server
The SICAM SCC setup installs the SICAM SCC software modules (plug-ins) for the WinCC Web Navigator in the
corresponding directory of the WinCC Web Navigator installation.
If the WinCC Web Navigator was installed after SICAM SCC, you must make the SICAM SCC software modules
for the WinCC Web Navigator Client available on the WinCC Web Navigator server computer.
If the WinCC Web Navigator server has already been installed before installing SICAM SCC, the files are copied
from the SICAM SCC setup into the WinCC Web Navigator server target directory.
Upon the installation of SICAM SCC, the SICAM SCC software modules for the Web Navigator are additionally
copied into the SICAM SCC installation directory on the hard disk. Afterwards, you can copy them from the
hard disk into your SIMATIC WinCC installation.
✧ Copy the WebNavClientSICAMSCCVxxx.EXE and the

WebNavClientSICAMSCCVxxx.XML files from the ...\SCC\WebNavigator\Server\Web\Install\Custom
directly into the ...\WinCC\WebNavigator\Server\Web\Install\Custom directory.

Web Navigator Client
On the Web Navigator Client computer, you must download the SICAM SCC software modules for the Web
Navigator from the Web Navigator Server and install them (see chapter 11.3.5 Configuring the WinCC Web
Navigator Client).

Publishing Process Diagrams

To make sure that the WinCC Web Navigator can show the process diagrams of the WinCC project, these
diagrams must be published on the Web Navigator Server.
To publish the process diagrams:
² In the WinCC Explorer, now open the WinCC project which you want to show using the WinCC Web Navi-

gator.

² In the WinCC Explorer, right-click Web Navigator and then select Web View Publisher from the context
menu.
The Web Publishing Wizard opens.

11.3
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Figure 11-1 Selecting Process Diagram Directories

² Enter the name of the directory which holds the process diagrams of the WinCC project (...\projectpath
\projectname).

² Enter the name of the Web access directory (...\projectpath\projectname\WebNavigator).

² Click Next. The diagram selection dialog is displayed.

² Select all diagrams.

² Click Next. The function selection dialog is displayed.

WinCC Web Navigator
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Figure 11-2 Selecting a Function

² Select all SICAM PAS, SICAM SCC and self-created functions.

² Click Next.
The selection dialog of the referenced graphic diagrams opens.

² Click Next.
² Click Finish.

The diagrams are published and available for display via the Web Navigator.

Installing Users for the WinCC Web Navigator

In SIMATIC WinCC, you must install a special user which is allowed to access the Web Navigator Server from
the Web Navigator Client.
To install a user for the WinCC Web Navigator:
² Set up a new user.

11.3.3
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Figure 11-3 Setting up New Users

² Select WebNavigator.
The Web Options are displayed.

² Select a published diagram (e.g. ROOT.PD_) as a start picture.

² Select the rights of the individual user.

ii NOTE
If the function number 1002 – Web Access – monitoring only – is activated, the user is only allowed to
monitor the WinCC project as a Web Navigator Client.
In order to display it in the SICAM Controls dialogs, an authorization must have been configured for the
Control.

Configuring the WinCC Web Navigator Server

Generate a web site on the WinCC Web Navigator Server and make it available to the Web Navigator Client.
² Start your WinCC project.

² In the WinCC Explorer, right-click Web Navigator and select Web Configurator from the context menu.
The WinCC Web Configurator opens.

² Click Next.

11.3.4
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Figure 11-4 Configuring the WinCC Web Navigator

As a rule, you can perform the specified settings in this dialog.
² Click Finish to finish the configuration of the server.

Configuring the WinCC Web Navigator Client

Installing Plug-ins
To install the SICAM SCC plug-ins on the client computer:
² Start the Internet Explorer.

² Enter the IP address of the server computer.

² Enter the WinCC user name and the password which have been previously set up on the server.

² Click OK to confirm.
The connection to the Web Navigator Server is established.
² Install the Web Navigator-Client.
² Navigate to the Download Area > Download Plug-Ins.

11.3.5
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Figure 11-5 Web Navigator, Installing Plug-ins

² Click the arrow under Version Install.
² Click Open in the dialog which opens. The plug-ins are installed.

² After the installation in the Windows Explorer, open the path C:\Program Files (x86)\Common Files
\Siemens\Bin (for Windows 32-bit C:\Program Files\Common Files\Siemens\Bin) and execute the
SCCCommon.bat file with administrator rights.

ii NOTE
The SICAM SCC WebPlugIn requires the Microsoft .NET Framework 4.7.2 and the Visual C++ runtime
components.
If the Visual C++ runtime components do not exist on your computer, you can install them from the SICAM
SCC DVD (..\SetupData\InstallationData\Prerequisites\vcredist_x86_xxxx.exe).

Displaying a Process Diagram
The WinCC project must have been started on the Web Navigator Server in order to display the process
diagram on the Web Navigator Client.
² Navigate to Process Diagrams. The process diagram is shown in the browser.

ii NOTE
Use the Logon and Logoff hotkeys in order to change the user on the Web Navigator Client. The hotkeys
are defined in the Project Properties, see 3.2.2 Defining Project Properties.

WinCC Web Navigator
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Overview
The time information for SICAM SCC can be updated by downloading the IANA time zone database.
In the SICAM SCC system, a correct time is very important. A radio clock can be used as timer. The time of this
clock is distributed over the system. The functionality of time distribution will be described by means of
example configurations.

12.1
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Updating Time Zones
In the IANA time zone database the time zone information of the world is maintained. This includes changes
caused by political decisions regarding time zone boundaries, UTC deviations, and changes between daylight
saving time and standard time. By downloading this time zone information you can update the time zone
information in the SICAM system.
To update the time zone information:
² Open the Internet site http://www.iana.org/time-zones.

² Download the current version of the time zone file tzdata20xxx.tar.gz, e.g.: Time Zone Data v. 2014g
(Released 2014-08-28) tzdata2014g.tar.gz (278.2kb)

² Open the directory where the program for updating the time zone information is located.
– For Windows 32-bit operating system:
   %CommonProgramFiles%\Siemens\Energy\TimeZoneCalculations\bin
– For Windows 64-bit operating system:
   %CommonProgramFiles(x86)%\Siemens\Energy\TimeZoneCalculations\bin

² Highlight the TimeZoneDataUpdater.cmd file and select Run as administrator from the context menu.
The command line tool opens.

² In the following dialog, navigate to the downloaded time zone file and open it.
The update of the time zone information is started.

² Click OK to close the program.
After the update the runtime loads the new time zone data within one hour. You do not have to shut down or
reboot the system.

12.2
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Time Synchronization
Time information within a SICAM SCC system can be synchronized as follows:

• Through an NTP clock (for example, SICLOCK, Hopf Time Server, and Meinberg Time Server), an external
device connected to the SICAM PAS/PQS computer through Ethernet.

• Through a remote terminal interface from the control center.from the control center.
This time synchronization method is not relevant for SICAM SCC.

The time synchronization of SICAM SCC is based on the NTP(Network Time Protocol) and the corresponding
NTPD (Network Time Protocol Daemon) software. Under a Windows operating system, the NTPD service runs
in the background. For the installation of SICAM PAS/PQS, it is referred to as the Network Time Protocol
Service It is configured by means of thentp.conf ASCII file. To edit this configuration file, Siemens recom-
mends a text editor with the YAML markup language support, for example, Notepad++. Using this editor,
comments and entries are displayed in different colors. The configuration file is located in the Windows direc-
tory, subfolder \drivers\etc\, for example: C:\WINNT\system32\drivers\etc\.

ii NOTE
Windows 7, Windows Server 2008 and Windows Server 2012 do not allow to edit the ntp.conf file
directly within the Windows directory.
If you use one of these operating systems, copy the ntp.conf file to another directory (outside of the
Windows directory), for example to the desktop. Edit the copied file there and save it to the Windows direc-
tory afterwards, overwriting the existing file.

The NTPD is automatically installed together with SICAM PAS/SICAM SCC. It is activated upon a restart of the
computer.
In a SICAM SCC system, several NTPDs are simultaneously active (for example, on the external radio clock, the
SICAM PAS/PQS, and the SICAM SCC computer). An NTPD can be configured as a Server or as a Client. Upon
the request of a Client, the Server communicates its time information to the Client.
Based on NTP, a precision of approximately 0.1 ms can be achieved under a Windows operating system. In
order to achieve this high precision, the system's NTPDs must perform extensive calculations. This process can
take several hours after the system starts. If the current Time Master fails, the NTPDs use the time data deter-
mined in order to keep an utmost level of time precision for as long as possible.
For more detailed information on NTP, refer to the following web site: http://www.ntp.org.

Network Time Protocol Daemon

For the configuration of the NTPD, knowledge about its main functions is required. Some NTPD functions and
terms are illustrated below.

Server, Client, and Peer
An NTPD can be configured as a Server or as a Client. The Server uses the current time information received
from a clock. The Clients poll the time information from the Server.
Besides this, an NTPD can be configured as a Peer. This is the case if several clocks with the same priority exist
in a distributed system. The roles (Server/Client) of the individual NTPDs are not specifically defined. The peers
communicate among each other in order to determine the quality of their time signal. The NTPD of the peer
with the most precise time signal is the Server.

Stratum, Offset, and Dispersion
The NTP time distribution is based on a hierarchical structure. Time information is distributed from the top
level down to the lower levels. A level is referred to as a stratum. The clock is the top level and is referred to as
Stratum 0. The Time Server, which receives its time information directly from the clock, is assigned Stratum 1.
The Server, which acts as a Client of this Server is assigned Stratum 2.

12.3
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The offset is the difference between the Client clock and the Server clock. The NTPD tries to keep the offset as
small as possible. The offset is the most important criterion for the determination of the quality of time infor-
mation.
The dispersion is another criterion used for quality determination. The dispersion defines the upper limit for
the deviation of the system time from the 'real' clock time. The smaller the dispersion, the higher is the quality
of the time information.

Quality of Time Information
During the SICAM PAS/PQS Runtime, the delivered time stamp is assigned a quality for the determination of
the system time. The following 4 quality levels can be assigned:

• High means that the system time deviates from the 'real' clock time by less than 10 ms and that the
quality of the time sources is sufficient for this determination. A dispersion of less than 10 ms is sufficient
to meet the standard requirements in the field of power automation.

• Medium means that the system time deviates from the 'real' clock time by less than 2 s and that the
quality of the time sources is sufficient for this determination. This level of precision ensures that no low-
quality time stamps are produced if a switching second is inserted and the clock therefore shows a
temporary deviation of ~1 second.

• Low means that the available time information does not have the required precision and that the system
must therefore be considered as 'out of synchronization'.

• Unknown is assigned if the system detects that no NTP service runs at all or that the service was not able
to detect a time source.

For compatibility reasons, a SICAM SCC-internal time stamp includes the ClockSync and ClockValid status
bits. These bits are set depending on the quality of the time stamp:

• High
The ClockSync and ClockValid status bits are set.

• Medium
The ClockValid status bit is set.

• Low
No status bit is set.

• Unknown
No status bit is set.

Configuration File for NTPD

When installing SICAM PAS/PQS or SICAM SCC, an ntp.conf configuration file is copied into the ...\%windir%
\system32\drivers\etc or ...\%windir%\SysWow64\drivers\etc directory. The %windir% directory name
depends on the operating system, for example, Windows or WINNT.
This file is used to configure the NTPD.

The Time Servers are indicated in the configuration files of the Clients. However, the Clients are not indicated
in the configuration files of the Servers. A Time Client can therefore be conveniently added to a system. Only
the configuration file of the new Client needs to be edited.

The configuration file includes some comments on its contents. This paragraph provides information about
important entries.
For more detailed information, refer to the following web site: http://www.ntp.org.
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General Settings

#---------------------------------------------------------------------
# general settings
#---------------------------------------------------------------------
 
# -- panic threshold --
# if system clock is more than that distance from the best external source,
# stop the service because something is really weird.
tinker panic 7200.0
 
# -- driftfile storage --
# NTPD will store the clock drift here, so after restart the service will
# lock the FLL/PLL faster. On embedded systems, make sure that file is
# writeable and on a non-write-protected file system!
driftfile %windir%\ntp.drift
 
# -- logfile storage --
# make sure this is a writeable file on a non-write protected file system!
#logfile D:\tmp\ntpd.log
 
# -- Statistic file storage --
# make sure this is a directory on a non-write protected file system!
#statsdir D:\tmp\ntpstats\

 

• Tinker panic
If the clock concerned deviates by more than 7,200 s from the best external clock, time information is not
synchronized. The NTPD stops automatically or does not start up.
The Services Manager indicates whether the NTPD has started or not. Press <F5> to update the Services
Manager. Set the local system time manually and start the NTPD.

• Driftfile, logfile, statsdir
Activate the logfile and statsdir lines for error detection only.
The quartz drift determined is stored in the ntp.drift file. This allows for faster synchronization after a
system start, because the clock can be set to the correct speed based on the offset value. If no writeable
(and reset-proof!) file system is available, the drift file can be disabled. In this case, optimum synchroniza-
tion can only be achieved some time (hours!) after a system start.

Reference Clocks

#---------------------------------------------------------------------
# reference clocks
#---------------------------------------------------------------------
 
# -- local system clock
# the local system clock is used as level 10 fallback if everything fails and
# the server must continue to operate because of (S)NTP clients like
# IEC61850 devices et al.
server 127.127.1.0
fudge 127.127.1.0 stratum 10

System Time
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Using the lines under local system clock, you can define the local clock as the timer. Define a high value for
the stratum. The local time is used unless another, better time base is available.

Shared Memory Clocks

#---------------------------------------------------------------------------
# shared memory clocks ('iburst' is not useful here)
#---------------------------------------------------------------------------
 
# minpoll 2 -> 4s / maxpoll 6 -> 64s, mode 33 -> adaptive polling
 
# channel 1
server 127.127.28.0 mode 33 minpoll 2 maxpoll 6
fudge 127.127.28.0 stratum 5
 
# channel 2
server 127.127.28.1 mode 33 minpoll 2 maxpoll 6
fudge 127.127.28.1 stratum 5
 
# channel 3
server 127.127.28.2 mode 33 minpoll 2 maxpoll 6
fudge 127.127.28.2 stratum 5
 
# channel 4
server 127.127.28.3 mode 33 minpoll 2 maxpoll 6
fudge 127.127.28.3 stratum 5

 
These lines are required in order to use shared memory clock drivers. They are used for time synchronization
through telecontrol protocols.

• Mode
Through mode 33 (see Table 12-1), you can define adaptive polling. During adaptive polling, the
frequency of the poll is automatically adjusted to the poll result. If the result rarely changes, polls are
performed less frequently..

• Minpoll, maxpoll
The minpoll and maxpoll parameters must be specified in such a way that the range matches the current
synchronization rate of the control center as precisely as possible.

Peers

#--------------------------------------------------------------------------
# peers: all time sync peers in a PAS installation
#--------------------------------------------------------------------------
# If the local system has reference clock access, mention all other systems
# (full servers and dips) in a PAS installation that can also access reference
# clocks. Peers will negotiate the leader of the pack...
 
# minpoll 2 -> 4s / maxpoll 6 -> 64s, iburst -> initial burst poll
#peer xxx.xxx.xxx.xxx minpoll 2 maxpoll 6 iburst
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If one Full Server and one or several DIP(s) are used, the synchronization sources can be distributed among the
computers used (HOPF6039 on the Full Server and telecontrol protocols on the DIP). To do this, activate the
peer line.
In this case, the computers must determine among each other which clock time is most suitable. Since the
classical Server/Client relationship cannot be applied in this context, all the computers involved must be
configured as peers (that is, colleagues with the same priority). Data is exchanged on a bidirectional basis in
order to ensure that synchronization can be performed by both systems.

Servers

#----------------------------------------------------------------------------
# servers
#----------------------------------------------------------------------------
 
# If the local system has no reference clock access, mention all systems that
# have reference clock access here. If there is a network path to an external
# clock source (NTP server in the control center, for example) list them
# here, too. And furthermore mention all fallback servers that can be used!
 
# minpoll 2 -> 4s / maxpoll 6 -> 64s, iburst -> initial burst poll
#server yyy.yyy.yyy.yyy minpoll 2 maxpoll 6 iburst

 
The following lines serve as examples for the definition of Time Servers. The information in these lines can be
used for demo purposes only. In a real environment, the user must enter the parameters for Real Time
Servers..
server 139.25.31.13 minpoll 2 maxpoll 6 iburst
server 139.25.208.27 minpoll 2 maxpoll 6 iburst
server ntp.lpz.siemens.de minpoll 2 maxpoll 6 iburst

Clock Driver for Telecontrol Protocols (Shared Memory Clock Driver)

The driver for telecontrol protocols (Shared Memory clock driver) has been modified in such a way that it
ensures proper time synchronization in the SICAM PAS/PQS system.
Using a shared memory clock driver, the time in a SICAM PAS/PQS system can be synchronized based on tele-
control protocols.
The following 2 modes are supported:

• Mode 0
Mode 0 corresponds to the mode described in the original HTML documentation. This mode cannot be
used with SICAM PAS/PQS.

• Mode 1
Mode 1 is a Shared Memory clock driver with an extended functionality as used for SICAM PAS/PQS.

This paragraph only describes Mode 1.
The ntp.conf configuration file consists of 4 blocks for time synchronization through telecontrol protocols. A
typical block has the following structure:
server 127.127.28.0 mode 33 minpoll 2 maxpoll 6
fudge 127.127.28.0 stratum 5
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The 3rd address section (assigned the value 28 in the example above) defines the type of clock driver. The 4th
address section (0 in the example) is used to distinguish between clocks of the same type.

Mode
Mode 33 is an advanced mode with timeout monitoring. In the fudge line, the value 5 is specified for the
stratum.

In a SICAM PAS/PQS, only modes 1 or 33 can be used for time synchronization through telecontrol protocols.
In a SICAM PAS/PQS, only modes 1 or 33 can be used for time synchronization through telecontrol protocols.
With mode 33, timeout monitoring is automatically included. This is the most convenient mode. When using
Mode 1, the values of the minpoll and maxpoll parameters must be selected very carefully in order to match
the synchronization frequency of the telecontrol center.
The minpoll parameter must be set in such a way that 2^minpoll is greater than the synchronization interval
of the control center. The maxpoll parameter must also be set to this value.

The mode parameter must be interpreted as a bit pattern (decimal value). The tables below illustrate the
significance of the bits.

Table 12-1 Bitmuster zu mode 33

Bit 7 6 5 4 3 2 1 0
Bitpattern 0 0 1 0 0 0 0 1
Value 0 0 1 0 1

Table 12-2 Parameter mode 33

Bit position Meaning
Bit 0 to 3 Bits 0 to 3 define the mode.

This half byte must have the value 1 for the cooperation with the telecontrol protocols
of SICAM PAS/PQS.

Bit 4
(Bit value 16)

Setting the clock time
If this bit is set, the clock driver initiates clock setting to the value present in the clock if
the difference between the system time and the time available in the clock is more
than 10 s.
This difference value can be increased, but not reduced by means of fudge time2.

Bit 5
(Bit value 32)

Timeout monitoring
If this bit is set, the clock driver attempts to optimize the actual poll cycle within the
limits predefined by minpoll and maxpoll.

Bit 7
(Bit value 128)

Writing information in the system log file
This bit is only relevant for diagnosis. All information, warning, and error conditions are
written into the system log file.
If this bit is not set, the driver does not attempt to perform any entries in the event list
of the system (’quiet mode’).

Minpoll, maxpoll
If automatic time monitoring (adaptive polling) is activated, the NTPD tries to set a polling interval within the
limits selected through minpoll and maxpoll. If the telecontrol protocol did not provide any value within a
defined interval, the polling interval is increased by one step. If more than 2 values are transmitted within an
interval, the polling interval is reduced by one step.
If synchronization based on the telecontrol protocol fails, the polling interval increases until the maximum
interval value has been reached. The clock is marked as faulty and the polling interval is set to the minimum
value in order to detect a recovery of synchronization as quickly as possible.
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The values for minpoll and maxpoll must be selected in such a way that they include the expected time
synchronization interval of the telecontrol protocol. Minpoll and maxpoll are exponents referred to a basis of
2. The following values can be used: minpoll = 2 (22 = 4 s); maxpoll = 10 (210 =1024 s = 17 min)

Fudge

• Time1
As with most clock drivers, this value is used in order to compensate a systematic (constant) offset. For
example, the runtime of the telecontrol telegram between the control center and the substation can be
corrected. The value is defined as a floating point value indicated in seconds.

• Time2
Time2 The difference value for clock time setting can be increased to a value greater than 10 s, see Bit 4
in the description of mode, Table 12-1. The value is defined as a floating point value indicated in
seconds.

Example – External Radio Clock as Timer

For system configurations with an IEC 61850 Ethernet bay bus, an external radio clock (for example,
SICLOCK, Meinberg, and Hopf) can be used as the Time Master on the Ethernet. If this clock fails or if the
quality of the time information is poor, another clock available in the system becomes the Time Master. In the
NTPD configuration files, you can define which clock is to become the new Time Master.
The NTPD is active on both SICAM PAS/PQS computers (Full Server and DIP) and on the SICAM SCC computer.
The NTPD of the radio clock is the Time Server; the NTPDs of the SICAM PAS/PQS computers are the Clients.
Additionally, time information can be transmitted from the telecontrol center.

[pasinst72, 1, en_US]

Figure 12-1 Time Synchronization through an External Radio Clock, Example
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The bay devices on the IEC 61850 bus are Clients, which poll time information from the radio clock. Their
configuration is not described in the present document. For more detailed information on this topic, refer to
the documentation of the corresponding devices.
All other bay devices connected through IEC 60870-5-103 receive time information from the DIP.

Configuration Files
This paragraph provides a list of the ntp.conf configuration files for the SICAM PAS/PQS and the SICAM SCC
computers. The entries in the list have been customized for the example illustrated. Be aware that the real
system configuration (for example, IP addresses) of your own environment must be considered.
Changes to the predefined configuration files have been highlighted.
Configuration file of the SICAM PAS/PQS DIP:

#---------------------------------------------------------------------
# general settings
#---------------------------------------------------------------------
 
# -- panic threshold --
# if system clock is more than that distance from the best external source,
# stop the service because something is really weird.
tinker panic 7200.0
 
# -- driftfile storage --
# NTPD will store the clock drift here, so after restart the service will
# lock the FLL/PLL faster. On embedded systems, make sure that file is
# writeable and on a non-write-protected file system!
driftfile %windir%\ntp.drift
 
# -- logfile storage --
# make sure this is a writeable file on a non-write protected file system!
#logfile D:\tmp\ntpd.log
 
# -- Statistic file storage --
# make sure this is a directory on a non-write protected file system!
#statsdir D:\tmp\ntpstats\

 

#---------------------------------------------------------------------
# reference clocks
#---------------------------------------------------------------------
 
# -- local system clock
# the local system clock is used as level 10 fallback if everything fails and
# the server must continue to operate because of (S)NTP clients like
# IEC61850 devices et al.
server 127.127.1.0
fudge 127.127.1.0 stratum 10
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#---------------------------------------------------------------------------
# shared memory clocks ('iburst' is not useful here)
#---------------------------------------------------------------------------
 
# minpoll 2 -> 4s / maxpoll 6 -> 64s, mode 33 -> adaptive polling
 
# channel 1
server 127.127.28.0 mode 33 minpoll 2 maxpoll 6
fudge 127.127.28.0 stratum 5
 
# channel 2
server 127.127.28.1 mode 33 minpoll 2 maxpoll 6
fudge 127.127.28.1 stratum 5
 
# channel 3
server 127.127.28.2 mode 33 minpoll 2 maxpoll 6
fudge 127.127.28.2 stratum 5
 
# channel 4
server 127.127.28.3 mode 33 minpoll 2 maxpoll 6
fudge 127.127.28.3 stratum 5

 

#--------------------------------------------------------------------------
# peers: all time sync peers in a PAS installation
#--------------------------------------------------------------------------
# If the local system has reference clock access, mention all other systems
# (full servers and dips) in a PAS installation that can also access reference
# clocks. Peers will negotiate the leader of the pack...
 
# minpoll 2 -> 4s / maxpoll 6 -> 64s, iburst -> initial burst poll
peer 192.168.1.6 minpoll 2 maxpoll 6 iburst

 
The SICAM PAS/PQS DIP must be entered as a peer for the radio clock. If this is not possible, the radio clock
must not be used as a peer, but as the Server:

#----------------------------------------------------------------------------
# servers
#----------------------------------------------------------------------------
 
# If the local system has no reference clock access, mention all systems that
# have reference clock access here. If there is a network path to an external
# clock source (NTP server in the control center, for example) list them
# here, too. And furthermore mention all fallback servers that can be used!
 
# minpoll 2 -> 4s / maxpoll 6 -> 64s, iburst -> initial burst poll
server 192.168.1.6 minpoll 2 maxpoll 6 iburst

Configuration file of the SICAM SCC computer and of the SICAM PAS/PQS Full Server:
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#---------------------------------------------------------------------
# general settings
#---------------------------------------------------------------------
 
# -- panic threshold --
# if system clock is more than that distance from the best external source,
# stop the service because something is really weird.
tinker panic 7200.0
 
# -- driftfile storage --
# NTPD will store the clock drift here, so after restart the service will
# lock the FLL/PLL faster. On embedded systems, make sure that file is
# writeable and on a non-write-protected file system!
driftfile %windir%\ntp.drift
 
# -- logfile storage --
# make sure this is a writeable file on a non-write protected file system!
#logfile D:\tmp\ntpd.log
 
# -- Statistic file storage --
# make sure this is a directory on a non-write protected file system!
#statsdir D:\tmp\ntpstats\

 

#---------------------------------------------------------------------
# reference clocks
#---------------------------------------------------------------------
 
# -- local system clock
# the local system clock is used as level 10 fallback if everything fails and
# the server must continue to operate because of (S)NTP clients like
# IEC61850 devices et al.
server 127.127.1.0
fudge 127.127.1.0 stratum 10
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12.3 Time Synchronization
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#---------------------------------------------------------------------------
# shared memory clocks ('iburst' is not useful here)
#---------------------------------------------------------------------------
 
# minpoll 2 -> 4s / maxpoll 6 -> 64s, mode 33 -> adaptive polling
 
# channel 1
server 127.127.28.0 mode 33 minpoll 2 maxpoll 6
fudge 127.127.28.0 stratum 5
 
# channel 2
server 127.127.28.1 mode 33 minpoll 2 maxpoll 6
fudge 127.127.28.1 stratum 5
 
# channel 3
server 127.127.28.2 mode 33 minpoll 2 maxpoll 6
fudge 127.127.28.2 stratum 5
 
# channel 4
server 127.127.28.3 mode 33 minpoll 2 maxpoll 6
fudge 127.127.28.3 stratum 5

 

#--------------------------------------------------------------------------
# peers: all time sync peers in a PAS installation
#--------------------------------------------------------------------------
# If the local system has reference clock access, mention all other systems
# (full servers and dips) in a PAS installation that can also access reference
# clocks. Peers will negotiate the leader of the pack...
 
# minpoll 2 -> 4s / maxpoll 6 -> 64s, iburst -> initial burst poll
#peer xxx.xxx.xxx.xxx minpoll 2 maxpoll 6 iburst

 

#----------------------------------------------------------------------------
# servers
#----------------------------------------------------------------------------
# If the local system has no reference clock access, mention all systems that
# have reference clock access here. If there is a network path to an external
# clock source (NTP server in the control center, for example) list them
# here, too. And furthermore mention all fallback servers that can be used!
 
# minpoll 2 -> 4s / maxpoll 6 -> 64s, iburst -> initial burst poll
server 192.168.1.3 minpoll 2 maxpoll 6 iburst
server 192.168.1.6 minpoll 2 maxpoll 6 iburst

System Time
12.3 Time Synchronization
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Converting Projects from Previous Versions

ii NOTE
Perform the conversion steps from earlier versions to the new version one after the other.

13.1 Converting Projects Independently of the Version 416
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13.4 Converting Topology, V9.00 419
13.5 Converting Projects, V8.04 420
13.6 Converting Projects, V8.03 421
13.7 Converting Projects, V8.02 422
13.8 Converting Projects, V8.01 or Earlier 423
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13.10 Converting SICAM PAS/PAS CC Projects, V5.0 and V6.0 425
13.11 Converting Projects, V6.0x 426
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13.13 Converting Projects, V5.10 or later 428
13.14 Converting Projects, V5.10 or earlier 429
13.15 Converting a SICAM WinCC Project 430

13

SICAM, SICAM SCC, Manual 415
E50417-H8976-C501-B5, Edition 05.2020



Converting Projects Independently of the Version
Perform the following steps in order to convert existing projects to the current version of SICAM SCC:

• Re-import the SICAM Graphic Object Library into your project.

• Open and save all diagrams (pictures) including SICAM objects:
Deactivate the SICAM Menu in the Graphics Designer (Tools > Add-In Manager > SICAM Add-in) and
initiate the picture conversion. To do so, select Tools > Convert Project Data > Pictures and faceplates
in the WinCC Explorer.

• The Topological coloring function has been revised. For information concerning versions earlier than
V9.00 refer to 13.4 Converting Topology, V9.00.

• Run the SICAM Import/Export Wizard with the data previously imported.
In order to create the configuration data for the current SICAM Runtime with Dynamic Alarm Filter (DAF),
you must execute the Import Wizard with existing import data once for each station in the project. This is
also required if you do not use the DAF.

• For further steps, refer to 13.3 Making Adjustments for V9.04.
If the parameters of the SICAM objects configured in your diagram differ from the current version, a warning is
shown in the Report when opening your diagram, informing you with which version the particular object was
configured. Check the newly added parameters on the corresponding object.
When you open a diagram and the Report shows an error message regarding the configuration of a SICAM
object, renew this object.

ii NOTE
Make sure that you use the appropriate configuration licenses.

ii NOTE
Perform the conversion steps from an older version to the new version sequentially.

SICAM Import/Export Wizard
To import and export SICAM SCC configuration data, you can use the SICAM Import/Export Wizard for all
supported import data formats. You can continue to use existing projects with the different predecessor
wizards or convert to TEA-X import.
Please note: When converting a SICAM PAS/PQS connection, the TEA-X file must have the same configuration
status as the previously imported PXD file. If this cannot be ensured, export both the TEA-X and the PXD file
from SICAM PAS/PQS and then perform another PXD import with the SICAM PAS Wizard before converting the
project via SICAM Import/Export Wizard.
During the conversion process, the name of the communication connection to SICAM PAS/PQS is changed to
the name which you have defined in SICAM PAS/PQS for this connection (device level).
Please note: During the TEA-X import process, only 1 SCC connection per SICAM PAS/PQS project can be
imported into an SCC project. You can import SCC connections from several SICAM PAS/PQS projects into an
SCC project. The project ID of the SICAM PAS/PQS project must be different (SICAM PAS/PQS – UI Configuration
– General Parameters of the Project).

13.1

Converting Projects from Previous Versions
13.1 Converting Projects Independently of the Version
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Making Adjustments for V9.06
With the revision of the topological coloring, there are some changes to the configuration.
Existing pictures work as usual in the runtime. However, if you want to make changes to a picture, you must
first convert it.
Therefore, do the following:

• Open an existing WinCC project and update it with one of the Wizards. Choose the following setting:
– Importing the SICAM graphic object library

• Open the Topological Project Settings dialog and make any changes (for example, apply the color for
de-energized lines to the project settings), then close the dialog with OK.

• Open the picture in the Graphics Designer.

• Select all objects and open the Topological settings for selected objects dialog.

• The dialog's title bar additionally displays Conversion mode.

• If necessary, adjust the settings. Click OK.

• If you selected Use topological project settings, the settings made through Topological Project
Settings are used for the selected objects.

• Save the picture and recreate the topological structure.

Adjustments for Topological Coloring
Lines can now be configured in different weights; the runtime uses the configured stroke weights of the lines.
It is possible to define line weights and the display mode for the lines project-wide.
When you open the Topological settings for selected objects dialog, the projected values of the selected
objects are read in and displayed.

13.2

Converting Projects from Previous Versions
13.2 Making Adjustments for V9.06

SICAM, SICAM SCC, Manual 417
E50417-H8976-C501-B5, Edition 05.2020



Making Adjustments for V9.04
Due to revisions and extensions of the Dynamic Alarm Filter (DAF) changes in the Alarm Logging have been
necessary.
Therefore, perform the following steps:

• Open an existing WinCC project and execute and update with the Wizard, using the following options:
– Importing the SICAM graphic object library
– Create SICAM text library
– Create SICAM alarm system

• Open an existing picture in the Graphics Designer.

• Open the Project Library and replace the Alarm Controls in the picture:
– SICAM SCC Warning Message List
– SICAM SCC Event List
– SICAM SCC Protection Message List

Adjustments for Using DAF
Before V9.04 every status could trigger an alarm. So for WinCC, every status change was a 'Came in' alarm
which restarted the WinCC-specific algorithm. In V9.04 the treatment of the single-point indications in the
DAF has been adjusted to the WinCC behavior: the single-point indication has 1 status triggering the alarm.
For this, 2 new filter types have been introduced. Use the types SI with Alarm when ON and SI with Alarm
when OFF, in order to trigger an alarm in WinCC with the ON or with the OFF status of the process value of
the single-point indication. With this change the WinCC algorithm for rising/falling indications in the alarm list
with the specific coloring and the acknowledge behavior is supported completely.
Therefore, move existing DAFs for single-point indications from the Binary node to the suitable node for
single-point indications (SI with Alarm when ON or SI with Alarm when OFF).

13.3

Converting Projects from Previous Versions
13.3 Making Adjustments for V9.04
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Converting Topology, V9.00
A topological coloring configured with a SICAM SCC version prior to V9.00 cannot be converted automatically.
This means that the configurations described in 4 Graphic Objects, 5 Topological Coloring, and 6 SICAM Add-
In have to be performed in order to convert an existing topological coloring.
To be able to use the topology in projects configured with a SICAM SCC version prior to V9.00, the according
Import Wizard has to be executed once. This extends the data structure within SICAM SCC with the informa-
tion required for the topology.
If you open an SCC project using topological coloring configured with an earlier version and start the runtime,
the topological coloring will not be executed. However, in certain situations there may occur unwanted
coloring. Thus, independent from topology usage, take care that all feeders are replaced by SICAM SCC V9.00
feeders.
The function Topologal coloring has been reworked. If you use the topological coloring you have to

• install the license for topological coloring,

• update the settings for the topological coloring in the SICAM Menu of the Graphics Designer,

• update the pictures of your project.

13.4

Converting Projects from Previous Versions
13.4 Converting Topology, V9.00
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Converting Projects, V8.04

The SICAM PAS Protocol Suite V7 is no longer included. Change your SICAM SCC projects to the SICAM PAS
Protocol Suite standard channel before updating the software.

13.5

Converting Projects from Previous Versions
13.5 Converting Projects, V8.04
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Converting Projects, V8.03

Replace the message list templates (changing the fixed selection).

13.6
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13.6 Converting Projects, V8.03

SICAM, SICAM SCC, Manual 421
E50417-H8976-C501-B5, Edition 05.2020



Converting Projects, V8.02

A new measured values object (SICAM Numeric) is available in order to speed up the updating times and
enhance the system dimensions, see 4.8 Measured/Metered Value Display.
The former objects can be replaced via the SICAM SCC menu in the Graphics Designer. Select Show task
dialog and perform steps 1 and 2 of the task Measured value up to V8.01: Upgrade to SICAM Numeric
Control (V8.02).

13.7

Converting Projects from Previous Versions
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Converting Projects, V8.01 or Earlier

The function Topological Coloring has been revised.
If you use topological coloring, you need to update the pictures of your project. To do this, you use Create
topological structure from the SICAM SCC menu to regenerate the topological links/scripts in the pictures.

13.8

Converting Projects from Previous Versions
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Converting Projects, V8.00 or Earlier
The SICAM SCC Runtime Data Server component was introduced in order to increase the quantity scopes
supported by SICAM SCC. SIMATIC WinCC, Version 7.0 SP3 or higher, is required as a prerequisite for using the
SICAM SCC Runtime Data Server component.
New projects are automatically configured for operation with the SICAM SCC Runtime Data Server. Existing
projects can be converted, but can also be operated without conversion.
The following conversion steps must be performed in order to convert existing projects (basis SIMATIC WinCC
V7.0 SP3 or higher) for operation with the SICAM SCC Runtime Data Server:
² Delete and re-import the process data using the corresponding wizard (at least the SICAM process tags

function).

² Re-import the SICAM Graphic Object Library into your project.

² If you use topological coloring, remove the topological coloring via SICAM add-in.

² Upgrade the switching device objects and bay overview objects via the SICAM SCC menu in the Graphics
Designer (show task execution box – perform the upgrade of V7 switching device objects and overview
objects for each picture).

² If you use the topological coloring, you generate the topological coloring once again via SICAM add-in.

² Replace the Acknowledge blinking button in the pictures.
For SICAM Switch Controls, V8.0 or later the AckFlashing tag is used (the status changes are inverse to the
tags for earlier versions – QuitBlinking).

ii NOTE
When replacing objects in WinCC V7.4, connections to the connectors may be lost and the topology cannot
be generated. In this case, re-connect the connectors to the switching device and bay overview objects.
This does not occur for WinCC V7.3 or earlier versions.

13.9

Converting Projects from Previous Versions
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Converting SICAM PAS/PAS CC Projects, V5.0 and V6.0
Conversion of the SICAM PAS project

During the conversion the contents (interface level) of the first SICAM PAS CC DIP of the SICAM PAS project are
transferred to the Full Server, and the IP address of the DIP is entered as the device address of the SICAM PAS
CC (SCC) control center.
All the other SICAM PAS CC connections are converted manually because the user cannot decide during
conversion whether further DIPs are redundant SICAM PAS CC (SCC) or independent SICAM PAS CC (SCC)
connections.
For redundant SICAM PAS CC connections on 2 Version 6 DIPs you only need to enter the IP address of the
second DIP at SICAM PAS CC (SCC) 2 in the communication parameters of the converted control center. After-
wards you can delete the DIP.
Next, export the control center data for SICAM PAS CC (SCC) and import the in your WinCC project. For picture
objects and scripts you need to adapt the tags which include the interface ID in the name. Afterwards, the
WinCC project can be duplicated to the redundancy partner using the WinCC Project Duplicator. No SICAMspe-
cific adaptations and no data import are required in the redundant project.
In case of independent SICAM PAS CC connections you can transfer the interface from the SICAM PAS CC DIP
into the SICAM PAS CC (SCC) application on the Full Server. Configure the IP address of the SICAM SCC
computer (Version 6 DIP address) on the control center level. Afterwards you can delete the DIP.
Export the control center data for SICAM PAS CC (SCC) and import them in your WinCC project. For picture
objects and scripts you need to adapt the tags which include the InterfaceID in their name.
After the conversion you must change the parameter settings of the SICAM PAS CC (SCC) interface. Enter e.g.
the IP address for communication with the SICAM SCC system.oll.

Different configuration
Contrary to SICAM PAS V6.0 the SICAM SCC connections are configured on the Full Server and no longer as a
DIP.
On the interface level you define the assignment of the switching authority group, the IP address of the Full
server network card for communication (this address corresponds to the one to be entered for the SICAM PAS
in the SICAM PAS channel) and the port number.
On the control center level you define the IP addresses of the SICAM SCC computer(s) and the channel moni-
toring time. (Make sure that an identical channel monitoring time is defined in SICAM SCC).
Redundant SICAM SCC systems are configured as a control center; the two IP addresses of the SICAM SCC
computers are entered in the communication parameters.
Independent SICAM SCC systems to be connected to a SICAM PAS are configured in separate interfaces. This
enables a different assignment of the switching authority group.

13.10
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Converting Projects, V6.0x
Perform the following steps with the SICAM PAS Wizard:
² Re-import the SICAM Graphic Object Library into your project.

² Update the process data using the PXD file.

13.11

Converting Projects from Previous Versions
13.11 Converting Projects, V6.0x
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Converting Projects, V5.11
Re-import the SICAM Graphic Object Library into your project using the SICAM PAS Wizard.
The Topological coloring function was completely revised and is no longer compatible with Version 5.11, but
you can still use pictures in the version.
Advanced structure types are required for substitution. You must convert the structure types if you want to
use the Substitute function supported for V6.0 or higher after the upgrade or if you use the Web Navigator in
your project.
There are 2 alternatives for the conversion of the structure types:

• Alternative 1
Follow the description in 14.8 Working with the SIMATIC WinCC Configuration Tool.

• Alternative 2
Use the wizard to delete the SICAM process tags and then manually delete the structure types in your
project.
Next, re-import the SICAM process tags using the wizard. The advanced structure types are generated
during this process.

13.12

Converting Projects from Previous Versions
13.12 Converting Projects, V5.11
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Converting Projects, V5.10 or later
Use the SICAM PAS Wizard to re-import the SICAM Graphic Object Library.
If problems occur during the archiving of an existing project in TagLogging, the SICAM Archives must be
deleted with the wizard. Afterwards, the MeasuredValueArchive_x and the MeteredValueArchive_x created
by the wizard must be deleted in TagLogging, and the SICAM time must be manually deleted. Afterwards you
can re-import the archive tags using the wizard.
Advanced structure types are required for substitution. If you want to use the Substitute function supported
for V6.0 or later after the upgrade or if you are using the Web Navigator in your project, you must convert the
structure types.
There are 2 alternatives for the conversion of the structure types:

• Alternative 1
Follow the description in 14.8 Working with the SIMATIC WinCC Configuration Tool.

• Alternative 2
Use the wizard to delete the SICAM process tags and then manually delete the structure types in your
project.
Next, re-import the SICAM process tags using the wizard. The advanced structure types are generated
during this process.

13.13

Converting Projects from Previous Versions
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Converting Projects, V5.10 or earlier
Use the SICAM PAS Wizard to re-import the SICAM Graphic Object Library in your project.
If problems occur during the archiving of an existing project in TagLogging, the SICAM Archives must be
deleted with the wizard. Afterwards, the MeasuredValueArchive_x and the MeteredValueArchive_x created
by the wizard must be deleted in TagLogging, and the SICAM time must be manually deleted. Afterwards you
can re-import the archive tags using the wizard.
If you use the AlarmListFilter object from the library, replace it by the new version. The functionality of this
object was swapped out to a global script. This ensures that the alarm list filter settings are also maintained
after exiting the Runtime, see 7.6.7 Global Actions.
Advanced structure types are required for substitution. If you want to use the Substitute function supported
for V6.0 or later after the upgrade or if you are using the Web Navigator in your project, you must convert the
structure types.
There are 2 alternatives for the conversion of the structure types:

• Alternative 1
Follow the description in 14.8 Working with the SIMATIC WinCC Configuration Tool.

• Alternative 2
Use the wizard to delete the SICAM process tags and then manually delete the structure types in your
project.
Next, re-import the SICAM process tags using the wizard. The advanced structure types are generated
during this process.

13.14
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Converting a SICAM WinCC Project
Use to SICAM Global Wizard in order to reimport the SICAM graphic object library into your project.
Advanced structure types (new IXHook element) are required for projects created with SICAM WinCC V3 or
earlier versions.
2 alternatives are possible for the conversion of structure types:

• Alternative 1
Proceed as described in 14.8 Working with the SIMATIC WinCC Configuration Tool.

• Alternative 2
Alternative 2: Delete the SICAM process tags using the Wizard. Afterwards, manually delete the struc-
ture types for the SICAM SAS connection (without PAS_ in the name) in your project.
Reimport the SICAM process tags using the Wizard. The advanced structure types are generated during
this procedure.

Replace the IndustrialX V3 objects by the up-to-date objects (V3 objects are only available in configuration
mode) using the SICAM add-in (upgrade of V3 switching device objects / overview objects).
In order to ensure that the properties of V3 switching device objects and overview objects are applied
correctly, the tag names and the text for the tooltip in the properties of the tag connection must be empty in
the target SAS object. Before calling up the update, open the properties of the SAS object and delete all tag
names and the tooltip text under Tag connection.
Connected scripts are also applied when replacing the objects.

• Check whether the configured scripts function correctly (especially with regard to object properties
used).

• Remove the script from the Clicked event of the object. This script served to open switching dialogs
which are no longer required with the current object because they are integrated.

13.15

Converting Projects from Previous Versions
13.15 Converting a SICAM WinCC Project
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Double/Redundant Configuration in V5/V6 Projects
This chapter explains the double/redundant configuration concept in SICAM PAS/SCC systems, SICAM PAS/ PAS
CC V6.03 or earlier. This type of connection of double SICAM PAS systems should no longer be used with the
new SICAM PAS V7.0 version. However, the parameters of systems which are upgraded from SICAM PAS V5/V6
do not necessarily need to be modified. The explanations below apply to these systems.
For safety reasons, a SICAM PAS system can be implemented in double/redundant configuration. This means
that certain components can be implemented in double/redundant configuration depending on the specific
requirements of the individual system. This section describes the implementation of the configurations illus-
trated below.

• A doubled SICAM PAS system is connected to 1 SICAM SCC Human-Machine Interface (HMI).

• 1 SICAM PAS system is connected to 2 redundant SICAM SCC HMIs.
Further double/redundant configurations are possible. For example, double SICAM PAS Full Servers can also be
connected to a redundant SICAM SCC system.
For more detailed information on redundancy, refer to the SIMATIC WinCC documentation.

Connection to 2 SICAM PAS Systems

A SICAM PAS system can consist of 2 SICAM PAS Full Servers running in parallel. Bay devices and substations
are connected to both SICAM PAS Full Servers. SICAM SCC is connected to both SICAM PAS Full Servers via the
SICAM PAS PROTOCOL SUITE.
The connection to a SICAM PAS Full Server (e.g. to Server1) is referred to as the normal path; the connection
to the other SICAM PAS Full Server (e.g. to Server2) is the so-called redundant path. During fault-free opera-
tion, the connection via the normal path is active.
For SICAM SCC, a switchover to the redundant path must be performed if one of the following 2 scenarios
occurs:

• The normal path of the SICAM PAS PROTOCOL SUITE to the connected SICAM PAS Full Server is inter-
rupted.
The active connection of the SICAM PAS PROTOCOL SUITE to the SICAM PAS Full Server is permanently
monitored. When an error occurs, the system automatically switches over to the redundant path (to the
other SICAM PAS Full Server), provided that this path has been configured.

• The communication between the SICAM PAS Full Server accessed by SICAM SCC and the bay devices is
disturbed.
This scenario also requires a switchover to the redundant path. This fault, however, cannot be detected
by the SICAM PAS PROTOCOL SUITE. The detection of the fault and the switchover to the redundant path
can be realized by other means. The required procedure is described below.

ii NOTE
For the connection to SICAM PAS V7.0, the configuration of the SICAM PAS PROTOCOL SUITE (SICAM PAS
channel DLL) must be set to SICAM PAS V6 redundancy.

14.1

14.1.1

Components and Functions of Earlier SICAM PAS CC/SCC Versions
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Figure 14-1 System with doubled SICAM PAS system

The following components are required for the monitoring and switchover of the connections (between the
normal and the redundant path):

• a process tag

• the ConnectionState_xxx bit array (32 bits)

• the ForceConnectionState_xxx bit array (32 bits)

• the WinCC script SicamPAS_ConnectionChange.pas

Process tag
In order to be able to monitor the connection between the SICAM PAS system and the bay devices, a process
tag must be created in SICAM PAS UI-Configuration and mapped to SICAM SCC. This process tag can be e.g. a
message derived via CFC and enabling the evaluation of the quality of the connection to the bay devices.
This process tag can be evaluated using the SicamPAS_ConnectionChange.pas or SicamPAS_IsHeMaster-
Check.pas WinCC script. The quality of the active connection can be assessed by means of the evaluation of
the process tags.

ConnectionState
The ConnectionState_xxx bit array shows the status of the active connection between the SICAM PAS
PROTOCOL SUITE and the SICAM PAS system.
The bit array is defined as follows:
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Bit Meaning
0 0 = no connection

1 = connection active
1 1 = connection via normal path
2 1 = connection via redundant path
3 to 31 System-internal use

ForceConnectionState
The behavior of the SICAM PAS PROTOCOL SUITE can be influenced by writing the ForceConnectionState_xxx
system tag.
The bit array can only be written completely. Read access is not possible.
The bit array is defined as follows:
Bit Meaning
0 If this bit is set, the SICAM PAS PROTOCOL SUITE switches over to the other SICAM

PAS Full Server.
The triggering is performed using the WinCC script.

1 If this bit is set, the connection is activated via the normal path.
2 If this bit is set, the connection is activated via the redundant path.
3 to 31 Reserved

WinCC script
The process tag is evaluated using the SicamPAS_ConnectionChange.pas WinCC script. The proper func-
tioning of the SICAM PAS system (including the communication with connected devices) can be checked by
means of this evaluation.
If the quality of the active connection is found to be poor, the system can switch over to the other path using
the system tag ForceConnectionState_xxx.
A template of the SicamPAS_ConnectionChange.pas WinCC script
is copied into the ...\SIEMENS\SICAM\SCC\PAS directory during installation.
In order to be able to use the WinCC script, proceed as follows:
² Copy the WinCC script into the PAS directory of your WinCC project.

² To customize the WinCC script, use the related process tags in the script editor.

Activating redundancy
Proceed as follows to activate the redundant configuration:
² In the WinCC Explorer, right-click PAS Data Server and select Properties from the context menu.

The Channel Unit Properties dialog opens.

² Click Properties.
The Connection properties dialog opens.

² Click Properties.
The PAS Connection dialog opens.
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Figure 14-2 Activating redundancy

² Select the Redundant Connection option.

² Enter the IP address of the second SICAM PAS Full Server.
The ports must match the ports parameterized in SICAM PAS.
The Test frame period must correspond to the Test frame period parameterized in SICAM PAS for SICAM PAS
CC/SCC.
² Click OK to confirm your settings.

Redundant SICAM SCC System

A redundant system can consist of two SICAM SCC which run in parallel. Each SICAM SCC provides a SICAM
PAS PROTOCOL SUITE connection to the SICAM PAS system.
The first SICAM SCC (e.g. WinCC1) is the Master Server, and the second one is the redundant Partner Server.
Both connections are active in case of fault-free operation.
The SIMATIC WinCC redundancy package for data synchronization and for the control of the server redun-
dancy must be installed on both SICAM SCC servers.
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[Kanal_dll_1, 1, en_US]

Figure 14-3 System with redundant SICAM SCC

Configuring SICAM PAS
In SICAM PAS, you must add two DIPs to your project and configure them accordingly.
Proceed as follows:
✧ To open SICAM PAS UI - Configuration, click

Start > Siemens Energy > SICAM > PAS > UI - Configuration.
✧ Create a DIP (e.g. PAS CC 1).
✧ Insert a PAS CC/SCC application, an interface and a control center for the DIP.
✧ The items of information to be used in SICAM PAS CC/SCC must be activated in the information mapping.
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[sc_first_dip, 1, en_US]

Figure 14-4 First DIP, PAS CC 1

✧ Create the second DIP (e.g. PAS CC 2).
✧ Insert a PAS CC/SCC application and an interface for the DIP.

The interfaces include different interface addresses and compatibility keys. They are assigned by the system
and cannot be modified. The compatibility key is automatically adapted upon each change of the interface
parameters.

[sc_second_dip, 1, en_US]

Figure 14-5 Second DIP, PAS CC 2

✧ Copy the control center of the first DIP and insert the copy into the second DIP.
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Exporting data
To import the configured items of information into SICAM SCC, they must be exported from SICAM PAS UI -
Configuration.
✧ Right-click Interface and select Export from the context menu.

The export function creates a PXD file in the selected directory. Afterwards, you can import this file into SICAM
SCC using the SICAM PAS Wizard.
✧ Export the configuration data of the first DIP.
✧ Export the configuration data of the second DIP.

Creating WinCC Projects
Create a separate WinCC project on each of the 2 computers.
✧ Create a new WinCC project (e.g. PAS CC 1) on the first computer.
✧ Import the PXD file of the first DIP using the SICAM PAS Wizard.

The administrative tags imported from SICAM PAS have the project and interface ID as an extension of the tag
name.

[pascc409, 1, en_US]

Figure 14-6 WinCC Project 1
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[pascc411, 1, en_US]

Figure 14-7 Alarm Logging WinCC Project 1

✧ Close your WinCC project.

Create the redundant WinCC project via the Project Duplicator. It must be saved on a second computer.
✧ To start the Project Duplicator, click Start > SIMATIC > WinCC > Tools > Project Duplicator.
✧ Enter PAS CC 1 as the source project.
✧ Enter a name for the redundant WinCC project (e.g. PAS CC 2).
✧ Click Duplicate. The redundant WinCC project is now created.
✧ Call up the SICAM PAS Wizard via the redundant WinCC project.

The administrative tags must be connected to the other interface in the redundant WinCC project.
✧ Import the PXD file of the second DIP. Only the names of the administrative tags are changed during

this step.

[pascc408, 1, en_US]

Figure 14-8 SICAM PAS Wizard, Warning
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✧ The SICAM PAS Wizard issues a warning. Click Yes in this dialog.
The project ID is not changed, and the HMI Interface ID is assigned the value 9.

[pascc410, 1, en_US]

Figure 14-9 WinCC Project 2

The modified process tags include the project and interface IDs of the second DIP as an extension of the tag
name. They are linked to the redundant interface.

[pascc412, 1, en_US]

Figure 14-10 Alarm logging WinCC Project 2

The new raw data tag is linked to the messages.
The CompKey of the redundant interface is used.
The modifications are documented in the trace window.
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Synchronizing SICAM acknowledgment data
SIMATIC WinCC supports the synchronization of data between redundant servers. In order to ensure that the
data of the SICAM SCC components can be synchronized between the redundant servers, the following
prerequisite must be met:
For the IX State Sync application, the same rules apply for a SICAM RTU system as for a SICAM PAS system,
see 14.5 IX State Sync Application.
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Circuit Breaker and Disconnector
This section describes the Circuit Breaker and Disconnector SICAM graphic objects for SICAM SCC V7.02 or
earlier. With SICAM SCC V8.00 or higher, they were replaced by SICAM graphic objects featuring more
powerful functions. However, the old SICAM graphic objects can still be used. The new circuit breakers and
disconnectors are described in 4.4 SICAM Switch Controls.
The Circuit Breaker and the Disconnector are available as switching devices. They are stored in the Switching
device objects folder under Controls in the SICAM graphic object library. These IndustrialX Controls already
include typical functions.

ii NOTE
If user-specific bitmaps, configured without absolute path, are used for display within the switching objects
(Bitmap option), these are not displayed during runtime in WinCC V7.2 or higher on the Web Navigator
Client .
The default search path is relative to the directory Programs (x86)\Siemens\WinCC\WebNavigatorClient
\bin.
You can reference the used bitmaps via this path or store them in this location.

Graphical representation
The SICAM graphic object library provides circuit breakers and disconnectors in five different representation
modes:
Circuit breaker View Graphic
SICAM CB in SICAM style

DIN CB based on DIN 42200

IEC 445 CB based on IEC 445

LSA CB based on LSA

Bitmap CB individual design

Disconnector View Graphic
SICAM CB in SICAM style

DIN CB based on DIN 42200

14.2
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Disconnector View Graphic
IEC 445 CB based on IEC 445

LSA CB based on LSA

Bitmap CB individual design

Graphical Representation of Circuit Breakers and Disconnectors

Each circuit breaker and disconnector must be assigned several properties.
✧ Double-click the graphic object.

The SICAM SCC CB/DIS Properties dialog opens.
✧ The properties can be found in the Style tab.

[pascc336, 1, en_US]

Figure 14-11 Specifying the style

Type
The Circuit Breaker or Disconnector types can be selected for the graphic object.

Standard
The following five options are available for the representation of a graphic object:

• SICAM

• DIN 42200

14.2.1
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• IEC 445

• LSA

• Bitmap
With the Bitmap style, specific diagrams can be displayed depending on the switch position.

ii NOTE
If user-specific bitmaps, configured without absolute path, are used for display within the switching
objects, these are not displayed during runtime in WinCC V7.4.
The default search path is relative to the folder Programs (x86)\Siemens\WinCC\bin.
You can reference the used bitmaps using this path or store them in this location.

Line width
The line width of the graphic objects can be adjusted in steps from 1 to 11. Step 1 represents the smallest line
width.
The adjustment of the line width is possible for all representation styles according to DIN 42200, IEC 445 and
LSA.

Orientation
For all representation styles apart from Bitmap, the orientation angles 0°, 90°, 180°, and 270° can be defined.

Tag Connection of the Circuit Breakers and Disconnectors

Each circuit breaker and each disconnector must be assigned tags.
✧ Double-click the graphic object.

The SICAM SCC CB/DIS Properties dialog opens.
✧ The interfacing to the process is defined in the Tag connection dialog.

[pascc337, 1, en_US]

Figure 14-12 Tag connection
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Tag information
Click the Browse button next to the edit field. The Tags dialog opens. Select the corresponding tag from the
list and click OK to confirm.

Tag command
If a tag name Command related to a tag name Information is indicated in the SICAM PAS import data record,
the command tab is determined automatically when the tag name information is selected. In this case, the tag
name Command is entered into the Command Direction edit field.
To select a tag, proceed as described under Monitoring Direction.

ii NOTE
If you do not want to use the stored functionality in command direction, delete the prespecified tag.

Acknowledge tag for spontaneous blinking
You can keep the predefined QuitBlinking tag or select another tag.
Click the Browse button next to the edit field to select another tag. The Tags dialog opens. Select the corre-
sponding tag from the list and click OK to confirm.
You can also assign a tag to several switching elements in order to form a group. Spontaneous blinking can be
acknowledged simultaneously for all switching elements of the group.

Tooltip text
Enter a text in the edit field. This text is displayed as Tooltip in the active project.

WinCC update cycle
The WinCC update cycle of the tags can be adjusted in time intervals from 250 milliseconds to one hour.
Furthermore, the setting For change is possible. 2 seconds is the default setting.

Colors of Circuit Breaker and Disconnector

Switch position
The color of the graphic object in normal state depends on its value. A specific color is set by default for each
individual value. However, the color can also be freely selected from a color palette.
In the Color tab, you can assign colors for the individual switch positions and states of the Circuit Breaker/
Disconnector.
✧ Double-click the graphic object.

The SICAM SCC CB/DIS Properties dialog opens.
✧ Select the Color tab.
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[pascc339, 1, en_US]

Figure 14-13 Assigning colors

The following colors are predefined for the graphic object:

Table 14-1 Switch position

Value Color
ON 10, value = 2 Red
OFF 01, value = 1 Green
Intermediate position 00, value = 0 Yellow
Disturbed 11, value = 3 Yellow

The form of the graphic object in representation styles in accordance with DIN 42200, IEC 445 and LSA
depends on the value.
The following forms are predefined for the graphic object in the representation style in accordance with DIN
42200 and IEC 445:

Table 14-2 In accordance with DIN 42200 and IEC 445

Value Form
ON 10, value = 2 Switch closed
OFF 01, value = 1 Switch open
Intermediate position 00, value = 0 Switch on/off dashed
Disturbed 11, value = 3 Switch on/off dashed

Graphic object forms in the representation style in accordance with LSA:

Table 14-3 In accordance with DIN 42200 and IEC 445

Value Form
ON 10, value = 2 Filled
OFF 01, value = 1 Not filled
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Value Form
Intermediate position 00, value = 0 Half filled
Disturbed 11, value = 3 Half filled

A red cross is indicated for values which are not indicated in the tables (e.g. Value=4).

State
The switch status is represented with small, colored rectangles next to the switch. A default color is predefined
for each status. The color can also be freely selected from a color palette.

[pascc340, 1, --_--]

Figure 14-14 Switch with switch status

The predefined colors of the rectangles depend on the status:

Table 14-4 Switch status

Status Color Explanation
Not topical Cyan (turquoise) The device state is not topical.
PAS not ok Dark cyan (teal) Connection between SICAM SCC and SICAM PAS

disturbed.
Bay blocked Red Messages from this bay are no longer transmitted to

SICAM PAS.
Substituted Blue The switch position was set manually because there

is no connection to the primary system.
Telecontrol blocked Red Messages from this bay are no longer transmitted to

the telecontrol center.

Background
The background color of the graphic object can be individually defined. Gray is the default color.

Advanced Properties of the Circuit Breaker and Disconnector

In the Advanced tab, you assign additional circuit breaker/disconnector properties.
✧ Double-click the graphic object.

The SICAM SCC CB/DIS Properties dialog opens.
✧ Select the Advanced tab.
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[pascc342, 1, en_US]

Figure 14-15 Advanced properties

During the connection to SICAM RTU or IEC 61850 devices, commands must be sent with Qualifiers of
Command (QoC) when commands are issued. To activate the function, select Send QoC with Command
Value in the Properties dialog of the switching device. Afterwards you can set the values to be sent in the
Preset section. If you need the possibility to display and change the values in the switching dialog at runtime,
select Visible in RT.

Enable state dialog
The display of status information by clicking with the right mouse button can be enabled or disabled.

3-D style
If this option is selected, circuit breakers and disconnectors can simulate a three-dimensional effect when
clicked.

ii NOTE
The 3-D effect highlights the selected icon. This effect is required for operation without a mouse.

Fix dialog position
The runtime dialogs can be anchored at a specified position on the display.

Command execution timeout
In the command execution timeout box, you must specify in seconds how long the system shall wait for the
successful execution of a command. When this time interval has elapsed, the command is terminated and the
negative command termination is logged.
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Authorization level
Enter the Authorization level. For example, select the value 3 for authorization level 3. For more detailed
information regarding the setting and assignment of user authorizations, refer to 3.8 Setting up User Authori-
zations.

ii NOTE
The line number (e.g. 3) corresponds to the authorization level in the object properties of the ActiveX
Controls.

Enable spontaneous blinking
Spontaneous blinking can be enabled or disabled.
The circuit breaker or disconnector blinks spontaneously if the value of the assigned tag changes and if
Spontaneous has been entered as cause.

Enable setpoint blinking
Setpoint blinking can be enabled or disabled.
When the command is issued, the graphic object starts to blink in the defined state as soon as the target
switching direction (ON or OFF) has been selected. The blinking stops when the command is terminated or
aborted, i.e. in the following cases:

• after the abortion of the command output

• when the monitoring time for the command output has expired

• if Command Termination was entered as the cause in the feedback message

Enable SET = ACTUAL
Switching in the represented ACTUAL state can be enabled or disabled. Select this option to enable the
switching direction independently of the switch position. For example, another switch-on command can be
issued for a switch which has already been switched on.

Use integrated dialog
The display of switching dialogs during runtime can be enabled or disabled.

Write command output
Deselect Write Command Output to prevent writing to the defined tag. In this case, you must define actions
for the command output via the Object Properties, Events tab (see 14.2.9 Defining Object Properties).

Command model 'Select before operate'
A switching operation can be executed in two steps.
A select command is issued before the actual switching command. To issue the switching command, a posi-
tive acknowledgment must have been received for the select command.

Controlling Synchronized Switching for the SICAM PAS Connection

In the Synchronization tab, you can define the control (switching device object) for synchronized switching
(e. g. in order to connect two busbars).
✧ Double-click the graphic object.

The SICAM SCC CB/DIS Properties dialog opens.
✧ Select the Synchronization tab.
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ii NOTE
In case of a connection to a SICAM PAS station, additional synchronization functions can only be used with
the IEC 61850 and SINAUT LSA ILSA communication protocols.

Synchronization functions with IEC 61850

[pascc341, 1, en_US]

Figure 14-16 Define synchronization

• Synchronizing model
With the communication protocol IEC 61850, the user can specify whether circuit breakers shall be
controlled in synchronized or unsynchronized mode. If unsynchronized switching is specified, further
settings or dynamic display properties must be defined. Advanced control dialogs are displayed during
runtime, and the user can determine how the switching operation is to be executed.

• Command execution timeout
In the Command execution timeout box (Advanced tab), you must specify in seconds how long the
system shall wait for the successful execution of a command. When this time interval has elapsed, the
command is terminated and the negative command termination is logged.

• Changeover Synchronized – Not Synchronized Switching tag name information
The tag to be indicated includes information on whether the device synchronization is active or inactive.
This tag must always be indicated.

• Changeover Synchronized – Not Synchronized Switching tag name command marker command
A tag name command can be indicated. This tag does not need to be defined if the synchronization func-
tion must not be modified during runtime.
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Synchronization functions with SINAUT LSA ILSA

[pascc341a, 1, en_US]

Figure 14-17 Define synchronization

• Synchronizing model
With the SINAUT LSA ILSA communication protocol, the user can specify whether circuit breakers shall
be controlled in synchronized or unsynchronized mode. If synchronized switching is specified, further
settings or dynamic display properties must be defined. Advanced control dialogs are displayed during
runtime and the user can determine how the switching operation shall be executed.

• Command execution timeout
In the Command execution timeout box (Advanced tab), you must specify in seconds how long the
system shall wait for the successful execution of a command. When this time interval has elapsed, the
command is terminated and the negative command termination is logged.

• Tag name command 'measurement interrogation'
In the Tag name command ’measurement interrogation’ box, define the tag name command which
triggers a measurement in the synchronization unit. The measured values are updated; no switching
operation is performed.

• Tag name command (not synchronized)
Define the tag name command for unsynchronized switching in the Tag Name Command (not
synchronized) entry field. If this tag is not defined, unsynchronized switching is not possible.

Synchronized Switching for Direct Connection of Devices

If devices are directly connected via the SICAM IEC COMMUNICATION SUITE, the Qualifiers of Command (QoC)
are included in the command telegrams. These QoC are defined in the Advanced tab.
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[QoC_einstellen, 1, en_US]

Figure 14-18 Defining Qualifiers of Command (QoC)

The Qualifiers of Command can be defined with the following object properties in the object properties of the
switching commands:

• Preset
With this property you can define which Qualifiers of Command are preset.

• Visible in RT
With this property you can define which Qualifiers of Command are displayed in the switching dialog
during Runtime and can be modified during the switching operations.

Runtime Dialogs of Circuit Breakers and Disconnectors

Dialogs are available for performing switching operations, for status display, to acknowledge blinking and for
synchronization.
To call up these dialogs during runtime, click the related graphic object.

2-step switching operation
Click the graphic object to open the dialog for a switching operation.
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[pascc501, 1, en_US]

Figure 14-19 Switching dialog without Qualifier of Command

The dialog below must be used for switching operations with SICAM RTUs and IEC 61850 devices and for
control via the SICAM IEC COMMUNICATION SUITE.

[pascc501_1703, 1, en_US]

Figure 14-20 Switching dialog without Qualifier of Command

This dialog has been complemented by 2 Qualifier of Command (QoC) setting options. Controls (switching
device objects) which already support this Qualifier of Command are available in the SICAM graphic objects
library, e.g. IEC 445 LS with QoC.
You can define the parameters of the Select before operate function via the properties of the control in the
Graphics Designer, see 14.2.4 Advanced Properties of the Circuit Breaker and Disconnector.
If bay devices are connected based on the IEC 61850 protocol, the Select command is transmitted when the
user clicks the ON or OFF button. Otherwise, the confirmation dialog opens directly (see Figure 14-22). The
ON and OFF buttons are disabled until a confirmation has been received.
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[pascc505, 1, en_US]

Figure 14-21 Switching dialog, Select command is running

The select command can receive a positive or negative acknowledgment. Depending on the acknowledgment,
one of the following dialogs opens.

[pascc506, 1, en_US]

Figure 14-22 Switching dialog, selection is active

The check resulted in a positive acknowledgment. The actual switching command can be issued by clicking the
Confirm button.

[pascc507, 1, en_US]

Figure 14-23 Switching dialog, the selection was rejected

The actual switching command cannot be issued. The switching operation must be aborted.

Synchronization functions
Based on the communication protocols IEC 61850 and SINAUT LSA ILSA, different functions for synchronized
switching can be performed by means of dialog extensions. The execution of the switching operation during
runtime depends on the individual protocol. For this reason, a distinction is made between these protocols in
the following sub-sections.
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Synchronized switching is supported by further communication protocols (e.g. IEC 60870-5-101 Master). In
this context, however, the dialog extensions are not used. For more detailed information, refer to the protocol
descriptions.
The extended synchronization dialog is only shown if a communication protocol (not the option -nothing-)
was selected from the drop-down list box Synchronization Model in the SICAM SCC CB/DIS properties
dialog.

Synchronization functions with IEC 61850
This section describes the execution of a synchronized switching operation based on the IEC 61850 communi-
cation protocol.
Click the graphic object to open the dialog for a synchronized switching operation.

[pascc508, 1, en_US]

Figure 14-24 Switching dialog for synchronized switching, synchronization function disabled

For synchronized switching, the Sync effective option must be selected. This selection opens the confirmation
dialog.

[pascc509, 1, en_US]

Figure 14-25 Dialog for Confirmation

Click Confirm to send a single command with the value OFF to the tag name command Sync not effective.
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At the same time, all buttons are deactivated until a command feedback is received.

[pascc510, 1, en_US]

Figure 14-26 Switching dialog for synchronized switching, synchronization function deactivated

As soon as a message has arrived via the tag name information Sync not effective, the Sync ON button is
active and can be clicked.
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[pascc511, 1, en_US]

Figure 14-27 Switching dialog for synchronized switching, Sync ON button activated

Clicking the Sync ON button now initiates synchronized switching. The switching command is issued as usual:
✧ Click Sync ON.

The control blinks in the setpoint status and the confirmation dialog opens.
✧ Click Confirm.

The command is output.

This dialog remains open until the synchronized switching operation has been completed or aborted.

Synchronization functions with SINAUT LSA ILSA
This section describes the execution of a synchronized switching operation based on the SINAUT LSA ILSA
communication protocol.
Click the graphic object to open the dialog for a synchronized switching operation.
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[pascc508a, 1, en_US]

Figure 14-28 Switching dialog for synchronized switching, synchronization function disabled

The Unsynchronized option deactivates the Sync ON button. Synchronized switching is not possible.
The Synchronized option activates the Sync ON button.
Clicking the Sync ON button now initiates synchronized switching. The switching command is issued as usual:
✧ Click Sync ON button.

The control blinks in the setpoint status and the confirmation dialog opens.
✧ Click Confirm.

The command is output.

This dialog remains open until the synchronized switching operation has been completed or aborted.
If a command with synchronization has been transmitted, the synchronization can be aborted by clicking on
Cancel synchronization. Afterwards, the control sends a cancel command to the tag name command.
Click Start Meas to issue a measurement trigger to the synchronization unit. The measured values are
updated without performing a switching operation.

Status
The status dialog can be opened by clicking with the right mouse button, provided that the status display has
been activated in the Properties dialog.
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[pascc503, 1, en_US]

Figure 14-29 Status dialog

The status is indicated by a tick in the corresponding checkbox. Click Substitute to open the dialog for
manually updating a switch position (see 14.2.8 Substituting the Switch Position).

Acknowledge blinking
Click a blinking graphic object to open the Acknowledging blinking dialog.

[pascc504, 1, en_US]

Figure 14-30 Acknowledge Blinking

Click This to acknowledge a status change or a spontaneous alarm for this switch.
Click All to use the Tag Acknowledge Blinking (under Properties) for acknowledging. All IndustrialX controls
linked to this tag are acknowledged.
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Substituting the Switch Position

[pascc503a, 1, en_US]

Figure 14-31 Substituting the Switch Position

In this dialog, you defined how to substitute the switch position. Click Substitute to open the Confirm dialog.
Click the Confirm button to execute the substitution.

ii NOTE
New structure elements are required for the substitution. To continue to use projects from SICAM PAS CC
Version 5.x, these projects must be converted first (see 10 Different SICAM PAS Versions).

Defining Object Properties

The Object properties dialog comprises the Properties and the Events tabs. The following section describes
certain parameters from these tabs.
Proceed as follows to open the Object properties dialog:
✧ Right-click the graphic object.
✧ Select Properties in the context menu.

The Object properties dialog opens.

14.2.8

14.2.9
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Properties tab

[pascc512, 1, en_US]

Figure 14-32 Object properties, Properties tab

The following table provides a list of certain important object properties of the circuit breakers/disconnectors.

Table 14-5 Object properties

Object properties Meaning
PermissionLevel Assigns a permission level for the IndustrialX Control. Click the control to

compare this value with the permission level in SIMATIC WinCC and to
disable or enable operator actions.

EnableSwitching This property generally enables or disables switching. Example of use:
Enabling user-defined switching between several workstations.

LabelButton... All properties whose name starts with Label... serve for the labeling of indi-
vidual buttons.

UserStringID This property can be used to display a text which the user has freely defined
from a selection of default texts. The texts must be saved in the text files for
language setting. The value of UserStringID corresponds to the number of
the text in the text file. If the UserStringID has the value zero, no additional
text is displayed.

Timeout This property defines the time in seconds after which the command execu-
tion is aborted by SICAM PAS if no feedback is returned from the process.
This value can also be modified in the Advanced tab.

InputValue1
InputValue2

Input points for topological coloring.

TOPOColorINVALID This value defines the default color for lines in the INVALID state. It is
forwarded to the related connectors if the graphic object is in the INVALIFD
state. Input points for topological coloring.
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Object properties Meaning
TOPOColorOFF Default value for defining the color in case of topological coloring. This value

is transferred to the corresponding connectors if the graphic object is in the
OFF status.

EnableBlinkingOnNeg
Confirm

If a switching command receives a negative acknowledgment (i.e. CO- is
returned), the switching device object switches from command blinking to
fast blinking in order to indicate that an abnormal event has occurred.
The default value is Yes. The switching device object does not blink fast if
this parameter has been set to No. The switching device object changes to
the actual position after a negative acknowledgment; command blinking is
terminated.

Events tab

[pascc513, 1, en_US]

Figure 14-33 Object properties, Events tab

The IndustrialX Control triggers the events listed in the table.
The name of the tag name command and the name of the tag name information are assigned to the
OnButton... events in the parameter list.
These events are used for a switch with C script (see 14.2.10 Circuit Breaker/Disconnector with C Script).

Table 14-6 Object Events

Object Event Meaning
Clicked This event is triggered by clicking on the IndustrialX Control.
OnButtonON This event is triggered by clicking the ON button in the switching dialog.
OnButtonOFF This event is triggered by clicking the OFF button in the switching dialog.
OnButtonEXECUTE This event is triggered by clicking on Confirm in the switching dialog.
OnButtonSYNC_ON This event is triggered by clicking the Sync ON button for synchronous

switching in the switching dialog.
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Object Event Meaning
OnButtonCANCELSYNC This event is triggered by clicking the Cancel Synchronization button in

the switching dialog for synchronous switching.
OnActivateSYNCFUNC This event is triggered by activating the Sync Effective option under

Synchronization Feature in the switching dialog for synchronous
switching.

OnDeactivateSYNCFUNC This event is triggered by activating the Sync Not Effective option under
Synchronization Feature in the switching dialog for synchronous
switching.

OnOutput1
OnOutput2

This event is triggered if a value change has occurred on InputValue1 or
InputValue2 in the ON position.

OnILSAStartMes This event is triggered by clicking the Start Meas button in the switching
dialog for synchronous switching.

Circuit Breaker/Disconnector with C Script

The default circuit breakers/disconnectors feature a predefined command output mechanism for issuing pulse
switching commands. The pulse duration cannot be defined.

CB/DIS with C script
The graphic objects CB/DIS with C Script and CB/DIS with CScript, SBO and QoC are available in addition to
these circuit breakers/disconnectors. The integrated command output mechanism of these objects is disabled
and emulated by means of C scripts. These C scripts can be customized to meet specific requirements.
The graphic object CB/DIS with C Script is provided for use with SICAM PAS connection, the graphic object
CB/DIS with CScript, SBO and QoC for use with direct connection to SICAM RTU and IEC61850 devices.
For example, you can perform the following actions using the CB/DIS with C Script and CB/DIS with CScript,
SBO and QoC graphic objects:

• link the command execution to a condition

• check for an interlock prior to command execution

• check the switching authority conditions prior to command execution

Example
The example below illustrates a C script for a command execution subject to a condition.
To customize the predefined C script:
✧ Open the object properties of the CB/DIS graphic object with C script.
✧ In the Events tab, click Object Events.
✧ In the OnButtonON row, right-click the flash icon. Select C Action from the context menu.

The C script is displayed.

14.2.10
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Figure 14-34 C script OnButtonON, graphic object CB/DIS with Script

✧ Insert the selected rows into the C script.
The MyEnableCommandExecutionTag WinCC tag must include the condition for command execution.

✧ Close the C script.

Indirect Addressing

The description in this section applies for IndustrialX Controls (Circuit Breakers/Disconnectors and Bay Over-
view) in SICAM PAS CC V5.0 and SICAM SCC V7.01.

Indirect addressing
Indirect addressing can be used with the attributes tagname, tagnameCMD, tagnameACK, tagnameSync,
and tagnameSyncCmd.

14.2.11
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The term "indirect addressing" signifies that the name of the SICAM tag is transferred in a string tag.
In the WinCC Object properties dialog, connect an internal string tag (e.g. TagnamePlaceholder) which
contains the name of the process tag during runtime and insert a & character as prefix of the tag name (e.g.
&TagnamePlaceholder). The control (switching device object) then interprets the tag as a string tag for indi-
rect addressing. During runtime, the string tag must contain the name of the process tag without extension
(e.g. .Value).
Parameters for indirect addressing can be defined in the following dialogs:

• Object properties

• SICAM SCC CB/DIS properties
To specify indirect addressing in the Object properties dialog:
✧ Enter the name of the string tag in the Static column.

[pascc516, 1, en_US]

Figure 14-35 Object properties, defining indirect addressing

Indirect addressing is also possible when using a server or tag prefix. The prefixes cannot be suppressed in
case of indirect addressing, see 14.2.12 Addressing Using Tag and Server Prefixes. For more detailed informa-
tion, refer to the WinCC Information System, Using Tag and Server Prefixes section.
To define indirect addressing in the SICAM SCC CB/DIS properties dialog:
✧ Enter the names of the string tags in the entry fields for the tag names in the Tag connection tab.

Components and Functions of Earlier SICAM PAS CC/SCC Versions
14.2 Circuit Breaker and Disconnector

SICAM, SICAM SCC, Manual 465
E50417-H8976-C501-B5, Edition 05.2020



[pascc517, 1, en_US]

Figure 14-36 Properties of SICAM SCC CB/DIS, defining indirect addressing

ii NOTE
In the SICAM SCC CB/DIS properties dialog, the Browse button cannot be used because string tags are
filtered in the selection dialog that opens.
The indirect addressing is evaluated upon the start of the IndustrialX Control. The string tag must therefore
include the name of the SICAM tag before the WinCC diagram is opened.

Addressing Using Tag and Server Prefixes

SIMATIC WinCC provides various options for the definition and structuring of tags. For a diagram window, you
can assign a tag prefix which is placed in front of all tags used in the corresponding diagram.
In a multi-user system, integrated diagrams can be stored on any server. The server is indicated either directly
when integrating a diagram using the server prefix or assigned later via the object properties of the diagram
window. Using the server prefix, tags can also be requested from other servers.

Addressing using a tag prefix in a diagram window
Using the Tag prefix attribute, you can define the character string which is placed in front of all tags included
in the diagram window object.
The tag prefix only applies to tags of the diagram window object; it does not apply to identical tags in the
higher-level window which includes the diagram window.
To define the parameters of the tag prefix:
✧ Open the diagram window object properties.
✧ For the Tag prefix attribute, enter the prefix text.

14.2.12

Components and Functions of Earlier SICAM PAS CC/SCC Versions
14.2 Circuit Breaker and Disconnector

466 SICAM, SICAM SCC, Manual
E50417-H8976-C501-B5, Edition 05.2020
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Figure 14-37 Defining tag prefix parameters in the diagram window

The properties of the Control, e.g. a circuit breaker, are defined as follows:

[tagprefix_2, 1, en_US]

Figure 14-38 Defining Control property parameters

Sample parameterization:

• Tag prefix of the diagram window: SICAM_PAS_61850_7SJ63_

• Tag name – monitoring direction of the Control: Control_Q0_1_Position
Result:
In the diagram window, the control requests the Control_Q0_1_Position tag.
If the diagram window is assigned the SICAM_PAS_61850_7SJ63_ tag prefix, the
SICAM_PAS_61850_7SJ63_Control_Q0_1_Position tag is requested.
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Addressing using a server prefix in a diagram window
Using the Server prefix attribute, you define in a multi-user system on which server the diagram to be repre-
sented in the diagram window is stored.
To define the server prefix parameters:
✧ Open the diagram window object properties.
✧ Enter the prefix text for the Server prefix attribute.

[serverprefix, 1, en_US]

Figure 14-39 Defining the server prefix in the diagram window

Requesting tags without a prefix
The example below shows how to suppress a tag prefix.
You want to use the QuitBlinking tag without a prefix. In a multi-user system or for use in diagram windows,
the server prefix or the tag prefix is always placed in front of the tag name. To use the QuitBlinking tag
without a prefix, you can disable the prefix using the following tag addenda.

• @NOTP:: disables the tag prefix

• @NOSP:: disables the server prefix

• @NOP:: disables both the server prefix and the tag prefix
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Figure 14-40 Suppressing the tag prefix for the acknowledge tag

For more detailed information, refer to the WinCC Information System, Using Tag and Server Prefixes
section.

Operation via Keyboard

The Circuit Breaker/Disconnector graphic objects can be operated via the mouse or using the keyboard.
To initiate a switching operation using the keyboard, buttons must be inserted into the display, and a hotkey
must be configured for each button.
The switching operation is initiated by pressing the configured key or key combination during runtime. Addi-
tionally, a user right can be assigned for the operation of the button.
The runtime dialogs of switching device objects are not displayed for operation via keyboard/buttons.
An ordinary PC keyboard or a special function keyboard can be used. To use a function keyboard, the PC
keyboard must be removed from the computer and the function keyboard must be plugged in instead.

Configuring a button
A specific button for each action must be inserted into the diagram (Object palette > Windows object). The
Button Configuration dialog opens as soon as the button has been inserted.

14.2.13
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Figure 14-41 Configuring a Button

✧ Enter the button text into the Text entry field.
✧ Next, click Hotkey... to define a hotkey for the button.
✧ Click OK to close the dialog.

For more detailed information regarding the configuration of a button, refer to the WinCC Information
System.

Defining a C script
In order to be able to initiate an action via a button for Circuit breaker/disconnector, a C script has to be
defined. When clicking on the button, the C script sets the attribute CommandID of the control (switching
device object) to the defined value.
The following table provides a list of all permissible integer values and their meaning.

Table 14-7 CommandID attribute

Value Constant Action of the Control (Switching Device Object)
0 COMMANDID_NOTHING No action
1 COMMANDID_CANCEL Cancel action
2 COMMANDID_SELECT_ON Preselect switch position ON
3 COMMANDID_SELECT_OFF Preselect switch position OFF
4 COMMANDID_EXECUTE Enable switching operation
5 COMMANDID_SINGLEACK Acknowledge blinking for the selected switch
6 COMMANDID_MULTIACK Acknowledge blinking for a group

(see 14.2.2 Tag Connection of the Circuit Breakers
and Disconnectors)
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ii NOTE
Since the Command control for synchronized/unsynchronized switching is very complex, controlling via
buttons/keyboard is not supported.

The following example illustrates how the select command for ON can be initiated for the control CB1.
✧ Open the Object properties of the button.
✧ In the Properties tag, select Font.
✧ Next, enter CB1 ON for the Text attribute.
✧ Select Mouse in the Event tab.

[pascc441, 1, en_US]

Figure 14-42 Opening the editor

✧ Right-click Mouse Action in the Action column.
✧ Select C Action from the context menu.

The editor opens.

[pascc442, 1, en_US]

Figure 14-43 Edit C action
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✧ Edit the C script.
✧ Compile the C script and click OK to close the editor.

You can now add further buttons for deactivating, confirming, and canceling the switching operation and
configure these buttons accordingly. In this case, the diagram looks as shown below.

[pascc443, 1, en_US]

Figure 14-44 Diagram with buttons for a switching operation

Switching operation during runtime
During runtime, a switching operation (OFF > ON) would be executed as follows:

• The switch is in OFF state. Click CB1 ON.

• The control (switching device object) starts blinking in setpoint state.

• Click CB1 Confirm. The switching command is executed.

• The control (switching device object) switches to the ON state. The switching operation is completed.
Feedback messages regarding the switching operation are shown in the event list.

Controlling Runtime Dialogs for Controls (Switching Device Objects)

Runtime dialogs can be shown individually using an additional function. Depending on specific conditions, a
runtime dialog can be shown or hidden. Some additional dialogs, e.g. for user authentication, can pop up
between the selection of the switch and the execution of the command.
The runtime dialog can open due to a value change of the CommandID attribute (in the object properties of
the control/switching device object). The attribute value can be modified by means of a C script.
The following table shows a list of required values.

14.2.14
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Table 14-8 CommandID Attribute, Additional Values

Value Constant Action of the Control (Switching Device
Object)

20 COMMANDID_SHOWSWITCHINGDIALOG Show the switching dialog
21 COMMANDID_SHOWSTATEDIALOG Show the status dialog

Configuring the sequence

✧ Deselect the Use Integrated Dialog Boxes option in the properties of the control (switching device
object).

This avoids the runtime dialog being displayed automatically.
✧ Open the Object properties of the control (switching device object).
✧ Select the Object events entry in the Events tab.
✧ Right-click Clicked in the Action column.

[pascc450, 1, en_US]

Figure 14-45 Opening the Editor

✧ Select C Action from the context menu.
The editor opens.
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Figure 14-46 Editing the C Script

The Clicked function has the wmbutton parameter assigned. Via this parameter, you can check which mouse
button has been clicked.

Table 14-9 wmbutton parameter

Value Constant Meaning
0x0201 WM_LBUTTONDOWN the left mouse button was clicked
0x0204 WM_RBUTTONDOWN the right mouse button was clicked

✧ Edit the C script.
Add the SetPropWord() function, your test functions and all applicable conditions.

✧ Save and compile the script.

Sequence during runtime
The following sequence applies during runtime:

• Click the control (switching device object).

• The runtime dialog opens. The Clicked event is triggered. The C script is executed.

• The functions defined in the C script are processed. Depending on the relevant conditions, the
CommandID attribute is set in the properties of the control (switching device object).

• The switching dialog is shown if the CommandID attribute includes the value 20.

Response to the Change of the CommandID Attribute

As soon as a control (switching device object) has processed the value change of the CommandID attribute, it
transmits a CommandResponse event. The event includes three parameters which provide information about
the processed action.
The CommandResponse function in the C script has the following structure:

14.2.15
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void CommandResponse(char* lpszPictureName, char* lpszObjectName,
long CommandID,
long ResponseID,
char* msg)
{
...
}

lpszDisplayName and lpszObjectName are default parameters of WinCC and are not described in this
section.
The CommandID parameter includes the value of the CommandID attribute which triggered the action. The
value of the ResponseID parameter describes the result of the action. In case of error, the msg parameter
includes an error description in text form.
The following table provides a list of the ResponseIDs and their meanings.

Table 14-10 ResponseID

Value Constant Action of the Control (Switching Device Object)
0 RESPONSEID_OK The action could be executed without errors.
1 RESPONSEID_NOT_IMPLEMENTD The action specified via the CommandID attribute has

not been implemented.
2 RESPONSEID_NOT_SELECTED The control (switching device object) has been

enabled without preselecting the switch position (ON,
OFF).

3 RESPONSEID_WRONG_MODE The runtime dialog could not be displayed, as the
control (switching device object) is in Synchronized
switching mode

4 RESPONSEID_WRONG_STATE The runtime dialog could not be displayed, as the
control (switching device object) is in Fast blinking
mode.
The blinking must be acknowledged first.

5 RESPONSEID_NO_CMD_TAG For the control (switching device object), no tag
name has been selected in command direction.

6 RESPONSEID_SETISACTUAL_ VIOLATION SET- ACTUAL violation
For example, the user has tried to execute an OFF
command although the ACTUAL position is OFF.

99 RESPONSEID_ANY_ERROR Another error has occurred.
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Bay Overview
This section describes the Bay overview SICAM graphic objects for SICAM SCC V7.02 or earlier. For SICAM SCC
V8.00 or higher, they were replaced by SICAM graphic objects featuring more powerful functions. However,
the old SICAM graphic objects can still be used. The new Bay Overview SICAM graphic object is described in
4.7 SICAM Bay Overview.
The Overview folder in the SICAM graphic object library includes the Bay Overview user object. It is imple-
mented as an IndustrialX Control and already contains typical functions.
You can use a bay overview to show the status of an entire bay by means of a single graphic object.

Graphical representation
4 bay overview variants are available in the SICAM graphic object library:

Table 14-11 Graphical representation of the bay overview

Bay overview View Graphic
LSA rounded LSA representation with circular symbol

LSA boxed LSA representation with rectangular symbol

Sicam rounded SICAM representation with circular symbol

Sicam boxed SICAM representation with rectangular symbol

Maximum bay extension
A bay overview diagram can show one single bay with the following maximum extension:

14.3
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Figure 14-47 Maximum bay extension shown in one bay overview

Properties of the Bay Overview

Each bay overview must be assigned several properties.
✧ Double-click the graphic object.

The SICAM SCC BAY properties dialog opens.

The properties are shown in the General tab.

Display
The following five options are available for the representation of a graphic object:

• SICAM boxed

• SICAM rounded

• LSA boxed

• LSA rounded

• Bitmap

14.3.1
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In the Bitmap representation mode, individual diagrams can be shown depending on the value. The file
formats BMP, WMF, EMF, JPG, and GIF are supported for diagrams.

Line width
The line width of the graphic objects (LSA only) can be selected in steps from 1 to 10. Step 1 represents the
smallest line width.

WinCC update cycle
The update cycle of the tags can be set in time intervals from 250 milliseconds to one hour. Furthermore, the
setting For change is possible. 2 seconds is the default setting.

Value
In the normal state, the color and the shape of the graphic object depend on its value. A specific color is set by
default for each individual value. It is also possible to select the color from a color palette.
In the SICAM representation mode, only the color and not the shape is changed depending on the corre-
sponding value.
The following colors are defined by default for the graphic object in the SICAM and in the LSA representation
modes:

Table 14-12 SICAM and LSA representation modes

Value Color Meaning
ON Red The circuit breaker, the line disconnector and at least one busbar

disconnector are switched on.
OFF Green The circuit breaker, the line disconnector or all busbar disconnectors

are switched off.
Intermediate posi-
tion

Yellow At least one of the connected devices in the bay has a fault.

Grounded Pink The bay is grounded.

Status
The switch state is indicated by small, colored rectangles next to the graphic object. A specific color is set by
default for each individual state. The color can also be freely selected from a color palette.
The following colors of the rectangles are set by default for the representation of the individual states:

Table 14-13 Status

Status Color Meaning
Not topical Cyan (turquoise) At least one of the devices in the bay has the status Not

Topical.
PAS not OK Dark cyan (petrol) The connection between SICAM SCC and SICAM PAS or

SICAM RTU is disturbed.

The default background color is gray. It can also be freely selected.

Tag Connection to Bay Overview

The bay overview must be assigned tags.
✧ Double-click the graphic object.

The SICAM PAS CC Bay Properties dialog opens.
✧ Open the Tags tab.
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Figure 14-48 Defining the Bay Overview

Tagname BBDC1
Assign a tag to Busbar Disconnector 1:
✧ Click the Browse button next to the edit field.

The Tags dialog opens.
✧ Select the corresponding tag from the list and click OK to confirm.

Tagname BBDC2
Assign a tag to Busbar Disconnector 2:
✧ Click the Browse button next to the edit field.

The Tags dialog opens.
✧ Select the corresponding tag from the list and click OK to confirm.

Tagname BBDC3
Assign a tag to Busbar Disconnector 3:
✧ Click the Browse button next to the edit field.

The Tags dialog opens.
✧ Select the corresponding tag from the list and click OK to confirm.
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Tagname CD
Assign a tag to the circuit breaker:
✧ Click the Browse button next to the edit field.

The Tags dialog opens.
✧ Select the corresponding tag from the list and click OK to confirm.

Tagname LNDC
Assign a tag to the line disconnector:
✧ Click the Browse button next to the edit field.

The Tags dialog opens.
✧ Select the corresponding tag from the list and click OK to confirm.

Tagname EDC
Assign a tag to the ground disconnector:
✧ Click the Browse button next to the edit field.

The Tags dialog opens.
✧ Select the corresponding tag from the list and click OK to confirm.

ii NOTE
Delete the default tag link for switching devices which do not exist in the bay.

• Double-click the tag to be deleted. The tag is selected.

• Press the Del key to delete the selected tag.
This ensures that the elements in question are no longer considered for the determination of the bay state,
i. e. the value and the status of the bay overview are independent of the deleted elements.

Grounded only with CB closed
Specify whether the grounding shall only be shown when the circuit breaker is closed.

Tooltip text
Enter a text in the edit field. This text is displayed as Tooltip in the active project.
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Showing Texts in Runtime Dialogs
Freely defined texts, e. g. notes for the operator, can be shown in runtime dialogs of switches. The texts must
be saved in the PCCIX_xxx.txt text files.
Texts can be shown statically or dynamically. In this context, the term "statically" means that the text defined
via the object properties is shown during runtime.
If a dynamic display is defined, the displayed text is entered during runtime. To do this, an entry field must be
configured in the display. Via this entry field, the value of the UserStringID can be changed dynamically.

Creating/editing texts

✧ Open the ...\Siemens Energy\SICAM\SCC\bin\PCCIX_xxx.txt file in a text editor. xxx is used as a wild-
card for the language code.

[pascc420, 1, en_US]

Figure 14-49 Entering user-defined texts

✧ Under User-defined strings, enter your text (e.g. Text01) between quotation marks.
Values between 1000 and 1198 can be used as text IDs.

✧ Save and close the file.

Showing Static Texts

Proceed as follows to show a static text:

Defining the object properties

² Open the Object properties of the switch in the Graphics Designer.

14.4
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Figure 14-50 Defining the Object Properties

² Enter the text ID for the attribute UserStringID in the Properties tab. The text ID corresponds to the
number of the text in the text file.
If the UserStringID has the value zero, no additional text is displayed.

² Close the Object properties dialog and save your display.

Text display
The defined text is shown in the runtime dialog of the switch during runtime.
² Start the runtime.

² Click the switch. The runtime dialog is displayed with the defined text.

[pascc422, 1, en_US]

Figure 14-51 Showing Text

Showing Dynamic Texts

To show a dynamic text, the text ID must be changed in the UserStringID attribute of the control object
during runtime. The ID can be changed via a direct connection, a C script or a VB script.
This paragraph explains how to change the attribute using a button or a direct connection.
 
Proceed as follows to show a dynamic text:
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Defining a button

² Add a Windows object of the Button type to your display.
The Button configuration dialog opens.

[pascc426, 1, en_US]

Figure 14-52 Configuring a button

² Enter a button text in the Text box.

² Click OK to close the dialog.

² Right-click the button and select Properties from the context menu.

² Select the Events tab in the Object properties dialog.

² Select Mouse.

² Right-click Action in the Mouse Action row and select Direct connection from the context menu.
The Direct connection dialog opens.
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Figure 14-53 Configuring a direct connection

² Enter the text ID under Source, Constant.
² Select the Object in picture option under Target.

The objects are shown in a list.

² Select the control object in order to show the text in the related runtime dialog.

² Select UserStringID under Property.

² Click OK to close the dialog and save the display.

Text display
The defined text is shown in the runtime dialog of the switch during runtime.
² Start the runtime.

² Click the button.
The text ID is written into the UserStringID attribute of the switch.

² Click the switch.
The runtime dialog is displayed with the defined text.
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Figure 14-54 Showing text

To deactivate the text, write the value 0 with a direct tag into the UserStringID attribute.
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IX State Sync Application
The IX State Sync application synchronizes the blinking of switching devices. For a redundant SICAM SCC
system, it must have been installed on both servers and configured accordingly.
It synchronizes operator control actions, such as acknowledgment of spontaneous blinking, on both
computers. This also applies for the acknowledgment of spontaneous messages on a switching device object.

ii NOTE
If V7 switching device objects are still used in existing SICAM SCC projects, the IX State Sync application
can be continued to be used.
With SICAM SCC V8.00, the related functions for the new switching device objects (ActiveX Controls) are
performed by the new SICAM SCC Runtime Data Server component.

[synctool, 1, en_US]

Figure 14-55 IX State Sync

The IX State Sync application consists of a data connection to WinCC, a database and a network connection to
the IX State Sync of the other server.

Installation
The IX State Sync application is not part of the default installation of SICAM SCC. For the user-defined installa-
tion, you can select the installation of this application as SICAM PAS Redundancy components.
A subsequent installation of the IX State Sync application is also possible.
To install the IX State Sync application:
✧ Select Start > Settings > Control Panel > Add/Remove Programs.
✧ Select SICAM SCC in the list of programs and then click Uninstall/Remove.
✧ In the setup of SICAM SCC, select the Change option.
✧ Select User-defined setup.
✧ Activate IX State Sync and click Next.

The IX State Sync application is installed.

14.5
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Starting the IX State Sync application
For operation, you can enter the IX State Sync application in the startup list of WinCC Runtime in order to be
able to start and stop this application automatically together with WinCC Runtime. To perform the entry in the
startup list, select WinCC Project > Computer Properties > Startup > Additional Tasks/Applications. The
default path of the IX State Sync application is C:\Programs\Siemens Energy\SICAM\SCC\bin.

If WinCC Runtime is not running, the IX State Sync application shuts down automatically. For this reason,
WinCC Runtime must be activated in order to be able to configure IX State Sync.
The icon of the started IX State Sync application is shown in the Windows task bar.

Configuring the connection
The IX State Sync application synchronizes data via a special TCP connection. To set up this connection, one
computer is configured as server, and the other computer is configured as client. The configuration is inde-
pendent of the function of the computer in the redundant system (master/standby). In this context, the term
"Server/ Client" only refers to the TCP connection. It must not be confused with the client-server terminology
used for SIMATIC WinCC.
This connection must be set up as described below:
✧ Right-click the icon of the IX State Sync application. Select Control Center from the context menu.

The PAS CC IX State Sync dialog opens.

[synctool01, 1, en_US]

Figure 14-56 Configuring a TCP connection

The state of the TCP connection is shown under State.
✧ Select the option OFF next to Startup.
✧ On the first computer, enter the name or the IP address of the second computer in the Server entry

field.
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✧ Continue to use the default Port.
If you have any problems with your connection, contact your network administrator to request a valid
port number.

✧ Select Client. The application now tries to establish a connection to the other computer.
The connection can only work properly if it has been set up also on the second computer.

✧ Enter the same port number on the second computer and then select Server.

The computers try to set up the connection. The status Connected shows that the connection is up.
User information/error messages are displayed in the Report. If the Enable trace output option is selected, all
actions are shown in the Report. In addition, status indications are shown in the internal SICAMPASCCSynch-
State WinCC tag.
The Synchronize and Chat buttons are enabled as soon as the connection to the other computer has been
established.
Click the Synchronize button to delete the entries from the database tables on the other computer and to
replace them with entries from the local computer.
Click Socket info to show current information about the connection in the trace window.
Click Chat to open a dialog window for contacting the partner computer. The current state of the connection
is shown in the status bar.
Click Reset to clear the connection to the WinCC Data Manager and to re-establish it afterwards.
✧ Click Close to close the PAS CC IX State Sync dialog window.

All settings performed are saved when closing the application. They are still available when the application is
started again later. Click Exit in the context menu to exit the application.

Configuring the IX State Sync database
You must determine which data is to be included in the data synchronization process. These are mainly tags
used for the representation of switching devices in the monitoring direction whose IX Hook tags must be
synchronized.
To do this, the names of the WinCC tags including this data must be entered in the database. As a rule, the
IXHook elements of structured tags of the PAS_Informationtype must be entered.
For more detailed information about how to change the IX State Sync database, refer to (Modifying the IX
State Sync database, Page 490).
To configure the database:
✧ Start the WinCC Explorer with your WinCC project.
✧ Start WinCC Runtime.

If no WinCC project is running, the IX State Sync application shuts down automatically. For this reason,
WinCC Runtime must be activated in order to be able to configure IX State Sync.

✧ Right-click the icon of the IX State Sync application and select Control Center from the context menu.
The PAS CC IX State Sync dialog window opens.

✧ In the PAS CC IX State Sync dialog, click the Add Tags button.
The WinCC Tag Selection dialog window opens.

✧ Click the Refresh List button.
All tags which meet the filter criteria are shown in the list.

The asterisk symbol (*) for the filter can be replaced, but the filter name must have the extension .IXHook.
For each entry, the application searches the name of the tag structure and the name of the corresponding tag
name command structure. This combination is shown in the list. Information tags for which no tag name
command is available are ignored.
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Figure 14-57 Selecting tags

✧ Select the elements which you want to transfer to the database.
✧ Click Add selected items to DB.

The elements are entered in the database.
✧ Click Close to close the dialog.
✧ To check the entries in the database, click the View tables button in the PAS CC IX State Sync dialog.

The Main Table, Information.IXHook dialog opens. The content of the database is shown.

[synctool03, 1, en_US]

Figure 14-58 Showing the content of the database

Table 14-14 Description of the menu items available in the Main Table, Information.IXHook dialog window

Menu Item Meaning
Close Closes the dialog.
Configure Delete values Deletes the entries in the DMQuality and Value

columns.
Delete table Deletes the contents of the database, i. e. all tags are

removed.
Subtables Information.Counter

Command.Counter
Command.ReplyCounter
Information elements

Shows the corresponding database table. Changes in
these tables are not possible.
These functions are only used for diagnostic purposes.
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✧ Click Close to close the dialog.

Synchronizing the IX State Sync databases
Following the configuration of the database on the first computer, the database has to be synchronized with
the one on the second computer.
To synchronize the database on the second computer:
✧ Select Control center from the context menu.

The PAS CC IX State Sync dialog opens.
✧ Click the Synchronize button to stop the application on both computers.

The database on the second computer is deleted; the tables of the local database are transmitted to this
computer. Afterwards, the application is restarted on both computers.

ii NOTE
After each change of the local database, this database has to be synchronized with the one on the partner
computer.

Modifying the IX State Sync database
To add a tag in the database or to remove it, proceed as described below.
✧ Modify the configuration of the IX State Sync database on a SICAM SCC server (refer to Configuring the

IX State Sync database, Page 488).
✧ Synchronize the databases of the two SICAM SCC servers (refer to Synchronizing the IX State Sync data-

bases, Page 490).

Following synchronization, the application is restarted on both servers. The data is synchronized according to
the new configuration.
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Measured-Value Display Using the Script/Project Function
The Measured/Metered Values folder in the SICAM graphic object library includes the Measured value inte-
grated C script and Measured value project function user objects. These user objects already include typical
functions.
Use these objects to show measured values with an upper and a lower limit.

ii NOTE
Use the Measured value integrated C script objects to implement various functions by means of script
changes to individual objects.
Use the Measured value project function objects to control the behavior of the objects from a central
level.

Defining the Measured-Value Output

Proceed as follows to define the measured-value output:
✧ Right-click the object and select Properties from the context menu.
✧ The parameters are located in the Properties tab under SICAM.

ii NOTE
Scripts stored in the user objects must not be changed in the Events tab.

Value (*.Counter)

✧ Right-click the green bulb icon in the Value (*.Counter) row of the Dynamic column. Select Tag from
the context menu in order to assign the output box a SICAM PAS tag (e. g. MW1.Counter).

ii NOTE
Always use the Counter structure element for Value (*.counter).

Limit Max/Min
You can define 2 upper and 2 lower limits for the measured value. The text color changes when the value
exceeds the first upper limit or falls below the first lower limit. The display starts blinking when the value
exceeds the 2nd upper limit or falls below the 2nd lower limit.
✧ Double-click Limit Max/Min in the Attribute column.
✧ Enter the limit value.

Update
For the Value (*.Counter) attribute, a parameter is entered in the Current column. With this parameter, you
can define the refresh cycle of the measured value.
The following parameter values can be defined: Picture cycle, Window cycle, Upon change and time values
between 250 ms and 1 hour. Besides this, user cycles can be defined. 500 ms is the default setting.
The refresh cycle of the diagram can be defined using the Update Cycle attribute under Miscellaneous in the
Properties of the diagram.
Recommendation: 2 s.
✧ Double-click the entry in the Current column. Select the parameter from the drop-down list box which

opens.

14.6

14.6.1

Components and Functions of Earlier SICAM PAS CC/SCC Versions
14.6 Measured-Value Display Using the Script/Project Function

SICAM, SICAM SCC, Manual 491
E50417-H8976-C501-B5, Edition 05.2020



Tooltip text
The tooltip text shows the name of the object on which the mouse cursor is positioned during runtime.
✧ Double-click Tooltip text in the Attribute column.
✧ Enter the desired text.

Divider
The measured value is divided by the entered value and shown.
✧ Double-click Divider in the Attribute column.
✧ Enter the desired value.

Digits
The measured value is shown with the number of entered digits.
✧ Double-click Digits in the Attribute column.
✧ Enter the desired value.

Font color value
The font color and the background color of the value can be selected. White is the default setting for the back-
ground color. The font color depends on the state. A specific font color is set by default for each of the
following states:

Table 14-15 Font color value

Color State Meaning
Black Normal state
Cyan (turquoise) Not topical The measured value is not topical.
Gray Not Connected The measured value object is not linked to a tag.
Dark cyan (petrol) PAS not ok The connection between SICAM SCC and SICAM PAS is

disturbed.
Red Limit Max 1 The defined first upper limit of the measured value has

been exceeded.
Blue-gray Limit Min 1 The measured value has fallen below the defined first

lower limit.
Pink Overflow A measured value overflow has occurred.
Blue Substituted The measured value has been substituted.

Unit
The font color and the background color of the unit can be selected. Black and white are the default settings.
Proceed as follows to enter the text to be shown as unit:
✧ Double-click Unit in the Attribute column.
✧ Enter the text to be shown as unit.

Unit
The font color and the background color of the unit can be selected. Black and white are the default settings.
Proceed as follows to enter the text to be shown as unit:
✧ Double-click Unit in the Attribute column.
✧ Enter the text to be shown as unit.
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Value range of the measured-value object
Figures with up to 7 digits can be shown using the measured value object. The WinCC data type does not
allow more digits.
The substitute dialog is set for the display of 5 positions before and 2 positions after the decimal point. It must
be reconfigured if another format is required. The dialog is a user object which has been configured according
to WinCC conventions.

Substitute Functionality

The measured value object from the SICAM graphic object library uses the PAS_Substitute_Float_V600 SICAM
function for substituting.

Setting parameters for value substitutions
To set the parameters for the substitution of a floating point value:
² Add the Measured value display measured-value object from the SICAM graphic object library to your

diagram.
It is available under Measured/metered value.

² Insert the Substitution dialogs graphic object from the same folder.
The DlgSubstitute graphic object opens the dialog for entering the substitute value. The DlgConfirm graphic
object opens the dialog for the confirmation of the substitution.
The CloseMeasuredValueDialoges graphic object automatically closes the value substitution dialogs.
The measured-value object is always visible during runtime. By default, the two dialogs are not shown during
runtime. They are only shown if required.
Several measured-value objects can be included in the same diagram. The Value Substitution Dialogs graphic
object must be inserted only once in each WinCC diagram.
During runtime, the dialogs are shown next to the measured-value object when you right-click the measured-
value object (provided that all conditions for the substitution are met). The position of the dialogs can be
defined in the C script of the measured-value object (PAS_ShowDialogSubstitute_V600 function).

[pascc530, 1, en_US]

Figure 14-59 Inserted graphic objects

During runtime, the dialogs show the second half of the tag name at the <name> position. int is shown if the
tag has the name Fullsever1_measuredvalue_int.*.

14.6.2
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A process tag must now be linked to the measured-value object.
² Right-click the EA field and select Properties from the context menu.

² Select SICAM in the Properties tab of the Object properties dialog.

² Right-click the bulb icon in the Value (*.Counter) row of the Dynamic column. Select Tags... from the
context menu.

² Select the desired tag of the *.Counter type and click OK.

² Close the Object properties window.

Substitution during runtime
A value substitution during runtime is performed as follows:
² Start WinCC runtime.

² Click the output box of the measured-value object.
The dialog for entering the substitute value opens. The current tag value is shown by default.

ii NOTE
This dialog is not shown if the status of a message does not allow for a value substitution.
Unless an operator action is performed, the value substitution dialogs are closed automatically after 30
seconds. In this case, the substitution is not executed.

[pascc531, 1, en_US]

Figure 14-60 Dialog for entering a value

² Enter the value and click OK to confirm.
The dialog for confirming the value substitution opens.

[pascc532, 1, en_US]

Figure 14-61 Confirmation dialog

² Click Execute to confirm the action.
The value is now substituted. The substitute value is shown in the measured-value object in the color of the
Substituted status.
The actions requested in the dialogs can also be performed by pressing the ENTER and ESC keys on the
keyboard.
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Introduction to the SIMATIC WinCC Configuration Tool
Overview

The Configuration Tool is subject to the system requirements of SIMATIC WinCC and Microsoft Excel. It is also
possible to use the Configuration Tool without SIMATIC WinCC. In this case, you cannot write data to SIMATIC
WinCC.
Starting from SIMATIC WinCC V7.3, the functions of the Configuration Tool of the WinCC Configuration
Studio are integrated in the SIMATIC WinCC UI.

ii NOTE
For Microsoft Excel, you require the Office Wizard in order to output warnings from the SIMATIC WinCC
Configuration Tool.

Installing the SIMATIC WinCC Configuration Tool

The SIMATIC WinCC Configuration Tool can be installed in two different ways.

Approach 1

² During the setup of SIMATIC WinCC, select the WinCC V7.0 complete entry in the Programs dialog.
SIMATIC WinCC is installed by means of the SmartTools, the SIMATIC WinCC Configuration Tool and the
SIMATIC WinCC Archive Configuration Tool.
To start the SIMATIC WinCC Configuration Tool, click Start > SIMATIC > WinCC > Tools.

Approach 2

² On the SIMATIC WinCC DVD, change to the InstData\WinCC\setup\Products\ConfigurationTool direc-
tory.

² Double-click the setup.exe routine.

² Follow the instructions in the different dialogs of the routine.
The SIMATIC WinCC Configuration Tool is installed.

After the installation, a file with SICAM SCC-specific extensions must be copied into the installation directory
of the Configuration Tool. On the SICAM SCC DVD in the ConfigurationTool, you will find version-specific zip
files. Each of them holds a resource.xla file.
² Select the zip file with the corresponding version and extract the resource.xla file.

² Copy this file into the installation directory of the Configuration Tool (... SIEMENS\WinCC\Configuration-
Tool).
The existing file must be overwritten.

For more detailed information on how to use the SIMATIC WinCC Configuration Tool, refer to the Help menu
item in Microsoft Excel.
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Figure 14-62 SIMATIC WinCC Configuration Tool, calling up the help menu

Creating an Excel Project Folder

✧ Start Microsoft Excel.
In the menu bar, you will find the WinCC entry.

Here you can:

• obtain information on the SIMATIC WinCC Configuration Tool (About)

• call up the SIMATIC WinCC help for the Configuration Tool (Help)

• select the language for the Configuration Tool (Change language)

• create an Excel folder with the data of an existing or new project (Create project folder)
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Figure 14-63 SIMATIC WinCC Configuration Tool, WinCC menu

✧ Select Create project folder.

You can create a project folder

• with a connection to an existing SIMATIC WinCC project

• without a connection to an existing SIMATIC WinCC project

• with a connection to a new SIMATIC WinCC project
 
The following tables are created by the SIMATIC WinCC Configuration Tool:

• Project properties

• DM_default values

• Connections

• Tags

• Structure tags

• Structure types

• ALG_default values

• Message blocks

• Message classes

• Group indications

• Single-point indications

• Limit-value monitoring

• Texts

• TLG_default values
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• Times

• Process value archives

• Compression archives

• Error list (only if errors occur when writing tags)
All tables can be edited using Excel functions.

Project Folder with Connection to an Existing SIMATIC WinCC Project
If Establish connection to existing project is selected, all the data of the SIMATIC WinCC project is trans-
ferred to the Excel project folder, i.e. all alarms, message classes, data types, structures, structure types, limit
values, etc.

[pas03, 1, en_US]

Figure 14-64 Creating a project folder
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Figure 14-65 Connecting a project folder with a SIMATIC WinCC project

[pas05, 1, en_US]

Figure 14-66 Properties of a project connected to a SIMATIC WinCC project
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Figure 14-67 SICAM structure data types of a project connected to a SIMATIC WinCC project
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Figure 14-68 SICAM message classes and their formatting of a project connected to a SIMATIC WinCC
project
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Project Folder without Connection to an Existing SIMATIC WinCC Project

[pas08, 1, en_US]

Figure 14-69 Creating a project folder

If No connection is selected, a project folder is created which includes the default values for the project
settings. It does not include any SICAM-specific project settings and no connections, tags, structure types and
alarms/messages.
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Figure 14-70 Predefined properties of a project without a connection to a SIMATIC WinCC project

You can now have a WinCC project created from the Excel project folder.
² To do this, select Create WinCC project in the WinCC menu of Microsoft Excel.
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Figure 14-71 Creating a SIMATIC WinCC project

² Define the project type (single-user project, multiple-user project or multi-client project), a project
name and a path.

All the files required for the SIMATIC WinCC project are created. In addition, the project properties, including
the project name and project type, are entered in the Excel project folder.
You can now modify the project using the WinCC Explorer (i.e. insert alarms, structure types, connections,
etc.) or further edit the Excel project.

Project Folder with Connection to a New SIMATIC WinCC Project
The result of a project folder with connection to a new SIMATIC WinCC project is the same as the creation of a
project folder without connection to a SIMATIC WinCC project and the subsequent Create WinCC project,
see chapter 14.7.2.2 Project Folder without Connection to an Existing SIMATIC WinCC Project
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Working with the SIMATIC WinCC Configuration Tool

ii NOTE
The following sub-chapters are only relevant for WinCC V7.2 or earlier!
The WinCC Configuration Tool is no longer supported for WinCC V7.3 or later.

For SIMATIC WinCC V7.3 or later, the functions of the Configuration Tool of the WinCC Configuration Studio
are integrated in the SIMATIC WinCC UI.
In WinCC Configuration Studio, open the connection properties and select the suitable communication
driver.

[sc_change_version_of_channel, 1, en_US]

ii NOTE
This is only possible for different SICAM PAS versions!

Modifying the Channel Version

When working with different versions of the SICAM PAS system, e.g. after an upgrade, version-specific chan-
nels must be used. To do this, it might be necessary to reconfigure existing project data.
The following SICAM SCC communication drivers are supported by SIMATIC WinCC:

Table 14-16 SICAM SCC communication drivers supported

SICAM PAS PROTOCOL SUITE (default channel) Channel for communication with a SICAM PAS of the same
version as the currently installed SICAM SCC version; and
default channel for all versions of SICAM PAS/PQS V7 and
higher, SICAM SCC V7 and higher

SICAM PAS PROTOCOL SUITE V5 Channel for communication with SICAM PAS V5.11
SICAM PAS PROTOCOL SUITE V6 Channel for communication with SICAM PAS V6.xx
SICAM IEC COMMUNICATION SUITE Channel for communication with IEC 61850 and

IEC 60870-5- 104 devices
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ii NOTE
When using different channels, you must ensure that you only integrate channels of different versions in
SIMATIC WinCC. The default channel cannot be operated with a version-specific channel of the same
version.
Only if different versions of SICAM PAS are connected to a SICAM SCC project, must different channels be
used. Several SICAM PAS with the same version can communicate with SICAM SCC via the same channel.

ii NOTE
If data was imported into a version-specific channel or if data has to be moved to such a channel, the
configuration must be modified accordingly. Data which you have imported into a channel is saved in the
SIMATIC WinCC database with its ID. Data therefore cannot be moved from one channel to another on the
SIMATIC WinCC user interface.
The standard solution in SICAM SCC would be to delete the data using the wizard and to re-import it into
the other channel. During this process, all data configured after the import will be lost. For this reason, this
approach does not always make sense. Using the SIMATIC WinCC Configuration Tool, it is possible to
exchange one channel for the existing data. To do this, the SIMATIC WinCC project must be loaded into
Microsoft Excel and further edited using the Configuration Tool in this program.
It is possible to exchange one channel for the existing data using the SIMATIC WinCC Configuration Tool. To
do so, the SIMATIC WinCC project must be loaded into Microsoft Excel and further edited using the Config-
uration Tool in this program.

Notes on parameterization

• During an upgrade, an update in the default channel is performed automatically. There is no need to
change the parameter settings.

• Data in version-specific channels with the versions 5 or 6 can only be moved by means of a manual
change of the connection - either to the default channel or a channel with a different version (as
described in the following paragraph).

The following paragraphs describe a change of the channel version for an existing SIMATIC WinCC project.

Creating a Project Folder

² Create an Excel project folder for the existing project and then connect it to the SIMATIC WinCC project.
To do this, the SIMATIC WinCC project does not need to be open.

² Open the Connections table.

Selecting a Channel
The channel currently used for a station is indicated in the Communication Driver column.

• SICAM PAS PROTOCOL SUITE for the default channel

• SICAM PAS PROTOCOL SUITE V5 for a channel for communication with SICAM PAS V5.11

• SICAM PAS PROTOCOL SUITE V6 for a channel towards SICAM PAS V6.xx
The default channel is used in the example below.

14.8.1.1

14.8.1.2
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[pas11, 1, en_US]

Figure 14-72 SICAM PAS PROTOCOL SUITE communication driver

In the WinCC Explorer, the connection of StationSouth is represented as follows:

[pas12, 1, en_US]

Figure 14-73 Representation of the connection in the WinCC Explorer
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✧ In the Excel table, double-click SICAM PAS PROTOCOL SUITE.
A selection menu with all the communication drivers available under SIMATIC WinCC opens:

[pas13, 1, en_US]

Figure 14-74 Selection of the communication drivers

✧ Select the corresponding communication driver.

ii NOTE
If several stations exist, you must either select the default channel for each station or select one of the
version-specific channels. You can select the same channel for several connections. The combination of a
default channel and a version-specific channel of the same version is not permissible.
No check is performed. A potentially incorrect parameterization is not blocked by SIMATIC WinCC.

Working with the default channel
In the example, the SICAM PAS PROTOCOL SUITE channel has been selected for all connections (stations).
Upgrades are performed automatically for this variant. It is not necessary to perform a manual parameteriza-
tion by means of the SIMATIC WinCC Configuration Tool.
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[pas14, 1, en_US]

Figure 14-75 Permissible parameterization: several stations on the default channel in the WinCC Explorer

[pas15, 1, en_US]

Figure 14-76 Permissible parameterization: several stations on the default channel in Excel
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Working with version-specific channels

✧ Based on the explanations in the Cases from Daily Practice paragraph, you must decide which channels
you want to use.

✧ Select the correct channel for the connections to your SICAM PAS systems:

• SICAM PAS PROTOCOL SUITE V5 for communication with SICAM PAS V5.11

• SICAM PAS PROTOCOL SUITE V6 for communication with SICAM PAS V6.xx
You can combine the different channels.
✧ Save the table.

[pas16, 1, en_US]

Figure 14-77 Parameterization: several stations on version-specific channels in Excel

Combination of the default channel and a version-specific channel
The combination of a default channel and a version-specific channel of the same version is not permissible.
However, no check is performed. A potentially incorrect parameterization is not blocked by SIMATIC WinCC.

ii NOTE
Be aware that different versions must be used when combining the default channel with a version-specific
channel. This check is particularly important for all upgrade scenarios.
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[pas17, 1, en_US]

Figure 14-78 Parameterization: combination of a version-specific channel with a default channel in Excel

Writing Connections Back into the SIMATIC WinCC Project
After selecting a valid combination for the channels, you can write the modified settings back into the SIMATIC
WinCC project.
If the SIMATIC WinCC project to be edited is open:
² In Microsoft Excel, select the WinCC > Write connections menu item.
If the SIMATIC WinCC project to be edited is not open:
² Select the Establish project connection menu item.

A connection is established with the SIMATIC WinCC project assigned to the project folder. To do this, the
WinCC Explorer is, however, not opened.

² In Microsoft Excel, select the WinCC > Write connections menu item.
You only need to write the changes.

14.8.1.3
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[pas18, 1, en_US]

Figure 14-79 Writing connections

You can now check the new connections in the WinCC Explorer.
After writing back the connections into the SIMATIC WinCC project, the version-specific channels with the
stations are displayed as soon as the view has been refreshed. The default channel originally used is empty.

[pas19, 1, en_US]

Figure 14-80 WinCC Explorer after the change to version-specific channels

The SICAM PAS PROTOCOL SUITE driver previously used is still displayed in the Tag Management of the
WinCC Explorer. This information cannot be automatically deleted from the system, but you can remove the
driver manually.
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The SubstationSouth station now uses the SICAM PAS PROTOCOL SUITE V5 driver, whereas the Substation-
North station uses the SICAM PAS PROTOCOL SUITE V6 driver.

Editing Structure Types

For a migration of SICAM PAS/SICAM PAS CC from V5.xx to SICAM SCC V8.04, the structure types must be
extended in order to be able to use new functions of SIAM PAS V7.00/V8.00 or the SIMATIC WinCC WebNavi-
gator.
For SICAM PASCC V6.00 or higher, you require an extension of the structure types by the DWORD WBCounter
element in order to be able to execute the Substitute function.

[pas20, 1, en_US]

Figure 14-81 PAS_Information V5.xx structure type
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[pas21, 1, en_US]

Figure 14-82 PAS_Information V6.xx/V7.00 structure type

Additional structure element for the PAS_Information V6.xx/V7.00 structure types:

• WBCounter
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[SCC_PAS_Information, 1, en_US]

Figure 14-83 PAS_Information V8.00 structure type

Components and Functions of Earlier SICAM PAS CC/SCC Versions
14.8 Working with the SIMATIC WinCC Configuration Tool

SICAM, SICAM SCC, Manual 515
E50417-H8976-C501-B5, Edition 05.2020



[SCC_PAS_Command, 1, en_US]

Figure 14-84 PAS_Command V8.00 structure type

From SICAM SCC V8.00 (SIMATIC WinCC V7.0 or higher), an extension of the structure types by further
elements is required in order to be able to establish the connection to the SICAM Runtime Dataserver, see
chapter7.8 SICAM SCC Runtime Data Server.
Additional structure elements for the PAS_Information V8.00 structure type:

• WBCounter

• COVCounter, external

• RTInfo, internal

• RTSync, internal
Additional structure elements for the PAS_Command V8.00 structure type:

• COVCounter, external

• RTCmd, internal

✧ Add/modify the structure types described in the paragraph below.
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Modifying Structure Types
Using the SIMATIC WinCC Configuration Tool, it is also possible to modify structure types and the corre-
sponding structure elements.
Proceed as follows in order to add a new structure element, e.g. WBCounter, to the PAS_Information struc-
ture type:
² Select the Structure types table in Microsoft Excel.

² Click Insert > Rows in order to insert a new row for the PAS_Information structure type.

² In the new row under Structure elements, enter WBCounter in the Name column.

² Double-click in the Data type column and select the 32-bit value without sign data type from the list.

² Double-click in the External tag column and select Yes.
Internal tags are only visible in SIMATIC WinCC on the internal, local or project level. The channel and
SICAM PAS cannot "see" them.

[pas22, 1, en_US]

Figure 14-85 Defining a new structure element

² In Microsoft Excel, select the WinCC > Write structure types menu item.
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[pas23, 1, en_US]

Figure 14-86 Writing a structure type

It is sufficient only to write changes - select the Changes only checkbox for writing connections.
² Open the Tags table.

² Select the WinCC > Write tags menu item.
The new tags are transferred back into the SIMATIC WinCC project.

[pas24, 1, en_US]

Figure 14-87 Writing tags

Deleting Structure Types/Tags
When exchanging a V8 default channel by a version-specific V5 channel, you can use the Configuration Tool in
order to delete V6-specific structure elements (if existing). If only SICAM PAS V5.xx is connected, the
WBCounter structure element can be deleted.

14.8.2.2
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In Microsoft Excel, do not use the Edit > Delete cells function in order to delete tags, structure types or struc-
ture type elements.

ii NOTE
Before each delete action, save the SIMATIC WinCC project because the delete action cannot be undone.

To delete tags, structure types, or structure type elements:
² Highlight the rows which you want to delete.

² Right-click the highlighted rows and then select WinCC - Delete selection from the context menu.

[pas25, 1, en_US]

Figure 14-88 Deleting a structure element

When deleting structure types and structure elements, the corresponding structure tags are deleted automati-
cally.
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Structures
In SICAM SCC, the items of PAS information (tags) is (are) processed as structures; a structure consists of
several elements. There are 6 different structure types.
When importing tags from SICAM PAS, the tags are automatically assigned to the corresponding structure
type.
In SICAM SCC, you directly access structure type elements, i.e. tags and relevant additional information.
This chapter provides a list of the structure types and an overview of the meaning of the structure elements.

External Structure Types
The following external SICAM SCC structure types are created by the SICAM PAS Wizard:

• PAS_Information

• PAS_InformationFloat

• PAS_InformationSInt

• PAS_Command

• PAS_CommandFloat

• PAS_CommandSInt

Structure Elements
The structures are composed of elements.

Table A-1 PAS_Information structure (monitoring direction)

Double word (4 bytes) Value
Double word (4 bytes) Validity
Double word (4 bytes) Valuetype
Double word (4 bytes) Cause
Double word (4 bytes) Additional cause (AddCause)
Double word (4 bytes) Counter
Bit Alarm
Double word (4 bytes) WBCounter
Double word (4 bytes) IXHook
Double word COVCounter
8-bit character set text variable RTInfo
8-bit character set text variable RTSync
8-bit character set text variable RTTopo

ii NOTE
WBCounter is only available for newly created projects. Old projects can be adjusted accordingly (see
14.8.2 Editing Structure Types)

Table A-2 Structure PAS_InformationFloat (monitoring direction)

Floating point (4 bytes) Value
Double word (4 bytes) Validity
Double word (4 bytes) Valuetype
Double word (4 bytes) Cause
Double word (4 bytes) Additional cause (AddCause)

A.1
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Double word (4 bytes) Counter
Bit Alarm
Double word (4 bytes) WBCounter
Double word (4 bytes) IXHook
Double word COVCounter
8-bit character set text variable RTInfo
8-bit character set text variable RTSync
8-bit character set text variable RTTopo

Table A-3 PAS_InformationSInt structure (monitoring direction)

Long (4 bytes) Value
Double word (4 bytes) Validity
Double word (4 bytes) Valuetype
Double word (4 bytes) Cause
Double word (4 bytes) Additional cause (AddCause)
Double word (4 bytes) Counter
Bit Alarm
Double word (4 bytes) WBCounter
Double word (4 bytes) IXHook
Double word COVCounter
8-bit character set text variable RTInfo
8-bit character set text variable RTSync
8-bit character set text variable RTTopo

Table A-4 PAS_Command structure (command direction)

Double word (4 bytes) Value
Double word (4 bytes) Validity
Double word (4 bytes) Valuetype
Double word (4 bytes) Cause
Double word (4 bytes) Additional cause (AddCause)
Double word (4 bytes) ReplyCounter
Double word (4 bytes) Command counter (CmdCounter)
Double word COVCounter
8-bit character set text variable RTCmd

Table A-5 PAS_CommandFloat structure (command direction)

Floating point (4 bytes) Value
Double word (4 bytes) Validity
Double word (4 bytes) Valuetype
Double word (4 bytes) Cause
Double word (4 bytes) Additional cause (AddCause)
Double word (4 bytes) ReplyCounter
Double word (4 bytes) Command counter (CmdCounter)
Double word COVCounter
8-bit character set text variable RTCmd
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Table A-6 PAS_CommandSInt structure (command direction)

Long (4 bytes) Value
Double word (4 bytes) Validity
Double word (4 bytes) Valuetype
Double word (4 bytes) Cause
Double word (4 bytes) Additional cause (AddCause)
Double word (4 bytes) ReplyCounter
Double word (4 bytes) Command counter (CmdCounter)
Double word COVCounter
8-bit character set text variable RTCmd

For monitoring and controlling, you specifically access the elements of the structures.

Structure Elements

• Value
The possible variants are indicated for each Value Type. The description does not mention all possible
types, but is restricted to the most important types.

 
Value Type 1: Organizational message
Freely defined, according to information address.
 
Value Type 2: Double-point indication
Highword
Lowword D

D: 00 Intermediate position
01 OFF
10 ON
11 Fault

Value Type 3: Single-point indication
Highword
Lowword S

S: 1 OFF
2 ON

Value Type 5: Transformer tap indication
Highword
Lowword LZ LK 8 bits Transformer tap (binary)

LZ: 0 Runtime monitoring not activated
LZ: 1 Runtime monitoring activated
LK: 0 Moving contact does not move (final position)
LK: 1 Moving contact moves (intermediate position)

Value Type 6: Message with value
Highword 32 bits real value
Lowword

Value Type 7: Bit pattern indication, 8 bits
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Highword
Lowword 8 bits bit pattern (binary)

Value Type 8: Bit pattern indication, 16 bits
Highword
Lowword 16 bits bit pattern (binary)

Value Type 9: Bit pattern indication, 24 bits
Highword
Lowword

 
 
Value Type 10: Bit pattern indication, 32 bits
Highword 32 bits bit pattern (binary)
Lowword

Value Type 12: Metered value
Highword 32 bits value, two’s complement
Lowword

Value Type 13: Persistent switching command
Highword
Lowword S

S: 0 OFF
1 ON

Value Type 14: Pulse switching command
Highword
Lowword

S: 0 OFF
1 ON

If 0 ms is used as the period, the time sent by the CFC is used.
 
Value Type 17: Transformer tap positioning command
Highword
Lowword 8 bits Transformer tap (binary)

Value Type 18: Setpoint digital, 8 bits
Highword
Lowword 8 bits setpoint value (binary)

Value Type 19: Setpoint digital, 16 bits
Highword
Lowword 16 bits setpoint value (binary)

Value Type 21: Setpoint digital, 32 bits
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Highword 32 bits setpoint value (binary)
Lowword

Value Type 22: Setpoint value analog, floating point
Highword 32 bits real value
Lowword

Values which cannot be represented as a 16 Bit-value are not output. They are BF-acknowledged with a plausi-
bility error as an additional cause.
 
Value Type 24: Setpoint value analog, fixed point
Highword
Lowword Value

16 bits value, two’s complement
Value Type 28: Measured value, floating point
Highword 32 bits real value
Lowword

Value Type 30: Measured value, fixed point
Highword
Lowword Value

16 bits value, two’s complement
 

• Status
The Status element is composed of two parts. Byte 0 and Byte 1 include the Status, Byte 2 and Byte 3
indicate a Timeout in seconds.
The timeout is the system-internal monitoring time for the command output.

Value
(Byte 0 and Byte 1)

Meaning

Bit 0 Reserved (System)
Bit 1 Reserved (System)
Bit 2 Bit 2 within the status means that the process data have been written into SICAM

SCC for the first time after a restart (SICAM PAS or SICAM SCC). This informs all
components about the system restart. The components then check if they can
continue from the last known status or if they have to re-initialize.

Bit 3 Reserved (System)
Bit 4 Reserved (System)
Bit 5 Reserved (System)
Bit 6 Reserved (System)
Bit 7 Counter state
Bit 8 Bay blocking set
Bit 9 Reserved (System)
Bit 10 Not updated (not topical)
Bit 11 Substituted
Bit 12 Reserved (System)
Bit 13 Remote monitoring direction blocked
Bit 14 Invalid
Bit 15 Overflow
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• Value Type

Value Meaning
1 Organizational indication
2 Double-point indication
3 Single-point indication
4 Event indication
5 Transformer tap position indication
6 Indication with value
7 Bit pattern indication, 8 bits
8 Bit pattern indication, 16 bits
9 Bit pattern indication, 24 bits
10 Bit pattern indication, 32 bits
11 Organizational acknowledgment
12 Metered value
13 Persistent switching command
14 Pulse switching command
15 Continuous control command
16 Auto-reclose command
17 Regulating step command
18 Scheduled value digital, 8 bits
19 Scheduled value digital, 16 bits
20 Scheduled value digital, 24 bits
21 Scheduled value digital, 32 bits
22 Setpoint analog, floating point
23 Setpoint analog, standardized
24 Setpoint analog, fixed point
25 GI request
26 Restore command
27 Organizational command
28 Measured value, floating point
29 Measured value, normalized
30 Measured value, fixed point
31 Sequence

 

• Cause

Group / Value Meaning
0 Irrelevant
1 Spontaneous
2 Cyclic, periodic
3 Initialized/default
4 Buffered
8 General interrogation
9 Request
10 Metered-value interrogation
16 Check
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Group / Value Meaning
17 Positive check result
18 Negative check result
19 Command execution
20 Command acceptance positive
21 Command acceptance negative
23 Return information negative
24 Command feedback intermediate position
25 Cancellation
26 Positive abortion procedure
27 Cancellation negative
28 Command execution ending
29 Release request
30 Positive release request
31 Negative release request
32 Organizational information
33 Information loss
34 Return Information
35 Command termination positive
36 Command termination negative
Bit 7 Direction bit

 

• Additional Cause

Value Meaning
0 No error
32 Release control
33 Reset command
34 Incorrect output time
35 Error on command check
36 Error in counter release
37 Unknown I/O channel
38 Too many commands active
39 Incorrect command type
40 Incorrect data type
41 Command not accepted
64 1-out-of-n error (hardware)
65 Target check
66 Voltage command relay
67 Release relay cannot be terminated
68 Output register not plausible
80 De-energized
81 Switching current check
82 Incorrect operational output
83 Command output voltage missing
96 Interlock finding
97 Switching error protection interlock
98 Parameter error
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Value Meaning
99 Violation of switching authority
100 Command too old
101 No process output object
102 Output disabled
103 Hardware error module
104 Hardware error I/O channel
105 Overload
112 Upper limit
113 Lower limit
114 Plausibility error
115 Sync. prerequisite missing
116 Device state preventing command
117 SCHEDULED = ACTUAL
118 Monitoring time elapsed (timeout)
119 Acquisition disabled
120 Chatter disabling active
121 1-of-n error (software)

 

• Counter

For process indications
The counter is increased by the SICAM PAS PROTOCOL SUITE whenever a new item of information has been
transmitted.
The WBCounter is increased by the WinCC object whenever an item of information must be substituted on the
SICAM PAS server.
 

For commands
For SICAM SCC to send a command, the command counter (CmdCounter) must be increased. In this way, the
SICAM PAS PROTOCOL SUITE detects that the information has changed.
The ReplyCounter is increased by the SICAM PAS PROTOCOL SUITE whenever a new item of information, e.g.
a CO+ or COE command feedback, has been transmitted.
 

System-wide centralized counter (COVCounter)
The COVCounter is managed consistently on a system-wide level in SICAM PAS and SICAM SCC and enables
the precise assignment of information.
 
 

• Alarm
This element is only relevant for old systems. For old projects in which the alarms are triggered by changes of
the process tags (bit message procedure), the alarm bit of the corresponding tag is used as a trigger.
0 OFF
1 ON
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• IXHook
The IXHook tag is created as an internal tag of an ActiveX Controls. It comprises the current status of the
ActiveX Controls during the runtime of the project.
 
 

• RuntimeDataServer Tags
The RTInfo and RTCmd tags are required for the internal communication of the graphic objects via the Runti-
meDataServer. Process values and command outputs are routed via the RuntimeDataServer which processes
them.
The RTSync tag is used in order to match items of SICAM information between redundant WinCC servers.
The RTTopo tag is used in order to transfer the topological information from the topology component (colors,
style, topological status).
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Quality Codes of Variables
The following table lists the quality codes that are set by the SICAM PAS PROTOCOL SUITE.

Table A-7 Quality codes of variables

Hex value Quality Meaning Q Q S S S S L LA
00 Bad Non-specific - There is no specific

reason why the value is bad. Used for
propagation.

0 0 0 0 0 0 - -

0C Bad Device Failure - Set if the source of the
value is affected by a device failure.

0 0 0 0 1 1 - -

14 Bad No Communication, with last usable
value - Set if this value had been set by
communication, which has now failed.

0 0 0 1 0 1 - -

18 Bad No Communication, with no usable
value - Set if there has never been any
communication with this value since it
was last "Out of Service".

0 0 0 1 1 0 - -

44 Uncertain Last Usable Value - Whatever was
writing this value has stopped doing so.
This is used for fail safe handling.

0 1 0 0 0 1 - -

48 Uncertain Substitute value - Predefined value is
used instead of the calculated one. This
is used for fail safe handling.

0 1 0 0 1 0 - -

4C Uncertain Initial Value - Value of volatile parame-
ters during and after reset of the device
or of a parameter.

0 1 0 0 1 1 - -

80 Good
(Non-Cascade)

OK - No error or special condition is
associated with this value.

1 0 0 0 0 0 - -

The 2 low-order bits are set optionally in the quality codes.

Table A-8 Limits - optionally in the quality codes

Meaning Q Q S S S S L L
O.K. - The value is free to move - - - - - - 0 0
High limited - The value has exceeded its high limits - - - - - - 1 0

The abbreviations in the table columns mean:
Q Quality
S Substatus of the quality
L Limits, this value is optionally

A.2

Appendix
A.2 Quality Codes of Variables

SICAM, SICAM SCC, Manual 531
E50417-H8976-C501-B5, Edition 05.2020



Character Conversion
When importing SICAM PAS process tags or SICAM PAS archive tags from SICAM PAS or SICAM plusTOOLS, the
tag names are adapted to the conventions of SIMATIC WinCC.
This paragraph contains conversion tables showing how the names are changed during the import process.

Process Tags
For SICAM PAS CC and SICAM SCC, the type of special character conversion is defined in the SICAM PAS
Wizard. For SICAM SAS, it is defined in the SICAM Global Wizard.

• Character conversion in SICAM SCC
In order to create a new station in SICAM SCC, the SICAM, V5.0 (or later) conforming parameter must
be selected in the SICAM PAS Wizard under General settings. The special characters in tag names are
converted as follows during the import process:

Table A-9 Character conversion in SICAM SCC

SICAM PAS SICAM SCC
\ _ (underscore)
Blank character is deleted
. _
; _
, _
: _
= EQ
< SM
> GR
{ (
} )
[ (
] )
* _
“ _
` _
´ _
& _
/ _
+ _
- _
’ _
? _
! _
$ _
% _

The special character conversion includes special characters of the German and English keyboard. All other
special characters which are represented on keyboards for other languages are converted to the corre-
sponding ASCII codes.

A.3
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ii NOTE
Special features in SICAM IEC Wizard:
Texts being too long are cut automatically. For resulting identical entries warnings are displayed during
import. This behavior may occur especially for direct SCD import, without editing via SICAM TOOLBOX II.
Observe the warnings.

• SICAM WinCC V2.xx character conversion
To update an existing station created with SICAM WinCC V2.xx, the Special character conversion SICAM
WinCC to V2.1x conforming parameter must be selected in the SICAM Global Wizard under General
settings. The special characters in tag names are converted as follows during the import process:

Table A-10 SICAM WinCC V2.xx character conversion

SAS WinCC
\ _
Blank character is deleted
. _
ä ae
ö oe
ü ue
Ä AE
Ö OE
Ü UE
; _
: _
= ##
< #_
> _#
{ _
} _
[ _
] _
* _
“ _
` _
´ _
& _
/ _
+ _
- _
@ _

• Character conversion SICAM WinCC V3.1
In order to create a new station with SICAM WinCC V3.1, the Special character conversion SICAM
WinCC, V3.1x (or later) conforming parameter must be selected in the SICAM Global Wizard under
General settings. The special characters in tag names are converted as follows during the import
process:
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Table A-11 Character conversion SICAM WinCC V3.1

SAS WinCC
\ _
Blank character is deleted
. _
; _
: _
{ _
} _
[ _
] _
* _
“ _
` _
´ _
/ _
+ _
- _

Archive Tags
Special characters in message names are converted during the import process as described below.

• SICAM SCC character conversion

Table A-12 Character conversion in message names

SICAM PAS SICAM SCC
\ _
Blank character is deleted
. _
; _
, _
: _
= EQ
< SM
> GR
{ (
} )
[ (
] )
* _
“ _
` _
´ _
& _
/ _
+ _
- _
@ _
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SICAM PAS SICAM SCC
’ _
? _
! _
$ _
% _

The special character conversion includes special characters of the German and English keyboard. All other
special characters which are represented on keyboards for other languages are converted to the corre-
sponding ASCII codes.
 

• SICAM WinCC character conversion

Table A-13 Character conversion in message names

SAS WinCC
\ _
Blank character is deleted
. _
ä ae
ö oe
ü ue
Ä AE
Ö OE
Ü UE
; _
, _
: _
= EQ
< SM
> BG
{ _
} _
[ _
] _
* _
“ _
` _
´ _
& _
/ _
+ _
- _
@ _
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Additional Information in Message Lists
This paragraph describes which additional items of information are written into which columns of the SICAM
SCC message lists.
The list refers to the text library which is included in the program.

Table A-14 Additional information in message lists - Value

Column Textlib-ID
(Offset in
Value
Text
Group)

Process Value German Text English Text

Value 0 0 Zwischenstellung Doppelmeldung interm. state double indication
1 1 AUS Doppelmeldung OFF double indication
3 2 EIN Doppelmeldung ON double indication
22 3 Störstellung Doppelmeldung bad state double indication
3 2 KOM Einzelmeldung RAISED single indication
4 1 GEH Einzelmeldung CLEARED single indication
5 0 Ereignis Statusänderung event state change
6 2 Wischer transient
7 SICAM SAS Trafostufenstellbefehl RC tap position RC
8 SICAM SAS Trafostufenstellung Laufkontakt tap position moving contact
9 SICAM SAS Messwert TCB (Total Count Bit) metered value TCB
10 SICAM SAS Messwert IEB (Internal Error Bit) metered value IEB
11 SICAM SAS Messwert RB (Restore Bit) metered value RB
12 1 AUS Befehl OFF static output command
13 2 EIN Befehl ON static output command
14 0/3 STOP Dauerbefehl STOP continous command
15 1 MINUS Dauerbefehl MINUS continous command
16 2 PLUS Dauerbefehl PLUS continous command
17 2 EIN Impulsbefehl ON pulse output command
18 1 AUS Impulsbefehl OFF pulse output command
19 1 TIEFER Trafostufenstellbefehl DOWN tap position command
20 2 HOEHER Trafostufenstellbefehl UP tap position command
21 _ nicht initialisiert not initialized

Table A-15 Additional information in message lists - Block Status

Column Textlib-ID 2030
(+ Offset)

German Text English Text

Block status 9 Aus Feld- und Fernwirksperre Not blocked bay and telecontrol
10 Feldsperre bay blocked
11 Fernwirksperre telecontrol blocked
12 Feld- und Fernwirksperre bay and telecontrol blocked
13 ignoriere Fernwirksperre ignore telecontrol blocking
14 werte Fernwirksperre aus evaluate telecontrol blocking

A.4
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Table A-16 Additional information in message lists - Location

Column Textlib-ID 1700
(+ Offset)

German Text English Text

Location 0 Irrelevant irrelevant
1 Vorort local
2 Nah near
3 Fern remote
4 Automatisch automatic
5 Automatisch (Feld) automatic (bay)
6 Prozess process
10 DIGSI Vorort DIGSI local
11 DIGSI Fern DIGSI remote
20 Gerät ungültig device invalid
21 Gerät gesperrt device locked
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Table A-17 Additional information in message lists - Cause

Column Textlib-ID 1000
(+ Offset)

German Text English Text

Cause 0 Ursache irrelevant cause irrelevant
1 spontan spontaneous
2 periodisch periodic
3 initialisiert initialized
4 Generalabfrage buffered
8 Generalabfrage general interrogation
9 Anfrage request
10 Zählwertabfrage counter value request
16 Prüfung check back
17 Prüfung + check back +
18 Prüfung - check back -
19 Befehl command
20 Befehl + command +
21 Befehl - command -
22 Rückmeldung + feed back +
23 Rückmeldung - feed back -
24 Rückmeldung stör feed back intermediate
25 Abbruch abortion
26 Abbruch + abortion +
27 Abbruch - abortion -
28 Befehlsende command execution end
29 Freigabeanforderung release request
30 Freigabeanforderung + release request +
31 Freigabeanforderung - release request -
32 Organisatorische Meldung organisatory indication
33 Meldungsverlust information loss
34 Rückmeldung feed back
35 Befehlsende + command execution end +
36 Befehlsende - command execution end -
37 Abbruch Ende + abortion end +
38 Abbruch Ende - abortion end -
39 Prüfungsende + check back end +
40 Prüfungsende - check back end -
41 Freigabeanf. Ende + release reg end +
42 Freigabeanf. Ende - release reg end -
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Table A-18 Additional information in message lists - Status

Column Textlib-ID 2100
(+ Offset)

German Text English Text

Status 5 Umspeicherbit metered value freeze bit
6 Internes Fehlerbit internal Error bit
7 Zählerstand metered value
8 Feldsperre bay blocked
9 Externer Fehler external error
10 Nicht aktuell not topical
11 Nachgeführt substituted
12 Flattersperre debounced
13 Fernwirksperre telecontrol blocked
14 Ungültig invalid
15 Überlauf overflow
16 Status Ok status ok
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Table A-19 Additional information in message lists - Additional Cause

Column Textlib-ID 1200
(+ Offset)

German Text English Text

Additional cause 0 Kein Fehler no error
32 Freigabeansteuerung release control
33 Rücksetzen Befehl reset command
34 Falsche Ausgabezeit output time error
35 Fehler bei Befehlskontrolle control error
36 Fehler Zählerfreigabe counter release error
37 Unbekannter I/O-Kanal unknown I/O channel
38 Zu viele Befehle aktiv too many active commands
39 Falscher Befehlstyp command type error
40 Falscher Datentyp datatype error
41 Befehl wird nicht angenommen command not accepted
64 1 aus n-Fehler (Hardware) 1 out of n-error (hardware)
65 Zielkontrolle target check
66 Spannung Befehlsrelais command relay voltage
67 Freigaberelais nicht absteuerbar release can not be terminated
68 Ausgaberegister nicht plausibel output register not plausible
80 Spannungsfreiheit de-energized
81 Schaltstromkontrolle terminal allocation
82 Falscher Betriebsausgang operational output error
83 Befehlsausgabespannung fehlt command output voltage missing
96 Verriegelungsbefund interlocking
97 Schaltfehlerschutzverriegelung switchgear interlocking
98 Parameterfehler parameter error
99 Verstoß Schalthoheit authority violation
100 Befehl zu alt command too old
101 Kein Prozessausgabeobjekt no process output object
102 Ausgabesperre output disable
103 HW-Fehler Baugruppe HW error module
104 HW-Fehler I/O-Kanal HW error I/O channel
105 Überlast overload
112 Obere Grenze upper limit
113 Untere Grenze lower limit
114 Plausibilitätsfehler plausibility error
115 Voraussetzung für Sync. fehlt sync. precondition missing
116 Gerätezustand verhindert Befehl dev. state disables command
117 SOLL = IST set = actual
118 Überwachungszeit abgelaufen monitoring time expiredset = actual
119 Erfassungssperre acquisition disable
120 Flattersperre aktiv debouncing active
121 1 aus n-Fehler (Software) 1 out of n-error (software)
196 Verriegelt, synchronisiert interlocked, synchronized
197 Verriegelt, nicht synchronisiert interlocked, not synchronized
198 Unverriegelt, synchronisiert non-interlocked, synchronized
199 Unverriegelt, nicht synchronisiert non-interlocked, not synchronized
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Table A-20 Additional information in message lists - ID number, Additional information

Column Textlib-ID 1900
(+ Offset)

German Text English Text

ID number 0 Identifikationsnummer irrelevant identification number irrelevant
1 Implizit bestimmt implicitly determined
2 Rückmeldungsidentifikator return information identifier
3 Fehlernummer fault number

Additional informa-
tion

4 Zusatzinformation irrelevant suppl. info irrelevant
5 Zusatzinformation impl. bestimmt suppl. info impl. determined
6 Relativzeit in ms relative time in ms
7 Quelladresse initiator address
8 Ein Laufkontakt ON transition information
9 Gemeldet von: Reported by:

Table A-21 Additional information in message lists - Time Status IEC Communication Suite

Column Textlib-ID 1170
(+ Offset)

German Text English Text

Time status IEC
Communication
Suite

0 W | EXT
(Winterzeit, Prozess - extern)

W | EXT
(Standard time, process - extern)

1 S | EXT
(Sommerzeit, Prozess - extern)

S | EXT
(DST, process - extern)

2 W | INT
(Winterzeit, Kanal - intern)

W | INT
(Standard time, channel - intern)

3 S | INT
(Sommerzeit, Kanal - intern)

S | INT
(DST time, channel - intern)
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Table A-22 Additional information in message lists - Time Status PAS Channel

Column Textlib-ID 1180
(+ Offset)

German Text English Text

Time status PAS
channel

0 W |GN
(Winterzeit, gültig, nicht synchroni-
siert)

W | VN
(Standard time, valid, not synchron-
ized)

1 S |GN
(Sommerzeit, gültig, nicht synchroni-
siert)

S | VN
(DST, valid, not synchronized)

2 W |GS
(Winterzeit, gültig, synchronisiert)

W | VS
(Standard time, valid, synchronized)

3 S |GS
(Sommerzeit, gültig, synchronisiert)

S | VS
(DST, valid, synchronized)

4 W |UN
(Winterzeit, nicht gültig, nicht synchro-
nisiert)

W | IN
(Standard time, not valid, not
synchronized)

5 S |UN
(Sommerzeit, nicht gültig, nicht
synchronisiert)

S | IN
(DST, valid, not synchronized)

6 W |US
(Winterzeit, nicht gültig, synchroni-
siert)

W | IS
(Standard time, not valid, synchron-
ized)

7 S |US
(Sommerzeit, gültig, synchronisiert)

S | IS (DST, not valid, synchronized)

8 e (von SICAM PAS ersetzt) r (replaced by SICAM PAS)
- (WinCC) Zeitstempel von SICAM SCC

erzeugt
(WinCC) Time stamp generated by
SICAM SCC

Table A-23 Additional information in message lists - Time Status SIMATIC S7 Channel

Column Textlib-ID 1190
(+ Offset)

German Text English Text

Time status SIMATIC
S7 channel

0 GN (gültig, nicht synchronisiert) VN (valid, not synchronized)
1 GS (gültig, synchronisiert) VN (valid, synchronized)
2 UN (ungültig) IN (invalid)
3 S (Sommerzeit) DST (Daylight Saving Time)
4 W (Winterzeit) noDST (Standard time)
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Performance Measurements

For a Core i5 3470 with 8 GB of RAM, you get the following results during the performance measurement:
Measurement Value
Average process-value changes per second max. 800
Short-term (< 1 h) value count 1900

NOTE: The maximum number of 800 values/s must not be
exceeded.

When using a 32-bit application, more memory and more cores do not necessarily improve performance. Less
high-performance PCs reduce throughput. Therefore, Siemens recommends that when approaching the tested
limits, you check whether the required response times can be achieved.
Since SICAM SCC uses structure variables for the process data-points and each structure variable has about 10
WinCC variables, Siemens recommends distributing the project for more than about 25,000 data points to
several WinCC servers.

A.5
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